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About This Manual

Design Architect manuals provide information about the Schematic Editor, th
Symbol Editor, and the VHDL Editor.

This application uses the BOLD Browser as its default on-line documentation
help viewer. The application can alternately use Adobe Acrobat as its
documentation and help viewer. On-line help requires a Mentor Graphics-
supplied software extension to Acrobat and also requires setting an environm
variable. For more information, refer toUsing Mentor Graphics Documentation
with Adobe Acrobat.

A Support pulldown menu allows the user direct access to Mentor Graphics
Customer Support. The menu is available in the Session Window of Design
Architect. For more information, see“Support Pulldown Menu” on page B-1.

TheDesign Architect User’s Manual consists of the following:

• “Overview” - Provides an overview of the editing environment and
functionality.

• “Design Capture Concepts” - Describes concepts necessary for creating a
editing a design.

• “Property Concepts” - Describes concepts related to properties associat
with design capture.

• “Editing in the Context of a Design” - Describes the concepts for editing a
schematic in the context of a design viewpoint.

NT
For Microsoft Windows NT users, this symbol identifies unique
information for using this application on the Windows NT
platform.
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• “Design Error Checking” - Discusses design checking.

• “Operating Procedures” - Provides operating procedures for various editin
tasks.

• “DA Design Checks” - Lists required and optional checks performed in
Design Architect.

Related Publications
The following list provides a brief overview of each of the Mentor Graphics
manuals that contain information on related topics.

Getting Started with Design Architectis for new users of Design Architect who
have some knowledge about schematic drawing and electronic design and a
familiar with the UNIX environment. This training workbook provides basic
instructions for using Design Architect to create schematics and symbols. Th
document provides about 4 hours of instructions including hands-on lab exer

Design Viewpoint Editor User's and Reference Manual (DVE) contains
information about defining and modifying design configuration rules for desig
viewpoints, along with latching the design. You can also add, modify and ma
back annotation data for the design from within DVE.

Design Architect Reference Manual contains information about the functions use
to create and modify schematic designs, logic symbols, and VHDL source fil

Design Viewing and Analysis Support Manual (DVAS) contains information
about functions and commands for selecting viewing, highlighting, analyzing
reporting, protecting, grouping, syntax checking, naming, and window
manipulating capabilities. DVAS functions and commands operate within
applications such as QuickSim, QuickPath, AccuSim, QuickGrade, and DVE

Component Interface Browser User's and Reference Manual describes the shell-
level utility that allows you to view and edit component interfaces.
Design Architect User’s Manual, v8.6_2xx
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AMPLE User's Manual provides overview information, flow-diagram
descriptions, explanations of important concepts, and task-oriented procedur
customizing the common user interface and writing AMPLE functions.

AMPLE Reference Manual contains information about AMPLE statements and
functions that are common to all applications.

Common User Interface Manual describes the user interface features that are
common to all Mentor Graphics products. This manual tells how to manage 
use windows, popup command line, function keys, strokes, menus, prompt b
and dialog boxes.

Common User Interface Reference Manual contains information about all of the
Common User Interface functions.

DFI User's and Reference Manual contains information about the Design File
Interface, a procedural interface that allows netlist read, back annotation, an
write access to a Mentor Graphics design database.

Design Dataport User's and Reference Manual contains information about
Design Dataport (DDP), a procedural interface that can read, write, and mod
schematic sheets and symbols.

Design Manager User's Manual provides information about the concepts and u
of the Design Manager. This manual contains a basic overview of design
management and of the Design Manager, key concepts to help you use the D
Manager, and many design management procedures.

Design Manager Reference Manual describes the AMPLE functions that are
available in the Design Manager. This manual also describes Design Manag
shell commands.

Digital Modeling Guide contains basic information for designers and modelers
using the Mentor Graphics digital analysis environment. This manual can he
you make some rudimentary decisions in model or design development.

Logical Cable User's Manual provides an overview of the Logical Cable
application, introduces key concepts, and describes procedures for performi
Design Architect User’s Manual, v8.6_2 xxi
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specific tasks. This manual also describes the relationship between Logical C
and Physical Cable.

Logical Cable Reference Manual contains information about the functions used 
create and modify logical cabling designs.

Properties Reference Manual contains information describing all properties
created and/or used by Mentor Graphics applications for associating textual
design data with circuit elements.
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Chapter 1
Overview

Design Architect is more than a computer-aided schematic capture applicati
is a multi-level design environment that includes: a Schematic Editor, a Sym
Editor, and the VHDL Editor. In a multi-level design environment you can:

• Implement top-down and bottom-up design methodology

• Specify a design at different levels of abstraction, from high-level
specifications to gate-level implementation

• Specify a design with different modeling techniques

• Configure and manage different design descriptions to explore alterna
design implementations

As Figure1-1 indicates, Design Architect is the center of activity for most Men
Graphics design processes. Design Architect lets you create and edit logical
designs that are used by downstream processes such as: board design, IC a
layout, and analog and digital simulation. Many applications return design
information to Design Architect in the form of back annotation values. These
values can then be edited in the context of the design viewpoint (a descriptio
design viewpoints begins on page4-1) by Design Architect and, optionally,
merged into the original source design. This cycle of creating a logical desig
passing it to a downstream application for processing, and then passing new
updated property values back to Design Architect for editing is a common de
process.
Design Architect User’s Manual, v8.6_2 1-1
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Figure 1-1. Design Architect Environment

To support not only the creation of logical designs, but the editing of a design
respect to a design viewpoint, Design Architect offers a collection of functiona
which is summarized in the following list:

• Schematic capture

• Symbol creation

• Digital and analog component library access

• Property annotation

• Back annotation

• VHDL creation

Design
Architect

Analog
Simulation

Digital
Simulation Design

Synthesis

Component
Creation

Board
Design

IC & PCB
Layout

VHDL
Modeling
Design Architect User’s Manual, v8.6_21-2
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Schematic Capture
Schematic capture is the process of drawing a schematic with a computer an
storing it so that it can be used in other processes. In its simplest form, you c
think of your workstation, shown in Figure1-2, as a computerized drafting table

Figure 1-2. Workstation Acts as a Computerized Drafting Table

Schematics drawn by Design Architect can include more than simple wiring
diagrams. They can contain detailed schematic information about instances, 
connectors, test points, timing, engineering notes, and many other important
properties and values needed by downstream applications.

The Design Architect Schematic Editor is used to capture schematic informa
and is shown in Figure1-3. Refer to “Design Capture Concepts” starting on
page2-1 for a detailed discussion of the concepts related to capturing a sche
Design Architect User’s Manual, v8.6_2 1-3
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Figure 1-3. Schematic Editor

Design Architect
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Symbol Creation
Design Architect allows you to create and modify analog and digital logic
symbols that can be used in other Design Architect schematic designs. Sym
can represent basic design elements such as logic gates, transistors, off-the
components, custom ICs, or a complete board design that represents a port
the total design effort. The Design Architect Symbol Editor is used to create
symbols, and is shown in Figure1-4. For more information about symbol creation
refer to “Elements of a Symbol” in Chapter 2 of this manual.

Figure 1-4. Symbol Editor

MGC EditFile

Design Architect

Setup Miscellaneous

symbol_draw

Check Report HelpView
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Digital and Analog Component Library
Access

Mentor Graphics component libraries contain a variety of model types, used
describe the behavior of a circuit. The behavioral description of a circuit is
necessary to simulate and analyze the circuit's functionality. The behavioral
description of a circuit is defined with a functional model. Some examples of
functional models are: schematic models, hardware models, Behavioral Lang
Models (BLMs), and VHDL models. The models are illustrated in Figure1-5.

Figure 1-5. Example of Modeling Types

In Design Architect, you can select component models from a wide variety o
component libraries, and then place and connect these components togethe
form schematics and simulation models. Mentor Graphics component librarie
named after the family of software models that they contain. For example, th
library of 74-series low-power Schottky component models is namedls_lib. You
use a location map or environment variables to access component libraries. 
environment variable forls_lib is MGC_LSLIB; the environment variables for
other component libraries are named similarly. Your system administrator sh
tell you where to find a location map and how to set your environment variab

C
LR

D Q

_Q
P

R
E

CLK

Simulation

Hardware
Modeling

Schematic
Model

Language
Model

PROCESS (d0, d1, sel)
BEGIN
  IF sel = '0' THEN
     q <= d1;
  ELSE
     q <= d0;
  END IF;
END PROCESS;

Symbol
Model

VHDL
Model

IF CLKRISE THEN
IF PRE and CLR = 1
THEN
IF D = 0 THEN
Q = 0 and QBAR = 1

Behavioral
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Location maps are discussed in “Design Management with Location Maps” in the
Design Manager User's Manual.

Component Models

The logical component libraries contain models which are created through va
modeling techniques. The models describe the logical functionality of the cir
The following list briefly describes the different types of models available.

• gen_lib Primitives. A set of primitive components, such as simple logic
gates, is provided in the generic librarygen_lib. Generic components are
non-technology specific, and are used to create other library componen
generic component has delay and other property values preset to zero

• Sheet-Based Models. Sheet-based models (schematics) are built with
Design Architect and contain instances of primitive parts and other she
based models. Sheet-based models use timing information (properties
added directly to the schematic sheet, instead of technology files.

• QuickPart Schematics. QuickPart schematic models are compiled from
Design Architect schematic. A QuickPart contains the schematic, a
description of the circuit's functionality, and a technology file that descri
the timing information. QuickPart schematic models occupy less disk sp
and simulate faster than sheet-based models.

• QuickPart Tables. QuickPart tables are truth tables representing the
functionality of a device. You can use Mentor Graphics applications to
compile the table into a binary form usable by other downstream
applications. A device modeled with a QuickPart table can be used as 
primitive on a sheet-based model or on a QuickPart schematic model. 
theQuickPart Model Development Manual for more information about
QuickPart Tables.

• Behavioral Language Models. Behavioral Language Models (BLMs) are
Pascal or C programs that simulate the function of complex devices. A
BLM can be used as a primitive, and can also be used to model at a h
level of abstraction. The program that describes the device can contain
timing information for the device, as well as a functional description. If
Design Architect User’s Manual, v8.6_2 1-7
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timing information for the device is not embedded within the BLM, a
technology file must supply the timing information. Refer to theBehavioral
Language Model (BLM) Development Manual for detailed information
about BLMs.

• VHDL Models. VHDL models describe highly complex circuits or
systems at high levels of abstraction. Typically, you would use a VHDL
model to define an ASIC system, or board whose function is too comple
model using an alternative modeling technique.

• Hardware Models. Hardware models supply the functionality of a devic
by way of a Mentor Graphics Hardware Modeler, such as LM-family
models. A hardware modeler is a network resource that applies stimulu
an actual IC to determine its behavior, and then feeds this information 
to the digital simulation. Refer to theLM-family User's Manual for
information about hardware models.

Property Annotation
Property annotation is the process of adding design information called
“properties” to schematics and symbols. Most design applications, including
analysis and layout, have certain design requirements that must be met befo
design can be implemented. Downstream applications require that correct
property values be added to the design for processing. These properties des
characteristics of the design which are not identifiable from the schematic alo
is very important to know which properties must be assigned in Design Arch
so that the proper information is transferred to a particular down-stream
application. For more information about properties refer to “Property Concepts”
in Chapter 3 and to theProperties Reference Manual.

Back Annotation
Back annotation is the process of attaching new or changed property values
created in a downstream application, to the original schematic sheet. For exa
after a circuit is physically placed on a PCB or IC, new time delay property
information is made available. The new property values pertaining to this ne
Design Architect User’s Manual, v8.6_21-8
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time delay information are associated with the design viewpoint, and a more
accurate simulation of the circuit can then be done using these updated valu
More information about design viewpoints and the concepts related to editin
back annotation data in the context of a design begins inEditing in the Context of
a Design in Chapter 4.

VHDL Creation
Design Architect creates VHDL models using the VHDL Editor and QuickHD
compiler. The VHDL Editor lets you create and edit VHDL text files by inserti
and expanding VHDL language constructs. The compiler built into the VHDL
Editor allows instant compilation of models.

For further information about creating VHDL models, refer to theQuickHDL
User’s and Reference Manual.
Design Architect User’s Manual, v8.6_2 1-9
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Chapter 2
Design Capture Concepts

The following topics introduce you to the Design Architect environment and
define important concepts necessary to create designs with Design Architec

Design Architect Environment
You have access to three editors within the Design Architect environment: (1
Schematic Editor to create schematics, (2) the Symbol Editor to create user-
defined symbols, and (3) the VHDL Editor to create VHDL models. The three
editors are accessible from a common Design Architect Session window. Ea
editor operates in its own window within the Session window. Multiple windo
for each editor can be open at the same time.

Design Architect Session Window

The Design Architect Session window can be invoked from the Design Mana
Tool window by double-clicking on the Design Architect icon. After the Desig
Architect Session window is activated, Design Architect editing windows can
opened using the Design Architect Session popup menu items, function key
palette icons. The softkey labels near the bottom of the window show the Se
function key descriptions.

NT
Design Architect is invoked on the Windows NT platform by
pressing the Windows Start button and selecting
Programs > Design Architect > DA.
Design Architect User’s Manual, v8.6_2 2-1
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The Design Architect Session window menu bar is illustrated in Figure2-1. The
menu bar always contains the names of the pulldown menus for the current 
window. You access pulldown menus by pressing and holding the Select (le
mouse button on the menu name.

Figure 2-1. Session Window Pulldown Menu Bar

The Session window pulldown menus include items that let you open and pos
windows, change window attributes, save and restore userware configuratio
print text and graphics, find components, open a Notepad window, and acce
line help.

Items in the Session window popup menu let you open edit windows to view
create, and modify symbols, schematic sheets, schematic sheets in the conte
design viewpoint, and VHDL text files. You display this popup menu by movi
the location cursor inside the desired window and pressing and holding the M
(right) mouse button. To choose an item from the menu, move the mouse (wi
Menu button still depressed) to slide the cursor down the menu; when the de
item is highlighted, release the mouse button. These items, except forMGC , are
also available in the SessionFile pulldown menu, and in the Session palette.

MGC SetupFile

Design Architect

Help Support
Design Architect User’s Manual, v8.6_22-2
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The Session popup menu and palette are shown in Figure2-2.

Figure 2-2. Session Popup Menu and Palette

Schematic Editor Window

A Schematic Editor window can be opened from the Design Architect Sessio
window by executing theSession > Open Sheet popup menu item, the
File > Open > Sheet pulldown menu item, or clicking on the Open Sheet icon 
the Session palette menu, or pressing the F1 (Open Sheet) function key, or 
the command or function in the popup command line. All of these methods
display the Open Sheet dialog box, prompting you for a component name. If
component does not exist, a new component is created with the name you s
You can also invoke the Schematic Editor on an existing schematic sheet by
double-clicking the Select (left) mouse button on a schematic or sheet icon i
Design Manager window. See theDesign Manager User's Manual for more
information about invoking a Mentor Graphics application from within the Des
Manager.

session_palette

FIND
COMP

OPEN
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OPEN
SYMBOL

OPEN
VHDL

SESSION
SETUP TRAN-

SCRIPT
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ARCHY
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When you open a schematic window, the softkeys show the Schematic Edito
function key definitions, the Session palette and popup menu are replaced b
schematic palettes and popup menus, the menu bar displays the names of t
schematic pulldown menus, and a status line is displayed beneath the menu
The Schematic Editor menu bar and status line are shown in Figure2-3. The status
line provides information about the design object in the window and current
editing status.

Figure 2-3. Schematic Window Pulldown Menu Bar

The palettes, popup, and pulldown menus supply you with the commands
necessary to create a schematic. The more commonly used Schematic Edito
window palettes and menus include commands to:

• Instantiate components

• Create and modify properties

• Create and modify nets

• Create and edit comment graphics and text

• Set up templates for creating nets, comments, property text, grids, pag

• Edit objects (moving, copying, deleting, connecting)

• Report on sheet objects' status

• View a sheet

• Check schematic sheets for errors

• Save and register schematics

• Access on-line help

MGC EditFile

Design Architect

Setup Miscellaneous Check Report HelpView

Sel:    0+    ( W | dae ) ( my_des | schematic | sheet1 )  (inv | inv)  (  ) (4.0189, -0.7736)

Libraries
Design Architect User’s Manual, v8.6_22-4
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The Schematic Editor has added functional capabilities when editing a schem
sheet in the context of a design viewpoint. This mode of editing is described
starting on page4-1.

Symbol Editor Window

The Symbol Editor window can be opened from the Design Architect Sessio
window by executing theSession > Open Symbol popup menu item or theFile >
Open > Symbol pulldown menu item, or by clicking on the Open Symbol icon
the Session palette menu, or pressing the F5 (Open Symbol) function key, o
typing the command or function in the popup command line. All of these meth
display the Open Symbol dialog box which prompts you for a component na
and a symbol name. If the component does not exist, a new component and
symbol are created. If the symbol name is not specified, the symbol name de
to the leaf name of the component. If the symbol does not exist within the
component, a new symbol is created.

You can also open an existing symbol by double-clicking the Select mouse b
on a symbol icon in the Design Manager window. See theDesign Manager User's
Manual for more information about how to invoke a Mentor Graphics applicat
from within the Design Manager.

When you open a Symbol Editor window, a set of symbol palettes, popup an
pulldown menus are available from the window, and the softkeys display the
Symbol Editor function key definitions. The Symbol Editor menu bar and sta
line are shown in Figure2-4. The palettes, popup and pulldown menus, and
function keys supply you with the commands necessary to create and edit a
symbol.

Figure 2-4. Symbol Window Pulldown Menu Bar

The Symbol Editor window palettes, menus and functions are similar to thos
the Schematic Editor.

MGC EditFile

Design Architect

Setup Miscellaneous Check Report HelpView

Sel:    0+    ( W | dae ) ( dff | dff )  (  )  (  ) (4.0189, -0.7736)
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The more commonly used Symbol Editor commands let you:

• Create symbol body graphics

• Set up templates for creating comments, property text, grids, pages

• Edit objects (moving, copying, deleting)

• Report on symbol objects' status

• View a symbol

• Add pins and properties to the symbol

• Create and edit non-instantiable comments

• Check a symbol for errors

• Save and register a symbol

• Access on-line help

VHDL Editor Window

The VHDL Editor window can be opened from the Design Architect Session
window by executing theSession > Open VHDL popup menu item, the
File > Open > Symbol pulldown menu item, or by clicking on the Open VHDL
icon in the Session palette menu, or pressing the F6 (Open VHDL) function 
All of these methods display the Open VHDL dialog box prompting you for a
VHDL filename. If the VHDL filename does not exist, a new VHDL file is
created with the filename you supply.

The VHDL Editor can also be invoked on an existing VHDL file by double-
clicking the Select mouse button on a VHDL text icon in the Design Manage
window. See theDesign Manager User's Manual for more information about
invoking a Mentor Graphics application from within the Design Manager.
Design Architect User’s Manual, v8.6_22-6
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When you open a VHDL window, a set of VHDL editing popup menus and
pulldown menus are available from the VHDL editing window, and a new list
items is displayed in the menu bar. The VHDL menu bar is shown in Figure2-5.

Figure 2-5. VHDL Window Pulldown Menu Bar

These popup and pulldown menus supply you with the commands necessar
create and compile VHDL models.

The VHDL editor window includes commands to:

• Create and modify VHDL text

• Expand and insert VHDL templates

• Compile VHDL text

• Access on-line help

The VHDL Editor palette and function keys also have some of the more com
commands for editing VHDL models.

Design Sheet Window

You open a Design Sheet window on a design viewpoint so you can edit a d
within the context of the design viewpoint.You open a Design Sheet window
first setting the editing session on a design viewpoint with theSet Viewpoint
command. You can click on the SET VIEWPOINT icon, or execute the comm
from a popup or pulldown menu. A dialog box appears as shown in the follow
illustration.

Edit HelpMGC File

Design Architect

Templates Compile View OptionsSearch
Design Architect User’s Manual, v8.6_2 2-7
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You fill out the dialog box as shown above, then clickOK . After the viewpoint is
set, the following dialog box appears:

Set Viewpoint

Component Name card_reader

OK CancelReset

Navigator...Viewpoint Name sim_vpt

Create New ViewpointExisting Viewpoint Unset Viewpoint

 Enter

Click

Open Design Sheet

Viewpoint: $TRAINING/danwp/card_reader/sim_vpt

OK CancelReset

Startup File Path:

Open Top Level Sheets

HierarchicalTop Level

Open as:

Editable Read Only

Options...Sheet Name sheet1

Source Sheet
Design Architect User’s Manual, v8.6_22-8
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From this dialog box, you can open a Design Sheet window by clickingOK , or
you can edit a source sheet within the design by clicking theSource Sheet button
and specifying the source sheet you want to edit.

When you open a Design Sheet window, you get the same set of popup and
pulldown menus as in the Schematic Editor window; while editing in the cont
of a design viewpoint, an additional set of functions become accessible. The
area of the window shows the name of the schematic sheet, as in the Schem
Editor, with “(Design Context)” appended to the name. The Schematic Edito
pulldown menus, the status line, and the title area of the edit window are sho
Figure2-6. The status line includes the name of the viewpoint.

Figure 2-6. Design Sheet Window Pulldown Menu Bar

These palettes, function keys, popup, and pulldown menus supply you with t
commands necessary to edit a schematic, plus commands to edit the schem
the context of a design viewpoint.

The Design Sheet window includes all the schematic editing commands, plu
commands to:

• View and edit back annotations

• Create back annotations

• View evaluated and unevaluated properties

• Merge back annotations to schematic sheet

MGC EditFile

Design Architect

Setup Miscellaneous Check Report HelpView

Sel: 0   ( W | DAe ) ( dff | schematic | sheet1 ) (inv/inv) ( dff/pcb_design_vpt ) (4.0189, -0.7736)

Libraries

Schematic#1 dff sheet1 (Design Context)
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Component Window

The Component Window allows you to view or edit detailed information abou
component. Some of the things you can do in the Component Window are:

• List the Part Interfaces for Models, Labels, Pins, Pin Properties, and B
Properties for a given component.

• Register and unregister component models.

• Add/delete or edit labels for a component.

• Show all objects contained by the component, and optionally filter out
objects depending on type.

You invoke the Component Window using the MGC pull down menu or from
session window palette. A window appears that is divided into four distinct
information list areas. Each list area has a separate popup menu. The four li
areas are:

• Component Information

Displays an indented list of the component and its contents. Icons nex
items indicate the object type. Multiple components can be shown at o
time. Use the setup form to filter the types you wish to view.

• Models

Displays all registered models for each part interface selected in the
component list area. Labels are shown indented underneath the mode
name. Models are distinguished for a given component by the gray he
bar.

• Pins

Displays Pin names and properties for each selected part interface.
Design Architect User’s Manual, v8.6_22-10
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• Body Properties

Displays the Body Property name and value for each selected part inte

Figure illustrates the initial display of the Component window. For more
information on the Component window, refer to theDesign Manager User's
Manual.

The following restrictions apply to the Component Window in Design Archite

• If you are editing a symbol in a Symbol Editor window, you cannot mak
model registration or label changes to the component that contains the
symbol in the Component Window.

• You cannot select a symbol or schematic model listed in the Compone
Window to open the symbol or sheet.

• You cannot change the component displayed in the Component Windo
from the Design Architect Active Symbol window.

• If you modify a component in the Component Window, sheets in the
component are not automatically updated to display the change.
Design Architect User’s Manual, v8.6_2 2-11
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Figure 2-7. Component Window

Component Window

Component Information

$TRAINING/danwp/my_df
my_dff (Default)

[$TRAINING/danwp/card_reader/my_dff]my_dff

[$TRAINING/danwp/card_reader/my_dff]my_dff

[$TRAINING/danwp/card_reader/my_dff]my_dff

D

Pins

Registered Model Info

Body Properties

schematic2
$TRAINING/danwp/card_reader/my_dff/schematic2

$schematic2

CLK
PRE
CLR
Q
QB

qfall = 0
qbfall = 0
qrise = 0
qbrise = 0
model = schematic

default_sym

$TRAINING/danwp/card_reader/my_dff/my_dff
Graphical Models

schematic
$TRAINING/danwp/card_reader/my_dff/schematic

$schematic

Functional Models

default

ANSI

$TRAINING/danwp/card_reader/my_dff/ANSI
part
schematic

schem_id
sheet1

my_dff

schemaitc2
schem_id
sheet1

C
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Component Hierarchy Window

The Component Hierarchy Window allows you to view your design's
configuration and component information without having to exit the applicatio
It also allows you to:

• Display a component hierarchy in the context of a specific viewpoint;

• Display design hierarchies that are not dependent on viewpoints;

• Display instance information for a given component;

• Display the path to a single instance;

• Display the hierarchy as an indented list or a graphical tree;

• Probe other applications; and

• Display the value of a specified property rather than the instance name
to component in the hierarchy listing.

Because you look at a physical or logical hierarchy listing rather then looking
file system, you get information concerning the instances names, property va
object designations and model information.

You access this Hierarchy Window using the MGC Pulldown menu or the ses
window palette.
Design Architect User’s Manual, v8.6_2 2-13
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The Hierarchy Window uses the mgc_component as the standard starting po
showing design hierarchy. Figure2-8 shows the Hierarchy window. For more
information on the Hierarchy window, refer to theDesign Manager User's
Manual.

Figure 2-8. Hierarchy Window

The following restrictions apply to the Hierarchy Window in Design Architect

• Cross-highlighting between open Schematic Editor Windows and the
Hierarchy Window is not supported.

• When instances are added or deleted in a Schematic Editor Window, t
changes are not reflected in an Hierarchy window until you reopen the
design.

Component Hierarchy Window

Current Component: $TRAINING/danwp/card_reader/add_convert

add_convert (schm:schematic)

74259  (primitive)

74ls161a (primitive)

portin (primitive)

and2 (primitive)

res.alt (primitive)

my_dff (schm:schematic)

latch  (primitive)

buf  (primitive)
inv  (primitive)

portin  (primitive)
portout  (primitive)

inv  (primitive)

portout (primitive)

ground (primitive)

vcc (primitive)

rip (primitive)
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Integrated Editing Environment

Design Architect provides an integrated schematic and symbol editing
environment, which includes an integrated command set, multiple window
viewing and editing, and the capability of editing a symbol in-place on a
schematic sheet.

Integrated Command Set

The Design Architect editors share a common, integrated command set. With
integrated command set, commands performing the same function are used
the editors. For example, the Add Circle command is used in both the Schem
and Symbol Editors, and calls the same function, $add_circle(). In either
application, a graphic circle is drawn. Within the Symbol Editor, the circle is
interpreted as symbol graphics, and within the Schematic Editor, it is interpre
as comment graphics. Refer to theDesign Architect Reference Manual for
descriptions of all commands and functions used within both Schematic and
Symbol Editors.

Common Strokes

Strokes are another way of issuing commands within applications. You can
activate stroke mode by pressing the Drag/Stroke mouse button (usually the
middle button), and then you use the mouse to graphically “draw” the comm

For example, to unselect all objects in many applications, you press and hol
Drag/Stroke mouse button and then draw a “U” on the screen. The “U” will s
graphically on the screen in the default stroke style and color, normally a nar
red line. When you have finished drawing the “U,” release the Drag/Stroke m
button. The command executes immediately and all objects are unselected.

A stroke is defined by a sequence of grid coordinates, as shown in the figure
the left. This grid is called thestroke recognition grid. When you draw a stroke,
the pattern is overlaid on the recognition grid, and a sequence of numbers is

NT When using a 2-button mouse, you activate strokes by pressin
both mouse keys simultaneously.
Design Architect User’s Manual, v8.6_2 2-15
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derived. If this sequence matches an existing defined sequence, the comma
that sequence is executed. If the sequence is not defined, you get a “not def
message.

In the example on the left, if you draw the “U” stroke, the pattern is interprete
the number sequence 1478963. This is mapped to the function $stroke_1478
which is defined as Unselect All. If you draw a “?” stroke, a quick help chart 
the available strokes appears as shown on the following page.

Help on Strokes

If you draw a question mark stroke “?” in a Design Architect window, the Qui
Help on Strokes chart appears as shown in the following illustration. This ch
defines the strokes that are available to you in that active window. Strokes ar
of the most productive methods for executing commands, because all you ha
do is wiggle the mouse in small patterns, instead of moving the pointer half w
across the screen to click a palette icon or reach a pulldown menu.

4

1 2 3

65

7 8 9
Unselect All

$stroke_1478963()
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Figure 2-9. Common Application Strokes

It is often helpful to make a photocopy of this form, cut it up into strips and ta
the strips on the edges of your display until you learn the strokes. After you u
the strokes over time, you will remember them and they will come to you
naturally, almost without thinking. Many of the strokes that you will learn from
this chart will carry over to other applications, so they are well with the effort
learn.

Quick Help on Strokes

Close Ref Help

Text Window Strokes Dialog Box Strokes

Copy

3214789

Copy to Clipboard

852

Cut (to Clipboard)

1236987

Delete

741236987

Draw Window

75357

Move

74159

Paste from Clipboard

258

Undo

7412369

Unselect

1478963

Close Window

456

Close Window

654

1     2     3

4    5     6

7     8     9

Stroke Recognition Grid

Execute
456
Cancel
654

Palette Strokes

Show Parent Palette (Back)
258

Show Top Palette (Root)
852

Other Strokes

Execute Last Menu
12369
Execute Prompt Bar
456
Cancel Prompt Bar
654
Help on Strokes
123658

Use the mouse to draw strokes while holding
down the middle mouse button and moving
the mouse in the stroke path.  Strokes are
recognized by fitting the stroke path onto a
3x3 grid which determines a numerical sequence.
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Schematic Window Strokes

Figure 2-10. Schematic Window Strokes

Quick Help on Strokes

CloseRef Help

Common Design Architect Strokes Schematic Strokes

3

Stroke Recognition Grid

Add Wire
258

Add Bus
852

Choose Symbol
36987

Help on Strokes
123658

Print

More help on strokes

Display Schematic Palette
78963

Connect All
1236987

Display Default Palette
98741

Place Active Symbol
14789

Connect Selected
7896321

Route Selected
96321

741236987

Undo
7412369

Set Active Symbol
321456987

Flip Horizontally
9632147

Setup Select Filter
32147

Rotate (90)
3698741

Report Selected
1474123

Unselect All
1478963

Select Area
74123

Add Property
32159

Modify Property
95123

Delete
5

View Centered
Double Click MMB

Copy
3214789

Zoom Out (2)
753

Zoom In (2)
357

Refresh
75357

Select Window
1475963

View All
951

View Area
159

Copy Multiple
9874123

Move
74159

Activate Window

4

21

5 6

7 8 9
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View and Edit of Multiple Sheets in a Single Window

Design Architect provides the user with the ability to rapidly navigate through
multi-sheet design. You can open and edit multiple sheets from within a sing
window. Refer to “Design Navigation” in this chapter for information about single
window viewing and editing.

Multiple Window Viewing and Editing

In Design Architect you can operate in a multi-window environment, giving y
the capability of having multiple edit or view windows displayed on the same
design. Each window must be opened in either edit or view mode. Having
multiple views of the same sheet or symbol allows changes made in one win
view to be displayed concurrently in the other window views.

Also, in a multi-window environment, graphics can be copied back and forth
between windows. For example, graphics generated in a schematic or symb
window can be moved to other schematic or symbol windows. Refer to “Inter-
Window Copy and Move” in this chapter for more information about inter-
window copy and move.

Editing a Symbol In-Place on a Schematic

In addition to editing a symbol in a separate window environment, you can e
symbols directly on a schematic sheet. This is calledsymbol edit in-place. This
methodology is useful for top-down design when creating and modifying
functional blocks.

When you edit a symbol directly in the context of its instance on the schema
the schematic sheet circuitry is still visible (grayed out) while you edit the sym
contents. Errors, such as mismatching the symbol pins with the connecting n
using incorrect pin spacing, are avoided because the symbol can be modifie
the position of its instance-to-be on the schematic. Refer to “Edit Symbol In-
Place” in this chapter for more information about editing a symbol in place.

DA Startup Files

When you are familiar with your DA environment, you can use startup files to
define your own menus, keys, strokes, or any functions used to initialize you
Design Architect User’s Manual, v8.6_2 2-19
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working environment. Startup files are written in the AMPLE language, and h
access to the full capability of DA functions within a specific window scope.

Before you begin writing DA startup files, refer to theAMPLE User's Manual for
information about how to write AMPLE macros and additional startup file
examples. Refer to theCustomizing the User's Interface Manual for instructions
for customizing your user interface.

For information about scopes and additional methods of introducing custom
userware such as libraries to Design Architect, refer toAppendix A in theDesign
Architect Reference Manual.

In DA, a startup file can be specified for the initial opening of a DA Session
window, Schematic Editor window, Symbol Editor window, and VHDL Editor
window.

DA supports four levels of startup files:

• Site-specific:$MGC_HOME/shared/etc/cust/startup/name.startup

• Workstation-specific:$MGC_HOME/etc/cust/startup/name.startup

• User-specific: $HOME/mgc/startup/name.startup

• Component-specific: pathname to startup file specified in the Open Sh
Open Symbol, and Open VHDL dialog boxes.

In DA, “name” can represent “da_session”, “schematic”, “symbol”, and “vhdl”
for each respective DA environment. $HOME is the value of the HOME
environment variable for your shell, typically your login directory.
$MGC_HOME is the value of the MGC_HOME environment variable that
specifies the location of your Mentor Graphics software. $MGC_WD is the va
of the MGC_WD environment variable that specifies the current working
directory.

All applications search for startup files and execute them in the following ord

1. Site-specific startup files, if they exist.
Design Architect User’s Manual, v8.6_22-20
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2. Workstation-specific startup files, if they exist.

3. User-specific startup files, if they exist.

Component-specific startup files are executed when a pathname is specified
Startup File Path text box for the dialog box that opens a symbol, sheet, or a
VHDL document. A default value for this pathname can be specified with the
$set_environment_dofile_pathname() function.

When debugging a startup file, be aware that function calls within the startup
are not, by default, transcribed when executed from a startup location. To
transcribe the lower-level functions in the startup file, first set the transcript m
to “bottom”. For example, to test a new startup file, type in the active session
window:

$set_transcript_mode(@bottom)

Type in an active schematic window:

$dofile( your_home/mgc/startup/schematic.startup)

The previous commands set the transcript mode to “bottom” and execute the
startup file “schematic.startup” in an active schematic window.

The sample startup files in the following code blocks could be placed in any o
supported startup file locations. Refer to theDesign Architect Reference Manual
and theAMPLE Reference Manual for descriptions of the functions used in thes
files.
Design Architect User’s Manual, v8.6_2 2-21
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//  This startup file sets up the DA Session environment
//  and sets the selection model to individual selection
//  rather than additive selection.  The following Session
//  setup options are specified:
//
//  Mouse button click speed = average
//  Input device = mouse
//  Window layout = quadrant tiling
//  Visible: menu bar, window title, message area, palette,
//           status line, softkey area, Active Symbol window.
//  Not visible: Context window.
   $form_setup_session(125, "mouse", @quad, [@true], [@true],
             [@true], [@true], [@true], [@true], [@true], []);
   $set_selection_model(@individual);
Design Architect User’s Manual, v8.6_22-22
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The next example, sets up the editing environment in the Schematic Editor, 
sets the default sheet checks.

//  This startup file sets net, property text, and comment
//  attributes, then sets default sheet checks.
//
//  Net attributes:
//   width = p1, dotted line, orthogonal mode = off,
//   snap angle = 44.9, snap = on, dotsize = 0.025,
//   dotstyle = square, junction dots at rippers,
//   closedots displayed, bus_width = p3, autoroute = on,
//   autoripper = on, ripper_symbol = "$MGC_GENLIB/rip", "1X1"
//
//  Property Text attributes:
//    font = "stroke",  ht=0.1875, left-bottom justification,
//    horizontal, transparent, visible
//
//  Comment attributes:
//    style = shortdash, width = p3, fill = clear,
//    font = "stroke", height = 0.1875,
//    left-bottom justification, horizontal, transparent
   $setup_net(@p1, @dot, @off, 44.9, @on, 0.025, @square, @on,
              @on, @p3, @on, @on, "$MGC_GENLIB/rip", "1X1");
   $setup_property_text("stroke", 0.1875, @left, @bottom, 0,
                         @on, @on);
   $setup_comment(@shortdash, @p3, @clear, "stroke", 0.1875,
                  @left, @bottom, 0, @on);
//  The following list shows the default sheet checks set by
//  the next function:
//    checkfile not saved, report in window and transcript
//    no user-defined checks
//    errors and warnings reported for: instances,
//        special symbols, nets, frames, expressions, pins,
//        notdots, closedots, dangling nets and pins
//    errors only reported for: parameters, property owners,
//        overlapping instances,
   $setup_check_sheet("da_check_file", @nofile, @window,
          @transcript, "", void, @all, @all, @all, @all,
          @errorsonly, @all, @all, @errorsonly, @errorsonly,
          @all, @all, @all, @nocheck);
Design Architect User’s Manual, v8.6_2 2-23



Elements of a Schematic Design Capture Concepts

oints,
ns.

s are
ets
ical

nt

es

e.
ion
pply

 is
e”,

. You

arting
Elements of a Schematic
Schematics are created in the Design Architect Schematic Editor window. A
schematic is more than a simple schematic drawing. It contains additional
schematic capture information about components, wiring, connectors, test p
timing, and engineering notes, which can be used by downstream applicatio

A schematic is a graphical and behavioral description of a circuit. Schematic
built by combining and connecting electrical objects together. Schematic she
can also be annotated with comment graphics and text which have no electr
meaning.

A schematic can contain the following elements:

• Instances of Logical Symbols. Instances of logical symbols can represe
anything from a simple logic function to a complete integrated circuit.
Instances of logical symbols, as illustrated in Figure2-11, are labeled as
U11 and U30.

• Nets. A graphical net is a pin-to-pin wiring connection between instanc
on a schematic sheet. In Figure2-11, the instances of logical symbols U11
and U38 are connected to each other by anet. Refer to “Nets (Wires, Buses
and Net Bundles)” in this chapter for more information about nets.

• Property Name/Value. A property name is the label for a property, much
like a variable name is a label for a variable in a programming languag
Theproperty value is the value associated with the name. The combinat
property name/value is attached to different objects in a schematic to su
more information about the object. For example, the rise time for a pin
specified by a value (for example, “10, 20, 30”) of a property name “Ris
attached to that pin.

Some property values are displayed on the sheet. Net property values
FINISH and COMPARE are displayed in Figure2-11. Other properties
attached to objects on a schematic sheet are not visible on the screen
control the visibility of the property value. There are several important
concepts to understand about properties; they are discussed in detail st
on page3-1.
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• Comment Text and Graphics. Comment text and graphics, also called
comments, have no electrical meaning, but add other information to the
schematic sheet.

For example, in Figure2-11, the border of the schematic sheet is created
with comment text and graphics. Many other forms of comments can b
added to the sheet. Refer to “Comment Objects” for a detailed discussion
about comment text and graphics.

Figure 2-11. Example of a Schematic Sheet

Electrical Connectivity

Electrical objects are graphically placed and annotated on a schematic shee
form an electrical connectivity model. The proper connection of nets, pins,

Instances of Symbols

 Property Values Net
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COUNT(11:0)
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instances, and special instance connectors creates the functional implement
of the circuit.

Electrical connectivity for a design is further defined by adding properties to th
objects. For example, the addition of a “Rise” or “Fall” property owned by a p
further defines the electrical quality of the pin connection. This is also the ca
when a “Net” property defines whether the net is a bus or a wire. Properties 
discussed in detail starting on page3-1.

Electrical Objects Represented on a Schematic

Many types of electrical objects make up a schematic. The objects in the
following list are used to build the schematic. When placed properly on the s
each electrical object forms a connection to another electrical object.

• Pins and pin bundles

• Nets, buses, and net bundles

• Instances

• Frames (specify conditional or repeated inclusion of electrical objects; 
electrical, itself)

• Special Instances

• Net connectors

• Bus rippers

• Implicit rippers

• Ports

• Off-page connectors

• Intra-page connectors

• Globals
Design Architect User’s Manual, v8.6_22-26
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• Null instances

Pins and Pin Bundles

A pin is an electrical connection between a net and a symbol instance, and i
of the symbol body. When a symbol is placed on a sheet, its pins become th
locations on the symbol instance at which a net connection can be made.

A pin bundle is an ordered collection of individual pins and/or wide pins. A pi
bundle must contain unique pins that occur only once on a symbol. Thus, if a
occurs in a pin bundle, it cannot occur as an individual pin elsewhere on the p
in a different pin bundle.

The syntax of pin names and pin bundle names are discussed in “Basic Pin and
Net Naming Syntax” in this chapter. Proper pin connectivity is defined by a set
checks, described in Appendix A, “DA Design Checks”.

Nets (Wires, Buses and Net Bundles)

A netis the fundamental unit of connection. A net with a single connection is
called awire. A net composed of a set of wires is called abus. And a net that is
composed of a group of wires and buses is called abundle. Nets bind instances of
symbols together at their pin locations through multiple hierarchies of the de
Nets on the same sheet, and different sheets in the same schematic, having
same name are automatically tied together. A single net can not have the same
name as a bus or bundle. For example, naming a single net DATA and a sep
bus DATA(4:0) is not allowed. Proper net connectivity is defined by a set of
checks, described in Appendix A,DA Design Checks.

A bus has the same electrical meaning as a set of individual wires collected
together. Buses have a defined width, derived from the number of elements 
bus. The expression A(0:15) defines a bus with a width of 16 wires. Each wi
referenced sequentially: A(0), A(1), ..., A(15) through the array.
Design Architect User’s Manual, v8.6_2 2-27
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Multi-Dimensional Buses

The expression B(0:2;0:2) defines a 2-dimensional bus which is a 3 X 3 matr
shown inFigure 2-12:

Figure 2-12. A Multi-Dimensional Bus

The following are two more examples of multi-dimensional buses:

A(2,5;1:4) is a 2 X 4 matrix with the following eight wires: A(2;1), A(2;2),
A(2;3), A(2;4), A(5;1), A(5;2), A(5;3), A(5;4).

Z(0:1;0:1;0:1) is a 2 X 2 X 2 matrix with the following eight wires: Z(0;0;0),
Z(0;0;1), Z(0;1;0), Z(0;1;1), Z(1;0;0), Z(1;0;1), Z(1;1;0), Z(1;1;1).

A net bundle is an ordered collection of wires, buses, and other bundles. Ne
bundles cannot span design hierarchy, since they are simply a means of coll
a set of signals into a logical unit in a single schematic. Proper net bundle

!
Caution

Downstream applications using the DFI procedural interface (li
Board layout applications) may not be able to recognize and uti
multi-dimensional buses, such as A(0:7;0:7), since they consid
multi-dimensional bus to be a single net joining all attached pin

B(0;0) B(0;1) B(0;2)

B(1;0) B(1;1) B(1;2)

B(2;0) B(2;1) B(2;2)

B(0:2;0:2)
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connectivity is defined by a set of checks, described in Appendix A, “DA Design
Checks”.

Global connections can be referenced by nets, rather than creating a net rou
global symbol component such as Vcc. Global components have a Global
property and a Class property. The Global property value is the name of the
(for example, Vcc), and the Class property value is “G”, which defines it as
global. In order to establish connectivity to these global instances, you need
assign the Global property to the desired net; the property value is the net na
(for example, Vcc). Global components available ingen_lib include Ground, Vcc,
Vcc.n, and Vee.

When a design has global nets, they are listed as “//net_name” when the des
evaluated in the Design Viewpoint Editor (DVE). All other nets (not global) a
listed as “/net_name”.

Basic Pin and Net Naming Syntax

In Design Architect, a net name is defined by selecting the net vertex and add
Net property with a string value that becomes the net name. A discussion ab
property name/value restrictions can be found in “Property Name/Value
Restrictions” in Chapter 3.

Pins, wires and buses are named using the following syntax:

name = AMPLE_expression or explicit_name

explicit_name=base_name[left_delimiter[dimension;...]right_delimiter...,[] 

base_name = string with no delimiters, or slashes

left_delimiter = '[', '(', or '<'

right_delimiter = ']', ')', or '>'

dimension = range...[,range]

range = field or field:field

field = AMPLE_expression or number
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The enclosed left and right brackets denote an optional block. The “...” chara
denote an optional repeating block.

• AMPLE_expression must comply with AMPLE syntax and evaluate to a
valid explicit_name.

• explicit_name is the base_name of the pin or net (bus), plus an optiona
array description. The base_name can be any legal name allowed in D
Architect. No space is allowed between the base_name and the delimi
Delimiters (square brackets or parentheses) are required if an array is
specified.

• base_nameis a text string with no delimiters or slash characters.

• dimension defines an array of nets delimited by either brackets,
parentheses, or angle brackets. Multiple dimensions can be defined ins
set of delimiters and separated by a semicolon.

The following list describes some array descriptions for single and mult
dimensional arrays:

• (2) -- Defines a single pin or net labeled “2”.

• (0:15) -- Defines an array of pins or nets labeled “0”, “1”, and so on,
to “15”.

• (1,3,5,7) -- Defines an array of pins or nets labeled “1”, “3”, “5”, and
“7”.

• (0:2; 0:2) -- Defines a two-dimensional matrix with array elements
labeled “0,0”, “1,0”, “2,0”, “0,1”, “1,1”, “2,1”, “0,2”, “1,2”, and “2,2”.
For information on ripping bits from a two-dimensional bus, refer to
“Special Instances” in this chapter.
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Bus Stepping Syntax

Design Architect gives you the ability to define a sub-bus by using a step
indicator. You specify the step indicator as an integer greater than zero. The
following figure illustrates the step indicator syntax:

Figure 2-13. Bus Stepping Syntax

The following examples also provide further explanation on how the stepping
works:

BUS1(0:3:2) - BUS1(0,2) - A two bit bus containing bits 0 and 2.

BUS2(5:0:3) - BUS2(5,2) - A two bit bus containing bits 5 and 2.

BUS3(0:20:5,23) - BUS3(0,5,10,15,20,23) - A six bit bus containing bits 0, 5,
15, 20, and 23.

BUS4(32:1:2) - BUS4(32,30,28,26,24,22,20,18,16,14,12,10,8,6,4,2) - A sixte
bit bus containing bits 32, 30,..., and 2.

BUS5(3:0:2;3:0:2) - BUS5(3,1;3,1) - A four bit bus containing bits 3;3, 1;3, 3;
and 1;1.

Bundle Syntax

Net and pin bundles are named using the following syntax:

explicit_name=base_name[left_delimiter[dimension;...]right_delimiter...,[] 

left_delimiter = '{'

right_delimiter = '}'

B(0:20:5)

step indicator

B(0, 5, 10, 15, 20)
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dimension = range...[,range]

The enclosed left and right brackets denote an optional block. The “...” chara
denote an optional repeating block.

• explicit_name is the base_name of the bundle, plus a collection
description. The base_name can be any legal name allowed in Design
Architect. Delimiters (braces) are required. No space is allowed betwe
the base_name and the delimiters.

• base_nameis a text string.

• dimension defines the collection of nets, buses, and nested bundles
delimited by braces. Multiple dimensions can be defined inside a set o
delimiters and separated by commas.

The following are examples of dimensions within bundle delimiters:

• {a,b,c,d} -- Defines a bundle of pins or nets labeled “a”, “b”, “c”, and
“d”.

• {w,x,y(0:1),bund{l,m,n}} -- Defines a bundle of pins or nets that
consists of single bits “w” and “x”, an array of “0” and “1”, and a
bundle of “l”, “m”, and “n”.

Bundle Repeating Syntax

When you use the bundle repeating syntax feature, you first specify a comm
separated list of one iteration of the bundle elements. You then specify an as
* after the closing curly brace, as shown inFigure 2-14, then specify an integer
greater than one.

Figure 2-14. Bundle Repeating Syntax

BUND1{A, B, C}*3

repeat indicator

BUND1{A, B, C, A, B, C, A, B, C}
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The following text provides several examples of bundle repeating syntax and
resulting elements in the bundle structure:

{A0,A0N}*3 - {A0,A0N,A0,A0N,A0,A0N} - A six bit un-named bundle which
contains A0, A0N, A0,..., and A0N. Notice that unlike buses repeating a bun
member does not reduce the width of the bundle.

BUND1{A,B}*2 - BUND1{A,B,A,B} - A four bit bundle which contains the
wires A, B, A, and B.

BUND2{{BUS(0:1)}*2,CLK} - BUND{{BUS(0:1),BUS(0:1)},CLK} - A five bit
bundle which contains an unnamed bundle, which contains BUS(0:1) twice, 
the wire CLK.

BUND3{{{A,B}*2,{X,Y}*2}*2,CLK}*2 - BUND3{{{A,B,A,B},
{X,Y,X,Y},{A,B,A,B},{X,Y,X,Y}},CLK,{{A,B,A,B},{X,Y,X,Y},{A,B,A,B},{
X,Y,X,Y}},CLK} - A 34 bit bundle which contains an unnamed bundle, a wire
named CLK, the same unnamed bundle again, and the same wire CLK. The
unnamed bundle in the top-level bundle contains four unnamed bundles, the
and third containing the wires A, B, A, and B, and the second and fourth
containing the wires X, Y, X, and Y.

Using Stepping Syntax and Repeating Syntax Together

The following net naming syntax example presents a NET property where
stepping and repeating have been combined. Since the repeat construct cre
bundle, the overall object created will be a bundle rather than a bus.

{BUS(3:0:2)}*2 - {BUS(3,1),BUS(3,1)} - A four bit un-named bundle which
contains two buses. Each bus is two bits wide and contains bits 3 and 1.
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Table2-1 lists additional wire, bus, and bundle naming examples.

For detailed information on pin and bus name character restrictions, refer to
“Special Case Restrictions” in Chapter 3.

Table 2-1. Net, Bus, and Net Bundle Naming Examples

Net Name Description

A A single wire name

A(0:15) A bus whose range is 16 bits (0 through 15)

A(2) or A[2] The number 2 wire of the bus named “A”

a_bus(1,3,5,7) A reference for the four bits “1,3,5,7” in a_bus

B(0:2;0:2) A matrix of wires, sized 3 wires by 3 wires

B(1:n) A parameterized net range “n” bits wide

Bundle{a,b,c} A bundle containing wires “a”, “b”, and “c”

Cable{Clk, Data(0:3)} A bundle containing a wire “Clk” and a
four-bit-wide data bus.

($strcat(“A(0:“, n,”)”)) The AMPLE function $strcat concatenates the
string “A(0:“with net range variable “n” and the
final right parenthesis ”)” to build a net name from
an expression.
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Net Bundle and Pin Bundle Connection

You can connect a net bundle to either a pin bundle with the same width or a
pin of the same width. The connections of nets to pins are determined by pos
that is, the first item listed in the pin bundle is connected to the first item liste
the net bundle, and so on.

You can connect a bus to a pin bundle of the same width. The connections
between bus bits and pins are determined by position; that is, the MSB (mos
significant bit -- left-most index in the subscript) of the bus is connected to th
first element in the pin bundle, and so on.

An example of net bundle and pin bundle connections is illustrated in Figure2-15.

Figure 2-15. Net Bundle/Bus and Pin Bundle Connections

The connections made by mapping positions within the bundles and buses a

1. Net “x” of U1_nets connects to pin “a” of U1_pins, net “y” of U1_nets
connects to pin “b” of U1_pins, and net “z” of U1_nets connects to pin
of U1_pins.

2. Bit “2” of U2_nets connects to pin “a” of U2_pins, bit “1” of U2_nets
connects to pin “b” of U2_pins, and bit “0” of U2_nets connects to pin “
of U2_pins.

U2_pins{a,b,c}
U2_nets{2:0}

(2)

U3_pins{0:2}
U2_nets{x,c(0:1)}

(3)

U1_pins{a,b,c}
U1_nets{x,y,z}

(1)
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3. Net “x” of U3_nets connects to U3_pins bit “0”, net “c(0)” connects to
U3_pins bit “1”, and net “c(1)” connects to U3_pins bit “2”. This particula
example shows that wide signals in a net bundle are flattened to indivi
signals before connections are made.

Unnamed Nets Connected to Pin Bundles

When an unnamed net connects either two pin bundles of equal width, or a p
bundle and a wide pin of equal width, the system creates an unnamed bus. T
enumeration for the unnamed bus is in descending order, such as (1:0) and
connections are made by mapping positions in each pin object. Figure2-16
illustrates the connectivity generated when using unnamed buses to connec
bundles.

Figure 2-16. Unnamed Net Connections to Pin Bundles

The system creates a bus named N$10(2:0), which has the following
connectivities:

• N$10(2:0) connects pin bundles U1{a,b,c} and U2{x,y,z}.

• N$10(2) connects pins “a” and “x”.

• N$10(1) connects pins “b” and “y”.

• N$10(0) connects pins “c” and “z”.

N$10
U1{a,b,c} U2{x,y,z}
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Nets Ripped by Name from a Net Bundle

You can separate, or rip, individual nets from a net bundle, just as you can ri
from a bus. Figure2-17 illustrates acceptable ways in which you can rip nets a
buses from net bundles:

Figure 2-17. Ripping from a Net Bundle

1. A bundle item can be ripped by name from a net bundle and connecte
net with the same name as the bundle item; this is the typical case.

2. A bundle item can be ripped from the net bundle and connected to any 
net, which essentially shorts the two nets together. In this example, “re
and “board_reset” are electrically equivalent.

3. An individual bit of a bus that is a member of a net bundle can be rippe
from the bundle and attached to any net. If the attached net has a diffe
name than the bus bit, the bit and net are shorted.

Bund{clk, Q, reset, bus(3:0)}

reset
reset

Bund{clk, Q, reset, bus(3:0)}

reset
board_reset

Bund{clk, Q, reset, bus(3:0)}

bus(1)
bus(1)

Bund{clk, Q, reset, bus(3:0)}

bus(2:1)
subbus(1:0)

(1)

(2)

(3)

(4)
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4. Any sub-range of a bus that is an item in a bundle can be ripped and
connected to another bus of matching width. Also, the entire bus can b
ripped from the bundle.

For an operating procedure on ripping nets from net bundles, refer to “Ripping
Members from Net Bundles” in Chapter 6.

Unnamed Nets Ripped from Net Bundles

When an unnamed net is connected to a ripper from a bundle, the net is one 
types:

• A single-bit net. Ripper rule must list one item.

• An unnamed bus. Ripper rule must list multiple items.

If an unnamed bus results, it has a width that matches the ripper rule, is in
descending order, and is connected by position. Figure2-18 illustrates the two
possible cases:

Figure 2-18. Unnamed Nets Ripped from Net Bundles

!
Caution

If you rip a bit from a bus and connect it to a net and then rip th
same bit from the bus and connect it to another net, the system
considers the two nets as shorted together.

BUND{x,y}
x,x,y

x

N$17

N$18

(1)

(2)
Design Architect User’s Manual, v8.6_22-38



Design Capture Concepts Elements of a Schematic

d a
de
ve a

up the

st
l net
:

arent.

, or
rder.
The following objects are defined:

1. A bus named N$17(2:0). Net N$17(2) connects to net “x”, net N$17(1)
connects to net “x”, and net N$17(0) connects to the net “y”.

2. The unnamed net N$18 connects to net “x”.

Design-Wide Net Naming Rules

A net representing a set of connected nets in a fully evaluated design is calle
design-wide net. If a design has more than one level of hierarchy, a design-wi
net spans the design hierarchy. Each segment of the design-wide net can ha
different net name. When the design is evaluated, the set of nets that make 
design-wide net name evaluates to only one name.

The following rules determine which design-wide net is chosen as the
representative from a set of equivalent design-wide nets.

1. If one or more of the nets is Global, the global net defined in the highe
level in the design hierarchy is chosen. If there is more than one globa
at that level, a net is chosen according to the following ranking system

a. If any of the nets are bus bits, choose the net with the widest bus p

b. If a representative net has not been determined (either no bus bits
parent buses have the same width), then choose by alphabetical o

2. If no nets are Global, use the following criteria, in order, until all nets
except one have been eliminated:

a. Highest level in the hierarchy

b. EXTERNAL net (connected to a port) state

c. Net with a user-given name

d. Bus bit with widest bus parent

e. Alphabetical order
Design Architect User’s Manual, v8.6_2 2-39



Elements of a Schematic Design Capture Concepts

SE

tivity

0).
mes
stance.
r bus

f the
e a
le to
e of a

ust
Frames

A frame is a graphical box which encloses some circuitry that is repeated or
conditionally included in a final netlist by a frame expression. FOR, IF, and CA
frame expression types are described in “Frexp Property” in Chapter 3. Frames are
used on schematic sheets only.

In order for the contents of a frame to be evaluated correctly, certain connec
rules must be followed. A full set of checks that define the proper frame
connectivity is described in Appendix A, “DA Design Checks”.

Repeating Instances

A repeating instance is a short-hand way to specify a simple FOR Frame. A
repeating instance enables you to repeat a single instance by entering a
one-dimensional range in the “INST” property; for example, INST = XINST(3:
Using this optional range in the INST property value defines the number of ti
the instance is repeated and how the nets are connected to each repeated in
Connections are implied by the ratio of the dimensions of a connected wire o
to the dimensions of the pin of the repeated instance.

The system creates a FOR frame to match the expression and connectivity o
repeated instance when the sheet is written to the EDDM database. Becaus
FOR frame is created for a repeating instance, downstream tools are not ab
tell the difference between a real FOR Frame and the short-hand FOR Fram
repeating instance.

Repeating instances should be used only in very simple cases. For more rob
purposes, you should use standard FOR frames.
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Instances

An instance is a reference to a component symbol, and reflects the connectiv
defined by that component symbol. An instance is graphically represented b
symbol and can be updated by updating the original symbol. Placing the
representative symbol on a schematic sheet is calledinstantiation.

In order for an instance to be evaluated correctly, it must follow a set of
connectivity rules. A full set of checks that define the proper instance connec
is described in Appendix A, “DA Design Checks”.

Special Instances

Special instance connectors are not part of the final evaluated design, and a
translated into physical components. They are used to pass connectivity
information to the Design Viewpoint Editor (DVE), QuickSim II, and other
downstream applications that define or use an evaluated design. They are c
by adding specific Class property values to an instance. Refer to “Class Property”
in Chapter 3 for more information about Class properties.

You may define your own special instance symbols, or use Mentor Graphics
supplied components. The following list defines Mentor Graphics-supplied
special instances located ingen_lib (accessgen_lib through the $MGC_GENLIB
environment variable):

• Net Connector. The net connector is used to connect two nets that hav
different net names. The net name is assigned by adding the Net prope
a net vertex. It is not possible to attach more than one name to a net be
conflicting property values are not allowed. Two nets with different net
names can be connected by attaching the first net to the pin on one sid
the net connector, and the second net to the pin on the other side of th
connector.   If two nets with the same name are attached to a net conn
or if a net attached to a net connector is unnamed, when the sheet is
checked, the Check command issues a warning.

A net connector has a Class property value “C” and at least two pins. T
netcon component is a Mentor Graphics-supplied net connector, and is
located in the gen_lib library. Refer to “Using the netcon Component” in
Chapter 6 for information about how to use the netcon component.
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• External Port. An external port establishes any signals connected to th
instance as externals, regardless of the level of hierarchy. The simulat
ignores the instance behaviorally in the same way that it would a port
instance at the top level of a design. The instance is included in the
evaluated design and therefore can be seen and annotated by downst
applications.

An external port has a Class property value of “E” that identifies a port
an external port, regardless of its position in the design hierarchy.

• Off-Page Connector. The off-page connector is used to connect nets w
the same name across different sheets in a schematic. Nets with the s
name, which are not graphically connected in the schematic, are
automatically connected. To identify a net as connected by name acro
sheet boundaries of the schematic, attach each such net to a pin of an
page connector.

Table2-2 summarizes the checking for off-page connectors during a Ch
-Schematic.

Table 2-2. Checking for Offpage Connectors

Connectors/Matching Names Check -Schematic Results

No connectors in design No checking for offpage connectors.

1 connector / matching net name Warning: Add connector to net with
same name.

1 connector / no matching net
name

Warning: Unneeded connector; no
matching net name found on other
sheets.

connectors on mismatched names /
matching names have no
connectors

Warning: Add connectors to matching
names.

Connectors on nets of different
names

All three of the above warnings are
possible.
Design Architect User’s Manual, v8.6_22-42



Design Capture Concepts Elements of a Schematic

 pin.
d

n
a
nting

ched

mand

The

ets
r
its

 nets
e of

yntax
 bit
e

rom

lues
 nets
An off-page connector has a Class property value “O”, and at least one
The offpag.out and offpag.in components are Mentor Graphics-supplie
off-page connectors, and are located in the gen_lib library.

• Port. The port component is used to indicate a net making a connectio
external to the schematic. The number and net names of the ports on 
schematic should match the pins on the interface of the symbol represe
that schematic. Refer to “Component Interface” in this chapter for a
definition of a component interface, and “Registration and Labeling” in this
chapter for a discussion about symbol registration. If the net name atta
to a port in the schematic does not match the name of a pin on its
representative symbol when the schematic is checked, the Check com
issues an error.

A port has a Class property value “P”, and must have exactly one pin. 
portin and portout components are Mentor Graphics-supplied port
components, located in the gen_lib library.

• Bus Ripper. A bus ripper is similar to a net connector. It connects two n
of possibly different names, and provides a way to rip off a single-bit o
sub-bus of a bus for connection to a different net. For example, it perm
connecting net N(1) to B(1) of bus B(0:7).

The bus must be attached to the ripper pin named “Bundle”. The ripped
must be attached to the corresponding ripper pins. In addition, the valu
the Rule property attached to the ripper must have a valid bus range s
to identify the bits to be ripped from the main bus; for example, a value
“1” of range “0:3”. The net must be named so that its width matches th
width specified by the Rule property.

When ripping bits from a two-dimensional bus, the value of the Rule
property must be set to rip one bit from the bus or to rip a range of bits f
a row or column of the bus. The following list shows the syntax and a
sample Rule property value for each possible type of rip. The sample va
assume that the bus is named “data(0:2;0:2)” and that the width of the
attached to the rip component match the width specified in the Rule
property:

x;y   Rip one value from the matrix. For example:
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Rule = 0;0

x;y1:y2Rip a range of values from a row in the matrix. For example:

Rule = 1;0:2

x1:x2;y   Rip a range of values from a column in the matrix. For example

Rule = 0:2;1

A bus ripper instance has a Class property value “R”. It must have at le
two pins. One pin must have a Pin property with value “Bundle”. A Rul
property must be associated with the instance body or with each non-
bundled pin. The value of the Rule property must have a valid bus rang
syntax.

The rip component is a Mentor Graphics-supplied component, located
the gen_lib library. The rip component provides a wide variety of ripper
symbols capable of ripping varying numbers of bits from a bus. Refer t
“Creating a Bus Ripper” in Chapter 6 for an example of how to create a b
ripper.

• Implicit Ripper.  An implicit ripper separates a named bit from a bus or
member from a net bundle. It differs from a standard ripper symbol in t

o The implicit ripper is not an actual symbol in any library.

o Implicit rippers do not have a Rule property attached to them, since
connection is established by name.

You can visually differentiate an implicit ripper from a standard ripper i
that the implicit ripper instance is the same color as a net. The name o
net connected to the implicit ripper must exactly match the name of a b
bit or member of a net bundle. You can configure implicit rippers to
connect at a 45-degree angle, much like standard rippers, or in a straig
line.
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Figure2-45 illustrates some examples of implicit rippers.

Figure 2-19. Implicit Ripper Examples

Implicit rippers are the default when you invoke Design Architect. Impli
rippers do not define any explicit connectivity; rather, electrical
connectivity is established only by name.

You can set the ripper mode to “auto” using the $setup_ripper() functio
which you can access through theSetup > Ripper pulldown menu. Auto
rippers must be used if you need to pull off a bit in a bus and connect it
wire with a different name, or if you want to pull off part of a bus and
connect it to a smaller bus.

• Globals. A global instance is a component that has a Global property a
Class property assigned to the symbol body. The value of the Global
property is the name of the net (for example, Ground and Vcc). The va
of the Class property is “G”. The global symbol must have at least one
and a Global property. Examples from the Mentor Graphics-supplied
gen_lib component library are Vcc and Ground.

Angled rippers

ADDR(7:0)

A
D

D
R

(0
)

Straight rippers

BUND1{s1, x, y, ADDR(7:0), s2}

x
A

D
D

R
(4

)

ADDR(7)

A
D

D
R

(3
)
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A global instance can exist at any level of the design. Nets that connec
the global instance, without creating a physical net route, must have a 
property value that is the same as the Global property value on the glo
instance to establish electrical connectivity.

• Null Instance. A null instance is a component that carries the compone
properties, but represents the component as electrically inert. In many 
the null function of a component can be provided using comments inst
A null instance has a Class property value “N” and no pins.

Comment Objects

Comment objects are graphical objects, such as lines, circles, rectangles, an
combined together for descriptive purposes. Comment objects can be used 
explanations, review notes, fabrication notes, or any purpose you have to
comment the design. Comment objects have no electrical significance.

Types of Comment Objects

The following are comment objects:

• Arcs

• Circles

• Lines

• Polygons

• Dots

• Polylines

• Rectangles

• Text
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Graphic Commands

Graphic commands create comment text and graphics on schematic sheets 
symbol graphics on symbols. The termsymbol graphics refers to the lines,
rectangles, circles, and other graphical objects used to create symbol bodies
same graphics-generating command set is used in both schematic editing an
symbol editing.

The following commands generate comment text and graphics:

• Add Arc

• Add Circle

• Add Dot

• Add Line

• Add Polygon

• Add Polyline

• Add Rectangle

• Add Text

• Convert to Comment

Most comment-generating commands are self-explanatory; for example, the Add
Rectangle and Add Circle commands add rectangles and circles to a schem
sheet. The Add Dot command adds a dot to a symbol body; the size and sty
the dot drawn on the symbol instance are determined by the values of the do
and dot_style internal state variables (same size and style as the DA- genera
junction dots). Other comment object attributes control how lines, text, and o
graphics are displayed, and are described starting “Summary of Object Attributes
and Associated Commands” in this chapter. Refer to theDesign Architect
Reference Manual for more detailed information about these commands.
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Convert Objects to Comments

The Convert To Comment command converts any selected electrical or grap
object, or group of objects, to comments.   For example, selected:

• Nets become comment lines

• Symbol instances become comment text and graphics

• Visible properties become properties of the newly created comment ob

Uses for Comments

Using comment text, graphic objects, and system functions that return stand
information (such as date and version numbers of the design), you can crea
many useful structures that are distinct from the electrical elements of the
schematic. For example, you can create:

• Title blocks (can be automatically created on a new sheet)

• Revision blocks

• Page borders (can be automatically created on a new sheet)

• Backplane, wire wrap, and other tentative design elements

• Explanations, review notes, and fabrication notes

!
Caution

After an object has been converted to a comment, all hidden
properties associated with that object are deleted. This process
be reversed using the Undo command.
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Object Handles in Design Architect

In Design Architect, every graphical comment and electrical object has an
associatedhandle. A handle is a unique, system-assigned identifier. You can a
assign a name to an instance with the Inst property. The system recognizes 
name you assign, but the instance handle is retained, not replaced. A handle
consists of one of the key letters listed below, followed by the dollar sign
character ($) and a system-assigned number.

• B = Bundle

• C = Comment

• F = Frame

• G = Group

• I = Instance

• N = Net

• P = Pin

• T = Property Text

• V = Vertex

An example of an instance handle is:

I$385

Handles, like this one, appear in various error messages and netlists. The ha
can be specified as an argument in commands such asSelect By Handle or Report
Object, as in the following examples:

Select By Handle  I$385  -View

Report Object I$385

The first command selects the object by its handle. The second command re
an extended status list associated with the object whose handle is I$385.
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Methods exist to make the handle of an instance visible. Assign the Inst prop
to the instance with a value of I$0. When theCheck or Save commands are issue
the I$0 value will be replaced by the unique handle for that instance. Similar
assigning the Net property a value of N$0 makes the net handles visible afte
Check or Save commands are executed.

Object Attributes

Text, lines, arcs, rectangles, nets, property values and many other objects
associated with a schematic or a symbol have additional graphical attributes
graphical attribute is a feature that affects the way the object is displayed.

Line Style Attributes

You can use different line styles and widths for lines created for symbol grap
or comment graphics, for example:

• Line style: solid, dotted, long dashed, short dashed

• Line width: 1 pixel, 3 pixels, 5 pixels, 7 pixels

A line and a net may have the same line style attributes, but only a net can h
electrical connectivity. A net is created with the Add Wire or Add Bus comma
and a line is created with the Add Line command.
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Text Attributes

Design Architect supports a variety of text attributes for text objects. Figure2-20
shows some of these styles. Comment text and property text attributes inclu
font type, text height, text horizontal justification, text vertical justification, tex
orientation, flip/rotate text restriction, text visibility, and text transparency. Re
to theSetup Comment andSetup Property Text commands in theDesign Architect
Reference Manual for more information about these commands.

Figure 2-20. Text Attributes

Setting Up Attributes

There are three ways to set object attribute information:

• Execute the proper “setup” command

• Execute the proper “change” command

• Execute the individual “$set” function for each internal state variable

The Design Architect “Setup” commands are used to set all the object attribu
for subsequently created objects of a particular type. For example, the Setup
Comment command sets all the attributes for comment text and graphics. Th
Setup Net command sets all the attributes for nets, such as style, width, pin s
and orthogonal routing. TheSetup Property Text command sets all the attributes
for property text display. The attributes set with the “Setup” commands rema
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unchanged for all subsequently created objects. A summary of attribute
descriptions associated with each “Setup” command is displayed in Table2-4.

The “Change” commands modify individual attributes of selected objects.   F
example, theChange Property Visibility command toggles the instance-specific
selected property to a visible or invisible condition. The change commands d
affect the default internal state variables. Object attributes associated with e
“Change” command are displayed in Table2-4.

The “$set” functions work like the “Setup” commands except they set only on
internal state variable at a time; refer to Table2-4. Refer to theDesign Architect
Reference Manual for information concerning internal state functions.

Summary of Object Attributes and Associated Commands

Design Architect supports a variety of graphical attributes that can be used t
customize the look of your schematic. Table2-3 catalogs the attributes available
for each object.

Table2-4 lists the object attributes with the associated commands and functi
used to set and change these attributes. This table points you to the comman

Table 2-3. Object Attributes

Object Types Object Attributes

Comment Text
and Graphics

line style, line width, fill type, text font, text height,
horizontal text justification, vertical text justification, text
orientation, transparency, and flip/rotate text restriction

Net net style, net width, orthogonal, orthogonal angle

Property name, value, type, visibility, text font, text height, text
justification, text orientation, and flip/rotate text restriction

Symbol
Graphics and
Comments

line style, line width, fill pattern, text font, text height,
horizontal text justification, vertical text justification, text
orientation, and flip/rotate text restriction
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functions necessary to set or change an individual object attribute, or to set o
change the sheet/symbol default for a particular attribute.

Table 2-4. Command and Function Attribute Reference

Attribute Descriptions Design Architect
Commands/Functions

Line Style (solid, dot, shortdashed,
longdashed)

Setup Comment
Setup Symbol Body
Change Line Style
$set_line_style()

Line Width (1pixel, 3pixels, 5pixels, 7pixels) Setup Comment
Setup Symbol Body
Change Line Width
$set_line_width()

Polygon Fill (clear, solid, stipple) Setup Comment
Setup Symbol Body
Change Polygon Fill
$set_polygon_fill()

Net Style (solid, dot, shortdashed,
longdashed)

Setup Net
Change Net Style
$set_net_style()

Net Width (1pixel, 3pixels, 5pixels, 7pixels) Setup Net
Change Net Width
$set_net_width()

Orthogonal Routing of net (on, off) Setup Net
$set_orthogonal()

Orthogonal Routing Angle (angle) Setup Net
$set_orthogonal_angle()

Dot Size (dotsize) Setup Symbol Body
Setup Net
$set_dot_size()
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Dot Style (square, circle) Setup Symbol Body
Setup Net
$set_dot_style()

Ripper Dot Toggle (on, off) Setup Net
$set_ripper_dot()

Pin Snap to grid (on, off) Setup Net
$set_pin_snap()

Text Font for property and comment text Setup Comment
Setup Property Text
Change Text Font
Change Property Font
$set_text_font()
$set_property_font()

Text Height for property and comment text Setup Comment
Setup Property Text
Change Text Height
Change Property Height
$set_text_height()
$set_property_height()

Text Horizontal Justification (left, center,
right) for property and comment text

Setup Comment
Setup Property Text
Change Text Justification
Change Property Justification
$set_text_hjustification()
$set_property_hjustification()

Text Vertical Justification (top, center,
bottom) for property and comment text

Setup Comment
Setup Property Text
Change Text Justification
Change Property Justification
$set_text_vjustification()
$set_property_vjustification()

Table 2-4. Command and Function Attribute Reference

Attribute Descriptions Design Architect
Commands/Functions
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Build a Schematic

A schematic may include many instances, wires and buses connecting the
instances, comments to annotate the circuit, and special instances for specia
connections. Refer to “Creating a Schematic” in theGetting Started with Design
Architect Training Workbook for a step-by-step tutorial on how to create a
schematic.

To build a simple schematic involves the following steps:

1. Open a Schematic Editor window

2. Draw a schematic

3. Check schematic for errors

4. Register schematic with component

Text Orientation (0,90) degrees Setup Comment
Setup Property Text
Change Property Orientation
$set_text_orientation()
$set_property_orientation()

Flip/Rotate Text Restriction Setup Symbol Body
Setup Comment
Setup Property Text
Change Property Orientation
$setup_text_restriction()

Visibility (on, off) for instance-specific
property display

Setup Property Text
Change Property Visibility
$set_property_visibility()

Table 2-4. Command and Function Attribute Reference

Attribute Descriptions Design Architect
Commands/Functions
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Open a Schematic Editor Window

TheOpen Sheet command opens a Schematic Editor window. You can activa
this command from the Session menu or the palette menu in Design Archite
This command opens an existing schematic sheet if the schematic name exi
creates a new schematic sheet, if a new name is given. When you open a ne
schematic sheet that does not have an existing symbol, you are also creating
component which, in the future, will contain other relevant objects such as a
symbol to represent the sheet, technology files, design viewpoints, and back
annotation objects.

You can also invoke a Schematic Editor window from the Design Manager b
double-clicking on a schematic sheet icon or its component icon.   Refer to
“Opening a Schematic Sheet” in Chapter 6 for the procedure to invoke the
Schematic Editor from a Design Architect Session window.

Draw the Schematic

Here are five basic steps that allow you to draw a simple circuit:

• Choose and place component symbols

• Draw and route nets

• Terminate off-sheet nets

• Name nets

• Add comments

Choose and Place Component Symbols

Component symbols are selected and placed on a schematic sheet from a li
palette or by typing the pathname to the component symbol. A library palette
be activated by selecting a library menu item under theLibraries  menu in the
Schematic Editor. A menu selection is available for every Mentor Graphics
component library installed. When activated, the library palette includes a lis
all library components available from that library. See “Choosing and Placing
Design Architect User’s Manual, v8.6_22-56
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Component Symbols on a Sheet” in Chapter 6 for procedures describing how to
select and place components on your schematic sheet.

Draw and Route Nets

After the component symbols have been placed, you can draw and route the
necessary to properly connect the component symbols. You can set the net 
to route automatically when a net is drawn, or you can manually route a set o
by selecting the net vertices to route and executing the Route command. To
activate automatic net routing, execute theSetup > Set Autoroute On menu
item. When automatic routing is turned on, the Route command is automatic
called after each net is drawn.

The net router defines an orthogonalized pathway for a connected net that a
instance extents, comment objects, and other nets. The net router utilizes th
snap grid as the routing grid. If net vertices are not on the grid, they are not ro
Routing performance is faster if the pin snap grid is set to a value larger than
pin interval during the route operation, and then set back for component
instantiation.

Unconnected wires, buses, and pins will cause warning messages when you
the schematic sheet. If you want to indicate that an unconnected wire, bus or
valid, attach the Class property to it with a value of “dangle”. You may first n
to declare pins and nets as valid owners of the Class property.

To specify a property owner, choose theSetup > Property Owner/Type >
Property Owner menu item. In the dialog box that appears, enter “class” in th
Property Name text entry field, and click thePins andNets buttons.

See “Drawing and Routing Nets” in Chapter 6 for procedures to draw and route
nets.
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Terminate Off-Sheet Nets

All input wires and buses should begin with a portin or offpag.in component f
thegen_lib component library. Similarly, output nets and buses should be
terminated with a portout or offpag.out component. Warnings may result if th
not done.

See “Choosing and Placing Component Symbols on a Sheet” in Chapter 6 for
procedures for placing these components on your schematic sheet.

See “Assigning Properties and Property Owners” in Chapter 6 for details about
how to add property values.

Modify Net Names

A net should always terminate at an instance's pin, or connect with another n
junction. The Schematic Editor uses several components for terminating a n
an input or output point. The components portin, portout, offpag.in, and
offpag.out provide net termination. By default, the portin and portout symbols
assign the name NET to an unnamed net when attached. To prevent many
different nets from being named NET (if two nets have the same name,
downstream applications see them as being connected), you will need to ch
the name of the nets so they each have a unique name.

See “Modifying Net Names” in Chapter 6 for a procedure for modifying a net
name.

Add Comments to the Schematic Sheet

Comment objects are graphical objects, such as lines, circles, rectangles, and
combined together for descriptive purposes. Comment objects can be used 
explanations, review notes, fabrication notes or any purpose you have to com
the design.

To review commands used to add comment objects, refer to “Types of Comment
Objects” in Chapter 2.
Design Architect User’s Manual, v8.6_22-58



Design Capture Concepts Elements of a Schematic

d at
ith the

p

ple,

eet. If

s.

 to
Check the Schematic

You must pass a set of required Mentor Graphics schematic checks before a
downstream application is invoked; if these checks fail, the downstream
application will issue a warning, highlighting a problem that may be uncovere
a later time.   These checks are set up for you by default, and are executed w
Check > With Defaults menu item.

To understand the additional capabilities of the Check command, refer to “Design
Error Checking” starting on page5-1. To find out how you can change your setu
to include optional checks to be executed by default, refer to “Checking a Symbol
for Errors” in Chapter 6.

Register Schematic with Component

You must register your schematic with a component before you can use the
schematic with a downstream tool. When you save your schematic, for exam
by executing theFile > Save Sheet menu item, by default, you register your
schematic with the component specified when you opened the schematic sh
you want to register your schematic with other components and component
interfaces, you need to know more about how the component structure work

Refer to “DA Model Registration” in Chapter 2 for concepts related to the
component structure and model registrations; for a procedure describing how
register a schematic, refer to “Saving a Sheet and Registering a Schematic” in
Chapter 6.
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Elements of a Symbol
The following topics define the concepts and terminology related to the objec
used to build a symbol.

Symbol Definition

The Symbol Editor creates symbol models. A symbol model is a graphical
representation of a component, as shown in Figure2-21.   A symbol consists of
five basic elements:

• Body (Shape). The symbol body is the graphical image of the symbol. T
graphics that display the symbol body are calledsymbol graphics.

• Pin(s). Pins are points where an instance of the symbol electrically
connects to the schematic sheet.

• Origin. The origin is the reference point used to place the symbol on th
schematic sheet.

• Properties. Properties provide information describing the functionality o
the symbol. Refer to page3-1 for more information about properties.

• Comments.Comments placed on a symbol provide documentation abo
the symbol. Comments cannot be added directly to a symbol; symbol
graphics can be converted to comment graphics with theConvert To
Comment command, and back to symbol graphics with theRemove
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Comment Status command. Comments on a symbol are non-instantiabl
and do not appear on an instance of the symbol.

Figure 2-21. Symbol Structure

Symbol and Schematic Relationships

Instances of symbol models and schematics form a hierarchical bond. An
instance, as illustrated on the right portion of Figure2-22, represents a higher-
level function to the sheet it references. The schematic below the instance o
flip-flop represents a more detailed level description of the function of the sym
model.

The flip-flop schematic sheet is said to be lower in the design hierarchy than
circuit schematic sheet. This is true because the flip-flop schematic is the
functional representation for the flip-flop symbol model, which is one of the
components using lower-level schematics. Sheets at the lowest level contain
components that are usually simple gates.

For down-stream applications such as simulation, the functionality of some l
level components is already known by the simulator and does not require an
underlying schematic sheet. Such a component is referred to as abuilt-in
primitive.

PRE
D Q

CLK

QBQB
CLRCLR

(BODY)

PIN

ORIGIN

PROPERTIES
(TEXT)

SHAPE

POINT

Modified  12/13/92COMMENT TEXT
Design Architect User’s Manual, v8.6_2 2-61



Elements of a Symbol Design Capture Concepts

lows
re
ning
This hierarchical bond between the symbol model and the schematic also al
the flexibility to represent that symbol with other functional models. Other mo
complex modeling methods can also be used to describe component functio
for primitives. Refer to theDigital Modeling Guide for more information about
different modeling techniques.

Figure 2-22. Symbol and Schematic Relationships
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Build a Symbol

The following topics present some of the common procedures involved in
building a symbol. Refer to “Creating a Symbol” in theGetting Started with
Design Architect Training Workbook for a step-by-step tutorial on how to create
symbol.

Creating a symbol involves the following steps:

1. Open a Symbol Editor window

2. Draw the symbol body

3. Add pins and pin properties

4. Add other symbol properties

5. Check a symbol for errors

6. Register the symbol with the component

Open a Symbol Editor Window

TheOpen Symbol command opens a Symbol Editor window. You can activate
this command from the Session menu or the palette menu in Design Archite
This command opens an existing symbol, if the symbol name exists, or crea
new symbol, if a new symbol name is given.

You can also invoke the Symbol Editor from the Design Manager by double-
clicking on a symbol icon. Refer to “Opening a Schematic Sheet” in Chapter 6 of
this manual for more information about how to invoke the Symbol Editor on a
existing symbol.

Draw the Symbol Body

A symbol body can be made up of lines, rectangles, circles, and arcs. A sym
body can also have “whiskers” which are short lines projecting from its body
indicate where the input and output pins will be connected. Whiskers are not
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required part of the symbol, but rather a convention used in the Mentor Grap
component libraries.

The following list presents commands used to draw the symbol body:

• Add Arc

• Add Circle

• Add Dot

• Add Line

• Add Polygon

• Add Polyline

• Add Rectangle

• Add Text

Add Pins and Pin Properties

You add pins to a symbol with theAdd Pin command. The pin name that you giv
as the Pin property is stored in the database as thecompiled pin name. A compiled
pin name is a non-volatile pin name on library symbols against which Hardw
Model Language files and Behavioral Language Model files can be compiled

When you make changes to the Pin property value (by changing the pin's us
defined name), with theChange Property Value command, the compiled pin nam
tracks the user pin name. If you change the compiled pin name with theChange
Compiled Pin Name command, future changes to the user pin name will not af
the compiled pin name. If you wish to have the compiled pin name again trac
user pin name, set the compiled pin name value to “” with the Change Comp
Pin Name command. The compiled pin name is not a property and cannot b
viewed on the sheet. You can examine its value by executing theReport Object
command. Compiled pin names are not used for connectivity of an instance 
schematic sheet.
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Add Other Symbol Properties

In addition to adding pins and their associated names, you will also want to a
and modify property values on pins, or on the symbol body itself.

Symbol properties attach data or characteristics about the symbol, and are
subsequently used during design simulation and by layout and other downst
applications. The addition of properties allows accurate modeling of the real
physical device. Symbol model properties are necessary for the component 
operate correctly. A more detailed discussion of symbol properties starts in
“Symbol Properties” in Chapter 3.

Add Comments to a Symbol

When you add graphics to a symbol, for example, with theAdd Rectangle
command, by default, you create symbol graphics. Symbol graphics are incl
with the symbol and are displayed with the symbol at instantiation time.
Comments are created by converting symbol graphics to comments with the
Convert to Comment command. Comments created on a symbol sheet are no
displayed on the sheet when the symbol is instantiated. They can only be vie
on the symbol while editing the symbol.

If you want to convert selected symbol comments back to symbol graphics y
can execute theRemove Comment Status command.

To review commands used to add comment objects, refer to “Types of Comment
Objects” in Chapter 2.

Check a Symbol

You must pass a set of required Mentor Graphics symbol checks or the sym
will not be valid for instantiation. These checks are setup for you by default, 
are executed with theCheck > With Defaults menu item.

To understand the additional capabilities of theCheck command refer to “Design
Error Checking” starting on page5-1. To learn how to include optional checks t
be executed by default, refer to “Checking a Schematic for Errors” in Chapter 6.
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Register Symbol with Component

You must register your symbol with a component before you can instantiate 
symbol. When you save your symbol, for example, by executing the
File > Save Symbol > Default Registration menu item, by default, you register
your symbol with a component, and use the component's leaf name for the sy
name.

To understand more about symbol registration, refer to “DA Model Registration”
in this chapter. A procedure describing how to register a symbol with a compo
interface is available in Chapter 6, see “Saving and Registering a Symbol”.

Create a Symbol from a Schematic

Design Architect can create a symbol to represent a schematic sheet. When
choose theMiscellaneous > Generate Symbol menu item while in the Schematic
Editor, a dialog box is displayed for you to specify the name of the symbol th
will be created.

The symbol can be generated from the currently open schematic sheet, ano
sheet, or a pin list. Options include replacing an existing symbol, opening the
newly created symbol for editing, and saving the new symbol.
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Create a Symbol from a Pin List

While in the Schematic Editor, you can generate a symbol from a pin list. Ch
the Miscellaneous > Generate Symbol menu item to display the Generate
Symbol dialog box (This dialog box is also available in the session window w
theFile > Generate > Symbol menu item). When you click thePinlist File
button, a text entry field appears for you to enter the file pathname, as show
Figure2-23.

Figure 2-23. Generate Symbol Dialog Box

Generate Symbol

OK CancelReset

Symbol Name addr

Component Name $PROJ_A/addr

Pinlist File $PROJ_A/addr/pin_list.ascii

Shape Arguments: [2,2]Pin Spacing (in pin grids) 2

SchematicPinlist FileChoose Source

Replace existing?

Yes

No

Once generated ...

Navigator...

Save Symbol

Edit Symbol

Save and Edit

Active symbol?

Yes

No

(Symbol must be saved)

Choose Shape

Current Shape: box
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The following code block shows an example of a pin list file.

The schematic generator always places user-defined ports on the input side
symbol, unless the user adds a PINTYPE property to the pin and specifies th
value as “OUT” or “IXO”.

For detailed information about the constructs used in the pin list file, refer to 
“Pin List File Format” appendix in theDesign Architect Reference Manual.

Edit Symbol In-Place

You can edit a symbol in-place on a schematic sheet. Errors such as misma
the symbol pins with connecting nets, or using incorrect pin spacing, are avo
because you can modify the symbol model in the position of its instance on t
schematic.

You open a selected instance in-place on a schematic sheet with theBegin Edit
Symbol command. When the symbol is opened, the nets and instances on th

// Mentor Graphics pin list file for symbol generation.
// Created:  05/16/94 by Fred Jones

pins {         // Pin information
  "DIN(7:0)",  input, width 8, side 3, position_on_side 1,
               no_bubble, no_edgesense;
  "DIN(7:0)",  input, width 8, side 3, position_on_side 1,
               no_bubble, no_edgesense;
  "DOUT(7:0)", output, width 8, side 1, position_on_side 0,
               no_bubble, no_edgesense;
  "CLK",       label "C", input, width 1, side 3,
               position_on_side 0, no_bubble, edgesense;
}

body_props {   // Property information
  name "W", text "W=", number, value "8", region 1;
  name "INST", string, value "I$0", region 3;
}

shape buf, 4;  // Shape information
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sheet are grayed out, but are still visible while you are editing the symbol
contents. All symbol editing commands are now accessible.

It is possible to have another window open on the symbol. This allows both a
schematic context edit view, and a symbol window where the symbol can be
viewed and edited by itself (out of context of the schematic). Edits made in th
out-of-context window are visible on the symbol edited in-place.

You exit the symbol edit in-place mode and update the symbol instance on t
schematic sheet with theEnd Edit Symbol command. If you do not specify the -
Force switch and edits have been made but not written, you are prompted w
“Save changes?” request. Answering with a “yes” response writes edits to di
before closing the symbol. You can use the -Force command line switch to q
out of edit, with no changes saved.

Make a Symbol on a Schematic Sheet

Instead of having to open a Symbol Editor window to execute the graphic
generating commands to create the symbol, you can make a symbol from
comment objects and symbol pins on your schematic sheet. This methodolo
useful for top-down design creation.

TheMake Symbol command converts selected schematic comment objects a
symbol pins to symbol graphics, and then checks the symbol. If errors in any
required symbol checks are found, the command is aborted, and the selecte
objects remain on the schematic sheet. If no errors are found, the selected
comment objects and symbol pins are deleted from the schematic sheet, an
symbol model just created is instantiated in-place on the schematic sheet. If
select objects other than comments and symbol pins, an error is reported.

NOTE: Symbol pins become part of a symbol when you issue the Make Sym
command. If the pins on a schematic sheet have not been made part of a sy
definition, an error will be reported with the required schematic sheet checks
Design Architect User’s Manual, v8.6_2 2-69



Elements of VHDL Design Capture Concepts

reate
Elements of VHDL
The VHDL language has many constructs that are similar to objects used to c
schematics and symbols. Both methods are capable of fully describing the
structural and behavioral characteristics of a circuit. To learn about creating
VHDL models, refer to the appropriate topics from the following list:

• VHDL language constructs

IEEE Standard VHDL Language Reference Manual

QuickHDL User’s and Reference Manual

• VHDL text editing

QuickHDL User’s and Reference Manual

Notepad User's and Reference Manual

• Compiling VHDL models

QuickHDL User’s and Reference Manual

• VHDL model registration

“VHDL Registration” in this chapter.
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Object Selection
To work with objects on the screen, you must first select them. You can mov
copy, flip, rotate, or pivot a selected object (or group of objects), as well as
perform a variety of other operations. For selection procedures, refer to “Selecting
and Unselecting Objects” in Chapter 6.

Topics related to object selection are as follows:

• General selection

• Specific selection

• Selection sets

• Reopen selection

• Reselection

• Selection filters

• Individual selection

• Text selection

• Selecting objects in multiple windows

• Unselecting objects

Note

If you select an object(s) and subsequently change the view s
selected object(s) is out of your immediate field of view, a
warning is issued to this effect. Refer to “Out-of-View Selected
Objects” in Chapter 6.
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General Selection

There are five common ways to select object(s):

1. Move the cursor over the object and click the Select (left) mouse butto
This action toggles the object between its selected and unselected sta

2. Put the cursor near the object(s) to select, hold the Select mouse butto
down, drag an expandable box, called thedynamic rectangle, until all the
object(s) you want selected are in the rectangle, then release the Sele
mouse button.

3. Put the cursor near the object(s) you want selected, hold the F1 (Select Area
Anything) function key down and drag the dynamic rectangle until all th
object(s) you want selected are in the rectangle. Release the function 

4. Execute the appropriateSelect menu items. For examples of using the
Select menu items, refer to “Selecting and Unselecting Objects” in Chapter
6.

5. Execute the “match” command from the popup command line to select n
or instances by their respective names or handles. For examples of usi
“match” command, refer to “Using the “match” Command to Select Nets o
Instances by Name or Handle” in Chapter 6.

Selection types 1 and 2 use the selection filter to define which type(s) of obje
are selected. To set up the selection filter, click on theSet Select Filter palette
button, or execute theSetup Select Filter command. Selection types 3 and 4 do n
use a selection filter; they select all object types within the dynamic rectangle
Refer to “Selection Filters” in this chapter.

Specific Selection

You can specify what types of objects you want to select or unselect. Popup 
itemsSelect > All, Select > Area,andSelect > Exterior let you choose one of
the following items:

• Comment graphics
Design Architect User’s Manual, v8.6_22-72



Design Capture Concepts Object Selection

y
ct.
n edit
emain
 the
eates
lection
• Comment text

• Frame

• Net

• Pin

• Property

• Segment

• Symbol pin

• Symbol body

• Vertex

OtherSelect popup menu items let you select:

• Attached (nets, pins, instances, branches)

• By object handle

• By property (owners, name, type, value)

• By object name

Selection Sets

Selected objects are called aselection set. Items are added to the selection set b
placing an object (instance, net) on the sheet or by selecting an existing obje
Multiple Select commands can add more items to the open selection set. If a
or report operation is performed, the selection set is closed, but the objects r
selected. Aclosed selection set means that no more selections can be added to
set. The next Select command or placement of a new object on the sheet cr
and opens a new selection set, and unselects all objects within the closed se
set.
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The Select Count in the status line shows whether the selection set is open 
closed. If the number of selected items is followed by a plus (+) character, th
selection set is open (“Sel. 2+”); otherwise, the selection set is closed (“Sel. 
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Reopen Selection

You can reopen the previously closed selection set with theReopen Selection
command. This selection set remains open until another edit operation is
performed. For example, if you select three instances and rotate them (closin
selection set), and then you want to move those three instances, plus four o
instances, you execute the Reopen Selection command, then select the add
four instances, prior to performing the move.

Reselection

The previously closed selection set is called thereselection set. You can use the
Reselect command to select the reselection set. If the current selection set is 
the Reselect command adds the contents of the reselection set to the curren
selection set, leaving the selection set open. If the current selection set is clo
will become the new reselection set, and the current reselection set will be th
selection set. The following example shows how reselection operates with re
to selection sets.

For this example, you select some instances and nets, and identify this selec
set as “Group A”. If you perform a Move command on Group A, the selection
is closed, but the objects in Group A are still selected, as shown in Figure2-24.

Figure 2-24. Group A Selected

Group A
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Next, select another group of instances and nets. This action closes Group A
creates another selection set identified as “Group B”, as shown in Figure2-25.
Group A is now the reselection set.

Figure 2-25. Group A Closed, Group B Selected

Perform a Move command on Group B, which closes this selection set. Next
issue the Reselect command. Because Group B is closed, it becomes the
reselection set, and Group A is the new selection set, as shown in Figure2-26.

Figure 2-26. Group A Reselected, Group B Closed

Group A Group B

Group A Group B
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Now Group A is current and open, able to accept additional selections. Issue
Reselect command again, which selects Group B. Because the current selec
set (Group A) is open, Group B is added to Group A. Thus, the new open sele
set is the sum of the selection set, Group A, and the reselection set, Group B
shown in Figure2-27.

Figure 2-27. Selection Set (Sum of Groups A and B)

Selection Filters

A selection filter lets you specify a set of criteria used to select a defined sub
objects. You can define a selection filter for one selection by supplying argum
to a particular Select command, or by defining a selection filter to use until it
subsequently modified. Selection filters are extremely useful when trying to s
a particular type of object in an area that contains many types of objects.

For example, you may want to select pins on an instance in a schematic she
Because this selection of “only pins” needs to occur once, you can use theSelect
Area command with the -Pin switch to select the pins. This command causes
pins in the specified area to be selected, and the selection filter is enabled a
after the selection is complete.

Design Architect has three selection filters defined for the Schematic Editor. E
filter is designed to use with the palette of the same name. The Add/Route fi
default setting selects instances, pins, net segments, and vertices. This is th
default selection filter. The Text filter default setting only selects property text
comment text. The Draw filter default setting selects comments and symbol 
The Symbol Editor selection filter default setting selects pins and symbol bod
by default.

Group A Group B
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You can change from one selection filter to another (in the Schematic Editor
redefine a selection filter by clicking on the Set Select Filter button in the pal
Design Architect does not change the selection filter when you change to a
different palette in the same scope.

You can also define unselection filters used in the unselection of objects. Th
$setup_unselect_filter() function is described in theDesign Architect Reference
Manual.

Individual Selection

By default, Design Architect uses the additive selection using open and clos
selection sets. However, you can change this method of selection to an indiv
selection model, in which the Select mouse button is defined to unselect obj
before doing a select using the selection filter. This means you never need to
the state of the selection set. This also lets you click the Select mouse button
empty space in the edit window to unselect all objects. To get additive selecti
this mode, press the Control key and Select mouse button simultaneously.

You can choose the selection model you want to use through theSetup > Set >
Additive Selection/Individual Selection pulldown menu item in the Session
window.

Text Selection

Generally, you do not mix the selection of text and graphics, so the select filt
rarely set to select text. To make text selection easier, the Shift key-Select m
button sequence is defined to select only text. This method of selection hono
additive versus individual selection model discussed in “Individual Selection” in
this chapter.

In the Schematic Editor, you can select any type of text using this method. In
Symbol Editor, this key sequence selects property text and comment text (sy
text converted to comment text); it does not select symbol text.
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Multiple Window Object Selection

When multiple windows are open on the same sheet, objects in the sheet whi
selected in one window are highlighted in each of the windows and can be
operated upon from any of the windows open into the sheet.

A selection set is created for each symbol or schematic sheet displayed in a
Design Architect window. When you activate another window, you have chan
the selection set you were working in to the new active window selection set
an example, you cannot select an object from one window and select anothe
object from another window and move both of these objects simultaneously 
the same move command to another window.

Unselect Objects

When you finish performing an action on selected objects, you should unsele
them, so you won't inadvertently perform any further actions on them.

There are several ways to unselect object(s):

1. Click the Select mouse button on the Unselect All icon in the palette.

2. Move the cursor over the object and click with the Select mouse button
This action toggles the object between its selected and unselected sta

3. Press the F2 (Unselect All) function key. This unselects all selected objec

4. Press and hold the Alt key and Select mouse button simultaneously, a
drag the dynamic rectangle to include the objects you want unselected
release the Alt key and mouse button.
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5. Put the cursor near the object(s) you want unselected, hold the Shift-F
Unselect Area Anything function key down and drag the dynamic rectang
until all the object(s) you want unselected are included in the rectangle
Release the function key.

6. Execute the appropriateUnselect menu items. Refer to “Selecting and
Unselecting Objects” in this manual for examples of using theUnselect
menu items.

Manipulate Objects
After electrical, graphical, and comment objects have been placed on the sc
they can be moved, flipped, rotated, copied, deleted, grouped, and pivoted a
required for the design. Refer to “Manipulating Graphical Objects” in Chapter 6
for detailed information on how to use these commands. These operations a
executed with the following commands:

• Move - moves selected objects

• Flip  - flips selected objects

• Rotate - rotates selected objects around a single basepoint in multiples
90 degrees.

• Copy - duplicates selected objects

• Copy Multiple  - duplicates selected objects the specified number of tim
in a line in the direction indicated by the cursor

• Copy to Array  - duplicates selected objects, placing them in the specif
number of rows and columns

• Group - groups selected objects

• Delete - deletes selected objects

• Pivot - pivots selected objects individually about their own origins in
multiples of 90 degrees.
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Inter-Window Copy and Move
You can move objects to and from schematic and symbol windows. Any obje
selected and visible on the screen can be moved or copied with the Move an
Copy commands. Refer to “Manipulating Graphical Objects” for inter-window
move and copy procedures.

When objects are moved to another window, they are converted to the type 
objects the other window's editor understands. For example, when you move
selected schematic objects to another schematic window a one-to-one trans
occurs. A net becomes a net, an instance becomes an instance, and so forth

When you move or copy objects from a schematic window to a symbol wind
or from a symbol window to a schematic window, an object conversion occu
Refer to Table2-5 for how schematic objects are converted to symbol objects

Refer to Table2-6 for information on how symbol objects are converted to
schematic objects.

Table 2-5. Schematic Objects to Symbol Objects

Schematic Objects To Symbol Objects

Instances, nets, pins, visible comments,
and visible properties

Symbol text and graphics, and
properties

Invisible properties No translation

Table 2-6. Symbol Objects to Schematic Objects

Symbol Objects To Schematic Objects

Symbol graphics, visible properties (not
pin properties), symbol comments

Comment text and graphics, and
properties

Pins No change

Properties attached to the pins No change

Invisible properties (not pin properties) No translation
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Undo and Redo
TheUndo andRedo commands help you return your application to a previous
state. They are usually used after a command has been executed by mistak
example, if you have moved an instance to a mistaken location, you can the
execute the Undo command to return to the state you were in before you mo
the instance. If you execute an Undo command by mistake, you can execute
Redo command, and return to the state before you executed the last undo
command.

The Undo command supports more than one level of undo; that is, you can
execute the Undo command “n” number of times until you reach the specifie
undo level or you reach the top of the undo stack. You can set the undo leve
theSetup > Set > Undo Levelmenu item or the $set_undo_level internal state
function. The default number of undos is 5. The undo level also controls the 
level.

There is an Undo icon in each palette in the Symbol and Schematic Editors. 
the Select mouse button on the icon to undo an action. In the selection sens
popup menus, chooseUndo > Undo. To redo an unwanted undo, chooseUndo >
Redo from any of the selection sensitive popup menus.

DA Model Registration
When you create a schematic, VHDL, or symbol model in DA that you want 
use in a design, you must register it with a component interface. The compo
interface is the mechanism that defines a set of models used by downstream
applications. Registration occurs when you save the model (symbol, schema
compile a VHDL model. The model is, by default, registered to a component
interface with the same name as the component. In most cases you will use
default registration set by the Save Sheet and Save Symbol commands.

Refer to “Saving a Sheet and Registering a Schematic” and “Saving and
Registering a Symbol” in Chapter 6 for information on how to save and registe
your schematic and symbol. Refer to “Invoking the Compiler” in theQuickHDL
User’s and Reference Manual for information on how to compile a VHDL model
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For the more advanced user, you may want to take advantage of the flexibili
the component structure. For example, you may want to have more than one
schematic or symbol defined for one component, link other models (for exam
technology files) with a single schematic, share the same model with other
component interfaces, or define other component structures that make sens
your design needs. In these cases, you need to understand the mechanisms
the registration process.

The following concepts are necessary to understand the registration process

• The structure and definition of component, component interface, and m

• The relationship between a component interface and a model

• How labels bind models together

• The relationship between evaluated instances and the component inte

Definition of a Component

The component is a container that includes a part and model(s). The compone's
models describe a device. A “flip flop”, “mux”, and “AND” devices are examp
of components. Figure2-28 shows the pieces that comprise a component and 
component's relationship to a library.

As shown in Figure2-28, a component contains the following:

• One or more component interfaces (stored within the part)

• One or more models

Hierarchically, a component is at a directory level. The models which make u
component are files or file sets hierarchically below the component. The
component is represented iconically within the Design Manager. Viewing “do
through the component reveals icons that represent the part, models, and ot
files.
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Thecomponent interface is not iconically represented within the Design Manag
The component interface defines the group of models used in a design applic
(simulation, for example). The component interface is stored within the part
object.

Thepart object appears as a icon in the Design Manager. One and only one 
can map to a component. The part is at the same hierarchical level in the file
system as the models, as illustrated in Figure2-28.

Figure 2-28. Composition of a Component

Component Interface

Thecomponent interfacedefines an electrical interface to a component, and a
of models that match that interface. One or more component interfaces can 
logically contained within a part. Figure2-28 shows the logical relationship
between a component and its component interface(s).

You can think of the component interface as the “roadmap” to the models us
For more information on how models and component interfaces interact with 
other, refer to “Instance Evaluation” in this chapter.

Component

Part

Component Interface

Model ModelModel Model

Component Interface
Component

Library

Component
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A component interface contains several pieces of information, including: the
component interface name, pin list, property set, and model table, as illustra
Figure2-29 and described in the following list:

• A component interface name can be set by you. The defaultcomponent
interface namematches its associated component name.

• A pin list is a one-to-one mapping with the pins used by the symbol mo
This list is created automatically when the component interface is creat
the time you save and register the symbol.

• A body property set contains property name/value pairs for the body of t
symbol model.    This is also created automatically when the compone
interface is created when you save and register the symbol.

• A model table contains model entries which are links between the
component interface and the models to which it has access.
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Figure 2-29. Component Interface

The elements of a component interface can be viewed and edited with the
Component Window or the Component Interface Browser. For more informa
about the Component Window, refer to theDesign Manager User's Manual. For
information about the Component Interface Browser, refer to theComponent
Interface Browser User's and Reference Manual. In Design Architect, the Report
Interfaces command also shows the elements of a component interface, but
information to models created only by Design Architect.
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Model

A model is defined as a functional or non-functional description of a device.
Functional models are used by analysis applications, such as QuickSim II, to
describe the function of a circuit. Examples of functional models are VHDL,
schematic, QuickPart table, and Behavioral Language Model (BLM). Non-
functional models are also used by applications, but do not describe the func
of a circuit. They describe, for example, the timing of the circuit (technology fi
or the graphical symbolic representation of the circuit (symbol). One or more
functional and non-functional models can be logically associated with a
component through a component interface. Figure2-28 shows the logical
relationship between models and components.

A model can be shared with other component interfaces, as shown in Figure2-30.
A model can be used by the component interface after it has been registered
the component interface. All models except symbol models and VHDL mode
can be registered with more than one component interface. Symbol models 
VHDL models can only be registered with one component interface per
component. To use a VHDL model with a different component, copy the VHD
source to reside under the new component and recompile. Use theMGC >
Design Management > Copy Object menu item in either Design Architect or th
Design Manager to copy design objects.

Figure2-30 shows the symbol model represented hierarchically above the
component interface. The one-to-one association of symbol and component
interface allows you to think of the symbol as the entity that represents the
specific pin property set of the component interface.

Registration and Labeling

Whenever you create a functional model that you wish to use in a componen
must register it with a component interface. Registration involves assigning a
label to a model, and associating the model and its label with a component
interface. Every model has at least one label associated with it.

NOTE: Models within the same type (such as symbols) registered to the sam
component interface must have unique user-defined labels.
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Labels are assigned to model entries in the component interface model table
can assign more than one label to a model, and register a single model with
than one component interface (except for symbol and VHDL models). Each 
you register a model with a component interface, you effectively add an entr
the model table. This entry provides the link between the component interfac
the model, and also provides the set of labels associated with the model use
model selection by downstream applications.

Figure 2-30. Shared Model

Symbol Registration

When you save a symbol usingFile > Save Symbol > Default Registration, your
symbol is automatically registered. If the symbol is new, a component interfa
created with a pin list, symbol body property list, and a component interface n
that matches the component name. If you do not specify other options, the
“default_sym” label is inserted in the model entry, as shown in Figure2-31. This
label identifies the symbol as the default symbol for the component interface.
default action also specifies the component interface as the default for this
component.

Model

Component Interface1

Symbol
Model

ModelShared
Model

Symbol
Model

Component Interface2
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If the symbol is already registered to the component interface when the sym
saved, it checks to see if the symbol is still valid for this component interface
the symbol is not valid for the component interface (for example, the number
pins on the symbol do not match the number of pins in the component interfa
theSave Symbol command will query you as to whether you want to save the
symbol and update the component interface. This action invalidates any othe
models registered to that component interface.

Refer to “Saving and Registering a Symbol” in Chapter 6 for a procedure on how
to save and register your symbol.

Figure 2-31. Symbol Registration
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Multiple Symbols Registered to One Component Interface

A component may contain multiple symbols that are graphically different but
share the same functionality of the component. For example, you may create
MG_STD positive logic, MG_STD negative logic, and an ANSI standard sym
for a specific component.

In the case where library parts have multiple symbols and each symbol has 
same pins and properties, it is recommended that you register all symbols to
component interface. This can only be done if each of the symbols have the
pins and properties.

In cases where they do not, a separate component interface must be create
each symbol.

For a procedure on how to register multiple symbols to one component inter
see “Registering Multiple Symbols to One Component Interface” in Chapter 6.

Schematic Registration

A schematic may be composed of multiple schematic sheets. Each sheet “kn
what schematic it belongs to. When you save the schematic sheet using the d
save menu itemFile > Save > Default Registration, your schematic is
automatically registered. If the schematic itself is new (this is the first schem
sheet saved in this schematic), and a component interface does not exist, a 
component interface (with no pin and property information) is created, and is
named the same name as the leaf of the component name.

If the schematic itself is new, but a default component interface already exist
schematic is registered with that component interface. If you are saving an
existing sheet, the schematic's registration does not change.

Every time you register a schematic, two labels are created and are inserted
component interface model table. The first is the name of the schematic, in t
case “schematic,” as shown in Figure2-32. The second label is $schematic. The
model type can be used by downstream applications to select the model.
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If the schematic is the first schematic model to be registered with this compo
interface, it is labeled “default,” specifying it as the default schematic model 
this component interface. Otherwise, to define the schematic as the default
schematic registered to the component interface, the “default” label must be
explicitly assigned with the Save Sheet command.

Refer to “Saving a Sheet and Registering a Schematic” in Chapter 6 for the
procedures used to save your sheet and register your schematic.

Figure 2-32. Schematic Registration

If the label “default” is used for a schematic, Design Architect scans the mod
table and removes the “default” label from any other schematic or VHDL mo
registered with that component interface.
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VHDL Registration

A VHDL model consists of two pieces: aprimary design unit and asecondary
design unit. The primary design unit describes the electrical interface between
modeled device and the outside world. In VHDL terms, the primary design un
also known as theentity description. The secondary design unit provides the
functional description of the electrical device. This unit can describe the devi
behaviorally, in terms of data flow, or at the gate level.

You can have multiple secondary design units that are compatible with the s
primary design unit. In VHDL terms a secondary design unit is known as an
architecture body. You can include both the entity description and the architect
body(ies) in the same text file or within individual files.

You register a VHDL model to a specified component when you compile the
model. In the VHDL Editor, the Compile command compiles the VHDL mode
(both entity and architecture body) using the options specified with the Set
Compiler Options command. The entity description and the architecture bod
registered as two separate entries into the model table as shown in Figure .

The first entry label is the entity description identifier, in this case “entity,” as
shown in Figure . The second entry has a label and a model type. The name
represents the architectural body identifier, in this case “arch_1”. The $hdl
identifies the model type as a VHDL which can be used by downstream
applications to select the model.

If the VHDL model is the first functional model to be registered with this
component interface, it is labeled “default,” specifying it as the default functio
model for the component interface. Otherwise, to define the VHDL model as
default VHDL registered to the component, the “default” label must be explic
assigned to the component interface with the Component Interface Browser.
Design Architect User’s Manual, v8.6_22-92



Design Capture Concepts DA Model Registration

 a set

 the
Figure 2-33. VHDL Registration

Registration of Multiple Models

If you register multiple model types to a component interface you should add
of labels that identifies the combinations of models you wish to use. In
Figure2-34, a schematic model, symbol model, and two technology files are
registered to one component interface. The label name “default_sym” is
associated with the symbol model and is used by Mentor Graphics to identify
symbol as the default symbol for the component interface.

VHDL
Architecture

Body

 default  schematic  $schematic
 default_sym

out

Schematic entity

VHDL
Entity

Description

arch_1  $hdl

A

B

. .
 .

. .
 .

Component Interface

Name
2input

Pins
A     B     OUT

Model Table

Property Set

Pintype = 'input'
Rise = 0
Fall = 0

Pin A Body

Model = arch_1
Comp = '2_input_and'/

/

Pintype = 'input'
Rise = 0
Fall = 0

Pin B

/
/

Design Architect User’s Manual, v8.6_2 2-93



DA Model Registration Design Capture Concepts

 and
ile,
In this example, the other label names .8uS and 1uS were picked by you to
identify combinations of models available for use. For example, in Figure2-34,
the label “.8uS” is entered in the model table for the .8-micron technology file
the schematic model. This binds the schematic to the .8-micron technology f
since both have the same label. The “1uS” label is entered for the 1-micron
technology file and the schematic. This binds the schematic to the 1-micron
technology file, since both have the same label.

Figure 2-34. Registering Multiple Models
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 default_sym
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Pins
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/
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Design Architect User’s Manual, v8.6_22-94



Design Capture Concepts DA Model Registration

n the

gh
 two
he
 to

ose.
e

h the
r

el.

ter
 the
ation
ce, the
kSim

perty
e
d
in

he
nd

rent
In
The different labels define all the workable combinations of models entered i
component interface. Labels are not restricted to these names. Any naming
conventions appropriate for your design needs can be used as labels, althou
models of the same type must have unique labels. For example, if you have
schematic models registered with an interface, Design Architect will assign t
“$schematic” label to them; you need to assign unique labels to each of them
identify the desired schematic model for a symbol instance.

To select the models appropriate to the .8-micron technology file, set the
instance's Model property to “.8uS” to tell the simulators which models to cho
Refer to “Instance Evaluation” in this chapter for more information about instanc
evaluation.

Labels are added to the component interface model table for schematics wit
Save Sheet command. For more information about registration syntax for othe
models, see the V8 document that describes how to create a particular mod

Instance Evaluation

An instance is defined as a reference to a particular component interface. Af
you have registered a set of models to a component interface, and identified
group of models you want to use through the use of labels, the analysis applic
can then evaluate the instance. Whenever an application evaluates an instan
application must understand how the device works. For example, when Quic
II evaluates an instance, it needs to know how the device's timing works.

An instance can have many properties. Of all these properties, the Model pro
is key to instance evaluation. The evaluating application uses the value of th
Model property on the instance to compare against the labels of its registere
models. For example, consider the component interface and models shown 
Figure2-35.

This example shows a component interface with several models. Note that t
models have been registered with several labels. This component interface a
group of models could represent a library organization that revolves around
different chip manufacturing technologies, or perhaps the need to have diffe
types of models for various downstream applications or types of simulation. 
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any case, several models exist that can possibly provide a definition for the
instance.

Figure 2-35. Instance Evaluation

Note also that the value of the Model property in the figure is “.8uS”. When t
instance is being defined, the group of labels for each model registered with
component interface is examined for a match against the Model property val
a match is found, that model becomes part of the instance's definition. When
models have been examined, the instance is defined.
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Figure2-35 shows the selected models by highlighting the labels that match 
Model property value of “.8uS”. In this example, the .8-micron technology file
and the schematic model both have labels that match the value of “.8uS”. Th
symbol model is labeled as the default symbol, including this model in any m
combination. None of the other registered models have the “.8uS” label or ar
labeled as default. Thus, the instance identified by the “.8uS” label has a
symbolic, functional, and timing description.

Changing the value of the Model property on an instance allows you to easil
select different models. Once a new definition for the instance exists, the
application can re-evaluate the device again. This can all occur without rebui
the design.

Manipulating Design Objects
You can copy, move, resize, group, delete, and release design objects in the
Design Manager, or with very similar functionality, in the Integrated Design
Manager (iDM) within Design Architect. For complete information about thes
topics, refer to theDesign Manager User's Manual.

CAUTION: Attribute files are in ASCII format. As a result, they can be edited
Do not edit these files.If you edit an attribute file directly, you can corrupt the
design object to which it belongs. Use the Design Manager or iDM to edit AL
design references; it will automatically update the attribute files for you.

In Design Architect, the iDM functions reside in theMGC  pulldown menu,
shown in Figure2-36, or in the Session popup menu. These functions provide
easy way to copy, move, delete, and change references from within Design
Architect. iDM also provides the ability to navigate through your designs, and
view and interact with your design hierarchy.
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Figure 2-36. File > Design Management Menu

Creating a Configuration Object

In the Design Manager, aconfiguration objectdefines a collection of data object
that are interrelated by containment or by references. The reason for a
configuration object is to give you the ability to treat design objects as a sing
unit for certain operations such as moving, copying, and releasing.

You specify which design objects (called primary objects) you want in the
configuration, then specify build rules for each primary object. The Design
Manager builds the configuration, according to the rules you set. Save the
configuration; all the information needed to recreate the configuration instant
a later time is stored in the configuration object.

Configuration objects are represented by icons in navigator windows. You ca
select the icon and perform operations on all objects in the configuration with
single command, or open the configuration object for editing or viewing.

Configuration objects are discussed in detail in theDesign Manager's User's
Manual.

Notepad

Cleanup Windows

Userware

Transcript

Export Screen:

Location Map

Design Management

Setup

Copy Object...

Move Object...

Delete Object...

Open Hierarchy Window

Change References...

Open Com ponent Window...
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Copying a Design/Library Component

The Design Manager copies objects in two modes: by reference or by
containment. The copy by reference requires a configuration object to find a
design objects associated with a design, and operates on them as a single u

Copying by containment is simpler and more common. All objects contained
the directory hierarchy below the specified object are copied. All resolved
references are automatically updated. Any references that were unresolved 
the copy operation remain unchanged. You can modify these references to p
existing objects within the Design Manager or the iDM environments. If you d
not use the Design Manager or iDM to copy design objects, the original refere
remained unchanged.

When you copy a schematic or symbol model, the new copy is not registered
any interface. You must register the newly copied object using either Design
Architect or the Component Interface Browser.

For general information about copying a design or library component, refer t
“Copying a Design Object” in theDesign Manager User's Manual.

Moving a Component

In general, design objects should be movedafter you have made a backup copy.
This is a reliability issue primarily for larger collections of objects because of
time required to complete the move and update the references. Network pro
could cause the operation to fail before it completed, leaving no easy way to
recover.

When you move an object within a component or design, all objects in the
selected object's containment hierarchy are also moved. When you move de
objects that refer to other design objects in the selected set, the Design Man
automatically updates those references to reflect the new location. (Unresolv
references remain unchanged.) When moving objects that contain other obje
such as components and schematics, all inter-object references between the
contained objects are updated.
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Any design object that references the moved object, but is not either contain
the moved object or in the selected set of objects to move, will not have the
reference updated. Thus, the design object reference that points to a non-ex
design object is broken. You must manually update this reference so that it p
to the new location of the moved design object.

Design Manager allows all types of objects to be moved. However, because
schematic models are registered with their containing components, attempts
move symbols and schematics outside of their containing components will re
in an error, and the move will not take place. You can move symbols and
schematics within the component, that is, rename them. You can also copy
symbols and schematics outside their containing components.

For general information about moving a component, refer to “Moving a Design
Object” in theDesign Manager User's Manual.

Renaming a Component

Renaming a component renames the file set (all objects that are of the same
set) that is selected, and then changes references within the file set (contain
hierarchy to reflect the change. External design object references that point 
objects in the renamed container are not updated. These references will nee
updated.

When you change the name of the component container, the Design Manage
changes the objects at this level in the hierarchy. Examine Figure2-37.

Figure 2-37. Renaming a Component Containing a Symbol

74ls74

part

74ls74
symbol

Changing the name here
does not change the name here
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Note that for the typical component, the symbol name is the same as the
component name. If you change the name of the component in the Design
Manager, the symbol name remains the same. The Design Manager update
component interface to reflect the new path so that when the component is
requested in an application, the references are preserved.

For general information about renaming a component, refer to “Renaming a
Design Object” in theDesign Manager User's Manual.

Resizing an Instance

Normally when you place a symbol on a sheet, you have no choice as to wha
it is; the size is determined in the Symbol Editor by how many pin grids it
occupies and in the Schematic Editor by the pin spacing of the sheet. By def
Design Architect does not allow you to resize instances on a sheet, since ma
sites have stringent drafting standards and cannot use this functionality. How
you can change the default for a sheet to enable resizable instances.

You can use the $allow_resizable_instances() function to set up the sheet fo
resizing. To determine if resizable instances are already allowed on a sheet,
can use the $get_allow_resizable_instances() function; when you issue the
command, “@true” in the transcript indicates that the sheet already allows
resizing and “@false” indicates the sheet is still in default mode.

Since instances cannot shrink so that they take up fewer pin grids than the or
symbol, the pin spacing of the entire sheet is changed such that the size of t
instance appears to have changed. The $allow_resizable_instances() functio
decreases the pinspacing of a sheet by a factor of four. New instances place
that sheet automatically appear at the same relative size as other unscaled
instances.

!
Caution

Changing the default on a sheet to allow resizable instances is
irreversible.
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If your site decides it wants to use resizable instances, the
$allow_resizable_instances() function should be issued from a schematic
environment file so that it is executed for every sheet that is opened. This ca
accomplished by placing the following function in ada_session.startup file:

$set_environment_dofile_pathname(@sheet,’ dofile_pathname ’)

The dofile specified in the above function should contain
“$allow_resizable_instances()” and any other sheet-specific startup comman
Using the method will ensure that every sheet that is opened at your site will
include the ability to resize instances by default.

If the $allow_resizable_instances() function is executed on an existing sheet
already contains instances or comments, the pin spacing for those objects w
automatically adjusted so that they appear at normal scale, rather than smal
larger. However, the preferred method is for a sheet to be set up for resizing 
it is created.

Grouping Design Objects

You can group design objects in order to make other editing actions easier. 
example, you can group objects together rather than repeatedly selecting the
items with time-consuming selection strokes. By giving the objects a group n
you can then select the group and move or copy it; the new objects do not re
the group name if they are copied.

You can append more objects to a group, which enables you to select and pe
editing actions on more objects than the ones you originally had in the group
Additionally, you can report all the names of the groups in a design.

For operating procedures on grouping objects, refer to “Grouping Objects” and
“Ungrouping Objects” both of which are in Chapter 6.
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Deleting a Component

When you delete an object within a component, other objects in that compon
that might reference the deleted object are updated. However, if you delete a
object (or an entire component), other objects that reference the deleted obj
(component) need updating. For example, if you delete$MGC_GENLIB/and2,
then any designs that reference that component need updating.

Keep the following in mind when deleting design objects:

• Before deleting a model other than a symbol or schematic, unregister t
model from the component interface using the Component Interface
Browser.

• Deleting a symbol does not delete the pin and property information fro
the interface, unless it is the last pin-creating model. Check Schematic
other evaluations will continue to compare the pins and properties with
models registered with the interface. When the last pin-creating model
deleted or unregistered from an interface, the pins are removed from th
interface. The models considered to be “pin-creating models” are symb
and VHDL entities.

• Always delete objects using iconic navigators. This method deletes file 
not just files. Remember, external object references to the deleted obje
will always need to be changed.

• Neverdelete an object using operating system commands. These
commands do not preserve design object and file set relationships, an
easily corrupt data beyond repair.

For general information about deleting a component, refer to “Deleting a Design
Object” in theDesign Manager User's Manual.

Changing Component References

In the iDM, you can change or delete the references that you previously crea
the Design Manager or in an application. After you move or delete a design
object, or if a design object has unresolved references, use theMGC >
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Design Management > Change References menu item to fix broken references
This displays a dialog box in which you specify a new reference target path. 
can enter multiple reference changes at one time.

If the design was originally stored using soft pathnames, the references asso
with the design should not have to be manually updated except to fix broken
references. When using the Design Manager to manually edit references, us
soft pathname, if possible.

The Design Manager environment does support operating system relative
pathnames, such as “.” and “..”. Although the Change Object References
command allows you to change a reference to any string, you should always
specify a path that begins with / or a “$” (such as$MGC_GENLIB) in order to
provide soft pathname and location map compatibility. For general informatio
about changing design or library component references, refer to “Working with
References” in theDesign Manager User's Manual.

Releasing Designs

A released design is a protected copy of a design object, or objects defined 
configuration object. When you release a design, you are only releasing a si
version. If the original design object is at version number 8, the released des
object becomes version number 1.

Containment relationships are preserved. References are automatically upda
reflect the new location. Important recordkeeping information is stored in the
copied configuration object. The Protect property is added to these design ob
you are not allowed to modify a released design. If you need to edit released
use one of the following options:

• Edit the original design and release it again using the same configurati
Only the files that have changed since the original release will be merg
This may not be possible if the original design has significantly evolved

• Copy the released design to a new location. This copy is not protected
Make changes to the copy and then release it.
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 a
For general information about setting up a configuration object and releasing
design or library component, refer to “Managing Designs” in theDesign Manager
User's Manual.

For more information about releasing a design, refer to “Releasing a
Configuration” in theDesign Manager User's Manual.
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Version Operations

Idea Station applications normally maintain two versions of a design object.
Realize that for large designs, retaining two versions can consume large am
of disk storage.

Changing the version depth does not immediately remove excess versions. I
prunes versions when the next version manager operation occurs. The next D
Manager or application write that occurs will update versions using the versi
manager.

For general information about working with design or library component versi
refer to “Working with Versions” in theDesign Manager User's Manual.
Design Architect User’s Manual, v8.6_22-106
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Design Navigation
Design Architect allows you to easily navigate through multi-sheet designs w
only using one window. You do not need to open all of the sheets in the sche
in order to accomplish this. This feature is only available in the Schematic sc

You can open and edit multiple sheets from within one window. In addition, y
can switch between existing sheets in the schematic and also create new sh
This ability exists in source sheets as well as design sheets. Design navigati
provides the following three general modes of operation:

1. moving to the next sheet of a schematic by using theRight Arrow Button
in the title bar of every schematic window;

2. moving to the previous sheet of the schematic by using theLeft Arrow
Button in the title bar of every schematic window; and

3. moving to any schematic sheet or creating a new sheet within a schem
by using theMultiple Page Icon Button in the title bar of every schematic
window.Figure 2-38 illustrates the Schematic Sheet Navigation Buttons

Figure 2-38. Schematic Sheet Navigation Buttons

Multiple-Page
      Icon

Previous
  Sheet Next

Sheet
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Navigating Multi-Sheet Schematics with a Single
Window

To use the Schematic Sheet Navigation Buttons, you must open at least one
schematic sheet of the design. To open a schematic sheet, refer to the step-
procedures in the “Opening a Schematic Sheet” in Chapter 6.

Sequentially Traversing a Schematic

Once the sheet is open and active, you can traverse a multi-sheet design by
stepping sequentially through the schematic sheets. This is achieved by usin
either theLeft Arrow Button  to step to the previous sheet or theRight Arrow
Button to step to the next sheet.

Multiple Page Icon Button

Design Architect also allows you to jump to any sheet in a schematic or crea
new schematic sheet within a single window. By clicking on theMultiple Page
Icon Button, the Display Specific Sheet Dialog box is presented.Figure 2-39
illustrates the Display Specific Sheet Dialog box.

Figure 2-39. Display Specific Sheet Dialog Box
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The Display Specific Sheet Dialog box presents a list of existing sheets that 
up the schematic. In addition to the sheet name, the Display Specific Sheet D
box provides the edit status of the sheet(s) as Closed, Editable, Read Only, 
Modified. If the sheet is open, the status of the last known Check for the she
(Unchecked, Passed, Failed) is displayed.

To open a sheet from within the Display Specific Sheet Dialog box, double c
on the desired sheet. To create a new sheet for the schematic, select theCreate
button. The resultant dialog box allows you to enter the name of a new shee
Refer toFigure 2-40.

Figure 2-40. New Sheet Option

Closing a Multiple Sheet Schematic

Once you have made edits to an existing schematic sheet or created new she
the schematic, you can close the schematic using the procedures outlined in
“Saving a Sheet and Registering a Schematic” in Chapter 6.

Display Specific Sheet
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OK Cancel
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Sheet Name sheet1
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If edits have been made to multiple sheets, then you must specify which of t
sheets you want to save. Upon closing a schematic, the dialog box inFigure 2-41
appears.

Figure 2-41. Save Multiple Sheets Dialog Box

All of the sheets with pending edits are selected. You can select all the shee
selected sheets, or unselect all of the sheets.

!
Caution

When navigating between sheets in the same window, ensure 
any Prompt Bars (for example, Move or Add Wire) are cancelle
Prompt bars are tied to a window rather than a sheet.

Save Selected Save Nothing

sheet1

sheet3

Select Sheet to Save

sheet2

Multiple sheets edited in schematic
$TRAINING/danwp/card_reader/my_dff/schematic

Warning: Edits to unselected sheets will be lost.

Cancel

Select All

Unselect All
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Chapter 3
Property Concepts

At the beginning of the design process you must know which properties are
required by other Mentor Graphics applications you plan to use. If you do no
assign the necessary properties, the downstream applications you want to u
not be able to process your design.

For information about specific properties, refer to theProperties Reference
Manual.

Introduction to Properties
Properties are “name/value pairs” that are assigned to specific graphic objec
within the design. The graphic object is called the property “owner”. Properti
that are created without an owner are called “logical” properties. Properties
contain design information that typically cannot be represented graphically.

Properties have many functions. They can define device timing characteristi
establish horizontal and vertical connectivity in multi-sheet and multi-level
designs, define a variety of design characteristics that cannot be conveyed b
images of components and wires that make up a schematic diagram, and m
more.

To show how properties provide information to a design, consider that schem
designs in Design Architect contain two types of information:

• Connectivity information, which is conveyed graphically by pin and net
connection.

• Property information, which describes some characteristic of a compon
that is not identifiable from the schematic drawing alone.
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The symbols and schematics created in Design Architect are the means by w
you communicate this connectivity information. For example, a schematic
diagram shows graphically that part A is connected to part B. The diagram a
cannot tell you the propagation delay of a signal through parts A and B. Tha
information comes from the values of the Rise and Fall properties attached t
pins of parts A and B.

If you only want to draw, store, and print schematics, you do not need to ass
properties at all. However, if you want to perform a check of the design rules
process a circuit design with other downstream applications, such as one of 
Mentor Graphics simulators or layout applications, you must assign certain
properties. Properties have the following characteristics:

• A property has an owner type (optional), a name, a type, and a
corresponding value. The value can be either a number, triplet, expres
or character string.

• A property can be assigned to the individual objects that compose the
schematic sheet in a component library, for example, instance, net, an
objects.

• Back-annotated properties are generally supplied to a design viewpoin
downstream applications such as IC and PCB layout. Back annotation
be merged back to the original source design.

• Some downstream applications require a specific set of properties in o
to operate properly. Refer to “Required Properties per Application” in the
Properties Reference Manual for information on these tools and the
properties they require.

• Certain properties are assigned automatically by the downstream Men
Graphics engineering applications when they are executed.
Design Architect User’s Manual, v8.6_23-2
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• Some components may not have all the properties required for them to
processed by other Mentor Graphics programs. If this is the case, you 
assign the necessary properties to the components in your designs by
the various property commands.

• Structured Logic Design (SLD) properties are special properties that a
built into Design Architect. When the source design is evaluated, SLDs
converted to connectivity information, and are not accessible as prope
in the evaluated design. Refer to “Structured Logic Design Properties” in
this chapter for more information about SLD properties.

Some of the fundamental properties assigned to components supplied in var
libraries are described in “Structured Logic Design Properties” in this chapter. A
comprehensive description of individual properties is available in theProperties
Reference Manual.

Table3-1 shows a few examples of properties, which may be helpful at this p
in the discussion.

Table 3-1. Property Structure

Property
Name

Property
Value

Property Type Property
Owner

Model nand String Instance or
Symbol Body

Net cl_line String Net

Rise 10, 15, 20 Triplet Pin
Design Architect User’s Manual, v8.6_2 3-3
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Property Ownership
Ownership is a key element in understanding the concept of property use. W
we say that certain kinds of objects “own” certain properties, we mean that th
properties can only be attached to those objects. Selectable items can own
properties, but certain classes of properties and certain classes of objects m
sense together, while others do not.

By way of analogy, you could assign a value to a property called “number of y
in school” for a person, and you could assign a value to another property cal
“number of cylinders” for a car. Thus, you could say that people own the prop
“number of years in school,” and cars own the property “number of cylinders
However, it does not make sense to provide a value to a property called “nu
of cylinders” and assign that property to a person. People don't own the prop
“number of cylinders;” that is, “number of cylinders” has no semantic meanin
the context of people.

Here is another example. Pins own properties called Rise and Fall. You can a
a value to the Rise property and attach that value to a specific pin in the des
However, it would not make sense to attach that value to a net in the design
would not understand the “Rise” property.

To help you keep track of application property ownership, Design Architect
provides “ownership” commands. These commands define property ownersh
and list the valid property owners for named properties. TheSet Property Owner
command lets you restrict property ownership to a specific type of object. Th
Report Default Property Settings command lets you check the “ownership statu
of properties, that is, to tell you which objects own which properties by defau
The owners for a particular type of property can be changed. This does not a
previously-created objects with that property.
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Once property ownership is defined, Design Architect does not allow a prope
be assigned to owners that are not valid for the property name. In fact, Desig
Architect only knows about a few default owners (for example, Structured Lo
Design properties). Other property owners could be defined before editing. I
Design Architect, the following six classes of items can own properties:

• Comments

• Frames

• Instances

• Nets

• Pins

• Symbol bodies

Property ownership is not required prior to adding a property value to a obje
You may establish specific “ownership” for all properties, although Structure
Logic Design (SLD) properties are built into Design Architect and already ha
default owners. These owners can be changed with the Set Property Owner
command.

Property Names Versus Property Values
Another important concept is the distinction between propertynames and property
values. Properties always have a name and a value; the name describes the
property, while the value is data that describes a characteristic of the design
Property names are entered and stored as strings of ASCII text. Property va
can be represented as text strings, numbers, triplets, or expressions. Propert
are discussed in the “Property Types” section of this chapter.

Previously, the example of the “number of cylinders” property was used to
illustrate the concept ofownership. Let's use this example again to illustrate the
relationship between property names and property values. Cars have a prop
named “number of cylinders” with a value (typically) of 4, 6, or 8. The proper
Design Architect User’s Manual, v8.6_2 3-5
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name is “number of cylinders;” the property name does not vary from car-to-
The property value can vary from car-to-car.

Similarly, in Design Architect the Rise property might have a value of “5, 10, 
on one pin, and a value of “10, 20, 30” on another. The numbers represent
minimum, typical, and maximum delays, respectively, in nanoseconds on the
owning pin. The property name Rise does not vary from pin-to-pin; the prope
value can vary. Property name and value restrictions are discussed after pro
types.

Property Types
A property value must have a property type assigned to it. A property type
identifies the property value's data type. The legal property types are:

• Character string

• Number (integer, real, exponential)

• Expression (arithmetic or string expression)

• Triplet. The special property type “triplet” is a 3-valued property used to
describe the best-case/typical/worst-case values used in timing analys
The three values of a triplet may be separated by a comma or spaces. 
are entering triplet values in a command or function, enclose the value
quotes (for example, “5,7,10”). When entering triplet property values in
prompt bar or dialog box, do not enclose the values in quotes (5,7,10).
value, whether entered as a string, a number, or an expression type, w
evaluated as a number.

If only one value is specified, it is used for the best-case, typical, and w
case values. If two values are specified, then the first is used for the be
cased value, and the second is used for typical and worst-cased value

It is important for you to know what the property type is before entering a
property value. For example, if the property type of property name “A” is a
character string, and you enter the value of 95, this value will be interpreted 
character string “95” not the numerical value of 95.
Design Architect User’s Manual, v8.6_23-6
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When you add the property value, theAdd Property command, by default, sets th
property type to the value set by the previousSet Property Type command for that
property name. If the -Type option is used with the Add Property command, 
property type can be changed to any of the property values listed previously

Once a property value has been attached to an object, its property type can o
modified through theChange Property Type command. After a property has bee
selected, the Change Property Type command can change the property type
string, number, expression, or triplet.

Property Name/Value Restrictions
Operating systems, AMPLE, and downstream applications all impose restric
on property names and values. Design Architect does not check for violation
all these restrictions. The following topics summarize the known restrictions.

Property Name Restrictions

Any identifiers that are saved in the design database, such as property name
must begin with a letter (a-z, A-Z), or a dollar sign ($).

Subsequent characters can be any of the aforementioned characters, an und
(_), or a digit (0-9).

Property names are case insensitive in Design Architect, and must have less
512 characters. Property names and values are stored as C Language style
terminated strings and, therefore, cannot contain a null character.

Property Value Restriction

Property values of type “string” have no real character restrictions. However
that property value is going to be used by a downstream application, that
application must be able to recognize the string. Property values have no cha
length restriction. Property values are case insensitive, although you can cha
the case for display purposes.
Design Architect User’s Manual, v8.6_2 3-7
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Property values of type “number” can be integers, real numbers, or exponen
decimal numbers. Downstream applications that use the design viewing and
analysis package (for example, Design Viewpoint Editor) do not handle
exponential notation and non-decimal radix notation.

Property values of type “expression” are evaluated as AMPLE expressions a
therefore, must follow AMPLE syntax.

Property values of type “triplet” include one, two, or three values. Each of the
must evaluate to a number. If any of the three values is an expression, the
expression must follow AMPLE syntax.

Special Case Restrictions

If a property value is the name of an object that must be recognized by the d
database, the same property name restrictions apply. These include values 
Pin, Net, and Inst properties. For example, the Net property value is the nam
the net, which is stored in the design database.

The following list describes additional restrictions for net and pin names:

• “_$”, “_B$”, “_b$”, “N$”, “n$”, “I$”, “i$”, “P$”, “p$”, “G$”, “g$”, “B$”,
“b$”, “R$”, and “r$” are reserved for the leading characters for handles
(such as net, instance, and pin handles) and for internal use.

• Even though a net/pin name is declared to be a “string” in Design Archi
if the value includes “( )”, “[ ]”, or “< >” the system will attempt to evaluat
the string within the delimiters.

• Pin/Net/Inst property values cannot contain a slash (/), back slash (\), a
space ( ), a period (.), an escape, or tab character.

• “[ ]”, “( )”, and “< >” are reserved to delimit bus subscript notation. The b
width is indicated between the delimiters. The numerical values for the
width can be indicated in binary (prefix with “0b”), octal (prefix
with “0o”), decimal (no prefix), or hexadecimal (prefix with “0x”).

• A comma (,), colon (:), and semicolon (;) should only appear as part of
bus subscript syntax.
Design Architect User’s Manual, v8.6_23-8
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• A period (.) should only be used for separating parts of a record in VHD

• In any name that might be evaluated (names surrounded by parenthes
the entire string within the parentheses is considered an AMPLE expres
and must follow the AMPLE expression syntax.

Mentor Graphics discourages the use of non-printing characters and special
characters in net/pin names because of their meanings in different applicatio
and operating systems.

Properties and Color

By default, property text is displayed in the color of the object that owns the
property. For example, symbol body properties are displayed in cyan, pin
properties are displayed in magenta, and net properties are displayed in gold
Normally, if a property value is annotated in the context of a design viewpoint
annotated value is displayed in the default color (red) so you can tell which va
are annotated.

Design Architect gives you the freedom to explicitly change the color of a
property to something different than the owning object. When you do this, bo
the original value of the property and the annotated value of the property are
displayed in the new color that you explicitly define for it.

If you view a schematic sheet in the context of a design viewpoint, annotated
property values may be displayed in red (by default) or displayed in a differe
color if the property color has been explicitly changed. When this is the case
Design Architect gives you the ability to temporarily change the viewing colo
all annotations, so you can tell which property values are annotated. The
command that allows you to temporarily view all annotations in a different co
is called Set Annotation Color.

Symbol Properties
Like other properties, symbol properties provide information about the object
owns the property. Symbol properties have additional characteristics and
functions other properties do not. For example, a symbol property:
Design Architect User’s Manual, v8.6_2 3-9
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• Can be owned by a piece of symbol graphics or by the “logical symbol

• Can be created either graphical or non-graphical, if owned by the logic
symbol.

• Has a property stability and property visibility switch.

• Is brought forth to the instance when the symbol is instantiated on a
schematic sheet. Refer to “Updating Properties on an Instance of a Symbo”
in this chapter for information about how an instance of a symbol is
updated.
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Logical Symbol Properties

Regular symbol properties are attached to symbol body graphics and can be
invisible, or displayed graphically on the symbol. They are created when you
a property (with theAdd Property command) to a selected symbol graphic. Thi
action attaches the property to a selected symbol object, for example, a sym
body or symbol pin.

A symbol property that has no graphic owner is called alogical symbol property.
These are created by adding a property with nothing selected, and are not at
to symbol body graphics, but rather are owned by the “logical symbol.” The
logical symbol is the symbol entity, rather than the collective symbol graphics
and represents the function of the component.

Logical symbol properties can be either graphic or non-graphic. A graphic
property has a location, which is displayed in gold to distinguish it from prope
owned by the symbol body, and has a name, value, and property attributes.

A non-graphic property is not displayed, but has a name, value, and property
attributes. Non-graphic properties are intended for program generated prope
that do not need to be displayed or changed.

If you delete a symbol body that has properties attached, those properties be
graphic logical symbol properties at their original locations.

If you add the property graphically, you must select the text itself (rather than
owner graphics) to change the property through a change property command
move or copy the property. If you add a logical symbol property that already
exists on a symbol, the value of that property (wherever it occurs on the sym
changes to the value of the property being added. To list the logical symbol
properties for the symbol, execute theReport Object command. Both graphical
and non-graphical logical symbol properties are included in the component
interface when the symbol is saved and registered.
Design Architect User’s Manual, v8.6_2 3-11
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Property Stability Switches

In the Symbol Editor, when you add properties to a symbol, a property stabil
switch is placed on the property. These switches control the changeability of
symbol property when an instance of the symbol is placed on a schematic sh
The following switches define four levels of stability:

• -Fixed specifies that property value, type, and name cannot be altered
deleted on any instance on a schematic sheet, although property attrib
can be changed.

• -Protect specifies that property value, type, and name can be altered o
instance at instantiation time on a schematic sheet. However, once
instantiated, the instance-specific property value cannot be changed, o
the property attributes can be changed.

• -Variable specifies that property value, type, name, and text attributes 
be altered on an instance at instantiation time or any time after.

• -Nonremovable specifies that property value, type, name, and text
attributes can be altered on an instance at instantiation time or after, bu
property cannot be deleted from the instance.

The default property stability switch setting is -Variable (except for Pin
properties), and can be changed with theSetup Property Text command and the
$set_property_stability_switch() function. TheChange Property Stability Switch
command changes the property stability for selected property names withou
changing the default switch settings.

The default property stability switch setting for Pin properties is -Fixed.

Note

In order to change the stability switch of a Logical Symbol Bod
property, no object should be selected. Therefore, it is best to
execute an $unselect_all() function first. You then select the
property with the $select_by_property() function and specify th
property name and value. You can change the stability attribut
using the $change_property_stability_switch() function.
Design Architect User’s Manual, v8.6_23-12
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Property Visibility Switches

In the Symbol Editor, when you add properties to a symbol with the Add Prop
command, a property visibility switch is placed on the property and is set to
“Visible” or “Hidden”. The Visibility Switch controls the visibility of the symbo
property when an instance of the symbol is placed on a schematic sheet. Hid
properties are not selectable. When adding graphic-properties to a symbol, a
properties are visible in the symbol window.

The default property protection switch setting is -Visible, and can be changed
the Setup Property Text command and the$set_property_visibility_switch()
function. TheChange Property Visibility Switch command changes the property
visibility for selected property names without changing the default switch setti

Property attributes listed in report windows may include “-Not Visible” and “-
Hidden”. If both of these are listed, the property was hidden when added, an
property visibility has not been changed. If “-Hidden” is listed without “-Not
Visible”, the property visibility was changed to visible on the sheet.

There is also a property visibility switch attached to the properties added to t
instance of the symbol. This switch controls the visibility of properties added
the instance of the symbol, and is set in the Schematic Editor.
Design Architect User’s Manual, v8.6_2 3-13



Updating Properties on an Instance of a Symbol Property Concepts

 and

ged

)

ion

n

d to

lue,

es
dows
Updating Properties on an Instance of a
Symbol

The following topics describe how properties are updated automatically and
manually, as well as how modified property values and attributes are flagged
how those flags affect the update process.

Attribute-Modified Properties

A property on an instance becomes Attribute_Modified when the graphical
attributes of the property are changed. When you change the appearance of
property text, you are making attribute modifications, and the property is flag
as Attribute_Modified. Some examples of commands that change graphical
attributes (assuming the operation is performed on a property, not the owner
includeMove (of a property attached to the instance),Change Text Height,
Change Property Justification, andChange Text Font.

The Attribute_Modified flag has no meaning in the Symbol Editor. A descript
of how Attribute_Modified properties affect the update process begins with
“Property Merge Options” in this chapter.

The Attribute_Modified flag can be manually set and reset using the pulldow
menu:Miscellaneous > Mark Property Attributes

Value-Modified Properties

When you change the value of a property, the Value_Modified flag is attache
that property. A property becomes Value_Modified when one of the following
actions occur:

• You change the property value with the Add Instance, Change Text Va
Change Property Value, or the Delete commands.

• You mark the property using theMark Property Value command.

A Value_Modified property, by definition, is also Attribute_Modified. Properti
on the symbol and the instance that are Value_Modified appear in report win
Design Architect User’s Manual, v8.6_23-14
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as “Value Modified”. The Value_Modified flag has no meaning in the Symbo
Editor. A description of how Value_Modified properties affect the update proc
begins in the “Property Merge Options” section of this chapter.

Mark Property Attributes

The Mark Property Attributes command operates on a property whose value
selected or on all the properties owned by selected objects. You can mark a
property’s attributes as either “Modified” or “Not Modified”, depending upon
how you want those properties updated.

You can also mark and unmark a property’s by choosing theMiscellaneous >
Mark Property Attributes:  menu item; in the prompt bar, enter the property
name and choose either “modified” or “notmodified” by clicking the stepper
button.

Mark Property Value

The Mark Property Value command operates on selected property values, o
specified property name. You can mark a property value as either “Modified”
“Not Modified”, depending upon how you want those properties updated.

You can also mark and unmark properties by choosing theMiscellaneous >
Mark Property Value:  menu item; in the prompt bar, enter the property name
and choose either “modified” or “notmodified” by clicking the stepper button.

!
Caution

If a property’s attributes are modified with the Change Property
Attributes or Change Text Attributes command, then clearing th
Attribute Modified flag with the Mark Property Attributes -
Notmodified command also causes the attributes to revert bac
their original values on the symbol immediately.

!
Caution

If a property value was modified with the Change Property Valu
or Change Text Value command, then clearing the
Value_Modified flag with the Mark Property Value -Notmodified
command also causes the value to revert back to the original v
on the symbol immediately.
Design Architect User’s Manual, v8.6_2 3-15
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Property Merge Options

The property update process is controlled by property merge options on the
Update andReplace commands. TheOpen Sheet dialog box also has options to
control how a sheet is updated when it is opened; this is discussed below in 
“Automatic Update Process” section. The update process can change some or
of the properties you have placed on an instance, depending on which prope
merge option you use with the Update or Replace command and how the
properties were modified before the update. How the properties are merged 
the instance of the symbol is based on the following two property merge sett

• -Clear: Symbol body graphics are updated. All instance-specific proper
are deleted. All other properties and property attributes are reset to the
current symbol values. Any new properties on the current symbol are a
to the instance. This is the default for the Replace command.

• -Auto: Symbol body graphics are updated. All instance-specific and
Value_Modified properties remain unchanged. All other properties are r
to the current symbol values. Any new properties on the current symbo
added to the instance. If the Attribute_Modified flag is not set on a prop
whose value is updated, then the attributes are also updated. This is th
default for the Update command.

Automatic Update Process

Properties on an instance of a symbol can be updated when a schematic sh
opened, giving instances on the sheet new, updated versions of the symbol.
you open a sheet, you can specify an update option, or you can explicitly se
default auto_update_mode for the Session. You can set the default from a s
file, especially if you use the same update option whenever you open a shee

TheOpen Sheet andOpen Design Sheet commands have an auto_update_mod
switch. This switch has the same-Clear and-Auto settings described page
“Property Merge Options” in addition to a -Noupdate setting, which means that 
update should be performed when the sheet is opened. The default switch s
for these commands is -Noupdate, unless you explicitly change it.
Design Architect User’s Manual, v8.6_23-16
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If you open a sheet via a menu path and dialog box, you can change the sw
setting by clicking on the Options? “YES” button, then clicking the Auto Upda
Mode stepper button until the desired setting appears. Changing the switch s
when opening a sheet only applies to that sheet; it does not change the defa
setting for the Session.

The$set_auto_update_mode() function lets you change the default setting for th
auto_update_mode switch. Auto_update_mode controls only automatic upda
when a sheet is read; it does not specify a default property merge for the Up
and Replace commands.

The $get_auto_update_mode() function returns the default. The following
example retrieves, then resets the auto_update_mode default.

$get_auto_update_mode() //   @noupdate $set_auto_update_mode(@auto)
$get_auto_update_mode() //   @auto

The $get_auto_update_inst_handles() function returns a vector of handles fo
the instances that were out of date when the sheet was read. These instanc
have been updated if the auto_update_mode option was not @noupdate. Th
system function only returns valid results immediately after the sheet is open

Property Update Examples

Table3-2 shows examples of how the Value_Modified and property merge
switches control which properties are merged onto the instance of the symbo

The second column shows the properties on the symbol at the time of
instantiation. The “Properties on Instance” show how the property values we
changed at instantiation time.

Assume the original symbol was edited to have the property values shown in
“Properties on Edited Symbol” column. The “Merged Properties” column sho
the results of updating the instance of the symbol.
Design Architect User’s Manual, v8.6_2 3-17
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In the “Properties on Instance” and “Merged Properties” columns, an asteris
indicates the property is Value_Modified.

Parameters
A parameter is a variable that is resolved outside of the design through a
temporary value in Design Architect or through a parameter rule in the desig
viewpoint. For example, the value of a property may be an arithmetic expres
that contains one or more variables. The value of that property cannot be
determined until the variables are resolved. The method the system uses to r
variables is defined by a set of rules which dictates the position in the design
where the system looks for the variables. Parameters are one of the rules us
evaluate property value variables.

Table 3-2. Property Update Examples

Merge
Switch

Properties
on Symbol

Properties on
Instance

Properties on
Edited Symbol

Merged
Properties

-Clear Model=AND
Ref=j1

Model=OR  *
Rise=“10 20 30”
My_property=16

Model=NAND
Ref=j2

Model=NAND
Ref=j2

-Symbol Model=AND
Ref=j1

Model=OR  *
Rise=“10 20 30”
My_property=16

Model=NAND
Ref=j2

Model=NAND
Rise=“10 20 30”
Ref=j2
My_property=16

-Instance Model=AND
Ref=j1

Model=OR  *
Rise=“10 20 30”
My_property=16

Model=NAND
Ref=j2

Model=OR  *
Rise=“10 20 30”
Ref=j1  *
My_property=16

-Auto Model=AND
Ref=j1

Model=OR  *
Rise=“10 20 30”
My_property=16

Model=NAND
Ref=j2

Model=OR  *
Rise=“10 20 30”
Ref=j2
My_property=16
Design Architect User’s Manual, v8.6_23-18



Property Concepts Parameters

 the
s. For

tinues
til a
he
hrough

eets,

or

e

s in
es the
ich
r of

.
the

a
eter

solve
ter list
Briefly stated, as each instance in a design is evaluated, the system looks at
instance properties in an attempt to resolve expressions that contain variable
those variables which are unresolvable at the instance level, the search con
up through the design tree. The search for the variable's value continues un
match is found, or the root level of the design is reached. If the root level of t
design is reached and the variable has not been resolved, the system looks t
the parameter list in the design viewpoint. See “Rules for Resolving Property
Value Variables” in this chapter for a detailed explanation of this process.

Given this method of evaluation for property value variables on schematic sh
there are two commands that help you create and evaluate designs more
efficiently. These commands are Set Parameter, used in the Schematic Edit
within the Design Architect Session window, and Add Parameter, used in the
Design Viewpoint Editor (DVE). The following two paragraphs briefly describ
the purpose of these two commands.

The Set Parameter command supplies dummy parameter values for variable
property value expressions on a schematic sheet. Without these dummy valu
Check command, when executed, reports warnings about expressions in wh
variables cannot be resolved. The ability to check syntax reduces the numbe
problems that otherwise would not be discovered until you create a design
viewpoint. Basically, the Set Parameter command offers a method to flag
forgotten variables entered on a schematic that need to be identified in DVE
These parameters are not known to the Design Viewpoint until you execute 
Add Parameter command in DVE.

The Add Parameter command in DVE lets you specify a particular value for 
variable. Issuing this command for a variable adds the definition of the param
to the parameter list for the current design viewpoint. If the system cannot re
the variable's value by the time the root of the design is reached, the parame
is searched for the value, and the variable can be resolved.
Design Architect User’s Manual, v8.6_2 3-19
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Using Expressions as Property Values
A property value can have a property type defined as anexpression. An
expression is a combination of variable(s), constant value(s), and arithmetic 
logical operator(s) defined by AMPLE expression syntax. For example, “x + 5
a simple expression with a variable “x”, and the constant value “5,” added
together with the arithmetic operator “+”. A full discussion of arithmetic operat
and expression syntax is included in theAMPLE User's Manual.

Expressions can be defined for any property values. Expressions are typical
used to redefine property values in commonly used components, without ha
to redesign the component. Expressions can also be used within the range
specification for a net or pin name (net and pin property values). Variables in
expressions are evaluated as needed. For example, expressions are evalua
when a sheet or schematic is checked, or when a design viewpoint is create
expressions defined. All expressions must follow AMPLE expression syntax 
described in theAMPLE User's Manual.

Rules for Resolving Property Value
Variables

When the design is evaluated in the context of a design viewpoint and the sy
finds an undefined variable in an expression, it starts a search up through th
design tree to find a value for that variable. Figure3-1 illustrates the search path
the system uses to find the value. As soon as a valid value is found, the sea
stops

The search is described as follows:

1. The property owner object (net, instance pin, or instance body) is search 

2. If the owner in the above step is an instance pin, the body properties of th
attached instance are searched next. (If the owner is a net, this step is sk

3. The body property list of the instance’s component interface table is sear
next. (If the owner is a net, this step is skipped.)
Design Architect User’s Manual, v8.6_23-20
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4. Does the design have more levels of hierarchy? If yes, the search moves u
level to the parent instance on the upper sheet. The properties on the ins
body are checked first, then the body property list of the instance’s compo
interface table is searched next.

During each step in the search up the design tree, the value of a paramete
be overridden by a back annotation specified in a connected back annota
object. If more than one back annotation object is connected, the BA obje
are search in prioritized order.

Figure 3-1. Parameter Evaluation Rules

5. After the parent instance on the top sheet is searched, the design viewpo
Parameters list is searched.
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6. If a value is still not found, a corresponding technology file (if registered to
top-level component) and then the library data technology file (if registere
with the top-level component) is searched for the parameter. If the value is
not found or if the technology files do not exist, an error is issued.

You must add a parameter prior to evaluation of the design, in order for the v
of the variable to be used in evaluation.

You can declare variables for the width of a parameterized bus, the number o
in a parameterized register, and many other types of expressions. These pro
value variables can be declared in Design Architect or through back annotat
When defining property value variables, remember to set the property value 
to expression. Variables can also be set up in CASE, IF, and FOR frames, ins
names, net names, pin names, and subscripts.

For example, suppose you design a generic register and declare a variable
“bank_size”. In DVE, you assign the bank size of this register to be 300 bits.

ADD PArameter  "bank_size" 300 -Numeral

Whenever a downstream application encounters an unresolved property var
named “bank_size” during evaluation, it assigns it the value 300.

If a variable is not resolved anywhere in the design hierarchy, the design
viewpoint, or technology file, an error message is generated.

Facts About Property Variable Resolution

The following list presents some facts and tips about property value resolutio
rules and their effect on property value evaluation:

• Property values assigned to primitives take precedence over property v
assigned to objects which are higher up the design tree.

• A common mistake is to assign constant property values on a device's
lower-most schematic sheet, expecting to be able to use a different pro
value when the design is evaluated. This is not a valid technique. The
property values at the outer-most leaves of the design tree are the pro
values first found, according to the scoping rules.
Design Architect User’s Manual, v8.6_23-22
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If you want to pass a property's value down to a schematic sheet from
higher up in the design tree, the property on the lower schematic sheet
consist of an expression containing variable(s) that are resolved furthe
in the hierarchy. The property value is retrieved when the expression is
evaluated.

• Property variable values assigned as parameters with the Add Parame
command in DVE specify global values for those variables. To find out
more about the Add Parameter command, see theDesign Viewpoint Editor
User's and Reference Manual.

• Property variable values originating with the symbol model (kept in the
component interface) specify “local” values. That is, they specify the va
of the property variable that is used on all underlying sheets of that sym

This rule is important because it allows you to specify that certain porti
of a design have a different value for a property variable than is specifie
the Add Parameter command in DVE.

Example of Property Variable Resolution

As an example of property variable resolution, suppose you have created th
design hierarchy shown in Figure3-2. In this design, the top-most schematic
contains an instance for device A (among other instances). The underlying
schematic sheet for device A contains instances for three devices designated
C, and D. Instances B, C, and D also have their underlying sheets.

Figure3-2 also shows the four symbol models to the right of the design. Each
graphic represents the symbol model and component interface pair to which
device is associated. Note that some properties appear to the right of each g
Finally, the figure also shows the viewpoint of the design and its parameter l
This parameter list is created using the DVE Add Parameter command.

To show how the same parameter in different legs of the design can evaluat
different values, consider the following scenario. Suppose instance B in the d
has a pin with a Rise property whose value is the triplet “5, 10, 15”, while
instances C and D have pins with “Rise” properties whose values are “delay
Furthermore, these property values appear on the schematic sheet making t
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specific to the instance. Because the value for Rise on instance B is not an
expression, the value will always be “5, 10, 15”.

The value for Rise on instance C, on the other hand, is unresolved. Note, how
that the symbol model for device C has a property named “delay” and its val
the triplet “10, 20, 30”. When the design is evaluated, the property value
resolution rules in this case begin by looking at the instance of device C itse
Finding no definition for the parameter “delay”, the system looks to the symb
model and its properties next. At this point, “delay” becomes defined for insta
C and the search stops.

For instance D, notice that the value for Rise is identical on the schematic sh
Here, though, the symbol model for D does not have a property that defines
“delay”. Note also that no definition for “delay” exists in the next higher level 
the design. That is, “delay” is not defined in instance A or as part of the symb
model for device A. The design viewpoint's parameter list, however, does de
“delay” as the triplet “15, 25, 35”.

When the design is evaluated, the property variable resolution rules first look
the instance of D. Because no value for “delay” is found there, the system ch
the properties associated with the symbol model for device D. Again, no
definition for “delay” exists. Having exhausted its search on this level of the
design, the system moves up one level of hierarchy and performs the same o
search beginning with instance A and finally the symbol model for device A. L
the underlying sheet, no definition for “delay” is found. Finally, the design's
viewpoint is searched and “delay” is determined to be the triplet “15, 25, 35” 
instance D.

To summarize this example, even though both instance C and D use the sam
parameter for the property Rise because of property variable resolution rules
system evaluates “delay” to different values.
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Figure 3-2. Property Variable Resolution Example
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Structured Logic Design Properties
Structured Logic Design (SLD) properties are special properties that are buil
Design Architect. They are used to pass connectivity information about the de
to the routines in DVE that evaluate the design. These properties are not
accessible from an evaluated design and can only be added to a schematic 
design.

While in Design Architect and editing in design context, the “annotations” sw
is turned on, by default. When this switch is ON, all property edits are stored 
the viewpoint, except edits to SLD properties which are made directly on the
source sheet. When you turn annotations OFF by choosing theSetup >
Annotations/Evaluations > Toggle Annotations menu item, all property
annotations are made directly on the sheet, and not recorded in the back
annotation object. While in design context, you should have annotations ON
edit all properties except SLD properties. The state of the annotations switch
displayed in the Design Architect status line. The upper case “A” in the status
shown in Figure3-3 indicates annotations are ON. A lower case “A” indicates
annotations are OFF.

Figure 3-3. Status Line Showing Annotations ON

MGC EditFile

Design Architect

Setup Miscellaneous Check Report HelpView

Sel: 0   ( W | DAe ) ( dff | schematic | sheet1 ) (inv/inv) ( dff/pcb_design_vpt ) (4.0189, -0.7736)

Libraries

Schematic#1 dff sheet1 (Design Context)
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The Design Architect objects which have valid SLD properties are shown in
Table3-3:

Table3-4, summarizes SLD properties. Note that the property values marked
an asterisk (* ) can include special notation; see “Frexp Property” and “Special
Notation for CASE, FOR, and IF Property Values” in this chapter. The following
pages describe SLD properties in more detail.

Table 3-3. DA Objects Associated with Specific SLD Properties

DA Objects SLD Properties

Bodies/Instance Class Rule Inst Global

Pins/Vertices Class Rule Net Pin

Frames Frexp

Table 3-4. Structured Logic Design Properties

Property
Name

Property Value Description

Class C Connector: Connects differently named
nets together.

Class E External Port: Identifies a port as an
external port, regardless of its position
in the design hierarchy.

Class G Global: Connects a net globally across
the design. For example, Ground.

Class I Intra-page connector: Identifies a net
connected to another net by the same
name on the same sheet.

Class P Port: Establishes design I/O
connectivity with a pin on the symbol
above it in a hierarchical design.

Class R Ripper: Extracts a range of nets from a
bus.
Design Architect User’s Manual, v8.6_2 3-27
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Class Property

The Class property identifies its owner object as having some special
characteristic. Ports, off-page connectors, net connectors, and rippers all ha
Class property values that define these devices. The Class property is placed
instance or symbol body. Instances or symbol bodies tagged with the Class
property are specially treated by Design Architect and DVE; they are not inclu

Class O Off-page connector: Identifies net
connected to a net on another sheets o
the schematic.

Class N Null: Defines object as electrically
inert.

Class dangle Identifies a dangling instance pin or ne
vertex that should not cause a check
warning.

Inst <instance_name> Instance name on a schematic sheet

Global global_name Name of a global net (used with Class
“G” property value).

Frexp CASE <clause>* Identifies a CASE frame.

Frexp FOR <clause>* Identifies a repeated frame.

Frexp IF <clause>* Identifies a frame to be included
conditionally.

Frexp OTHERWISE <clause>* Otherwise case for the CASE frame.

Pin <pin_name> (<range>) Name of pin on symbol.

Rule <range> Identifies bus lines to extract with
ripper (“Class” R).

Net <net_name> (<range>) Name of a net or bus.

Table 3-4. Structured Logic Design Properties  [continued]

Property
Name

Property Value Description
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in the evaluated design viewpoint. Refer to “Special Instances” in Chapter 2 for
more information on the special instances that are defined using the Class
property.

Properties on pins propagate to the net vertices under the pins when an inst
having the Class property is placed on a sheet or updated if those properties
be owned by nets and do not already exist. If you wish to propagate properti
this manner, you must explicitly declare “net” as a legal owner of the desired
properties using theSet Property Owner command in the Symbol Editor.

When an instance with a Class property attached is placed on a sheet, maki
connection to an existing net, the Init and Net properties which may have be
placed on the pin of the symbol are propagated to the net vertex under the in
pin, assuming the net vertex does not already have an Init or Net property. If
Init property already exists on the net vertex, it is replaced by the instance pi
Init property only if the new instance is a global instance (Class property
value = G).

If the property is created on a symbol, its behavior upon symbol instantiation
determined by the values specified for the symbol_visibility_switch and
symbol_stability_switch arguments in the$add_property() function. If these
switches are not specified, the values of the property_visibility_switch and
property_stability_switch internal state variables are used.

You can also use the Class property to declare a valid dangling net vertex o
instance pin. Add the Class property with a value of “dangle” to a pin or net ve
to indicate that the Check command should not issue a warning because tha
object is unconnected.

For example, if you want to connect only one output pin of an instance of a f
flop, you can add this property to the other output pin to identify it to theCheck
command as an acceptable dangling pin. To add the Class property to a pin 
you may first need to execute theSet Property Owner command to declare pins
and/or nets as valid owners of this property.
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Global Property

The Global property defines a global net such as VCC and GND. The Globa
property is assigned with the Class property value “G” and forms a property/v
pair for the device body. If you assign the Global property to a body without 
assigning the Class G property to the body, the design will pass the Check
command without generating an error or warning. However, the net will not b
recognized as global in that case. Global connectivity is established directly
downward and at the same level in hierarchy by giving nets the same name 
Global property value.

Inst Property

All schematic items have unique object handles which are assigned, maintai
and used by the application. Usually, they are not visible to you. You can als
assign names (with the visibility and other attributes under your control) that
be used to identify each instance. This is accomplished by assigning unique
names, for example “U23-A”, to instances with the Inst property.

The values used with Inst property assignments must be unique on all sheet
schematic. The Check -Schematic command detects repeated “Inst” values f
current schematic sheet level in Design Architect.

Net Property

The Net property value is used to name the net and is assigned to a net vert

Pin Property

The Pin property value placed on a symbol pin is used to name the pin. The
property on the symbol provides the connectivity interface between levels of
design hierarchy.

Rule Property

The Rule property is used on ripper devices with the Class property value “R
specifies which wire or group of wires is to be ripped, or branched, from a bu
Design Architect User’s Manual, v8.6_23-30
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The Rule property must be assigned to objects with the Class property value
TheCheck command generates an error message if the Class property value
is present without the Rule property.

You must adhere to the following guidelines when assigning the Rule proper
a Class “R” device:

• You must observe proper syntax for the Rule property value. This synt
discussed in the “Basic Pin and Net Naming Syntax” section in Chapter 2.

• The width of the Rule property must match the width of the ripped bus.
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Frexp Property

This property is used to define frames. Frames provide you with the ability to
repeat or conditionally include a circuit in a schematic sheet. The number of
iterations, or the conditions determining inclusion or selection are controlled 
parameters assigned during design creation and evaluation, and make use o
frame expression assigned as a value to the Frexp property. The frame expr
uses similar constructs to those used in high level programming languages.

All frames must have the Frexp property assigned to them with a valid Frexp
property value. The value assigned to the Frexp property must adhere to a sp
syntax which uses key words such as FOR, IF, CASE, OTHERWISE, DOWN
and TO with the assignment, equality, and relational (:=, ==, !=, <, <=, >, >=)
characters. For example “FOR i := 1 TO 5” is correct, but “FOR i += 1 TO 5” i
not. The syntax for FOR, IF, CASE, and OTHERWISE frames is discussed n

Special Notation for CASE, FOR, and IF Property
Values

The Frexp property contains specific syntax that can be used to indicate pro
values. The clause or range required is defined before each description. Nam
values that you must supply appear in italics, and any punctuation shown is
necessary. Except for the FOR example, property value syntax described in
examples is defined by the AMPLE language.

These values are only applicable to the Frexp property.

CASE <clause>

Clause: parameter==”value” or parameter == “value”

In the CASE frame clause, if the value equals the parameter, the circuitry de
within the frame is included in the schematic sheet. If not, and an OTHERWI
frame exist, the OTHERWISE frame is included. The CASE parameter name
follows the rules for AMPLE identifiers, whose default value is declared with 
Set Parameter command. The value is any valid AMPLE expression.
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OTHERWISE <clause>

Clause:     variable_name

The OTHERWISE value is used in conjunction with the CASE value. If the
evaluation of the CASE value is false, the OTHERWISE frame is included. T
variable_name is a local variable which follows the rules for AMPLE identifie

FOR <clause>

Clause:     variable_name:= expressionTO expression

      or

Clause:     variable_name:= expressionDOWNTO expression

The FOR frame expression specifies that the frame contents are to be repea
the sheet “n” times. The variable “n” can be a variable in a frame expression o
outer frame. The value of “i” as it iterates through the values 0 to n-1 in the
following example can be used to evaluate the value within this frame.

Example:     FOR i := 0 TO n-1

DOWNTO works the same way as the TO example, except it decrements the
index value by one. For example, FOR i := n-1 TO 0, would generate the “i”
values of n-1, n-2, to 0 in that order.

The variable_name is a local variable which follows the rules for AMPLE
identifiers. Frame expressions on frames in an inner nest can involve the du
variables assigned in outer nest, or property names valid for Design Architec
instance items.

Note

In expressions of this type, the “:=” operator must be preceded an
followed by a space, and the colon (:) must be followed
immediately by the equal sign (=), with no intervening spaces.
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Positive and negative integers and integer expressions can be used as indic
Integers are treated as unsigned values, so you will receive a warning mess
you use negative indices. These messages inform you that names in the des
database may be different than expected (as they will be represented in two
complement form). For example, a net name expression such as $strcat(“OU
I) used in the FOR frame expression “FOR I := -1 TO 0” produces the net na
“OUT_65535” and “OUT_0”, instead of “OUT_-1” and “OUT_0”.

Because the evaluated value of -1 is larger than the terminating value of 0, a
warning message is issued, and the design logic within the frame is omitted 
the design viewpoint.

The relative size of indices used in a FOR frame expression affects the num
iterations generated as follows:

• When the start index is less than the end index, the number of iteration
equal to (end_value - start_value +1). Ten iterations are generated wit
expression “FOR I := 1 TO 10”.

• Only one iteration exists if the start index equals the end index, such a
“FOR I := 1 TO 1”.

• When the start index is greater than the end index, no iterations are
generated. An example of this is “FOR I := 10 TO 1”. A warning messag
displayed if this occurs.

Note

To avoid unexpected (and possibly unpleasant) results, Mento
Graphics strongly recommends that you do not use negative
indices.
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Figure3-4 illustrates a typical FOR Frame.

Figure 3-4. Typical FOR Frame

IF <clause>

Clause: expression

In the IF expression, if the expression evaluates to FALSE (or zero) at desig
evaluation time, the frame is not included in the design. Otherwise, the frame
included.

Frame expressions can involve property names that are valid for instance ite
the following example, the contents of the IF frame are included on the shee
the instance property “logic” is set to the property value “TTL”.

Example:   IF logic == “TTL”

FOR I := 0 TO N-1
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Chapter 4
Editing in the Context of a Design

The following topics provide a conceptual overview of Design Viewpoints an
Back Annotation objects and explain how to use Design Architect to merge b
annotations onto a source schematic.

What is a Design Viewpoint?
Schematics are represented by files and directories in a software environme
they can take on some of the characteristics of a software program. A timing
value, for example, can be represented by a numeric expression such as (X 
shown in Figure4-1. This expression must be evaluated to a constant before 
downstream tool like a simulator can operate on it. The object in the data mo
that allows a downstream tool to view the source schematic as fully evaluated
is called adesign viewpoint.

Figure4-1 provides a conceptual illustration of the Design Viewpoint.

You may think of a design viewpoint object as a picture frame through which
downstream tool views the source schematic. In your mind’s eye, think of the
image of the source schematic as being reflected onto the back of the glass 
picture frame. Notice in the diagram that the simulator sees the fully evaluate
data through the viewpoint (15 in this case) even though the expression on t
source schematic (X + 5) does not change. The value of X can be defined
elsewhere on the schematic or defined in the viewpoint itself.
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Figure 4-1. Conceptual Illustration of a Design Viewpoint
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Because the glass in the viewpoint protects the source schematic, you cann
change the source schematic from the downstream tool. You can appear to c
the schematic, however, by selecting a property in the simulator Schematic V
Window and making a change. The change is recorded in a Back Annotation
object, which is conceptually represented as a transparent sheet laid over th
of the glass in the viewpoint. In Figure4-1, the timing value in front of the cente
and gate is changed from 5 to 10 nanoseconds. The simulator sees 10 ns, a
shown in the lower part of the figure, even though the source schematic is
unchanged. All downstream tools must view a source schematic through a d
viewpoint. Typically, if a schematic does not have a design viewpoint, the
downstream tool creates one automatically when the tool is invoked on the d

Design viewpoints can only be edited with a tool called the Design Viewpoin
Editor. (Refer to theDesign Viewpoint Editor User's and Reference Manual for
more information about editing design viewpoints.) Design Architect can also
invoke on a design viewpoint (using the SET VIEWPOINT icon) as well as a
source schematic (using the OPEN SHEET icon). When you invoke Design
Architect on a design viewpoint, you may selectively merge back annotation
information from the Back Annotation object onto the source schematic, but 
cannot edit the design viewpoint directly.

Multiple Views of a Source Design
Concurrent Engineering is a design method that allows the members of a desi
team to work in a parallel on the same design. Although perfect concurrency 
possible, it is possible to start downstream processes much sooner than eve
before. Tasks like simulation and physical layout can get started early even 
significant modifications are still being made to the original source design. T
illustration in Figure4-2 shows how the concept of the design viewpoint make
this possible.
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Figure 4-2. Multiple Views of a Source Design
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As shown in Figure4-2, the Simulator and the Layout tool both see the reflect
image of the source design in their respective design viewpoints. Changes m
the design by these downstream tools are captured in their respective Back
Annotation objects.

The person working with the simulator has changed the timing value on the c
and gate to10 ns in order to see the effect on circuit performance. Also, in ord
to ensure a minimum wire length between the two upper blocks, the simulati
person has pre-assigned the reference designator U1 that tells the PCB
PACKAGE tool to include these blocks in the same physical package.

The person using the Layout Tool has also made some changes from a layo
perspective. The bottom two blocks are assigned reference designators and
timing value (7) has been added to the wire on the left side, possibly due to a
physical wire length. Notice that this person does not see the change to the 
timing value that was made by the person using the simulator. (see the botto
figures).

An important concept in keeping this design scenario stable is a concept cal
latching. The creator of each viewpoint typically “latches” the viewpoint to a
particular version of the source schematic. This keeps the schematic view sta
each viewpoint, even though the design version may be slightly different. At 
same time, the person developing the source schematic can keep working o
refining the design on the original schematics. At any point in time, a person
working with a particular viewpoint can “unlatch” the viewpoint, update the
schematic to the most current version, then re-latch the viewpoint.

Viewing Layout Changes in the
Simulator

The ability toconnect any Back Annotation object to any viewpoint makes it
possible for design changes to be shared between tools. Figure4-3 illustrates how
back annotations recorded in a physical layout back annotation object are
connected to a simulation design viewpoint.
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Figure 4-3. View Layout Changes in the Simulator
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In Figure4-3, the Layout Tool Back Annotation object is now connected to th
Simulation design viewpoint. It can at the same time also be connected to th
Layout Tool viewpoint and can continue to receive changes made by the per
doing the physical layout. Notice that the Layout Tool Back Annotation objec
connected inread only mode. The person using the simulator now sees the
changes being proposed by the Layout Tool and can test the affects on circu
performance, but cannot make changes to the Layout Tool Back Annotation
object. The illustration at the bottom of Figure4-3 shows what the simulator see

Dealing with conflicting change. It is possible that in a situation like the one o
the left that a change is made to the same property on two different back
annotation objects. In these situations, the object connected last has the hig
priority. In the illustration, the simulation BA object has the highest priority an
takes precedence over any conflicting changes that may occur between the
connected BA objects.

Dealing with a Diverging Design. With many people making changes to a desi
in parallel, the design tends to diverge rather than converge. It is up to the te
members to meet at regular intervals and “synchronize”the viewpoints. This is a
process where the team members decide which changes are valid. The valid
Layout changes like the reference designators on the Simulation BA object a
selectively “exported”, then “imported” to the Layout Tool BA object. Likewis
the timing change on the Layout Tool BA Object can be exported, then impo
to the Simulator BA Object. A Mentor Graphics shell-level utility called
Reconcile has been provided to help design team members manage back
annotations from different sources. The Reconcile utility is documented in th
Design Viewpoint Editor User's and Reference Manual.

Merging Final Changes onto the Source Schematic.When the design is
finished, the changes in the Back Annotation objects can be merged onto th
source schematic before archiving. This is done by invoking Design Architec
each viewpoint and merging the annotations (selectively or all together) onto
source schematic. If you are working with reusable sheets, this practice of
merging annotations may not be desirable.
Design Architect User’s Manual, v8.6_2 4-7
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Importing and Exporting Back
Annotation ASCII Files

Exporting and importing back annotation data in ASCII form is a way to trans
data between back annotation objects. ASIC vendors may use this simple me
to transfer physical layout back annotation information to customers at remo
sites.

Figure4-4 illustrates how the information in a back annotation object may be
exported as an ASCII text file. The ASCII file is formatted in a way that uses
certain key words that are meaningful to the transfer of data in this format.

In a similar manner, the information in an ASCII back annotation file may be
imported to another specified back annotation object.
Design Architect User’s Manual, v8.6_24-8
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Figure 4-4. Importing and Exporting ASCII Back Annotation Files
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Iconic View of Design Viewpoints
Even though you can think of a viewpoint as a “wrapper” around the source
design, the viewpoint object and the associated back annotation objects are
to a position inside the root component container. This is done so that when
copy the design from one location to another, all you need to do is specify the
compound container and you get all the associated viewpoints and back
annotation objects with it.

Figure4-5 shows the default location for the design viewpoints and back
annotation objects.

Figure 4-5. Iconic View of Design Viewpoints

$PROJECT/designs/counter

schematicalu8

alu8alu4

$PROJECT/designs

part

defaultdefault

$PROJECT/designs/counter/default

quickpath_setup

pcb_design_vpt pcb_design_vpt

dvpt

ba

timing.info delay_report_1

dvpt

ba
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In this directory structure, the directory with the path$PROJECT/designs
contains two designs,alu and counter. The counter design has a symbol, a
schematic, two viewpoints, and two back annotation objects. The viewpoint c
default is assumed to be setup for QuickSim, because this is the default nam
given for a QuickSim compatible viewpoint. The back annotation object calle
“default” is assumed to go with the “default” viewpoint. The name
pcb_design_vpt is the default name given to a PCB viewpoint.

Notice that the viewpoint is a container itself that can hold objects and files w
are specific to it. In this case, thedefault viewpoint holds aquicksim_setup
object, a quicksim_state object, and asimview_setup object. It could also hold a
forces waveform database object that could be used as input stimulus for the
design during a simulation.

Downstream Tools and Viewpoints
Figure4-6 shows how any number of downstream tools can create a viewpoin
a single design. Because the viewpoints capture changes in Back Annotatio
Objects, and the source design is protected from change, people using the
downstream tools can work in parallel and experiment with different design
modifications and scenarios. Notice that this design has two QuickSim
viewpoints. Each viewpoint can be configured differently with different mode
and different timing value combinations. And because a viewpoint is a conta
input stimulus and the simulation results from each configuration can be kee
inside their respective viewpoints.
Design Architect User’s Manual, v8.6_2 4-11



Downstream Tools and Viewpoints Editing in the Context of a Design
Figure 4-6. Downstream Tools and Viewpoints
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How Design Viewpoints are Created
A design viewpoint can be created in several ways as shown in Figure4-7.

Figure 4-7. How Design Viewpoints are Created

 Auto-Tool Mode

In most cases, simply invoking a downstream tool like QuickSim II, PCB
PACKAGE, or IC Station on the source design causes the tool to create a
default design viewpoint for you, if the design has no viewpoint. If a viewpo
already exits for the tool and it has the default name for that tool, then the
automatically invokes on that viewpoint.
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 Batch (script) Mode

Some companies and ASIC vendors provide shell scripts that you invoke
generate a custom viewpoint that fits the design process and libraries bei
used. The script usually contains AMPLE code that invokes the Design
Viewpoint Editor in-nodisplay mode and executes the necessary DVE
functions to set the design configuration, global parameters and visible
properties list.

TimeBase Mode

TimeBase is a Mentor Graphics subprogram that is used to calculate timi
When you invoke TimeBase directly on a design, TimeBase creates a
persistent (saved to disk) default viewpoint and back annotation object,
calculates the timing, then saves the Timing Cache file in the design viewp
container. This is a fast way to create a persistent viewpoint and at the sa
time speed application invoke time all in one step. The persistent viewpoi
can then be used as a place to save the QuickPath setup object and anal
reports.

 Interactive Mode

This mode allows you to custom create your own design viewpoint using 
Design Viewpoint Editor. You can also invoke DVE on an existing design
viewpoint and add further customizations of your own.
Design Architect User’s Manual, v8.6_24-14
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Properties in the Context of a Design
The following topics describe how to set the visibility of new back annotation
how to view properties, and how to add new properties in the context of a de
viewpoint.

Setting New Annotation Visibility

By default the following back-annotation properties are hidden if they do not
already exist on the sheet:

You can customize the visibility of back-annotated objects that do not alread
exist on a sheet by creating a dofile which is called automatically when open
design in the context of a design viewpoint. Existing back annotations are no
affected. The dofile must be namedsetup_new_ba_properties.dofile and contains
calls to the $set_new_annotation_visibility() function. Design Architect searc

part_no brd_loc geom

refloc pow_typ pow_max

pow_min junction_max_t pow_derating

pow_del_max pow_del_typ pins_out

mfg therm_jc therm_r

comp_height therm_cond spec_heat

mass_density surface_area pcb_pin_loc

pcb_pin_pad pcb_ba_net source

terminator pcb_ba_name netdelay

cap_net
Design Architect User’s Manual, v8.6_2 4-15
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for the dofile in the following order and uses the first occurrence of the file th
finds:

1. $HOME/mgc/setup_new_ba_properties.dofile

2. $MGC_HOME/etc/cust/setup_new_ba_properties.dofile

3. $MGC_HOME/shared/etc/cust/setup_new_ba_properties.dofile

The following code block shows a sample listing of a
setup_new_ba_properties.dofile:

{ local original_mode = $set_transcript_mode(@off);
$set_new_annotation_visibility(@vi sible, 'baprop1', 'baprop2');
$set_new_annotation_visibility(@hidden, 'baprop3', 'baprop4');
$set_transcript_mode(original_mode);}

Design Architect does not issue a warning if this file does not exist, but if the
AMPLE syntax is not correct, you will get an error message. The HOME
environment variable must be set before using this dofile.

Additionally, if the DES_ARCH_HIDE_BA_ONLY_PROPS environment
variable is set to any value, the dofile is overridden and all new back annota
properties are hidden.

Adding Properties

There are three commands that control whether properties are added to the
schematic sheet or the back annotation object while editing in the context of
design. The Set Edit Mode command controls whether schematic sheet edit
“on” or “off”; the Show Annotations command turns editing of back annotatio
“on”, and the Hide Annotations command turns editing of back annotations “

The combinations of setting back annotations on/off and schematic sheet ed
on/off controls where and how properties are added. For example, as shown
Table4-1, if annotations are “off”, and edits are “on”, properties are added to
Design Architect User’s Manual, v8.6_24-16
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schematic sheet. If annotations are “off”, and edits are “off”, properties canno
added; if annotations are “on”, properties are added to the back annotation o

Viewing Annotations vs. Evaluations

There are two menu items that control how properties are viewed on the sche
sheet. TheSetup > Annotations/Evaluations >Toggle Evaluations menu item
controls whether property values are displayed in their unevaluated or evalu
form. Design Architect uses the design configuration rules defined in the des
viewpoint to resolve and evaluate the properties. See “Rules for Resolving
Property Value Variables” in Chapter 3 for details on property resolution rules.

TheSetup > Annotations/Evaluations > Toggle Annotations changes the
current state of viewing to either viewing properties from the back annotation
object or viewing properties on the schematic sheet only.

The results of the annotation and evaluation settings are displayed in the tab
the facing page. If evaluations and annotations are both set to on, the sheet
displays evaluated properties from both the back annotation object and the
schematic sheet. If evaluations are on and annotations are off, the sheet dis
evaluated properties from the schematic sheet only; back annotations are no
displayed. If evaluations are off and annotations are on, the sheet displays
unevaluated properties from both the back annotation object and the schem

Table 4-1. Where Properties are Added

Annotations On Annotations Off

Edits On Properties added to back
annotation object.

Properties added to
schematic sheet.

Edits Off Properties added to back
annotation object.

Properties cannot be
added.

Note

If you edited the schematic sheet in the context of a design, yo
must save your sheet before you change the edit mode to “off”
Design Architect User’s Manual, v8.6_2 4-17
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sheet. If both evaluations and annotations are off, the sheet displays unevalu
properties from the schematic sheet.

If you change or add a property value as an expression and evaluations are 
on, and you would like to see the new property expression in its evaluated s
but you must first execute theMiscellaneous > Recalculate Properties menu
item.

Refer to Table4-2 for the four viewing cases.

Traversing the Design Hierarchy
After you have opened a design sheet that has multiple levels of hierarchy, y
can traverse the hierarchy of your design with the Open Down, Open Up, an
Open Top commands.

• Open Down - Opens a sheet one hierarchical level down from a select
instance. If the sheet is already open, Open Down activates and pops 
window to the front. The following options are available:

o Open Down Stroke (258) performed within the boundary of an obje
opens the sheet named “sheet1” even in situations where more tha
sheet exists.

o Open Down from the Design Architect Menu Pulldown Bar or Doub
click on an object’s border: presents the user with a dialog box.

Table 4-2. Property Values Displayed

Evaluations On Evaluations Off

Annotations
On

View evaluated properties
from back annotation object
and schematic sheet.

View unevaluated properties
from back annotation object
and schematic sheet.

Annotations
Off

View evaluated properties
from schematic sheet.

View unevaluated properties
from schematic sheet.
Design Architect User’s Manual, v8.6_24-18
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• Open Up - Activates and pops to the front any window containing an
existing view on the sheet being opened.

• Open Top - Activates and pops to the front any existing window contain
the top-level schematic sheet. If more than one top-level schematic sh
exists, you are prompted to select a sheet.

You can lock schematic sheet edits by attaching the Source_Edit_Allowed
property with the value of “False” to the parent instance. In this case, when y
traverse to the sheet of the parent instance, edits cannot be made to the sch
sheet until the Source_Edit_Allowed property value is changed to “True”.

Merging Back Annotations to Schematic
You can merge back annotations into the schematic sheet when editing in th
context of a design viewpoint. When a schematic sheet is open with back
annotations displayed and schematic edits “on”, you can merge all back
annotations shown on the current schematic sheet using the Merge Annotat
command. This command merges annotations on only one sheet at a time.

The Merge Annotations command replaces all the schematic sheet property v
with the back annotated property values from the connected back annotation
objects on the currently-viewed sheet. After this command is executed, if you
decide to save the sheet, the back annotation objects will no longer contain 
property values which were successfully merged into the schematic sheet.

Property values may not be successfully merged if the property has a stabili
switch value that does not allow changes to the schematic sheet value. Back
annotations for a symbol's fixed properties are stored in the viewpoint.

!
Caution

If the schematic sheet is used in more than one place in your
design, and you merge back annotations to that one sheet, all o
components that use this sheet see the changes. Since all
occurrences of the component see the changes, you should no
merge to reusable sheets.
Design Architect User’s Manual, v8.6_2 4-19
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Viewing Back Annotations
In the following example, a schematic sheet is opened in the context of a de
viewpoint from within Design Architect, and viewing of back annotations is
enabled. Next, a design sheet in the same viewpoint is opened on another in
with back annotations enabled. The purpose of this example is to show how
enable and disable the viewing of back annotations in the context of a desig
viewpoint in Design Architect. You will also see the relationship between
identical sheets used in multiple instances.

For this example assume that you have:

• A design named “my_design” with two 74161 instances with instance
handles I$1 and I$2; see Figure4-8.

Figure 4-8. “my_design” Design

• A design viewpoint called “default,” which is associated withmy_design.

my_design(Design Context)

I$1

74161 74161

I$2

Instance handles
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• A back annotation object called “default” is connected to the viewpoint

called “default”. Version 1 of the back annotation object is displayed in
Design Viewpoint Editor window as shown in Figure4-9.

Figure 4-9. “default” Back Annotation Window

Assume that you openmy_design in the “context of a design viewpoint,” by
clicking on the following icon and filling out the dialog box:

The Open Design Sheet dialog box appears and you clickOK .

Back Annotation: default

Instance Pathname             (Property Name,   Property Value)
/I$1/I$3 (REF,  “U1")

Pin Pathname             (Property Name,   Property Value)
Net Pathname             (Property Name,   Property Value)

/I$2/I$3 (REF,  “U2")

Set Viewpoint

Component Name my_design

OK CancelReset

Navigator...Viewpoint Name default

VIEWPOINT
SET

Create New ViewpointExisting Viewpoint Unset Viewpoint

2. Enter

3. Click

1. Click
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By default, both the viewing of back annotations and the evaluation of param
are enabled, as shown in Figure4-8. For this and the following examples, the
viewing of back annotations and the evaluation of parameters are initially tur
off.

To view the sheet under the I$1 instance, you select the instance and execu
Open Down command. A new window displays the schematic sheet for 7416
with instance handle I$1 in the context of the “default” design viewpoint.

For more information about design configuration rules, see theDesign Viewpoint
Editor User's and Reference Manual. Remember that the back annotation object
connected. The “74161” window for I$1 is shown in Figure4-10.

Figure 4-10. “default: I$1” Window

The schematic sheet of instance I$1 has two symbols, I$3 and I$4, both of w
have a property named “REF”. Because back annotations are not currently b
viewed, the property values in the design view of the sheet are A1 and A2, w
are the same values as the source schematic sheet.

The first line in the “default” back annotation window shows that the instance
“I$1/I$3” has a “REF” property whose back annotation property value is “U1”
When you display back annotations with the Show Annotations command, th
REF property value for instance I$1/I$3 changes from “A1” to “U1”, as shown

Schematic#2 74161

I$3 I$4

REF properties

A1 A2
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Figure4-11. Turning on back annotations does not change the REF property v
on the schematic sheet, which is still “A1”.

Figure 4-11. “default: I$1” Window with Back Annotations

The display of back annotation values can be turned off using the Hide
Annotations command.

Schematic#2 74161

I$3 I$4

REF properties

U1 A2
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If you specify instance handle I$2 of “my_design” and Open Down to compon
74161, a window displays the schematic sheet for the 74161, that is, I$2 in t
context of the “default” design viewpoint. In the view of I$2, shown in Figure
4-12, notice it is identical to I$1, and that back annotations are not displayed
evaluation is disabled.

Figure 4-12. “default: I$2” Window

The second line in the “my_ba” back annotation window defines that the inst
“I$2/I$3” has a “REF” property, whose back annotation property value is “U2
When you turn on the display of back annotations, the “REF” property value 
instance I$2/I$3 changes from “A1” to “U2”, see Figure4-13.

Figure 4-13. “default: I$2” Window with Back Annotations

Schematic#2 74161

I$3 I$4

REF properties

A1 A2

Schematic#2 74161

I$3 I$4

REF properties

U2 A2
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The 74161 component instance I$3 is referenced with two unique properties 
context of “default” viewpoint for the same reusable component. Since the 74
component is reused in the design, merging the back annotations to the sche
sheet would give only the current-viewable property value to the schematic s

Evaluating Properties
In the next example, a design sheet is opened in Design Architect, with evalu
of property values and the viewing of back annotations disabled, to show the
schematic sheet property values. Property evaluation is then enabled to sho
property values, resulting from applying the design viewpoint parameters an
hierarchy to the schematic sheet properties. Next, the display of back annota
is enabled. This example illustrates the concept of the evaluation and resolut
property values with respect to back annotations.

While editing in the context of a design, you can set the evaluation property v
to be either “on” or “off” by using the Set Evaluations command. If “on” is
specified, all property values are evaluated; if “off” is specified, property valu
are displayed unevaluated.

For the example, the “my_design” design has a property named COMP who
value is 74161, as shown in Figure4-14. The REF source property value for
I$1/I$4 has been modified to “$strcat(COMP, '_U2')” for this example.

Figure 4-14. “my_design” Design with COMP Property

my_design(Design Context)

I$1

74161 74161

I$2

COMP properties
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Also for this example, the “default” back annotation object has a new REF
property value defined for I$1/I$4, as shown in Figure4-15.

Figure 4-15. “default” Back Annotation Window with I$1/I$4

If you specify instance handle I$1 in the Open Design Sheet command, a win
displays the schematic view of the sheet for the 74161; that is, I$1 in the con
of the “default” design viewpoint. Notice in Figure4-16 that back annotations are
not displayed and evaluation is disabled.

Figure 4-16. “default” with Expression

Back Annotation: default_1

Instance Pathname             (Property Name,   Property Value)
/I$1/I$3 (REF,  “U1")

Pin Pathname             (Property Name,   Property Value)
Net Pathname             (Property Name,   Property Value)

/I$2/I$3 (REF,  “U2")
/I$1/I$4 (REF,  “MIL5")

Schematic#2 74161

I$3 I$4

REF properties

A1 $strcat(COMP, '_U2')
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If evaluation is enabled using the Set Evaluations command, the displayed R
property value for I$1/I$4 changes to “74161_U2”, shown in Figure4-17.

Figure 4-17. “default” with Expression Evaluated

If back annotations are enabled, the displayed REF property value for I$1/I$
changes to the value specified in the connected back annotation object, “MIL
regardless of the evaluation setting, shown in Figure4-18.

Figure 4-18. “default” with Back Annotations Enabled

Schematic#2 74161

I$3 I$4

REF properties

A1 74161_U2

Schematic#2 74161

I$3 I$4

REF properties

U1 MIL5
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Expressions in Back Annotation Objects
You can also place expressions in back annotation objects. In this situation, 
display setting of the evaluation and back annotations is important. If back
annotations are displayed while evaluation is disabled, you will see the
unevaluated property value in the back annotated property. If evaluation and
annotations are enabled, you will see the evaluated back annotation value.

In the following example, a design sheet is opened in Design Architect, with
evaluation of property values and viewing of back annotations disabled, to s
the schematic sheet property values. The display of back annotations is then
enabled to show the unevaluated value of the back annotated property. Nex
property evaluation is enabled to show the resulting property value.

For this example the back annotation object has been modified to use an
expression for the I$1/I$4 REF property value, as shown in Figure4-19. Assume
that the “my_design” is the same as Figure4-14.

Figure 4-19. “default” Back Annotation Window with Expression

Back Annotation: default_1

Instance Pathname             (Property Name,   Property Value)
/I$1/I$3 (REF,  “U1")

Pin Pathname             (Property Name,   Property Value)
Net Pathname             (Property Name,   Property Value)

/I$2/I$3 (REF,  “U2")
/I$1/I$4 (REF,   $strcat(COMP,‘_ref’)
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Before back annotations are displayed, the sheet appears as shown in Figur4-20,
with the REF property values of A1 and A2.

Figure 4-20. “default: I$1” Window

When back annotations are displayed without evaluation, the I$1/I$3 REF
property value changes to “U1”, and the I$1/I$4 REF property value changes
“$strcat(COMP, '_ref')”, as shown in Figure4-21.

Figure 4-21. “default” with Back Annotation Expression

Schematic#2 74161

I$3 I$4

REF properties

A1 A2

Schematic#2 74161

I$3 I$4

REF properties

U1 $strcat(COMP, '_ref')
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After evaluation is enabled with the Set Evaluations command, the I$1/I$4 R
property value changes to “74161_ref”, as shown in Figure4-22.

Figure 4-22. “default” with Back Annotation Expression Evaluated

Applying Edits to the “In-Memory”
Design

When you invoke Design Architect on a Design Viewpoint and turn annotatio
on, you may edit both the annotations and the source schematic at the same

Assume, for example, that you graphically add a hierarchical instance to the
sheet while you are editing in the context of a design viewpoint. Before you c
Open Down into this new hierarchical instance, you must apply this edit to th
image of the design data that is in memory. This can be done in one of two w
(1) execute an $update_all() function which saves all the design sheets to di
before updating the in-memory design, or (2) executeFile > Apply Edits. When
you use the Apply Edits method, you update the memory directory, thus
eliminating the time it takes to save all the sheets to disk plus you eliminate 
additional version updates that take place.

Apply Edits is just a short hand approach of updating the in-memory design 
you can see the effects of your edits without updating the sheets that are sav
disk.

Schematic#2 74161

I$3 I$4

REF properties

U1 74161_ref
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When you are editing in the context of a design viewpoint and there is a nee
apply the edits to the in-memory design, an ampersand “&” appears in the ba
of the Schematic window as shown below.

After you execute theFile > Apply Edits pulldown menu, the ampersand goes
away.

Reconnecting Annotations when
Objects are Deleted

Sometimes during the course of editing a design, an object like an instance 
deleted and replaced by another instance. If the original instance owns one 
more properties that are back annotated through a back annotation object, th
annotations become unattached. Design Architect gives you the ability to ch
for and report on unattached annotations and either reattach them to current
objects or delete them from the design.

Opening Non-Existent Schematics and
Components in Design Context

Design Architect has the ability to create a sheet in a new schematic inside a
existing component which is opened in the context of a design viewpoint. Fo
example, assume that you use Design Architect to open a schematic in the c
of a design viewpoint and that the schematic has an instance of a componen
contains only a symbol. If you open down on the instance, Design Architect 
create a new (blank) schematic sheet for you. You can then edit the sheet, t
check and save the sheet - all without leaving the context of the design view

my_design(Design Context)&

COMP properties

Apply Edits needed
Design Architect User’s Manual, v8.6_2 4-31
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Design Architect also has the ability to create a sheet in a new schematic ins
new component which can be opened as a design sheet. For a description o
operating procedures required to do this, refer to “Opening a Non-Existent
Schematic in Design Context” in Chapter 6.
Design Architect User’s Manual, v8.6_24-32
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Chapter 5
Design Error Checking

Mentor Graphics applications are designed to insure that you produce a vali
workable circuit. To produce a workable circuit, a full set of checks must be
passed, starting in Design Architect when the design is created, continuing a
the design is evaluated, and finally when the downstream application is invo
on the design.

Performing error checks early in the design process reduces rework.

Error Checking in Design Architect
Design checks are grouped into selective categories: schematic checks, sch
sheet checks, and symbol checks, as illustrated in Figure5-1.

Mentor Graphics requires symbols and schematic sheets to pass a set of req
Design Architect checks. Required schematic sheet checks are listed in
AppendixA, in “Schematic Sheet Checks” starting on pageA-1. Required symbol
checks are listed in “Symbol Checks” in Appendix A.

In addition to the required checks available, Design Architect includes a set 
optional checks that can be incorporated into your own design check and
validation process. You can specify that a sheet not be marked as having pa
check successfully until some set of the Design Architect optional checks pa
without errors. You can also check a design for common electrical rule violati
Optional checks are listed in AppendixA.
Design Architect User’s Manual, v8.6_2 5-1
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Designs are not complete and may not be processed further until they have p
the minimum required checks. For example, if the symbol does not pass the
required symbol checks, the symbol will not be valid for instantiation on a
schematic sheet. Also, if a schematic sheet does not pass its required check
before a downstream application is invoked, the downstream application will
issue a warning when it is invoked, highlighting a problem that may be uncov
at a later time.

Figure 5-1. Symbol, Schematic, and Schematic Sheet Checks

Symbol Checks

Schematic Sheet Checks
Schematic Checks
Design Architect User’s Manual, v8.6_25-2
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The Check Command
The Design Architect Check command is used to:

• Validate that the symbol or schematic sheet is syntactically correct, and
be used by other Mentor Graphics applications.

• Issue warnings to identify areas which could be the result of user error

• Issue messages which are informative (for example, the not-dots chec
provides a list of not-dots active on the sheet).

• Automatically name instances and nets by their handles.

TheCheck command also performs checking appropriate to the object curren
being edited. The type of checks executed by a particular Check command c
specified by a previous Setup Check command, or by setting the switches o
Check command itself.

Table5-1 lists Check switches for schematic sheet checks.

Table 5-1. Check Command Sheet Switches

-INStance
-SPecial
-Net
-FRame
-PArameter
-EXpression
-PIns
-OWner

-OVerlap
-NOTDots
-Closedots
-Dangle
-INIt_props
-Userrule
-UserruleFile
-busshorts
Design Architect User’s Manual, v8.6_2 5-3



The Check Command Design Error Checking

n)

. For

t to a
Table5-2 lists Check switches for symbol checks.

Table5-3 lists Check switches for schematic (all schematic sheets in a desig
checks. Refer to theDesign Architect Reference Manual for descriptions of Check
command switches and internal state variables.

Checks can be selected for individual schematic sheet and symbol elements
example, if you want to check only the nets on a schematic sheet, you could
execute the Check command with the -Net switch set to “all”, and set the
remaining switches to “nocheck”. Most Check command switches can be se
value of “all”, “errorsonly”, or “nocheck”. The “all” value displays both errors
and warnings for the specified item. The “errorsonly” value displays only the
errors, and the “nocheck” value turns off the specified check switch.

For a step-by-step procedure on how to setup and execute checks, see “Checking a
Sheet for Errors”, “ Checking a Symbol for Errors”, and “Checking a Schematic
for Errors” in Chapter 6.

Table 5-2. Check Command Symbol Switches

-SPecial
-PIns
-SYMBolbody

-INTerface
-Userrule
-UserruleFile

Table 5-3. Check Command Schematic Switches

-SChematicINTerface
-SChematicSpecial
-SChematicInstance
-SChematicNet

-SChematicUserrule
-SChematicuserruleFile
-SCHNETI.o
-SCHB.usshorts
Design Architect User’s Manual, v8.6_25-4
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Setting Up the Check Command
The Check command switches are set at invocation to execute, by default, a
the required Mentor Graphics checks for each of the check groupings. You d
need to set up the required checks, though you may want to add or delete op
checks from the list of default checks. This is done with theSetup Check Sheet
command for individual schematic sheet checks, theSetup Check Schematic
command for schematic checks, and theSetup Check Symbol for symbol checks.
Check switches set with the Setup Check command remain set for the durat
the session, or until a subsequent Setup Check command is executed, or the
internal state variables are changed.

User-Defined Error Checking
You can extend the functionality of Design Architect’s basic check capability
adding your own user-defined macros. User-defined macros are executed a
reported in the same manner as other Design Architect checks.

A user-defined macro is written in the AMPLE language, and has access to 
full capability of Design Architect functions within the specific editor's scope.
user-defined macro can be specified for a schematic sheet check and a sym
check. A macro specified for a schematic sheet check has access to all func
within the scope of the Schematic Editor. A macro specified for a symbol che
has access to all functions within the scope of the Symbol Editor.

Every user-defined macro must have a$set_userrule_error() and/or a
$set_userrule_warning() function included that passes a formatted error string
back into Design Architect for subsequent display in the check report. This is
only way to cause errors or warnings to be included in a check report. To lea
more about how to write AMPLE macros, refer to theAMPLE User's Manual.

The setup procedure used to activate a user-defined check is similar to the s
procedure used to set up other checks. A macro file_name and -Userrule sw
are specified as arguments to the “Setup Check” commands and the Check
command. When both arguments are set and the Check command is execut
user-defined macro is executed with the other specified checks, and errors
generated by the macro are reported like other Check errors. To find out mo
Design Architect User’s Manual, v8.6_2 5-5
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about how to set up your symbol checks and schematic sheet checks, refer 
“Setting Default Symbol Checks” and “Checking a Schematic for Errors” both in
Chapter 6.

This example defines a symbol check to enforce character restrictions on ea
on a symbol. This macro loops through a list of pin names, identifying invalid
name syntax, and notifying Design Architect of the errors with the
$set_userrule_error() function.

// This AMPLE macro check is executed on symbols, and checks
// for enforcement of character restrictions for each pin of a
// symbol.
// This macro will do the following:
// (1) extract a set of pin handles
// (2) declare a regular expression defining valid pin name
//     syntax
// (3) loop through each pin
//    (3a) extract pin_name using the DA
//         $get_object_property_attributes function
//    (3b) perform pattern match between pin_name and valid
//         pin_name syntax as defined by the regular
//         expression "pattern"
//    (3c) notify errors to DA using the $set_userrule_error()
//         DA function
{
 local pin_handles = $get_pin_handles();
 local pattern="^[a-zA-Z][a-zA-Z0-9_$]*(\\([^)].*\\)){0,1}$";
 local i, pin_name;
 for (i = 0; i < length(pin_handles); i = i+1) {
 pin_name = $get_object_property_attributes(pin_handles[i],
     "pin", @value)[0];
 if ($string_locate(pin_name, pattern, 0) == UNDEFINED)
 {
   $set_userrule_error($strcat("Invalid pin name '",pin_name,
     "' on ", pin_handles[i]));
 }
}

Design Architect User’s Manual, v8.6_25-6
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Listing Status of Checks
Current settings can be reported using theReport Check command. This
command shows the current settings of each internal state function and the c
status of each corresponding check category for the active schematic sheet 
symbol.

Evaluated Design Checking
Evaluated design checking occurs outside of Design Architect. Evaluated de
checks examine the contents of an entire design by using the configuration r
defined in the design viewpoint to evaluate the design. These checks examin
design for mismatched connections, unique names, parameter values, and m
other types of checks. The individual evaluated design checks are described
Design Viewing and Analysis Support Manual.

Figure5-2 shows the meaning of evaluated design checks with respect to a de
Unlike schematic sheet checks, evaluated design checks examine the desig
different hierarchical levels.

Extended design checking is available in DVE and during the invocation of m
downstream applications, such as QuickSim II.

NOTE: For detailed descriptions of error, warning, and information message
issued when performing evaluated design checks, see theDesign Viewing and
Analysis Support Manual.
Design Architect User’s Manual, v8.6_2 5-7
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Figure 5-2. Evaluated Design Checks

Schematic
Checks

Schematic
Sheet Checks

Symbol
Checks

Evaluated
Design
Checks
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Chapter 6
Operating Procedures

The following topics describe the most commonly used schematic and symb
editing procedures in the Design Architect Symbol and Schematic Editors.

Procedure Conventions
You will need to keep in mind the following information when referring to the
operating procedures:

• In the examples, what you type and menu paths are shown inboldface type.

• A standard typeface dollar sign ($) character represents a shell promp

• Square brackets indicate the name of a palette, followed by the name o
icon: [Text] Sequence Text.

If needed for clarity, the name of the window, in parentheses, precede
palette name: (Schematic)[Text] Sequence Text.

The first item is generally the name of the menu (Setup), or it appears 
most popup menus (Select). The name of the window may precede the
menu name if needed for clarity.
Design Architect User’s Manual, v8.6_2 6-1
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Invoking Design Architect
You can invoke Design Architect windows and design data from the Design
Manager or an operating system shell.

From the Design Manager

To open a schematic, symbol, or VHDL editing window, you first invoke the
Design Manager by entering the following command at a shell prompt:

$ dmgr

This shell command opens the Design Manager with a Tools window and a
Navigator window within the Design Manager window. The Tools window
contains icons that represent the tools authorized to run on your workstation
Navigator window contains either a list of elements or icons that represent d
objects. These windows are illustrated in Figure6-1.

You can modify your startup file to automatically enter the Design Manager w
you log in to your user account. Refer to theCommon User Interface Manual for
information about customizing startup files.

Two methods of invoking Design Architect editors are provided from the Des
Manager:tool-centeredanddata-centered. For tool-centered invocation of Design
Architect, move the cursor to the Tools window and double-click the Select
mouse button on the Design Architect icon.

For data-centered invocation from the Design Manager, move the cursor to t
Navigator window, then double-click the Select mouse button on either the li
element or the icon that represents the data object you want to edit or view. 
Design Manager invokes the default tool for the selected data object. When 

NT
Design Architect is invoked on the Windows NT platform by
pressing the Windows Start button and selecting
Programs > Design Architect > DA.
Alternatively, you can invoke Design Architect from a command
line in a Korn Shell.
Design Architect User’s Manual, v8.6_26-2
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d in a
than one tool can operate on the selected data, a list of valid tools is displaye
popup menu. You can then choose from the list of tools.

Refer to theDesign Manager User's Manual for more information about how to
invoke a Mentor Graphics application from the Design Manager.

Figure 6-1. The Design Manager
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From the Operating Shell

To invoke the Design Architect editors from an operating system shell, enter
following command at a shell prompt:

$ da

No arguments are needed for invocation. A new sheet or symbol is not
automatically opened for editing or viewing, unless you specify a pathname 
appropriate switches with the invocation, or execute one of theSession > Open
popup menu items from the Design Architect Session window.

NOTE: When referencing a design object, if you provide a relative pathname
does not begin with the dollar sign ($) character, that relative pathname will 
converted to an absolute pathname, based on the value of the environment
variable MGC_WD. You must ensure that the value of MGC_WD is set to th
correct value for your current working directory. If it is not set properly, an
incorrect pathname for the reference may be stored.

For a complete listing of switches available for theda shell command, refer to
“Shell Command Dictionary” in theDesign Architect Reference Manual.

Exiting Design Architect
To exit from Design Architect, select theClose orQuit  menu item from the active
Design Architect Session window border. Alternatively, you can exit Design
Architect by selecting MGC>Exit from the Design Architect Session window
pulldown menu. If you have other windows open in the Design Architect ses
area and if edits have been made since the last save in these windows, a dia
is displayed for each of these windows asking whether you want to save the
or discard them before closing the individual window within the Design Archit
session. When all other windows are closed, then the Design Architect Sess
window is closed.
Design Architect User’s Manual, v8.6_26-4
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Obtaining On-line Help
All Mentor Graphics applications have aHelp pulldown menu which provides
access to both quick help and reference help. The same menu appears whe
choose theSession > MGC > Help popup submenu item. Menu items with an
arrow have a submenu.

To list all commands that are available for a particular window, first activate 
window by clicking the Stroke (middle) mouse button in that window. Type “*”
the window, then press the Ctrl-? or Ctrl-Shift-? keys to display a list of
commands.

Quick Help

Quick help is an ASCII file describing the object(s) you specify. You can disp
a quick help file for each of the first six menu items, except “On Functions”, b
clicking the Select mouse key on the menu item.

Choosing “On Functions” displays a prompt bar in which you enter the name
function. When you press the Return key or click theOK  button, a description of
the function, along with the syntax (in most cases), is displayed in a window.

You can print the help for strokes by clicking the Select mouse button on the 
button near the bottom of the help window.

Reference Help

The menu items beginning with “Open” are reference helps; they open a ma
for on-line viewing in a document browser. To display the Getting Started wi
Design Architect Training Workbook, choose theHelp > Open Tutorial >
Design Architect menu item. If there is no document browser open on your
workstation, a message box is displayed, asking if one should be created; cli
Yes button.
Design Architect User’s Manual, v8.6_2 6-5
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You can access reference help from a quick help message window by clickin
Ref Help button. Reference help is also available through the first threeHelp
menu items. The submenu items open summary tables in theDesign Architect
Reference Manual.

More Help Submenu

ChoosingHelp > More Help > Release Notes Highlights displays a list of new
features in the current release, and lists of new, changed, or deleted function

Setting Up the Design Architect Session
Before you begin creating and editing schematics and symbols, there are se
settings that you should verify and reset if you choose. The following proced
identify these settings and outline your choices.

Setting the Color Configuration
The background color of a Schematic or Symbol editor window and be eithe
black or white. The default is black. To change the background to white, exe
the following pulldown menu:Setup >Set >Color Config:

Click on the stepper button to select white, then clickOK.

When you invoke this function to change the background, all design objects 
windows are reset to their default colors. Objects currently displayed are repa
in their appropriate defaults and the background is changed, if necessary.

Setting the Color of Design Objects

You can set the color of a design object to any one of a number of choices. I
want to set net junction dots to white, for example, do the following:

SET CO C OK CancelColor white
Design Architect User’s Manual, v8.6_26-6
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1. Execute the pulldown menu:Setup >Set > Color...

2. Move the window slider button down to the bottom, click onWhite , click
on Dots , then clickOK.

All the junction dots on the current schematic (and future schematics) turn w

All colors can be returned to their default values by executingSetup >Set >
Color Config:

If you change the color of property to something different than the object tha
owns the property, then the annotated value of the property as well as the or
value of the property are displayed in the new color. Normally, the annotated
value is displayed in the default color red.

Set Color

OK Reset Cancel

VioletRed
Violet

Yellow
White

YellowGreen

Wheat

Comments
NetsFrames
DotsInstances

Pin Symbol Bodies
Design Architect User’s Manual, v8.6_2 6-7
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Setting the Selection Color
When you select an object, the color of that object turns white by default whe
using a black background. You can change the color of selected objects as
follows:

1. Execute the pulldown menu:Setup >Set > Selection Color...

2. Move the window slider button down to the bottom, click onWheat , then
click OK.

Selected objects will now turn the color “Wheat”.

Setting the Annotation Color

If you view a schematic sheet in the context of a design viewpoint, annotated
property values may be displayed in red (by default) or displayed in a differe
color if the property color has been explicitly changed. When this is the case
Design Architect gives you the ability to temporarily change the viewing colo
all annotations, so you can tell which property values are annotated. The
command that allows you to temporarily view all annotations in a different co
is called Set Annotation Color.

Set Selection Color

OK Reset Cancel

VioletRed
Violet

Yellow
White

YellowGreen

Wheat

Selection Color
Design Architect User’s Manual, v8.6_26-8
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You can change the color of back annotated objects as follows:

1. Execute the pulldown menu:Setup >Set >Annotation Color...

2. Move the window slider button down to the bottom, click onYellow , then
click OK.

Back annotated property values will now turn the color “Yellow”. If you click t
“No” button on the dialog box, the annotation colors return back to their origi
colors. This color change is for display purposes only and is not saved when
sheet is saved.

Setting the Viewpoint

You open a Design Sheet window on a design viewpoint so you can edit a d
within the context of the design viewpoint.You open a Design Sheet window
first setting the editing session on a design viewpoint with theSet Viewpoint
command. You can click on the SET VIEWPOINT icon, or execute the pulldo

Set Annotation Color

OK Reset Cancel

VioletRed
Violet

Yellow
White

YellowGreen

Wheat

Annotation Color

Override Annotation Color? No Yes
Design Architect User’s Manual, v8.6_2 6-9
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menuSetup >Set >Viewpoint... A dialog box appears as shown in the followin
illustration.

You fill out the dialog box as shown above, then clickOK . To help you select the
component or viewpoint you wish to use, click theNavigator button. The dialog
navigator appears on the screen, allowing you to traverse your directory stru
to select a Design Architect component or viewpoint. Refer to “Using the Dialog
Navigator” in this chapter for a description of how to use the dialog navigator

Setting the Individual Selection Model

Two selection models are possible when you use the Mouse select button. W
you execute the pulldown menuSetup >Set > Individual Selection Model,each
selection is preceded by a call to $unselect_all(). When you execute the pull
menuSetup >Set > AdditiveSelection Model, each selection is added to the
current selection set.

Setting the Dynamic Cursor

The Schematic and Symbol Editor can be setup to use a plus sign (the defau
diamond, or a full window crosshair cursor when prompting for a diagram
location. The full window crosshair cursor is especially helpful when connect
instance pins with nets during a schematic editing session. To set the cursor 

Set Viewpoint

Component Name card_reader

OK CancelReset

Navigator...Viewpoint Name sim_vpt

Create New ViewpointExisting Viewpoint Unset Viewpoint

 Enter

Click
Design Architect User’s Manual, v8.6_26-10
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activate the Design Architect Session window, then choose the following
pulldown menu:

Setup >Set >Dynamic Cursor: The following prompt bar appears:

Use the stepper buttons to select the shape, then clickOK.

Setting the Hidden Symbol Property Display

If you add a property value to a symbol and that property is to remain invisib
when the symbol is instantiated on a schematic sheet, the property value will
a solid DimGray rectangle as a background. The color and background of th
rectangle can be changed from the Design Architect Session pulldown menu
Setup > Hidden Symbol Property Display...To change the background color o
all hidden property text to white, for example, perform the following steps:

1. Activate the Design Architect Session window, then execute the popup
menu item
Setup > Set > Hidden Symbol Property Display...

SET DV C OK CancelShape crosshair
Design Architect User’s Manual, v8.6_2 6-11
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The Change Color dialog box is displayed as shown below:

2. Move the window slider button down to the bottom, click onWhite , then
click OK.

Setting the Closeness Criteria for Make Polygon

Design Architect allows you to select a closely grouped set of lines and poly
and make them into a single Polyline or Polygon. The endpoints of the lines 
be within a defined distance. You can set this distance as follows:

Set Hidden Symbol

OK Reset Cancel

Background Pattern

Solid

Stipple

VioletRed
Violet

Yellow
White

YellowGreen

Wheat

Background Color

Display background ?

Property Display

YesNo
Design Architect User’s Manual, v8.6_26-12
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Setup >Set >Editing Parameters...

Selecting and Unselecting Objects
The following procedures describe how to select, unselect, reselect, reopen
selection, and set the default selection filter. Refer to “Object Selection” in
Chapter 2 for a description of how the selection/unselection mechanism ope

Selecting a Single Object

Before you can manipulate objects, you must select the objects you want to
change. By default, the Select mouse button selects various objects for you.
can use it to select a single object or a number of types of objects which fall w
an area of a sheet.

To select a single object, follow these steps:

1. Position the cursor on the object to be selected.

2. Click the Select mouse button.

The selected object becomes highlighted on the display, as shown inFigure. The
basepoint (hourglass) icon is a reference point for future manipulations. The s

Setup Editing Parameters

OK Reset Cancel

0.05Point Closeness Criteria for Make Polygon and Make Polyline
Design Architect User’s Manual, v8.6_2 6-13
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count in the status line of the window reflects the number of selected objects
this case, 1).

Figure 6-2. Selecting a Single Object

Selecting Multiple Objects

To select multiple objects, as shown in Figure6-3, follow these steps:

1. Position the cursor at one corner of the objects to be selected. Press a
hold the Select mouse button.

2. Move the cursor while still holding the Select mouse button. A dynamic
rectangle is created which defines an area of the sheet. Manipulate the
rectangle until it surrounds the objects to be selected.
Design Architect User’s Manual, v8.6_26-14
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3. Release the Select mouse button.

Figure 6-3. Selecting Multiple Objects

The object types selected are controlled by the Selection Filter. Objects
completely or partially intersected by the rectangle are selected. Each select
vertex has a selection (bow tie) icon. The basepoint icon is a reference point
future selections. The select count in the status line reflects the number of se
objects.

Using the “match” Command to Select Nets or
Instances by Name or Handle

The “match” command is used to select nets or instances by a given name o
the object’s handle. The command is entered via the popup command line a
followed by one or two arguments. Selection is accomplished by calling eithe
$select_by_handle() or $select_by_property() functions. For nets, if at least one
vertex of a net is selected by this command, then all other vertices and segm
of the selected net are selected.
Design Architect User’s Manual, v8.6_2 6-15
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Command Syntax with One Argument

When one argument is used, the selection is based on a net’s or instance’sregular
expression name or string handle. Command usage is as follows:

match <arg>

The figure below demonstrates the use of the command. The net with the ha
“N$2” would be selected.

Command Syntax with Two Arguments

If two arguments are provided, then the first argument represents a net’s or
instance’sstring property name. The second argument represents the net’s o
instance’sregular expression property value. The command syntax below
illustrates the usage of the command:

match <arg1> <arg2>

For example,match PINTYPE “I.*” would call the$select_by_property() function
as follows:

$select_by_property(@re_union,”PINTYPE”, “I.*”,void);

Selecting Attached Objects

Selecting Attached Branches

A branch is defined as the portion of a net between junction dots, pins, or dan
vertices. The following procedure selects the entire branch of any net contai
selected vertices on a schematic sheet.

1. Select one or more net vertices.

2. Execute the following menu items:
(Most popup menus)Select > Attached > Branches
(Pulldown menu)Edit > Select > Attached > Branches

schematic match N$2
Design Architect User’s Manual, v8.6_26-16
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Selecting Attached Instances

The following procedure selects all unselected instances that have selected 

Whenever an object is selected, the basepoint is automatically reset to the o
of the newly-selected object. If several objects are selected concurrently, the
basepoint is reset to the left-most, lowest origin of the newly-selected object
(left-most takes precedence over lowest).

1. Select one or more pins.

2. Execute the following menu items:
(Most popup menus)Select > Attached > Instances
(Pulldown menu)Edit > Select > Attached > Instances

Selecting Attached Nets

The following procedure selects all unselected net segments and vertices of
that have at least one selected net segment or vertex.

As explained above, whenever an object is selected, the basepoint is automa
reset to the origin of the newly selected object. If several objects are selecte
concurrently, the basepoint is reset to the left-most, lowest origin of the newl
selected objects (left-most takes precedence over lowest).

1. Select one or more net vertices.

2. Execute the following menu items:
(Most popup menus)Select > Attached > Nets
(Pulldown menu)Edit > Select > Attached > Nets

The following procedure selects all vertices and segments of a net, and/or a
with the same name.

1. Select one or more net vertices.

2. Execute the following menu items:
(Most popup menus)Select > Attached > Nets
(Pulldown menu)Edit > Select > Attached > Nets
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3. Hold the Ctrl key down and re-select the object with the pointer and Le
Mouse Button. Alternatively, hold the Ctrl key down and re-select by ar

At this point, all the net components will be selected.

4. To select all nets with thesame name as the selected net, hold the Ctrl ke
down again and re-select the object.

All nets with the same name are now selected.

Selecting Attached Pins

The following procedure selects pins of one or more selected instances.

1. Select one or more pins.

2. Execute the following menu items:
(Most popup menus)Select > Attached > Pins
(Pulldown menu)Edit > Select > Attached > Pins

Selecting by Object Name

This selection is based upon the INST property for instances, the NET prope
for nets, and the PIN property for pins. The following procedures allow you to
select instances, nets, and pins by name.

1. Execute the pop up menu in the Schematic session.

2. Execute the following menu items
For instances,Select > By Name > Instances:
For nets, Select > By Name > Nets:
For pins, Select > By Name > Pins:

3. The Select by Name Prompt bar appears. Type the INST, NET, or PIN
property name of the object you want to select in theNames field and select
OK .

Alternatively, you can enter names with wild cards using regular expression
syntax. Use the following procedure:
Design Architect User’s Manual, v8.6_26-18
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1. Execute the pop up menu in the Schematic session.

2. Execute the following menu items
For instances,Select > By Name > Reg Expr: > Instances:
For nets, Select > By Name > Reg Expr: > Nets:
For pins, Select > By Name > Reg Expr: > Pins:

3. The Select by Name Prompt bar appears. Type the INST, NET, or PIN
property name of the object you want to select in theNames field and select
OK .

For instances and pins, only the object(s) that match the specified n
are selected. For nets, all vertices and segments on nets that matc
specified name are selected.

Unselecting a Single Object

To unselect a single object, position the cursor on the object you want to uns
Click the Select mouse button.

The object is now unselected. Note that if you do not move the cursor and cl
the Select mouse button again, this action reselects the currently unselected
object.

Unselecting Multiple Objects

To unselect multiple objects, as shown in Figure6-3, follow these steps:

1. Position the cursor at one corner of the objects to be selected.

2. Press the Shift-F2 (Unselect Area Anything) function key sequence and
hold.
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3. Move the cursor while still holding the function key. A dynamic rectang
is created which defines an area of the sheet. Manipulate the rectangle
it surrounds the objects to be unselected, then release the keys.

Figure 6-4. Unselecting Multiple Objects

Unselecting Everything

To unselect all selected objects on a sheet, press the F2 (Unselect All Anything)
function key or theUnselect All button, or execute theUnselect > All >
Anything  menu item. Objects that were previously unselected remain unsele

Reselecting a Selection Set

To reselect the last closed and discarded selection set, press the Ctrl-F4 (Reselect)
function key or execute theSelect > Reselect popup menu item. Refer to
“Reselection” in Chapter 2 for a description and example of the reselection
mechanism.
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Reopening a Selection Set

To reopen the last closed selection set, execute theSelect > Reopen Selection
popup menu item, or press the Ctrl-F1 (Reopen Selection Set) function key. 
to “Reopen Selection” in Chapter 2 for a description of the Reopen Selection
command.

Setting the Default Selection Filter

To setup the default selection filter, perform the following step:

1. Either choose theSetup > Select Filter menu item, or click the Select
mouse button on theSet Select Filter button in any palette. The Setup
Select Filter dialog box appears.

2. Click with the Select mouse button on the object types you want selecte
default. Refer to “Selection Filters” in Chapter 2 for a description of how
selection filters work.

Out-of-View Selected Objects

Design Architect issues a warning if a selected object moves out of your view
The warning occurs when the view first changes and excludes a selected ob
from view. The warning will not be re-issued until one of the following occurs

1. An Unselect All is performed.

2. A View All is performed.

3. The viewed area is altered by a View Selected.

You can toggle this warning on or off by executingSetup > Set > Out of View
Warning  from the Design Architect Session Window Pulldown Menu Bar.
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Name Display of Selected Instances and Nets

To display the name of instances, or net vertices and segments when select
the following procedures:

1. Activate the Design Architect Session Window Pulldown Menu Bar.

2. Select theSetup > Set > Select Name Display pulldown menu.

The Select Name Display toggles toON or OFF. When you execute
Setup > Set, the current status ofSelect Name Display is presented.

3. Toggle to desired setting.

4. Using the “Selecting a Single Object” procedures outlined in this chapter,
select the desired instances or nets.

The results of the selection operation are written to the session transcript.

Note

Name display for instances and nets is only available by using
point selection. Selection by area will not display instance or ne
names.
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Manipulating Graphical Objects
The following topics describe how to move, copy, delete, rotate, pivot, and fl
selected schematic and symbol objects. These edit operations do not automa
make new electrical connections when a net passes over any existing pins o
vertices. The connectivity before the edit is preserved.

Hot Keys Usage During Move and Copy

Design Architect provides hot keys during move and copy which allow the us
manipulate graphical objects with a single keystroke.Table 6-1 summarizes the
available hot keys and their behavior.

Table 6-1. Hot Key Behavior

Number of
Selected
Objects

Applicable
Operation

Hot Key Behavior

One Move, Copy, or
Instantiation

“a” cycles origin clockwise
through the object’s pin
locations

“c” cycles origin counter-
clockwise through the
object’s pin locations

“f” flips the object*

“p” pivots the object*

“r” rotates the object*

Multiple Move or Copy

“c” changes the basepoint

“f” flips the object
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* Note: The use of these hot keys after cycling through the origin will cause the drag image to reset to
original position.

To utilize the hot keys, the object must first be selected and the move or cop
prompt bar invoked.

Moving Objects

To move objects from one position to another, perform the following steps:

1. Select the object(s) to be moved. For information about selecting and
unselecting objects, refer to “Selecting a Single Object” in this chapter.

2. Press the Ctrl-F2 (Move) function key or choose the Move > Selected
popup menu item. TheMove prompt bar appears in the schematic windo
with the location cursor on “To Location”. The moving cursor also appe
when you move the mouse into the active window.

To alter the basepoint while moving multiple objects, activate the Move
prompt bar either by theMove Stroke or theMove > Selected popup menu
item. Once the Move prompt bar appears, type the letter “c”. The Basep
prompt bar appears over the Move prompt bar. Move the cursor to the
desired location and set the new basepoint by pressing the Select mou
button. To finish moving the objects, proceed to Step 4.

3. Using the mouse, move the object(s) from one location to another. A g
image of the object(s) appears on the screen. This image is dragged a
the screen as the cursor moves.

4. Press the Select mouse button when the ghost image is in the proper
location.

Multiple Move or Copy “p” pivots the object

“r” rotates the object

Table 6-1. Hot Key Behavior

Number of
Selected
Objects

Applicable
Operation

Hot Key Behavior
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Repeat Moving

To move the same object(s) again, hold theShift key down, move the cursor
inside the schematic window, and click the Menu mouse button (right). This
repeat key sequence only works if no other popup menu command has been
in the meantime.

Moving Objects Between Windows

You can move objects to and from different schematic and symbol windows.
procedures for these operations are the same. When objects are moved from
type of editor to another, a conversion of object type may occur. Refer to the
“ Inter-Window Copy and Move” in Chapter 2 for a description of how object
types are converted when moved from one editor to another.

To move object(s) from one schematic or symbol window to another schema
symbol window, perform the following steps:

1. Activate the Schematic or Symbol Editor window from which you wish 
move objects by clicking the Stroke mouse button in the window area.

2. Select the object(s) to be moved.

3. Press the Ctrl-F2 (Move) function key or choose the Move > Selected
popup menu item. TheMove prompt bar appears in the schematic windo
with the location cursor on “To Location”. The moving cursor also appe
when you move the mouse into the active window.

4. Using the mouse, move the object(s) from one location to another. A g
image of the object(s) appears on the screen. This image is dragged a
the screen as the cursor moves.

5. Press the Select mouse button when the ghost image is in the proper
location.
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Copying Objects

To copy object(s) from a schematic sheet, perform the following steps:

1. Select the object(s) to be copied.

2. Press the Ctrl-F5 (Copy) function key, or click the Select (left) mouse
button on theCopy palette button, or choose the Copy > Selected popup
menu item. TheCopy prompt bar is displayed in the schematic window
with the location cursor on “At Location”. The moving cursor appears
when you move the mouse into the active window.

To alter the basepoint while copying multiple objects, activate the Cop
prompt bar either by theCopy Stroke or theCopy > Selected popup menu
item. Once the Copy prompt bar appears, type the letter “c”. The Base
prompt bar appears over the Copy prompt bar. Copy the cursor to the
desired location and set the new basepoint by pressing the Select mou
button. To finish copying the object(s), proceed to Step 4.

3. Press, but do not release the Select mouse button.

4. Drag the ghost image to the position where you want the copy placed.
moving cursor is located on the basepoint of the ghost image.

5. Release the Select mouse button when the ghost image is in the final
position.

Repeat Copying

To copy the same instance again, hold theShift key down, move the cursor inside
the schematic window, and click the Menu mouse button (right). This repeat
sequence only works if no other popup menu command has been issued in 
meantime.
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Copying Objects to a Line

You can place copies of one or more selected objects in a line, specifying th
locations by the offset between the basepoint of the selected objects and the
basepoint of the first copy. The line of copied objects can be in any direction
create a diagonal line of four copies of two instances, perform the following s
and refer to Figure6-5.

1. Select the instances to copy.

2. ChooseCopy > Multiple  from one of the popup menus. This displays th
Copy Multiple prompt bar. Enter the number of copies in the “Count” te
entry box. Press either the Return key or the Tab key to move the loca
cursor to “Placement”.

3. Drag the ghost image of the selected items to the desired location for 
first copy.

4. Press the Select mouse button when the ghost image is in the correct
position for the first copy. The distance and angle between the basepo
the selected objects and the location you specify determine the placem
for the other copies. The last copy remains selected. Figure6-5 shows the
result of this Copy Multiple.

Figure 6-5. Result of Copy Multiple
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Copying Objects to an Array

There are two methods of copying one or more selected objects to an array. 
know the x- and y-offsets, perform the following steps.

1. Select the object to copy.

2. ChooseCopy > To Array from one of the popup menus.

3. Enter the number of columns in the “X Count” text entry box and the
number of rows in the “Y Count” text entry box. Press the Tab key to m
from one prompt bar entry field to another.

4. The offset values displayed in the prompt bar are the minimum values
can use without objects overlapping when the array is created with the
selected object in the upper left corner. Change values as needed.

5. Click the Select mouse button onOK . Figure6-6 shows the array created.
The last copied object remains selected.

Figure 6-6. Result of Copy to Array
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If you want to use the mouse cursor to specify the row and column locations
can use the Copy Multiple command as follows:

1. Select the object to copy.

2. ChooseCopy > Multiple  from one of the popup menus.

3. Enter the number of rows in the “Count” text entry box in the Copy
Multiple prompt bar. Press the Tab key to move the location cursor to
“Placement”.

4. Drag the ghost image of the selected object to the desired location for
second row of the array, then release the button. This creates the first
column.

5. Select the column of objects.

6. ChooseCopy > Multiple  from one of the popup menus.

7. Enter the number of columns in the “Count” text entry box. Press the T
key to move the location cursor to “Placement”.

8. Drag the ghost image of the first column to the location for the second
column, then press the Select button. The last column of the array rem
selected.

Copying Objects Between Windows

You can copy objects to and from different schematic and symbol windows. 
procedures used to copy between different windows are the same. When ob
are copied from one editor to a different editor, a conversion of object type m
occur. Refer to “Inter-Window Copy and Move” in Chapter 2 for a description of
how object types are converted when copied from one editor to another.
Design Architect User’s Manual, v8.6_2 6-29



Manipulating Graphical Objects Operating Procedures

tic or

e

nd

ft)

h

the

 the

sition.
To move object(s) from one schematic or symbol window to another schema
symbol window, perform the following steps:

1. Activate the window from which you wish to copy objects by clicking th
Stroke mouse button in the window area.

2. Select the object(s) to be copied. For information about how to select a
unselect objects, refer “Selecting and Unselecting Objects” in this chapter.

3.  Press the Ctrl-F3 (Copy) function key sequence, or click the Select (le
mouse button on theCopy palette button, or choose the Copy > Selected
popup menu item. The Copy prompt bar is displayed in the window wit
the location cursor on “At Location”. The moving pointer appears when
you move the mouse into the active window.

4. Using the select mouse button, activate the window you want to copy 
objects into.

5. Drag the ghost image of the object(s) to the location within the window
where you wish to copy the object(s). The moving pointer is located at
basepoint of the ghost image.

6. Press the Select mouse button when the ghost image is in the final po
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Resizing Instances

You can set the schematic environment to allow resizing of instances.

To enable resizing of instances within a sheet, perform the following steps:

1. (Optional, but preferred) Set the schematic environment to automatica
allow resized instances by doing the following:

a. Enter the following function in an appropriateda_session.startup file:

$set_environment_dofile_pathname(@sheet,
’ dofile_pathname ’)

b. Enter the following function in the dofile specified in the above
function:

$allow_resizable_instances()

If you are unsure in which startup file and dofile to put these functions,
contact your system administrator.

2. If resizable instances are not automatically set in the schematic
environment according to the last step, issue the
“$allow_resizable_instances()” function in a popup command line.

To resize one or more instances in a schematic, follow these steps:

1. (Optional) Ensure that resizable instances are enabled in the schemat
using the following command in the Schematic window:

$get_allow_resizable_instances()

If the transcript returns @true, then the sheet is set up for resizing insta
If the transcript returns “@false”, then you must set the environment to
allow resizable instances using the previous procedure.

!
Caution

Changing the default on a sheet to allow resizable instances is
irreversible.
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2. Select the appropriate instance(s) to be resized.

3. Execute theResize > Half Size | Quarter Size | Normal Size | Four_x
Size | Two_x Size item in the Schematic popup menu.

All the size choices are absolute; that is, they are relative to the “norma
size of the component as established when the symbol was created in
Symbol Editor. Thus, if you choose “Four_x Size”, the selected instanc
will be four times normal size. If you then choose “Half Size”, for examp
the instance(s) will be one-half normal size, not one-half the Four_x siz

The grid size is adjusted for both the Half Size and the Quarter Size so
the pin spacing on the smallest instance is still accurate.

Grouping Objects

To create a group of objects on the schematic sheet, perform the following s

1. Select the objects to be grouped. For information about selecting and
unselecting objects, refer to “Selecting and Unselecting Objects” in this
chapter.

2. Execute theMiscellaneous > Group pulldown menu to display the Group
prompt bar.

3. Enter the appropriate value beside “Group Name.”

4. Choose the appropriate mode beside “Existing.”

5. Choose whether the name is persistent or temporary beside “Duration

6. OK  the prompt bar.

Once a group is created, you can select the group using the following steps:

1. Execute theSelect > Group popup menu item to display the Select Grou
prompt bar.
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2. Enter in the text box the name of the group you want to select.

3. OK  the prompt bar.

Ungrouping Objects

To remove the name of a group from a set of objects, perform these steps:

1. Execute theMiscellaneous > Ungroup pulldown menu item to display the
Ungroup prompt bar.

2. Enter the name of the appropriate group beside “Group Name.”

3. OK  the prompt bar.

Reporting Groups

To list the names of the groups available in a schematic design, follow these

1. Execute theReport > Groups pulldown menu item.

Deleting Objects

To delete object(s) from schematic sheet, perform the following steps:

1. Select the object(s) to be deleted. For information about selecting and
unselecting objects, refer to “Selecting and Unselecting Objects” in this
chapter.

2. Click the Select mouse button on theDelete palette button, or execute the
Delete > Selectedpopup menu item.

The selected object is now deleted. Instances, frames, net vertices, pins,
properties, comment text, and comment graphics can be deleted in this man
Properties can also be deleted by executing theDelete > Propertypopup menu
item.
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NOTE: Notice that the basepoint icon is left behind after you delete a selecte
object(s). This icon remains until something else is selected. It facilitates pla
the object(s) in the same location when you issue the Undo command. The
basepoint icon is not a part of the design.

Pivoting and Rotating Objects

Pivoting and rotating are two identical operations when executed on an indiv
object. However, when you pivot or rotate a group of selected objects, there
important difference. Pivoted objects move with respect to the origin on each
individual object. Rotated objects move with respect to the basepoint of the
selected objects. Furthermore, pivot operations do not affect nets, while rota
operations do.

Perform the following steps to pivot or rotate an object:

1. Select the object(s) you want to pivot or rotate. For information about
selecting and unselecting objects, refer to “Selecting and Unselecting
Objects” in this chapter.

2. Execute the (Schematic) Instance > Rotate/Flip > Pivot or Instance >
Rotate/Flip > Rotate menu item. Cascading to the right of these menu
items are four more menu selections. Select one of the following:

• -90 - moves object(s) 90 degrees, clockwise

• 90 - moves object(s) 90 degrees, counter-clockwise

• 180- moves object(s) 180 degrees

• As Specified

The selected object(s) are pivoted (or rotated) to the specified position. The
rotation must be multiple of 90 degrees. The Rotate and Pivot functions are 
available in the(Schematic) [Add_Route] palette, and in theSymbol Body &
Pinsmenu in the Symbol Editor, and theMixed Selection menu in the Symbol
and Schematic Editors.
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Flipping Objects

Perform the following steps to flip an object or a group of objects.

1. Select the object(s) you want to flip. For information about selecting an
unselecting objects, refer to “Selecting and Unselecting Objects” in this
chapter.

2. Execute theInstance > Rotate/Flip > Flip menu item. Choose either
Horizontal or Vertical from the cascading submenu.

The selected object(s) are flipped to the specified position. Flip is also availab
the(Schematic) [Add_Route] palette, and in theSymbol Body & Pinsmenu in
the Symbol Editor, and theMixed Selection menu in the Symbol and Schematic
Editors.

Using Strokes to Manipulate Objects

If you hold down the middle mouse button and draw a question mark stroke “
a Schematic Editor window, the Quick Help on Strokes chart appears as sho
the following illustration. This chart defines the strokes that are available to yo
that active window. Strokes are one of the most productive methods for exec
commands, because all you have to do is wiggle the mouse in small pattern
instead of moving the pointer half way across the screen to click a palette ico
reach a pulldown menu.

Note

Objects are flipped, pivoted, and rotated in place. If you want to 
pivot, or rotate object(s) that you are moving or copying, theCopy
andMove menu items have cascading menu items for these
operations.
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Figure 6-7. Schematic Window Strokes

It is often helpful to make a photocopy of this form, cut it up into strips and ta
the strips on the edges of your display until you learn the strokes. After you u

Quick Help on Strokes

CloseRef Help

Common Design Architect Strokes Schematic Strokes

3

Stroke Recognition Grid

Add Wire
258

Add Bus
852

Choose Symbol
36987

Help on Strokes
123658

Print

More help on strokes

Display Schematic Palette
78963

Connect All
1236987

Display Default Palette
98741

Place Active Symbol
14789

Connect Selected
7896321

Route Selected
96321

741236987

Undo
7412369

Set Active Symbol
321456987

Flip Horizontally
9632147

Setup Select Filter
32147

Rotate (90)
3698741

Report Selected
1474123

Unselect All
1478963

Select Area
74123

Add Property
32159

Modify Property
95123

Delete
5

View Centered
Double Click MMB

Copy
3214789

Zoom Out (2)
753

Zoom In (2)
357

Refresh
75357

Select Window
1475963

View All
951

View Area
159

Copy Multiple
9874123

Move
74159

Activate Window

4

21

5 6

7 8 9
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the strokes over time, you will remember them and they will come to you
naturally, almost without thinking. Many of the strokes that you will learn from
this chart will carry over to other applications, so they are well with the effort
learn.

Creating a Schematic
Sometimes you will start working on a new schematic, and other times you w
want to modify an existing schematic. The following topics describe some of
basic procedures used to create and edit a schematic. If you are unfamiliar w
basic elements of a schematic, read “Elements of a Schematic” in this chapter.

When specifying a component or any other object that begins with a dollar s
($), do not begin the pathname with the “$” character. Any relative pathname
begins with a “$” is assumed to be a soft pathname. To reference an object in
current working directory that starts with a dollar sign, use ./$object_name ins
of $object_name.

Opening a Schematic Sheet

To open a schematic sheet, press the Open Sheet function key, or click the 
mouse button on the[Session] Open Sheet icon in the palette. You can also ope
a sheet from the Session popup menu, or from the File pulldown menu. Eac
method displays the Open Sheet dialog box which prompts you for the compo
and sheet names.

The system assumes you are editing “sheet1” of the default “schematic” mod
You can change the sheet name for the default model, and you can open an
existing sheet in read only mode, or list the component hierarchy in a window
you need help selecting a component, press theNavigator button. The dialog
navigator appears on the screen allowing you to traverse your directory struc
to select a Design Architect component. Refer to “Using the Dialog Navigator” in
this chapter for a description of how to use the dialog navigator. You can rep
the default schematic and sheet names by pressing theOptions button. The
options for a new sheet are different than those for an existing sheet. Click th
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New Sheet button to see theOpen Sheet Options dialog box illustrated in
Figure6-8.

Figure 6-8. Open (new) Sheet Options Dialog Box

The Open Sheet Options dialog box lists the names of available sheets in th
component. You can click the Select mouse button on a name in the list, or y
can enter schematic and sheet names in the respective text entry boxes in th
dialog box. If you hold down the SHIFT key and select more than one sheet i
list, then all selected sheets will be opened at the same time.

By default, the most current version of a sheet (indicated by “0”) is opened; if
want an older version, enter the number in theVersion box. To see which
versions exist, click theVersion button. If you want to execute a startup file for
this sheet, clickYes for that option and enter the file pathname.

Open Sheet Options

Component Name:  $CUSTOM_PARTS/dff

Available :

Version...

0

OK CancelReset

Sheet : sheet1Schematic : schematic

Sheet Border : Size : D Set...

Existing New Sheet

No Yes
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You can automatically create a sheet border and a title block on a new shee
clicking the Sheet BorderYes button, and selecting the desired sheet size. If yo
click theSet button, another dialog box is displayed with the available sheet s
and the title block option button. ClickOK  on each dialog box; a new sheet is
displayed in a schematic edit window. If you requested a title block, a dialog
is displayed for you to enter information.

When you are opening an existing sheet, theAuto Update Mode allows you to
specify whether instances should be updated when the sheet is opened and
how the properties are merged. Click on one of the following buttons:

• No: Out of date instances are not updated when the sheet is opened.

• Clear: Instance-only properties are deleted; all other properties are res
the current symbol values.

• Symbol: Instance-only properties are not changed; all other properties 
reset to the current symbol values.

• Instance: All existing properties are unchanged; new properties on the
current symbol are added to the instance.

• Auto: Instance-only and Value_Modified properties are not changed; n
properties on the current symbol are added to the instance.

For more information about how properties are updated, refer to “Updating
Properties on an Instance of a Symbol” in Chapter 3.

Setting Up the Schematic Editor

Before you start working on a schematic sheet you can change some or all o
default attribute settings for your schematic editing environment. Attributes s
as pin spacing, grid spacing and snap, net drawing, and comment text and gr
display are all set to default settings when a new schematic sheet is opened.
items contained in theSetup menu set these attributes. The following procedur
show you how to set up these attributes. These settings are available after th
Schematic Editor window is opened.
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Setting Pin Spacing

The pin spacing attribute sets the minimum distance between pins on the sy
and on the schematic sheet.

In the schematic editor, if pin spacing is set to .25 inches, for example, there
be at least .25 inch between pins. Pin spacing is a real number measured in
units: inch, centimeter, millimeter, or pin.

In the symbol editor, you create symbols using pin grid units for spacing. Wh
symbol is placed on a schematic sheet, Design Architect sets the pin spacin
the symbol to the pin spacing of the schematic.

To setup the pin spacing on the schematic sheet or the symbol, perform the
following steps:

1. Place the cursor in a Schematic or Symbol Editor window and press th
Select mouse button.

2. Execute theSetup > Net/Comment/Page > Pagemenu item in the
schematic editor or theSetup > Other Options > Page in the symbol
editor. The Set Page prompt bar appears.

3. Type the pin space number in the “Pin Space” text entry box.

4. Enter the user units (inch, pin, mm, cm) by clicking the choice stepper
button until the unit you want is displayed. Even though you are allowe
choose a user unit in the symbol editor, all pin spacing is measured in 
grid spaces in the Symbol Editor window.

5. When pin spacing setup is complete, press theOK  button.

Setting Grid Spacing and Snap

A pattern of grid points is normally displayed in the editing window you are
working in to assist you in drawing straight lines and finding points of referen
If you like, you can turn the grid pattern off or redefine the layout of the grid
points. You can also stipulate that any object drawn will snap to the nearest 
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point. Each window can have independent grid settings allowing different ob
placement characteristics (dynamics) for each window.

To set up the grid spacing and snap, perform the following steps:

1. Activate a symbol or schematic edit window and execute the
Setup > Grid/Report/Color > Grid menu item. The Set Grid dialog box
appears.

2. Enter the number of grid points to be established between pins in theGrids
Per Pin text box. A value of 4 means 4 grid points within 1 pin space. A
value greater than 1 defines a finer grid by placing the specified numbe
points between each pin spacing interval. A value less than 1 is a coar
grid, which you can use to “spread out” objects in a design. The default

3. Type in theMinor Multiple  text box the number of grid locations betwee
displayed locations. Dots indicate minor multiple grid points. The defau
1.

4. Type in theMajor Multiple  text box the number of visible grid points to b
highlighted with a cross. This feature can be used to highlight pin spac
or to note relative distances between various objects on the sheet.   Th
default is 4.

5. Click the Select mouse button on the snap you want (On/Off ).

6. Click the Select mouse button on whether to show the grid (On/Off ).

7. When the grid and snap setup are complete, press theOK  button.

The number used for each grid setting must be an even divisor of 1920. If th
number you specify is not a divisor of 1920, the next larger divisor will be us
Valid numbers include 1, 2, 3, 4, 5, 6, 8, 10, 12, ... Numbers not supported in
7, 9, 11, 13, 14, ... If the system uses a number other than the one you specif
will receive a warning message.
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Setting Net Drawing Attributes

Before you begin drawing nets, you can specify how nets are graphically
represented (bus width and net style), and other net drawing characteristics,
as automatic orthogonal net drawing, automatic net routing, and pin snappin

To set up the net characteristics, perform the following steps:

1. Place the cursor in a Schematic Editor window and press the Stroke m
button to activate the window.

2. Execute theSetup > Net/Comment/Page > Netsmenu item. The Setup
Net dialog box appears in the active Schematic Editor window.

3. Type in theSet Dot Size text box the dot size (default is 0.025 user units

4. Type in theSet Snap Angle text box the snap angle (default 44.9).

5. Click on eitherCircle or Square to choose the dot style.

6. Press theSet Ortho buttonOn and theSet Snap buttonOn, to set up
orthogonal routing and pin snap.

7. If you want nets automatically routed immediately after they are drawn
press theSet Auto Route button On. The net router defines an orthogon
path for a connected net that avoids instance extents, comment object
other nets.

8. Select the net style (Solid, Dotted, Long Dash, Short Dash, Centerline
Phantom) and bus width (3 pixels, 5 pixels, or 7 pixels) by pressing the
Select mouse button on the appropriate buttons.

9. If you want junction dots to appear where bus rippers join bus lines, pr
theSet Ripper Dots buttonOn.

10. If you want close-dots displayed on the sheet, press theSet Close Dots
buttonOn. The close-dot appears on a vertex when a non-orthogonal n
segment passes so close to the vertex that it is visually difficult to deter
that they are not connected.
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11. Set Auto Ripper specifies whether single bit bus rippers are placed
automatically during net creation when the current net width is “1” (defa
wire width), and one of the input vertices falls on a net segment with w
greater than “1” (default bus width is “3”). If you press theOn button, you
also need to specify a ripper component and symbol name. The defau
the 1X1 symbol of$MGC_GENLIB/rip.

12. When you turn onAutomatic Name Placement and optionally specify a
Name Offset,net names are automatically placed when you name nets
do not already have a NET property attached.

13. When net setup is complete, press theOK  button.

Drawing a Schematic

There are five basic procedures used to draw a circuit: choosing and placing
component symbols, copying and moving objects, drawing nets, terminating 
and naming nets. Schematic sheets are drawn in a Schematic Editor window
Design Architect.

Choosing and Placing Component Symbols on a Sheet

Component symbols can be selected and placed on a schematic sheet from
library palette or by typing the pathname to the component symbol in a dialo
box. A library palette can be activated by selecting a library menu item unde
Libraries  menu. If$MGC_HOME/pkgs/mgc_analog_uw is installed, Design
Architect will automatically load the AccuParts library menus. A menu select
is available for every Mentor Graphics component library installed. The librar
palette includes a list of all library components available from that library.

Choosing from the library palette:

1. Place the cursor in a Schematic Editor window and press the Stroke m
button. This activates the window.

Note

The specified ripper must have one BUNDLE, and one WIRE p
evenly spaced in the X & Y direction.
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2. Execute the Libraries > MGC Digital Libraries > Display Libraries
Palettemenu item. A palette listing of installed Mentor Graphics librarie
replaces the schematic palette.

3. Move the cursor to the library palette and scroll through the list of librarie
Activate a library by placing the cursor over the library name and clicki
the Select mouse button. A palette appears with a listing of all compon
in the activated library.

4. Move the cursor to the palette and scroll through the list of component
Activate a component symbol by placing the cursor over the componen
name and clicking the Select mouse button.

5. Move the cursor to the schematic window. The moving cursor is now
displayed, prompting you for a location to place the symbol. Move the
cursor to display a ghost image of the symbol. Drag the ghost image to
desired location. At this point, you can, by the use of the hot keys, flip 
rotate the object, and cycle the origin through the objects pins:

• Flip  - move the object to the desired location, then type the hot keyf”

• Rotate - move the object to the desired location, then type the hot k
“ r ”

• Cycle Origin through Pins - move the cursor to the desired location
and use the hot key “c” to cycle the origin through the pins clockwise o
use the hot key “a” to cycle the origin through the pins counter
clockwise

6. Click the Select mouse button.

Choosing from the Dialog Navigator:

1. Activate the Schematic Editor window by pressing the Select mouse bu
Execute the Add > Instance > Choose Symbol popup menu item. The
Choose Symbol dialog box with a dialog navigator is displayed. Refer 
“Using the Dialog Navigator” in this chapter for information about how to
use a dialog navigator.
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2. Choose a component name, change property values, if needed, then c
theOK  button. The Add Instance prompt bar appears.

3. If the symbol name of the component you want is not the default name,
the desired symbol name in the Symbol Name entry box.

4. Click the Select mouse button on the “At Location” button. The moving
cursor is now displayed, prompting you for a location to place the symb
A ghost image of the symbol is displayed.

5. Move the ghost image to the desired location in the active window. At 
point, you can, by the use of hot keys, flip and rotate the object, and cy
the origin through the objects pins:

• Flip  - move the object to the desired location, then type the hot keyf”

• Rotate - move the object to the desired location, then type the hot k
“ r ”

• Cycle Origin through Pins - move the cursor to the desired location
and use the hot key “c” to cycle the origin through the pins clockwise o
use the hot key “a” to cycle the origin through the pins counter
clockwise

6. Click the Select mouse button.

From the Add Instance dialog box:

1. Execute theAdd > Instance > Symbol by Path popup menu. The Add
Instance dialog box is displayed.

2. Enter the component name; if you do not know the component name, 
you wish to navigate through directories to find it, click the Navigator
button. Using the navigator, you can select a component name. Refer 
“Using the Dialog Navigator” in this chapter for more information about
how to use the dialog navigator.

3. Click theOptions? YES button if you want to specify a symbol other tha
the default. Property values can also be added or modified in this dialog
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by clicking theOptions? YES button and entering the property name(s)
and value(s) in the fields provided.

4. When option selection is complete, click theOK  button.

5. Move the cursor to the schematic window. The moving cursor is now
displayed, prompting you for a location to place the symbol. Move the
mouse to see the ghost image, then drag the ghost image of the symb
the location desired. At this point, you can, by the use of hot keys, flip 
rotate the object, and cycle the origin through the objects pins:

• Flip  - move the object to the desired location, then type the hot keyf”

• Rotate - move the object to the desired location, then type the hot k
“ r ”

• Cycle Origin through Pins - move the cursor to the desired location
and use the hot key “c” to cycle the origin through the pins clockwise o
use the hot key “a” to cycle the origin through the pins counter
clockwise

6. Click the Select mouse button.

Choosing the active symbol (theactive symbol is the last symbol instantiated, an
is displayed in the Active Symbol window):

1. Execute theAdd > Instance > Active Symbol or Active Symbol >
Add Active Symbol menu item. The Place Active Symbol prompt bar is
displayed

2. When you move the cursor in the schematic window, a ghost image of
symbol appears. Drag the ghost image to the desired location. At this p
you can, by the use of hot keys, flip and rotate the object, and cycle th
origin through the objects pins:

• Flip  - move the object to the desired location, then type the hot keyf”

• Rotate - move the object to the desired location, then type the hot k
“ r ”
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• Cycle Origin through Pins - move the cursor to the desired location
and use the hot key “c” to cycle the origin through the pins clockwise o
use the hot key “a” to cycle the origin through the pins counter
clockwise

3. Click the Select mouse button.

You can also place an instance of the active symbol by clicking the Select m
button in the Active Symbol window, dragging the ghost image to the desired
location, and clicking the Select mouse button.

Viewing the Active Symbol History List

The active symbol history list is simply a list of the symbols that have been
activated during the edit session, and some common symbols from
$MGC_GENLIB, such as ports and ground, that are listed by default. To loo
the list, choose theActive Symbol > Symbol History > List menu item, or press
the Ctrl-H keys. To reactivate a symbol in the list, click the Select mouse but
on the symbol name in the dialog box.

Loading an Active Symbol History

You can load symbols into the active symbol history list, then activate and pl
the symbols from the list as you need them. This is convenient and faster tha
other methods of activation and instantiation when you need just a few
components from each of several component libraries. Following are two met
of loading the symbol history list.

Interactive loading:

1. Execute the Libraries > MGC Digital Libraries > Display Libraries
Palettemenu item.

2. Click the Select mouse button on the desired library. Activate the desir
component to activate it and display it in the Active Symbol window.

3. When the prompt bar appears, click the Select mouse button onCancel.

Repeat steps 2 and 3 for each symbol you want in the list.
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The second method of pre-loading symbols is putting function calls in a file,
which can be read with the $dofile() function. The following example shows h
to activate symbols from a file:

$set_active_symbol("$MGC_GENLIB/4bit_multi", "", [], "");
$set_active_symbol("$MGC_GEN LIB/and3", "", [], "");
$set_active_symbol("$MGC_GENLIB/rip", "8X1", [], "");
$set_active_symbol("$MGC_GENLIB/rip", "1X3", [], "");

If these lines were placed in the file,$HOME/da/load_symbols, the following
would execute the function calls:

$dofile("$HOME/da/load_symbols")

When you are ready to instantiate symbols from the history list, view the list,
select the symbol, and place it on the sheet, as described in “Viewing the Ac
Symbol History List”.

Activating a Symbol From the Symbol Editor

If you have been editing a symbol, and you want to instantiate it on a sheet,
perform the following steps:

1. In the Symbol Editor, check the symbol, then save it.

2. Set the select filter to select only symbol bodies; select the symbol bod

3. Move the cursor to the Active Symbol window. Choose the
Active Symbol > Activate Selected menu item.

4. Activate a schematic window; instantiate the symbol using any of the
previously described methods.

Setting a Default Component Library

You can specify a default library that you want displayed whenever you choo
theLibraries > Display Default Palette menu item. This lets you move quickly
from one library to another when most of the components you need are in on
library, but you still need a few components from other libraries. Perform the
following steps to setgen_lib as the default:
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1. Execute the Libraries > MGC Digital Libraries > Display Libraries
Palettemenu item. The library palette replaces the schematic palette.

2. Press the Select mouse button on “gen_lib” in the library palette.

3. ExecuteSet Default Palette from either theLibraries  pulldown menu or
thePalette popup menu. Now, when you want gen_lib displayed, execu
eitherLibraries > Display Default Palette or Palette > Display Default
Palette.
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Setting the Interface Default

You can set an interface default to use when adding instances to a schemati
from one of the MGC Digital Libraries. For example, you can use this feature
you want the ANSI interface for all instances that you add. The interface def
if available for the component you want to instantiate, overrides the compon
default interface. If the interface default is not present in a component, then 
component default interface is used.

To set the interface default so that the component default interface is used w
adding an instance to a schematic, choose theLibraries > MGC Digital
Libraries > Set Interfaces Defaults > Default Interfaces menu item.

To set the interface default so the ANSI interface is used when adding an ins
to a schematic, choose theLibraries > MGC Digital Libraries > Set Interfaces
Defaults > Symbol > ANSI menu item.

To set the interface default so the positive logic interfaces are used when ad
instances, choose theLibraries > MGC Digital Libraries > Set Interfaces
Defaults > DeMorgan's Logic > POS Logic menu item.

Updating and Replacing Instances

TheUpdate command lets you update a symbol instance with the newest ver
of the same symbol. TheReplace command lets you replace a symbol instance
with an instance of a different symbol, such as replacing an AND with an OR

The method used to merge current symbol properties with properties attache
instances that are updated or replaced is determined by the following switch

• -Clear

• -Symbol

• -Instance

• -Auto

These switches are described in “Property Merge Options” in Chapter 3.
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For example, to update some instances on a sheet using the -Instance optio
perform the following steps:

1. Select the instances you wish to update.

2. Choose theInstance > Update > Instance menu item.

To update selected instances using the default property merge, chooseInstance >
Update. Update is also available through theEdit > Update > submenu. The
default Update menu pick is Auto.

To automatically update all instances on a schematic when you open a shee
specify the desired Auto Update Mode choice on theOpen Sheet dialog box. You
can set up your Design Architect session to perform automatic updates usin
different property merge option by executing the$set_auto_update_mode()
function. For example, to perform an update with the -Instance merge, type t
following function:

$set_auto_update_mode(@instance)

If you do not want subsequently opened sheets automatically updated during
current session, type this function:

$set_auto_update_mode(@noupdate)

When you set the auto_update mode, that setting remains in effect for the cu
Design Architect session, or until you explicitly change it. If you do not specify
auto_update_mode, sheets are not automatically updated when they are rea

The Replace command, like Update, is accessible through theEdit  pulldown
menu and theInstance popup menu. You can replace selected instances with
active symbol, or you can choose a replacement symbol from a library, or yo
enter the pathname of the replacement symbol in a dialog box.

To replace selected instances with the active symbol, choose theActive Symbol >
Replace Selected menu item.

Replace Instance is also available in the Palette popup menu.

To replace a selected symbol instance by choosing the replacement symbol 
library (when you do not know the pathname), perform the following steps:
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1. Display the library that contains the desired component, as described 
“Choosing and Placing Component Symbols on a Sheet” in this chapter.

2. Choose thePalette > Replace Instance menu item.

3. Click the Select mouse button on the desired component in the library

If no instances were selected, you will be warned that the replace did not oc
because no instances were selected to be replaced. Select the instance to r
then select the replacement symbol.

The Palette > Replace Instance menu item changes toPalette > Add Instance,
indicating that the next component selected from a library will be instantiated
the sheet.

Instance > Replace > From Library Menu andEdit > Replace > From Library
Menu are used in the same manner: select the instance to be replaced, then 
the menu item. These methods use the default replacement property merge
the specific library menus. Mentor Graphics library menus set the default to 
Clear.

You can replace a selected symbol instance with the active symbol by choos
the desired property merge from theInstance > Replace > Active Symbol >
submenu.

If you know the pathname to the replacement component, select the instance
be replaced, then chooseInstance > Replace > Other. The Replace Instance
dialog box is displayed for you to enter the pathname. If you want a symbol o
than the default, or a property merge other than -Clear, click theOptions? YES
button and enter the appropriate information.

Drawing and Routing Nets

To draw a net perform the following steps:

1. Press the F3 (Add Wire) function key, click on the[Add/Route] Add Wire
icon, or execute theNet > Add Wire or Add > Wire  popup menu item.
The Add Wire prompt bar is displayed on the screen, prompting you to
select the beginning net vertex location.
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2. Position the cursor where the net is to begin (usually, at an instance p
location). Click the Select mouse button. This is the start of the net
segment, and is identified by the moving pointer.

3. Move the cursor to where the net segment is to end and click the Sele
mouse button. The net segment is created from the start point to the on
just specified. Notice that the moving pointer moves to the end of the n
net segment.

4. To continue the net, move the cursor to the vertex and click the Select
mouse button. A net can be continued to as many points (vertices) as
necessary. Notice that at each net vertex there is a small hollow dot.

5. To complete a net, double-click the Select mouse button.

The Add Wire prompt bar is still displayed. Follow steps 1 through 5 to add m
net segments. To exit from the Add Wire mode, click theCancel button on the
prompt bar. As you create net segments, and before the net is unselected, th
be deleted with theDelete key or the Backspace key.
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Automatic Net Routing

To set up automatic net routing, perform the following steps:

1. Activate the schematic window by moving the cursor into the window a
pressing the Stroke mouse button.

2. Execute theSetup > Set AutoRoute Onmenu item. Nets are now
automatically routed as drawn.

Net routing concepts are discussed in “Draw and Route Nets” in Chapter 2.

Connecting and Disconnecting Net Vertices

After moving or copying objects, you may need to change some net connect
A not-dot on a vertex indicates that not all segments passing through the ver
are connected, even though they appear to be connected.

To force connections for an instance or an area, select the instance or area,
choose theAdd > Connections > Connect Area menu item. To force
connections at all not-dot locations on a sheet, choose theAdd > Connections >
Connect All menu item. The not-dots disappear, indicating there is an electri
connection. The not-dots are replaced by junction dots at overlapping net
segments. Connect All is also available through a function key and in the
Add/Route palette.

To disconnect nets, choose theAdd > Connections > Disconnect Area or the
Add > Connections > Disconnect All menu item.

Naming Nets

You can name one or more selected nets by clicking on the Name Net icon i
Text palette, or by choosing theNet > Name Nets popup menu item. A net must
be selected (not a vertex). A prompt bar is displayed as follows:

• If there is no Net property on the net, you are prompted to add one.

• If there is already a Net property on one of the vertices, you are promp
for a new Net property value.
Design Architect User’s Manual, v8.6_26-54



Operating Procedures Creating a Schematic

cted
alue
alue

net at
net at

 of the
• If there is already a Net property, but it is not attached to any of the sele
vertices, you are prompted to place another Net property of the same v
on one of the selected vertices. You can change the current property v
at the same time, if you wish.

In all cases, the Net property is added to only one of the selected vertices.

Modifying Net Names

A net should always terminate at a component's pin, or connect with another 
a junction. The Schematic Editor uses several components for terminating a 
an input or output point. The components portin, portout, offpag.in, and
offpag.out provide net termination. By default, the portin and portout symbols
assign the name NET to an unnamed net when attached. To prevent many
different nets from being named NET (if two nets have the same name, the
simulator sees them as being connected), you will need to change the name
nets so they each have a unique name.

To modify a net name, perform the following steps:

1. Place the cursor over the name of the net.

2. Press theChange Text Value function key, or execute theEdit >

Change Attributes > Text > Value menu item.

3. When the prompt bar appears on the screen, type in the new text.

4. Press the OK button on the prompt bar.

The new net name appears at the same location.

You can also modify selected net names by clicking on theText > Name Net
palette icon, or by choosing theNet > Name Nets popup menu item. This is
described in “Naming Nets” in this chapter.
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Moving Net Names

Sometimes, after placing a net property value on the sheet, you may decide
you want it somewhere else. To save the effort of deleting the property and a
a new one, you can easily move the net property text value by doing the
following:

1. Place the cursor on the text you want to move.

2. Press the F7 (Select Text and Move) function key and hold it down. Notice
that you do not have to select the text beforehand; this is done automat
for you.

3. A ghost image of the text outline is displayed when the mouse is move
Move the mouse until the text is positioned where you want it.

4. Release the F7 (Select Text and Move) function key to lock in the new
position of the text.

The net property text value is now in its new location.

Terminating a Dangling Net

All input nets and buses should begin with a portin or offpag.in component fr
thegen_lib component library or any other component with a Class = “P” or Cl
= “O” property value. Similarly, output nets and buses should be terminated 
a portout or offpag.out component. Warnings can result if this is not done.

See “Choosing and Placing Component Symbols on a Sheet” in this chapter for
details about how to place these components onto your schematic.

See “Assigning Properties and Property Owners” in this chapter for details on
how to add property values.
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Declaring Valid Dangles

You can specify that a dangling net vertex or instance pin is valid and should
be reported by the Check command when you check the schematic. You do t
attaching the Class property with a value of “dangle” to any unconnected net
or instance pin that you want the Check command to recognize as valid.

When you attempt to add the Class property to a pin or net, you may receive
following error message:

//  Warning: Added 0 properties (1 failed for bad owners)
(from: Capture/gdc/warning B6)

If this occurs, use the Set Property Owner command to declare pins and/or n
valid owners of the Class property, then add the property to the pin or net.

Design Error Checks
Once the design has been drawn, instances placed, nets added, and proper
added, the last step before saving and registering is to check the sheet or sch
for errors. All sheets and schematics must pass a set of required checks bef
sheet or schematic is usable.

Design Architect allows the user to perform checks on specified designs onc
schematic has been drawn. The checks are grouped into the following two di
categories:

• Sheet Checks - checks performed on a single, active sheet

• Schematic Checks - checks performed on an entire schematic contain
multiple sheets

Note

Required schematic checks are set up at invocation time and 
executed with the Check command. Default schematic checks
the Check command are described in Appendix A “DA Design
Checks” of this document.
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Checking a Sheet for Errors

To execute the default sheet checks, perform the following steps:

1. Activate the Schematic Editor window you wish to check by placing the
cursor in the window and clicking the Stroke mouse button.

2. Press the Ctrl-F5 (Check) function key. Errors and warnings are displaye
in the Check Sheet window by default for each individual check. The e
log, by default, is displayed in its own window, but can be sent to a file
to the transcript.

Figure6-9 shows a Check Sheet log for a schematic sheet.

Figure 6-9. Check Sheet Log

To set up your own default sheet checks, perform the following steps:

1. Activate a Schematic Editor window by placing the cursor in the schem
window and clicking the Stroke mouse button.

2. Execute theSetup > Check > Sheet menu item. The Default Sheet Check
Settings dialog box appears in the active Schematic Editor window.

Check #2 dff/schematic/sheet1:Sheet

Check Sheet "dff/schematic/sheet1"
Check SymbolPins -------- 0 errors  0 warnings  (MGC-required)
Check Overlap ----------- 0 errors  0 warnings
Check NotDots ----------- 0 errors  0 warnings
Check Closedots --------- 0 errors  0 warnings
Check Dangles ----------- 0 errors  0 warnings
Check INIT Props -------- 0 errors  0 warnings
Check Owner ------------- 0 errors  0 warnings  (MGC-required)
Check Instance ---------- 0 errors  0 warnings  (MGC-required)
Check Special ----------- 0 errors  0 warnings  (MGC-required)
Check Net --------------- 0 errors  0 warnings  (MGC-required)
Check Frame ------------- 0 errors  0 warnings  (MGC-required)

"dff/schematic/sheet1" passed check: 0 errors 0 warnings
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3. Select the checks you wish to execute by clicking the Select mouse bu
beside the appropriate check name button. Select one of the three but
displayed for each check. The labelErrors/Warnings  means display both
error and warning messages, the labelErrors only  means display errors
only, and the labelNo check means this check is not executed. See the “The
Check Command” section in Chapter 5 for a detailed discussion regardi
Default Sheet Check Settings.

Figure 6-10. Default Sheet Check Settings Dialog Box

4. Press theOK  button, when check settings are complete.

Default check settings you set with theSetup > Check menu item are set
only while in the application. When you exit from Design Architect thes
settings are lost. The required default checks are set when Design Arc
is invoked.

To specify and execute a set of sheet checks, perform the following steps:

1. Activate a Schematic Editor window by placing the cursor in the schem
window and clicking the Stroke mouse button.

Default Sheet Check Settings

Errors/

Macro File:

OK Reset Cancel

Warnings
Errors
Only

No
Check

Instance*

Special*

Net*

Frame*

Symbol Pins*

Parameter

Expressions

Errors/
Warnings

Errors
Only

No
Check

Owner

Overlap

Notdots

Closedots

Dangles

INIT Props

Annotations

Bus Shorts
Required check category*

Userule Checks:

All No Check

File Mode:

Add Replace

File: da_check_file

Display in Window

Write to Transcript

No File
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2. Choose theCheck > Sheet > As Specified > Using Current Settings
menu item. The Sheet Check dialog box appears in the active sheet
window. The check settings in the dialog box show how they were last

Alternately, you can choose theCheck > Sheet > As
Specified > Using Default Settings menu item. The Sheet Check dialog
box appears in the active sheet window. The current internal default ch
settings are displayed in the dialog box.

3. Select the checks you wish to execute by clicking the Select mouse bu
beside the appropriate check name button. Select one of the three but
displayed for each check. The labelErrors/Warnings  means display both
error and warning messages, the labelErrors only  means display errors
only, and the labelNo check means this check is not executed.

4. Press theOK  button when check selection is complete. The checks sele
are now executed.

Checking a Schematic for Errors

To perform a check of a schematic, which may involve numerous sheets, yo
must open and set active at least one of the sheets which make up the sche

To execute the default schematic checks, perform the following steps:

1. Activate the Schematic Editor window you wish to check by placing the
cursor in the window and clicking the Stroke mouse button.

2. Select theCheck > Schematic > With Defaults menu item. Errors and
warnings are displayed in the Check Schematic window by default for e
individual check. The error log, by default, is displayed in its own windo
but can be sent to a file, or to the transcript.

Note

The check settings you specify with theCheck > Sheet > Check
As Specified > Using Current Settingsmenu item are set only
for that execution of the Check command. However, the curren
settings can be saved as default settings by setting the “Updat
Default Settings” switch from the Sheet Check dialog box.
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To set up your own default schematic checks, perform the following steps:

1. Activate a Schematic Editor window by placing the cursor in the schem
window and clicking the Stroke mouse button.

2. Execute theSetup > Check > Schematic... menu item. The Default
Schematic Check Settings dialog box appears in the active Schematic
Editor window.

3. Select the checks you wish to execute by clicking the Select mouse bu
beside the appropriate check name button. Select one of the three but
displayed for each check. The labelErrors/Warnings  means display both
error and warning messages, the labelErrors only  means display errors
only, and the labelNo check means this check is not executed. See the “The
Check Command” section in Chapter 5 for a detailed discussion regardi
Default Schematic Check Settings.

4. Press theOK  button, when check settings are complete.

Default check settings you set with theSetup > Check menu item are set
only while in the application. When you exit from Design Architect thes
settings are lost. The required default checks are set when Design Arc
is invoked.

To specify and execute a set of schematic checks, perform the following ste

1. Activate a Schematic Editor window by placing the cursor in the schem
window and clicking the Stroke mouse button.

2. Choose theCheck > Schematic > As Specified >  Using  Current
Settings menu item. The Schematic Check dialog box appears in the ac
sheet window. The check settings in the dialog box show how they we
last set.

Alternately, you can choose theCheck > Schematic > As Specified >
Using Default Settings menu item. The Schematic Check dialog box
appears in the active sheet window. The current internal default check
settings are displayed in the dialog box.
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3. Select the checks you wish to execute by clicking the Select mouse bu
beside the appropriate check name button. Select one of the three but
displayed for each check. The labelErrors/Warnings  means display both
error and warning messages, the labelErrors only  means display errors
only, and the labelNo check means this check is not executed.

4. Press theOK  button when check selection is complete. The checks sele
are now executed.

Note

The check settings you specify with theCheck > Schematic >
Check As Specified > Using Current Settingsmenu item are set
only for that execution of the Check command. However, the
current settings can be saved as default settings by setting the
“Update Default Settings” switch from the Sheet Check dialog
box.
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Saving a Sheet and Registering a Schematic

To save a schematic sheet and register a schematic, execute theFile > Save Sheet
menu item. The schematic sheet is saved, and the schematic (all the schem
sheets) is registered to the default component interface for the component
specified when the sheet was opened.

To save a schematic sheet and change the registration, follow these steps:

1. When the schematic sheet is ready to be saved, select theFile >
Save Sheet > Change Registration/Labelmenu item. The Save Sheet
dialog box appears in the active Schematic Editor window

2. Using the Save Sheet dialog box, execute the following steps:

a. To delete registration from component interface(s), type the name 
the component interface to delete in theDelete Registration From
Interfaces text entry box.

b. To register the schematic to another component interface(s), type 
component interface name in theAdd Registration From Interfaces
text entry box.

c. To remove multiple labels associated with the component interface
type one label per box in theRemove Labels text entry boxes.

d. To add multiple labels to a component interface(s), type one label 
box in theAdd Labels text entry boxes.

Schematic registration is discussed in more detail in Chapter 2. See “Schematic
Registration”.
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Creating a Bus and Bus Connections

Buses let you represent multiple nets without drawing them individually. This
increases drawing speed, reduces space requirements, and increases reada
Figure6-11 shows a typical bus, four inverters connected into a bus for a set
output nets.

Figure 6-11. A Bus Connected to a Four-Wide Output Port

The following topics describe procedures that demonstrate:

• How to create and represent buses

• How to run individual lines from the bus through the use of bus rippers

Information is also presented on the use of the netcon component, which is u
connect two nets having different Net property values.
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Creating a Bus

You create a bus by assigning a net name which defines an array of nets. N
name syntax is described in the “Basic Pin and Net Naming Syntax” section in
Chapter 2. For example, a bus could use the following naming conventions:

“bus_net_name(msb:lsb)”

• bus_net_name is the name of the net representing the bus. It can be an
legal name allowed in Design Architect. No space is allowed between 
name of the bus net and the parenthesis. The parenthesis is required. 
example of a bus name isaddress.

• msb is the most significant bit of the bus. No spaces are allowed betwe
the msb, the first parenthesis, and the bus_net_name. The colon must
follow the most significant bit, with no intervening spaces.

• lsb is the least significant bit of the bus. Following the least significant b
of the bus is the final parenthesis.

Downstream applications such as Design Viewpoint Editor (DVE) and Quick
II interpret buses based on bit ordering; the bit appearing first is considered 
the msb (that is, “0:7” labels bit 0 as the msb, whereas “7:0” labels bit 7 as th
msb).

When Design Architect compares or evaluates values on a bus, it scans the
of bit values from left to right. Thus, you can arrange your wires in ascending
order (from left to right) or you can arrange your wires in descending order (o
again, from left to right).

Regardless of the way you number the wires in your bus, you must always b
consistent within your design. Portions of the same bus must always have its
arranged in the same order.
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When you name buses, keep the following limitations in mind:

• The least significant bit and most significant bit must be non-negative.

• No suffix is allowed following a right parenthesis. Thus, net name A(10
legal, but name A(10)IN is illegal. The Check command will report an er
if such suffixes are encountered.

An example of a full bus name isaddress(31:0). This name represents the
following:

• A bus whose name isaddress

• A bus whose wires range from 31 to 0 (zero)

Again, the ordering of the bits is a convention you establish within your
schematic. Design Architect only checks that the bus lines define legal limits
numbers.

To create a bus from a net, perform the following steps:

1. Draw the bus:

a. Click on the[Add_Route] Add Bus icon, press the Shift-F3 (Add Bus
function key, or choose either theAdd > Bus or theNet > Add Bus
popup menu item.

b. Press the Select mouse button at the start location for the bus.

c. Move the mouse cursor to the end location of the bus, and double 
the Select mouse button.

d. Click theCancel button on the prompt bar to terminate the Add Bus
command.
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2. Name the bus:

a. Select a vertex on the bus segment by clicking the Select mouse b
on one of the vertices.

b. Click on the[Text] Net Name icon, or choose theNet > Name Nets
popup menu item. The Add Property dialog box appears.

c. Type “Net” in theProperty Name text box.

d. Type the name that defines the bus in theProperty Value text box. Net
name syntax is described in Chapter 2 in “Basic Pin and Net Naming
Syntax”.

e. Press theOK  button.

f. Move the cursor in the schematic window. Press the Select mouse
button and drag the property name text to the location to where you
want it displayed. Release the mouse button.

Representing a Bus Graphically

To increase the readability of your schematic, you can represent buses with
different graphical rendering (line width and style). The default bus width is th
pixels, and the default style is solid. To change the graphical rendering for the
perform the following steps:

1. Click the Select mouse button on the bus graphic to select it.

2. To change the graphical rendering for the bus width, select the desired
Net > Change Net > Width > 1 pixel | 3 pixels | 5 pixels | 7 pixels menu
item.

3. To change the graphical rendering for the bus style, select the desired
Net > Change Net > Style > Solid | Dot | Long Dash | Short Dash menu
item.
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Creating a Bus Ripper

On a schematic sheet, you may be required to run individual lines from the b
either another bus or a component. To accomplish this on your schematic, y
need a special component called abus ripper. A bus ripper connects individual
lines or sub-buses from a source bus to a destination wire, bus, or device pin
precise order.

The bus ripper has a Class property value of “R”, indicating that the compone
used to extract a range of lines from a bus (see Table3-4, “Structured Logic
Design Properties” in Chapter 3).

The following topics provide information about the bus ripper component, an
directions for connecting a bus ripper to a DRAM with eight data pins.

Understanding the Bus Ripper Component

You can find the bus ripper component in$MGC_GENLIB/rip. Figure6-12
shows a bus ripper for connecting eight wires to a bus. Figure6-12represents only
one type of bus ripper (8x1); many other types are also available.

Figure 6-12. A 8x1 Bus Ripper from $MGC_GENLIB/rip

Table6-2 describes the variations of the bus ripper that are available:

Table 6-2. Available Bus Rippers in $MGC_GENLIB/rip

Symbol
Name

Description

1X1 1 wire wirex 1 grid

1X2 1 wire x 2 grids

1X3 1 wire x 3 grids

1X4 1 wire x 4 grids

8X1 8 wires x 1 grid

RRRRRR R R
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To select and activate an instance of a bus ripper symbol on a schematic sh
perform the following steps:

1. Click the Select mouse button on the[Add_Route] Library  icon. This
displays the library palette.

2. Click the Select mouse button on “gen_lib” in the library palette. This
displays the components in$MGC_GENLIB.

3. Scroll down the component names until you see “rip”. Click the Select
mouse button on the arrow after the name. This displays the list of bus
ripper symbol names shown in Table6-2.

4. Click on the name of the desired symbol. The Place Active Componen
prompt bar is displayed.

5. Move the cursor to the schematic window. Press the Select mouse bu
and hold. A ghost image of the symbol is displayed. Drag the ghost im
to the location desired and release the mouse button.

Each bus ripper pin owns a Rule property. This property tells you which lines
extract from a “source” bus. Figure6-12 shows each bus ripper pin having this
property, as identified by the series of eight “R” characters. The Rule proper
called the “Ripping Rule,” identifies the bus lines that the ripper taps.

1r1 1 wire x 1 grid, rounded corner

1r2 1 wire x 2 grids, rounded corner

4X1 4 wires x 1 grid

3X1 3 wires x 1 grid

2X1 2 wires x 1 grid

16X1 16 wires x 1 grid

Table 6-2. Available Bus Rippers in $MGC_GENLIB/rip  [continued]

Symbol
Name

Description
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When the bus ripper is first instantiated, each Rule property is set to a defau
value of “R”. You must change this property to identify what line or lines of th
source bus are connected to an attached net, pin, or sub-bus. For example, 
change the Rule property to “1”, then any pin or net attached to that ripper is
connected to the “number one” wire of the bus. You must not leave the Rule
property unchanged, or you will produce an error when you check the sheet.

Each bus ripper component has at least two pins: the “wire” end and the “bu
end. Figure6-13 shows a 1x1 bus ripper illustrating the wire end, the bundle e
and the Rule property.

Figure 6-13. Bus Ripper Symbol

The bundle end is actually a pin that has a Pin property value called “bundle”
wire end is also a pin, and (for Mentor Graphic-supplied bus rippers) has a P
property value called “wire”. The property value is not required to be “wire”.

If you wish to create your own bus ripper component, your bus ripper compo
must have only one pin whose Pin property value is “bundle”. Each other pin 
own a Rule property, and the symbol body must own a Class property with a 
of “R”. If your bus ripper does not have these characteristics, then your bus r
will not work correctly in Design Architect.

<-- Bundle End

<-- Rule Proper

Wire End -->

R
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In addition, when you tap a source bus with your own bus ripper, you must o
the following the connection rules:

1. The bundle end must always be graphically connected to the bus you 
to tap. If you are connecting two buses together, then the bundle end m
be connected to the source bus (the bus whose wires you want to tap)

2. When you connect the wire end, it must be connected to a single net t
represents a single wire or a range of tapped wires (destination bus).

If you are connecting a source bus to a destination bus (sub-bus), then
wire end must be connected to the destination bus.

Figure6-14 shows how the bundle and wire ends must be connected to a bus
bundle end must be connected directly to the bus you want to tap.

Figure 6-14. Installing a Bus Ripper

Bus rippers allow you to tap the entire source bus or a specific range of wire
That is, bus rippers are not restricted to tapping only single wires. Figure6-15
shows an example of a bus NETS(3:0), created by bundling individual wires
a sub-bus called STROBES(127:126) branching off a larger bus. Bus ripper
components from$MGC_GENLIB are used in both cases.

O

BUS(0:7)
BUS(0:7)

Bus Installation

If a bus is installed backward, you will receive
an error when a Check command is executed.

Bundle end
extends towards
bus

Yes No

WireWire
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The STROBES bus taps the bus wires NETS(3) and NETS(2) (which are the 
as the wires named QB and Q, respectively), and assigns them to STROBES
and STROBES (126). Thus, the following wires are equivalent:

QB = NETS(3) = STROBES(127) and Q = NETS(2) = STROBES(126)

Figure 6-15. A Bus with a Connected Sub-Bus

You must alter the Rule property in a special manner when you run a group 
wires from a source bus. Figure6-16 illustrates the following rules for connecting
sub-buses through the use of a bus ripper:

• The Rule property value specifies a range of wires to be extracted. You
use the following methods to identify which wires you want to tap:

a. The Rule property value follows the range of nets to be ripped. The
range format “bus_line1:bus_line2” represents the beginning and
ending wires of a range of wires to be tapped. The colon must be
present between the numbers, with no intervening spaces. For exa
0:10 is a legitimate way to specify that you want to tap the first to
eleventh wires of the bus as a range.

b. The Rule property value can specify a group of non-sequential wire
the format “wire, wire, [wire]”; “wire” can be any wire on the bus. If

CLK

CLR

Q

QB o

o

o

o
0

1

2

3

NETS(3:0)

STROBES(127:126)

3:2

Bus Rippers
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the source bus wires are in ascending order, then the order of the ta
wires must be in ascending order; and if the source bus wires are i
descending order, then the order of the tapped wires must be in
descending order. Here are legitimate examples: 0, 3, 6, 9 or 8, 6, 

c. The Rule property value can mix single wires with a range of wires
Here are legitimate examples: 0, 3, 5:12    or    20:10, 7

d. The Rule property can be parameterized, allowing the same schem
sheet to be used in different designs which require different wires t
extracted from a bus. Here is an example of a parameterized Rule
property: w, x, y, z

In this example, a value must be supplied, using the Add Parameter
command for each parameter in DVE. A value can be supplied in Desi
Architect with the Set Parameter command. If no value is supplied to th
parameter in Design Architect, a warning message “undefined parame
occurs when the schematic is checked.

• The most significant bit and the least significant bit must match. If you
always put the least significant bit first when you name a bus, you mus
continue to follow that convention. The same holds true if your naming
convention puts the most significant bit in the first position of the bus na

Figure 6-16. A Bus Ripper Extracts a Range of Lines

QB

NETS (3:0)

STROBES (127:126)3, 0

3

The Rule property designates the MSB of the
NETS bus to go to bit 127 of the STROBES

bus. The LSB goes to bit 126.
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Connecting a Bus Ripper

The following steps show you how to connect the address pins of a 4164_20
DRAM to an 8x1 bus ripper, and then how to connect the bus ripper to a bus
DRAM component is available in the $MGC_DRAMLIB library.

1. Place the source bus,address(7:0), an 8x1 bus ripper component, and the
DRAM component onto your schematic sheet, as shown in Figure6-17.

Figure 6-17. Basic Layout

2. Flip the bus ripper component vertically, by first selecting the bus rippe
component and then executing theInstance > Rotate/Flip >
Flip > Vertical popup menu item. To flip and also move the bus ripper,
execute theInstance > Move > Flipped > Vertical popup menu item.

3. Draw a net segment between the wire end of each separate bus rippe
pin on the memory component. To draw a net segment from the top-m
pin on the bus ripper to the top-most pin on the memory component,
perform the following steps:

a. Press the F3 (Add Wire) function key or click the Select mouse butto
on the[Add_Route] Add Wire  palette icon.

b. Click the Select mouse button on the bus ripper pin.

address(7:0)

4164_20

D

A6
A5
A4
A3
A2
A1
A0

Q
_C

A
S

_R
A

S

_W
A7

R

R

R
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R

R

R
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c. Move the cursor to the corresponding pin on the memory compone
and double click with the Select mouse button.

d. Repeat steps b and c for all the bus ripper pins.

e. Click theCancel button in the prompt bar.

4. Change the Rule property of each separate bus ripper pin to indicate w
wire you want your DRAM pin to match. For example, if you want pin A
to connect to address(0), then you must change the Rule property valu
the given bus ripper to “0”.

To change the Rule property value of each individual bus ripper, perfo
the following steps:

a. ‘Click the Select mouse button on the[Text] Sequence Text icon.

The Sequence Text dialog box is displayed as shown below:

SEQUENCE

3

2

1

NAME
NAME
NAME

TEXT

Sequence Text

New Prefix

OK Reset Cancel

Beginning Index Number 0

Step By 1

Sequence Type

Text will be sequenced

New Suffix

Fill in Form

Click

ManualAuto

left to right, top to bottom. Choose Sequence Order...
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b. Type the initial index number (for this example “0”) representing th
first Rule property value in theBeginning Index Number text box.

c. TheStep By value determines the difference between sequenced
property values. You can also specify a prefix and suffix for the
property values.

d. Click onAuto for the Sequence Type.

e. (optional) Click onChoose Sequence Order... to change the sequence
order.

f. Click OK .

g. The Select Area prompt bar is displayed. Move the cursor to the to
the bus ripper. Press and hold the Select mouse button; move the c
so that all the “R” property text is within the dynamic rectangle. Be s
no other property text is within the selected area. Release the Sele
mouse button.
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Design Architect automatically replaces the Rule property values within
selected area. Figure6-18 shows the memory component and the bus ripp
after you complete the preceding steps. Note that all the original “R” va
of each bus ripper have been changed to indicate what bus line a pin g
to.

Figure 6-18. Fully Connected Bus Ripper

5. Connect the top of the bus ripper to theaddress(7:0) bus with a net
segment. This step does not require you to perform any special action
other than connecting the bus ripper and theaddress bus. Table6-3 shows
how each pin relates to theaddress(7:0) bus.

Table 6-3. Pin and Bus Line Connections

Pin Name Data Bus
Connection

Rule Property
Value

A0 address(0) 0

A1 address(1) 1

A2 address(2) 2

A3 address(3) 3

A4 address(4) 4

address(7:0)
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D
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Instantiating 1x1 Bus Ripper Automatically

When the ripper mode is set to “auto” using either the $set_ripper_mode()
function or the $setup_ripper() function, Design Architect places a real rippe
symbol. At startup, Design Architect uses the 1X1 ripper symbol from the
$MGC_GENLIB/rip component. You can change the default using the
$setup_ripper() function.

Using the Automatic 1x1 Bus Ripper

The following steps show an example of using automatic ripper instantiation

1. Route a wire to a bus; the bus ripper is placed automatically.

2. Select the bus ripper and its net.

3. ChooseCopy > Multiple  from one of the popup menus. In the prompt b
enter the number of additional ripped nets you need. For example, if yo
need eight bus rippers, enter “7” for the number of copies.

4. Position the first copy and click the Select mouse button. The copies a
created at an equal displacement.

A5 address(5) 5

A6 address(6) 6

A7 address(7) 7

Table 6-3. Pin and Bus Line Connections  [continued]

Pin Name Data Bus
Connection

Rule Property
Value
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Creating an Implicit Bus Ripper

Implicit rippers are the default when you invoke Design Architect. To place a
implicit ripper, follow these steps:

1. Execute the ADD WIRE palette menu item to display the Add Wire prom
bar.

2. Route the wire between the bus or bundle and the object to which you
connecting it using a single click for the beginning of the wire and a
double-click for the end of the wire. If the ripper is set for a 45-degree
angle, you will need to take that into account when placing the wire.

3. If the wire is routed into a bus, Design Architect displays the Choose B
Bit dialog box, which tells you the bus name. Follow these steps:

a. Beside “Bit,” enter the bit of the bus that you are ripping. You can
either specify just the bit number, such as “17” from bus “data(19:0
in which case Design Architect puts the bus name and parenthese
around the bit; or you can specify the entire bus/bit name, such as
“data(17).”

b. OK  the dialog box.

4. If the wire is routed into a bundle, Design Architect displays the Choos
Bundle Member dialog box. Follow these steps:

a. Either select the bundle member to be ripped from the list of memb
or enter the name of a bundle member in the “Bundle Member” ent
field. Text that you enter will override any selections made in the lis

b. OK  the dialog box.

5. If the wire is routed into an unnamed wide net, Design Architect displa
the Name Ripped Net dialog box. Follow these steps:

a. Enter the name of the wide net beside “Wide Net Name.” You can
create either a bus or a bundle using the wide net name.
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b. Enter the name of the ripped bit beside “Ripped Net Name.” Make 
that you enter the entire name, such as “out(3)” from bus “out(7:0)”
Giving only a bit number will result in an error during a Check Shee

c. OK  the dialog box; the Add Property To Handle prompt bar appear

d. Click the Select mouse button in the appropriate location to place t
new wide net name.

Changing the Type of Ripper

Implicit rippers are the default when you invoke Design Architect; they are no
library symbols, but rather instances that look like rippers. To change the de
setup from implicit rippers to the$MGC_GENLIB/rip symbol, follow these steps

1. Display the Setup Ripper dialog box using the SETUP RIPPER palette
menu item.

2. Press the button beside “Auto” under “Set Ripper Mode.”

3. If appropriate, change other specifications you need for the ripper sym

4. OK  the dialog box.

To change from auto rippers to implicit rippers, follow these steps:

1. Display the Setup Ripper dialog box using the SETUP RIPPER palette
menu item.

2. Press the button beside “Implicit” under “Set Ripper Mode.”

3. If appropriate, change other specifications you need for the ripper sym

4. OK  the dialog box.
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Changing the Angle for Implicit Rippers

When you invoke Design Architect, the default ripper is an implicit ripper set 
45-degree angle. You can set implicit rippers so that they are attached at a
90-degree angle. To do this, follow these steps:

1. Display the Setup Ripper dialog box using the SETUP RIPPER palette
menu item.

2. Press the button beside “Straight” under “Set Implicit Ripper.”

3. If appropriate, change other specifications you need for implicit rippers

4. OK  the dialog box.

Using the netcon Component

The net connector component$MGC_GENLIB/netcon is used to connect togethe
two nets possessing different Net property values. In Design Architect, the re
is a single net with two names. But when the schematic is evaluated, the two
property values become the same.

There are several occasions when you might want to use the netcon compo
For example, you might be copying a portion of an earlier schematic into the
you are currently working on, and find a mismatch in the names of some of t
wires on the two designs (you named the reset line “Reset” on one design a
“Rst” on the other). By connecting the appropriate nets together with netcon,
can avoid changing either of the Net property values.

NOTE: Although use of netcon may be convenient at times, if it is used too o
the time spent in evaluating the design can increase dramatically.
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Creating and Naming a Net Bundle

You can create a net bundle by adding a Net property to a wide net. The val
the Net property must include a comma-separated list of nets, buses, and/or
net bundles. Specifically, net bundle syntax requires a list to be enclosed in 
braces “{}”; for example, “{ground,clk,data(15:0)}.”

A member of a net bundle is defined as a net, bus, or nested bundle contain
the list of a net bundle. If a bundle includes a nested bundle, the members o
nested bundle must be enclosed within curly braces; for example,
“{clk,data(15:0),{ground,out(15:0)}}.”

A net bundle list can be preceeded by a bundle name. Such names cannot b
expressions or include parentheses, square brackets, curly braces, or slashe
example “BUND{ground,clk,data(15:0)}.”

You can refer to an existing bundle without again listing its members by using
bundle name and empty curly braces, but only if the full list of members has 
defined elsewhere on the sheet or on another sheet of the schematic. For ex
“BUND{}” identifies the same net bundle as “BUND{ground,clk,data(15:0)}”
within the same schematic.

A net bundle definition can span multiple sheets of a schematic. You create 
bundle using the following steps:

1. Draw a wide net on a sheet.

2. Select the new net.

3. Use theName Nets pulldown menu item to name the net using bundle
syntax within the value of the Net property.

You can edit a net bundle by changing the value of the Net property. Errors ca
by editing the syntax of a net bundle are identified only when the sheet or
schematic is checked. For more information on creating properties, refer to
“Assigning Properties and Property Owners” in the chapter.
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Net bundles have the following characteristics:

• A net bundle can contain nets, buses, and other net bundles.

• A net can be contained within different net bundles.

• Only one net bundle in a schematic needs to list the contents; all other
occurrences of the net bundle can use the bundle name followed by “{

• The contents of all occurrences of a named net bundle in a schematic 
be the same; there cannot be two net bundles of the same name in the
schematic, but containing different members.

• A net that is a member within a bundle is the same as the net by itself;
is, a new net is not created when it is placed in a bundle.

• A net bundle can have properties. However, the properties on a net bu
are not propagated to the individual members, since a net or bus can b
multiple net bundles and there is no way to determine which property
should be used if a conflict occurs.

• The order in which the members are specified in a net bundle defines 
position. Two declarations of the same net bundle where the members
listed in a different order will produce an error when the sheet is check

• The position of a member in a net bundle is important when connecting
pins.

• A net can appear more than once in a single net bundle.

• A net can be ripped more than once from a net bundle.

• A net bundle can connect to pin bundles or wide pins. The connection
between the members in a net bundle and the members in a pin bundl
wide pin is mapped by position.

• A net bundle can be connected through a Net Connector to another ne
bundle of the same width, or to a bus of the same width.
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• The width of a net bundle is the total number of individual nets and bus
in the bundle. If a net bundle contains a bus, the bits of the bus are cou
in the width, but not the bus itself. The same is true for the elements of 
bundle included in another net bundle.

• The width of the net bundle must match the width of a connecting pin
bundle or wide pin.

• A net bundle name cannot be a parameterized expression.

• Nets are ripped by name from a net bundle; the ripped net must exist i
net bundle.

• A net bundle can contain parameterized buses.

• The name of a bundle member must be explicit; names generated thro
evaluating an AMPLE expression are not allowed.

For more information on pin bundles, refer to “Adding and Naming a Pin Bundle”
in the chapter.

Note

Net bundles are named using the entire Net property. Thus the
bundle “B{x,y}” is named “B{x,y}”, whereas the bus “B(3:0)” is
named “B”.
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Ripping Members from Net Bundles

You can rip members from net bundles by name, which is similar to ripping b
of a bus by bit position. To rip a member of a net bundle, follow these steps:

1. Choose the ADD WIRE palette icon to display the Add Wire prompt ba

2. Connect the net bundle and the object to which the new wire leads; th
Choose Bundle Member dialog box appears.

3. Choose a member from the list or enter the name of the member you w
to rip from the bundle beside “Bundle Member.”

4. OK the dialog box.

The name of the ripped bundle member appears beside the wire and i
the value of the Net property for that wire. Figure6-19 illustrates the
Choose Bundle Member dialog box.

Figure 6-19. Choose Bundle Member Dialog Box

Choose Bundle Member

OK Reset Cancel

Members on attached bundle:

Clk

ClkBundle Member:

gnd
data(19:0)
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Creating FOR, CASE, and IF Frames

FOR, IF, CASE, and OTHERWISE frames are tools provided by the Design
Architect Schematic Editor to allow repetitive or conditional inclusion of circui
in the final netlist.

Creating FOR Frames

There are many times you find yourself repeating the same circuit over and 
Although you can copy the circuit so that it appears in its entirety as many tim
as it is needed, by using FOR frames you can save disk space, minimize the
number of pages a schematic fills, and make the design easier to understan

Furthermore, by using a property value variable in the frame expression, the
schematic sheet can be used in different designs requiring a different numbe
copies of that frame.

To add a FOR frame that repeats the same circuit “N” times, perform the
following steps:

1. Execute theAdd > Frame menu item. The Add Frame prompt bar appea
with the location cursor in the “Frame Expression” text box.

2. Type a FOR frame expression, for example: “FOR I := 0 TO N-1”. Refe
“Frexp Property” in Chapter 3 for a description of valid FOR frame
expression syntax.

3. Click the Select mouse button on the “Frame Area” button.

4. Position the moving pointer at the initial edge of the frame. Press, but 
not release the Select mouse button.
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5. Move cursor to the desired size of the frame, and release the Select m
button. Refer to Figure6-20 for an example circuit enclosed in a FOR
frame.

Figure 6-20. FOR Frame Example

Creating Repeating Instances

A repeating instance is a short-hand method of creating FOR frames for sing
instances. To create a repeating instance, follow these steps:

1. Select the instance that you want to repeat in your design.

2. Execute theProperties > Add schematic popup menu to display the Add
Property dialog box.

3. Select the “INST” item in the list box under “Existing Property Name.”

4. Enter a name followed by a continuous range enclosed in parentheses
beside “Property Value.”

5. Choose the type of visibility appropriate in your design for the Inst
property.

6. OK  the dialog box.

FOR I := 0 TO N-1
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EN
OUT(I)
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The following are rules used to determine which nets attach to which pins of
repeating instance:

• If a single bit pin is connected to a single bit net, then the net will be
connected to the pin on each repeated instance.

• If a single bit pin is connected to a bus or bundle, then the width of the
or bundle must be equal to the number of times the instance is repeated
pin on each repeated instance will be attached to the bus bit or bundle
member in the matching position.

• If a wide pin is connected to a bus of the same width, then the bus will
connected to the wide pin on each repeated instance. Likewise, if a wid
is connected to a net bundle of the same width, then the net bundle wi
connected to the wide pin on each repeated instance.

• If a wide pin is connected to a bus which is wider than the pin, then the
width must be equal to the width of the pin times the number of times t
instance is repeated. Each sub-bus with a width equal to the width of th
will be connected to the pin on the repeated instance. A wide pin cann
connected to a net bundle with a different width.

• A bus connected to a wide pin must be named.

• All other connections are illegal and result in an error during Check Sh

Figure6-88 illustrates an example of a repeating instance.

Figure 6-21. Repeating Instance Example

NEW(3:0)

X(3:0)

DATA(15:0)

CLK

INST = XINST(3:0)

(1)

(2)

(4)

(5)

(6)
Bund{N1, N2}

A(3:0)

CLK

B(3:0)

X

D(1:0)
(3)

Bund1{N1, DATA(1:0), N2} BP
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Assume that the system calls the instance “I$231.” When the sheet is written
Design Architect creates a FOR frame with the expression
“FOR I231_REPEAT := 3 downto 0.” When the EDDM evaluates the FOR
frame, it generates four instances named XINST#3, XINST#2, XINST#1, and
XINST#0. Each instance has the same set of pins, A(3:0), B(3:0), CLK, X, BP
D(1:0), but some are attached to different nets.

1. The pin XINST#3/A(3:0) is attached to the net DATA(15:12); the pin
XINST#2/A(3:0) is attached to the net DATA(11:8); the pin
XINST#1/A(3:0) is attached to the net DATA(7:4); and the pin
XINST#0/A(3:0) is attached to the net DATA(3:0).

2. The net CLK is attached to the CLK pin on each repeated instance.

3. The pin XINST#3/BP is attached to the net N1; the pin
XINST#2/BP is attached to the net DATA(1); the pin
XINST#1/BP is attached to the net DATA(0); and the pin
XINST#0/BP is attached to the net N2.

4. The pin XINST#3/B(3:0) is attached to the net NEW(3:0), as is the pin
XINST#2/B(3:0), and so on.

5. The pin XINST#3/X is attached to the net X(3), the pin XINST#2/X is
attached to the net X(2), and so on.

6. The pin XINST#3/D(1:0) is attached to the net bundle Bund{N1, N2}, a
the pin XINST#2/D(1:0), and so on.

Creating IF Frames

IF frames let you conditionally include circuitry in your schematic. An IF frame
created in the same way as a FOR frame, except the IF frame follows its ow
frame expression syntax. To create an IF frame follow the procedure describ

Note

The FOR frame expression is created as a “to” expression whe
the subscript is ascending and as a “downto” expression if the
subscript is ascending and has no parameters.
Design Architect User’s Manual, v8.6_2 6-89



Design Error Checks Operating Procedures

n. If

ot
u

 in a
 If the
SE

if an

OR

 You
eet is

tside
you

e

eter
“Creating FOR Frames”. Refer to “Frexp Property” in Chapter 3 for a description
of valid IF frame expression syntax.

The evaluation of an IF frame expressions results in a True or False conditio
True, the enclosed circuitry is included in the schematic sheet. If False, the
circuitry is not included in the schematic sheet. The Check command does n
check non-included circuitry. You may want to check your circuitry before yo
create an IF frame around it.

Creating CASE, OTHERWISE Frames

CASE frames allow you to define cases when a portion of a circuit is included
schematic sheet. You can have multiple CASE frames in a schematic sheet.
CASE frame expression evaluates to True, the circuitry is included. If the CA
frame expression evaluates to False, the framed circuit is not included, and 
OTHERWISE frame exists, the circuitry within the OTHERWISE frame is
included. CASE and OTHERWISE frames are created in the same way as F
frames, except the CASE and OTHERWISE frames have a different frame
expression syntax.

To create a CASE or OTHERWISE frame follow the procedure described in
“Creating FOR Frames”. Refer to “Frexp Property” in Chapter 3 for a description
of valid CASE and OTHERWISE frame expression syntax.

Setting Parameters

You need to provide a value for any variables included in frame expressions.
can set a parameter value in Design Architect which is used only when the sh
checked. Although this value is stored with the sheet, it is not recognized ou
of the sheet or by other tools. Suppose you have some framed circuitry that 
want repeated ten times, and the Frexp property value is “FORI = 0 TO N-1”. To
provide a value to be used when the sheet is checked, do the following in th
Schematic Editor:

1. Choose theCheck > Parameters > Set menu item to display the Set
Parameter prompt bar.

2. Enter “N” in the parameter name text entry box, and “10” in the param
value text entry box in the prompt bar. Click theOK  button.
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Another method of assigning a value to the variable is to add a property to th
symbol body representing the sheet, or to an instance of that symbol on a hi
level sheet. You can add the property to the symbol body and give it some du
value that you change for different instances of the symbol (similar to Net an
Rule property values). Here are the steps using the previous frame expressi

1. Open the component in the Symbol Editor.

2. Select the symbol body (be sure nothing else is selected).

3. Click the Select mouse button on the Add Property icon in the Text pal
This displays the Add Property dialog box.

4. Enter “N” for the property name and “1” for the property value, click the
typeNumber and the stability switchVariable buttons, then clickOK .

5. Move the cursor to a location for the text, and click the Select mouse
button.

6. To indicate the meaning of the number on the symbol, choose the[Text]
Add Text icon.

7. Type “N=” in the text entry box in the displayed prompt bar. Click theOK
button, move the cursor to the left of the “1” and click the Select mouse
button.

When you place the symbol on a sheet, you can change the value of N for th
instance. Because the property stability is variable, its value can be changed 
time.

You can also assign values to variables through back annotation and design
viewpoints. Back annotated values take precedence over all others, followed
instance-specific values.
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Creating a Symbol
Sometimes you will start working on a new symbol, other times you will wan
extend or modify an existing symbol. If you are unfamiliar with the basic elem
of a symbol, or the concepts of editing a symbol in-place on a schematic she
read “Elements of a Symbol” in Chapter 2 before you continue on.

Opening a Symbol Editor Window

To open a Symbol Editor window from the Design Architect Session window
click the Select (left) mouse button on the[Session] Open Symbol palette icon, or
press the F1 (Open Sheet) function key, or type the command or function in 
popup command line, or execute theSession > Open Symbol popup menu. This
menu displays the Open Symbol dialog box and prompts you for the name o
component you wish to edit.

To help you select the component you wish to use, press the Navigator butto
The dialog navigator appears on the screen allowing you to traverse your dire
structure to select a Design Architect component. Refer to “Using the Dialog
Navigator” in this chapter for a description of how to use the dialog navigator

You can replace the symbol name by pressing the Options button (which op
the expanded Open Symbol dialog box), and type the new symbol name in t
Symbol Name text box. Also, from the expanded Open Symbol dialog box, y
can open the symbol as editable or read-only. If you want to execute a startu
for this symbol, clickYes for that option and enter the file pathname.

After the argument selections are complete, press theOK  button.
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 3
Setting Up the Symbol Editor

Before you start working on a symbol you can change some or all of the defa
attribute settings for your symbol editing environment. Attributes such as pin
spacing, grid spacing and snap, and symbol body attributes are all set to def
settings when a new Symbol Editor window is opened. Menu items containe
theSetup andSet menus set these attributes.

The following procedures show you how to setup these attributes. Refer to
“Object Attributes” in Chapter 2 for a summary of object attributes.

Setting Grid and Pin Spacing

The procedure for setting grid and pin spacing is the same as in the Schema
Editor setup. Refer to “Setting Pin Spacing” in this chapter, and “Setting Grid
Spacing and Snap”, also in this chapter, for these procedures.

Setting Symbol Body Attributes

To set up symbol body text and graphical drawing attributes, perform the
following steps:

1. Place cursor in a Symbol Editor window and press the Select mouse b

2. Execute theSetup > Setup Defaults > Symbol Bodymenu item. The
Setup Symbol Body dialog box appears in the active Symbol Editor
window.

3. Click with the Select mouse button on the line style you want (Solid,
Dotted, Long Dash, Short Dash, Centerline, and Phantom).

4. Click with the Select mouse button on the line width you want (1 pixel,
pixels, 5 pixels, 7 pixels).

5. Type in the font name you want. Fonts and font registries for all
workstations are located in$MGC_HOME/registry/fonts. The default is the
“stroke” font.

6. Type in the text height you want. The default height is 0.75 user units.
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7. Type in the text orientation you want (0 or 90 degrees). The default is 
degrees (horizontal).

8. Click with the Select mouse button on the text vertical justification you
want (Top, Center, Bottom).

9. Click with the Select mouse button on the text horizontal justification y
want (Left, Center, Right).

10. Click with the Select mouse button to set the orthogonal drawing mode
(On, Off).

11. Click with the Select mouse button on the text transparency you want 
Off).

12. Click with the Select mouse button on the fill type you want (Clear, So
Stipple).

13. Type in the dot size (diameter) you want. The default size is 0.1 user u

14. Click with the Select mouse button on the dot style you want (Square,
Circle).

15. Press theOK  button, when symbol body attribute selection is complete.

Drawing a Symbol Body

A symbol body can be made up of the following graphical entities:

• Arcs

• Circles

• Dots

• Lines

• Polygons
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• Polylines

• Rectangles

In addition, a symbol body typically has short lines, called “whiskers”, that pro
from the symbol body border to indicate where the pins will be connected. T
“whiskers” are not a required part of the symbol, but rather a convention use
the Mentor Graphics component libraries.

The menu items used to draw the symbol body are accessed from theAdd popup
menu. You can also perform these tasks by clicking the Select mouse button
the appropriate[Draw ] icon.

Before you start drawing your symbol, you can set the dot style, dot width, lin
style, line width, and polygon fill that will determine the attributes of the graph
entities. To use something other than the default values for these attributes, 
theSetup > Symbol Body menu item to change the default values. This topic 
discussed in the “Setting Symbol Body Attributes” procedure.

All graphical entities can be selected, moved, copied, or deleted.

Drawing an Arc

To draw an arc, perform the following:

1. Click on the[Draw] Add Arc  icon, or choose theAdd > Arc  popup menu
item, or press the F5 (Add Arc) function key. The Add Arc prompt bar is
displayed with the location cursor on “Initial Point”.

2. Move the mouse so the moving pointer is displayed in the active windo
Click the Select mouse button at the desired initial arc point. The locat
cursor in the prompt bar moves to “End Point”.

3. Click the Select mouse button at the desired end point for the arc. The
location cursor moves to “Arc Point”.

4. Click the Select mouse button at the desired arc point location.
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The prompt bar disappears and the completed arc is displayed. The basepo
positioned on the arc's end point. Line style and width are controlled by valu
specified in theSetup > Symbol Body dialog box, discussed in the “Setting
Symbol Body Attributes” in this chapter.

Drawing a Circle

The steps in the following list outline the procedure for adding a circle:

1. Click the Select mouse button on the[Draw] Circle  icon, or choose the
Add > Circle popup menu item. The Add Circle prompt bar appears wi
the location cursor on “Center”.

2. Position the moving cursor to the desired center point of the circle. Pre
but do not release the Select mouse button. The location cursor moves
“Circle Point”.

3. Position the moving pointer to indicate the perimeter of the circle (the
Select mouse button is still depressed). A ghost image of the circle app
in the window. Release the mouse button.

The prompt bar disappears and the completed circle is displayed. The basep
positioned in the center of the circle. The line style, line width, and fill type of
circle are controlled by the values specified in theSetup > Symbol Body dialog
box, discussed in the “Setting Symbol Body Attributes” of this chapter.

Drawing a Dot

To add a graphical dot, perform the following:

1. Select theAdd > Dot popup menu item. The Add Dot prompt bar appea
in the active symbol window. The location cursor is on “At Location”.

2. Click the Select mouse button at the desired dot point. The prompt bar
disappears and the dot is displayed in the active symbol window. The
basepoint is positioned on the dot.

Dot style and size are set by values specified in theSetup > Symbol Body dialog
box, as discussed in the “Setting Symbol Body Attributes” section of this chapter.
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Drawing a Line

To add a line, perform the following steps:

1. Select the Add > Two Point Line popup menu item. The Add Line promp
bar is displayed with the location cursor on “Endpoints”.

2. Position the moving pointer at the desired location for the initial point of
line. Press, but do not release the Select mouse button.

3. Position the moving pointer away from the initial point. You will see a li
from the initial point to the current location of the moving pointer. With t
Select mouse button still depressed, position the moving pointer to the
location of the end point. Release the Select mouse button.

The prompt bar disappears and the line is displayed. The basepoint is locate
the initial point. The line style and line width are controlled by the values
specified in theSetup > Symbol Body dialog box, discussed on in the “Setting
Symbol Body Attributes” section of this chapter.

Execute this menu item when you want to draw whiskers for pins on a symb
Place the cursor at the desired point of the border of the symbol as the initial 
of the line. As you add whiskers, it is important to remember that pins will alw
snap to the nearest grid point (as defined by the value of the arguments in th
Setup > Grid/Report/Color > Grid  dialog box) regardless of whether objects
snap to grid. Therefore whiskers should be terminated on a displayed grid
coordinate which matches the pin spacing.

Drawing a Polyline

To add multiple contiguous lines, perform the following steps:

1. Select theAdd > Polyline popup menu item, or the[Draw] Add Polyline
icon, or press the F3 (Add Polyline) function key. The Add Polyline prompt
bar is displayed with the location cursor on “Points”.

2. Click the Select mouse button at the initial point of the polyline.

3. Click the Select mouse button at each vertex of the polyline.
Design Architect User’s Manual, v8.6_2 6-97



Creating a Symbol Operating Procedures

line.

. The

or

e
the

The
4. Continue with step 3, until you have created all the vertices of the poly
On the last vertex, double-click the Select mouse button.

The prompt bar disappears and the polyline is displayed in the active window
basepoint is located on the initial point of the polyline.

The line style and the line width of the polyline are controlled by the values
specified in theSetup > Symbol Body dialog box.

Drawing a Rectangle

To create a rectangle, perform the following steps:

1. Select theAdd > Rectangle popup menu item, or the[Draw] Rectangle
icon. The Add Rectangle prompt bar is displayed with the location curs
on “Rectangle”.

2. Position the moving pointer at the desired location of one corner of the
rectangle. Press, but do not release the Select mouse button.

3. Position the moving cursor away from the initial edge with the Select
mouse button still depressed. You will see a ghost image the size of th
rectangle. At the desired location for the diagonally opposite corner of 
rectangle, release the Select mouse button.

The prompt bar disappears and the rectangle appears in the active symbol
window. The basepoint is positioned on the lower left edge of the rectangle. 
line style, line width, and fill type (clear, solid, stipple) of the rectangle are
controlled by the values specified in theSetup > Symbol Body dialog box.
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Drawing a Polygon

To create a polygon, perform the following steps:

1. Choose the[Draw] Polygon icon, or select theAdd > Polygon popup
menu item. The Add Polygon prompt bar appears with the location cur
on “Points”.

2. Position the moving pointer at the initial point of the polygon. Click the
Select mouse button.

3. Move the cursor to the next polygon vertex and click the Select mouse
button.

4. Repeat step 3 until you have created all vertices of the polygon. At the
vertex, double-click the Select mouse button, indicating you have
completed the polygon. A polygon is always a closed figure; the segme
between the initial point and the last point is automatically drawn for yo

The prompt bar disappears and the polygon appears in the active window. T
basepoint of the polygon is located at the initial point. The line style, line wid
and fill type (clear, solid, stipple) of the polygon are controlled by the line_sty
line_width, and polygon_fill arguments as defined in theSetup > Symbol Body
dialog box, discussed in the “Setting Symbol Body Attributes” section of this
chapter.

Symbol bodies can be created using several polygons layered on top of each
For example, a symbol body that looks like a motor can be created using thi
technique. The layered position of an object can be changed using thePOP TO
FRONT andPUSH TO BACK  icons on the DRAW palette.
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Slicing Geometric Objects

The $slice() function is an interactive function that allows you to cut a geome
object into two or more pieces.

You slice an object using the following procedure:

1. Select the object.

2. Execute the following menu item: Edit > Edit Operations > Slice:

The Slice prompt bar appears.

3. Draw a slice line by pressing the left mouse button, dragging the mous
across the object, then releasing the mouse button.

The selected object is first “exploded” into the lines that define it, then 
lines are sliced by the slicing line. This does not apply to arcs and circl
An arc is sliced into 2 or 3 arcs, depending on how many times the slic
line passes through the arc. A circle is sliced into two arcs if and only if
slicing line passes into and back out of the circle. If there is only one
intersection between the circle and the slicing line, no slice will occur.

In all cases, the original object is deleted and in its place are the new objects
created by the slice. The new objects do not have any relationship with the o
object. You have the ability to choose whether only one of the new sliced ob
inherits the properties from the original object or whether all new sliced objec
inherit the properties. In either case, all of the property values are displayed 
exactly the same diagram location as the original property values. If a box is
into 6 pieces, for example, and there was one property on the original graph
each of the 6 lines will have that property and there will be 6 property values a
same diagram location. If you want only one piece of sliced graphics to inher
properties, you may choose that option, then only one property value will rep
the original.

You can get the original object back by selecting the pieces of the geometric
object and executing the pulldown menu itemEdit > Make > Polygon or Edit >
Make Polyline.
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Joining Sliced Objects into Polylines and Polygons

The Make Polygon function takes a selection of polylines and lines, and if th
selection is all end to end with at most one cycle, the selected graphics will b
made into a single polygon. The procedure is as follows:

1. Select a group of polylines and lines.

2. Execute the pulldown menu:Edit > Make > Make Polygon

You may configure a closeness criteria, using the $set_closeness_criteria()
internal state function found atSetup > Other Options > Editing Parameters,
and if the line endpoints are within the closeness criteria the lines will be join
automatically.

This Make Polygon command may add an extra line to close the polygon. If 
selection is not end to end, the error “Error: Unable to connect line/polyline
segments to form polygon” will be displayed. If the polylines and lines form m
than one cycle, the error “Error: Unable to create polygon, selected items for
more than one cycle” will be displayed.

The selected polylines and lines can be made into a single polyline by execu
the pulldown menu:Edit > Make > Make Polyline.

Adding and Naming Symbol Pins

Once you have drawn the symbol body, you must include information on wh
the symbol's input and output pins are on the symbol body. A pin is named b
adding a Pin property to the pin.

Pins are graphic entities representing a connection point. The presence of a
property tells the system that an object is a pin, while the value assigned to t
Pin property separates that pin from all the others on that symbol.

Pin names appear as Pin properties on the symbol. A pin and its Pin propert
value are used to define where and what electrical connections will be made 
component. Pin properties on a symbol pin should match Net properties on t
symbol's underlying schematic sheet in order to establish cross-hierarchy
connections. Pins on a component define where an electrical connection ma
made to the component when it is placed on a schematic sheet.
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You can add pins by clicking on the[Draw] Add Pin  icon, by executing the
Add > Pin(s) popup menu item, by executing the corresponding function or
command on the command line, or by pressing the Shift-F4 (Add Pin) function
key sequence.

Pins must be placed on the pin grid which defines the minimum spacing betw
pins. Select theSetup > Grid/Report/Color > Grid  menu item (see “Setting Grid
and Pin Spacing”) to define the pin grid. Setting the displayed grid points to ma
the pin grid makes it easy to see where pins can be placed.

Adding a Single Pin

To add a single pin to a symbol, perform the following steps:

1. Press the Shift-F4 (Add Pin) function key sequence. The Add Pin prompt
bar is displayed.

2. Enter a text string representing the name of the pin. Press theTab key. The
location cursor moves to “Pin Location”.

3. Click the Select mouse button on the location for the pin.

4. Press and hold the Select mouse button, and move the ghost image o
pin name to the desired location. Release the Select mouse button.

The prompt bar disappears and the pin name appears at the specified locati

Adding Multiple Pins

To add multiple pins to a symbol, perform the following steps:

1. Select theAdd > Pin(s) menu item, or the[Draw] Add Pin  icon. The Add
Pin(s) dialog box appears.

2. Specify a value forName Height by clicking one of the buttons or typing a
value in the text entry box. This value is the height of the pin name with
respect to the pin grid.

3. Click on one of theName Placement buttons:
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• Manual. You manually specify the pin location and text location.

• Name (with diamond). You specify the pin location; the text is
automatically placed next to the pin.

• Name (with diamond and whisker). You specify the pin location; the
pin and whisker are created, and the text is placed next to the pin. W
you choose this option, specify pin locations one pin grid away from
symbol body to allow space for the whisker.

4. The Pin Type property can be IN, OUT, IXO, or you can omit it.Pin
Placement specifies whether the pin is placed to the left, top, bottom, o
right of the symbol body.

5. Enter the pin names (pin property values) in the dialog box, one per lin
Use theTab key to move to the next line. All pins specified at the same ti
have the same pintype and placement.

6. Click theOK  button on the dialog box. The Add Pin prompt bar appear
the active symbol window. The name of the first pin is displayed as the 
Property Value”. The location cursor is on “Pin Location”.

7. Click the Select mouse button at the desired pin location. If you chose
manual name placement, click the Select mouse button at the desired 
name location. If not, the pin name is placed automatically.

8. The Add Pin prompt bar is displayed again, with the name of the next 
Repeat step 7 for each pin you specified in the dialog box. After the las
has been specified, the prompt bar disappears.
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Creating Consecutive Pins

When you need to create many pins of the same type and on the same side
symbol body, the Copy Multiple and Sequence Text commands are helpful. 
following steps show how to add, copy, and renumber the pins on the symbo
the$MGC_PLDLIB/16hd8 component.

1. Click the Select mouse button on the[Draw] Add Pin  icon. This displays
the Add Pin(s) dialog box.

2. Enter the following information in the dialog box:

• Name Height: 0.75

• Name Placement: Name with whisker

• Pintype: IN

• Pin Placement: left side

• Pin name(s): 1

Click the Select mouse button onOK .

3. When the Add Pin prompt bar appears, click the Select mouse button 
pin location in the symbol edit window.

4. Move the Pintype property text (“IN”) by placing the cursor over the tex
and pressing the Select Text and Move function key. Hold the key whil
you move the cursor to the new text position, as shown in Figure6-22.

Figure 6-22. Pintype Property Text Location

5. Press the F2 (Unselect All) function key. Using the F1 (Select Area An
function key, select the pin, whisker, and property text.

1IN
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6. Choose theCopy > Multiple  menu item from the popup menu. Enter “9” i
the Count text entry box. Click the Select mouse button one pin grid be
the selected pin. The left panel of Figure6-23 shows the result.

7. Press the F2 (Unselect All) function key. Click the Select mouse button
the[Text] Sequence Text con. Enter the following information in the
Sequence Text dialog box, then click theOK  button.

• New Prefix: P

• Beginning Index Number: 1

• Step By: 1

8. The Select Area prompt bar is displayed; select the pin names (1s). M
the cursor to “P10” and press the Change Text Value function key. Ent
“P11” in the New Value text entry box in the prompt bar, and click theOK
button. The pins and text should look like the center panel of Figure6-23.

Figure 6-23. Copying Pins and Sequencing Text

1IN

1IN

1IN

1IN

1IN

1IN

1IN

1IN

1IN

1IN

P1

P2

P3

P4

P5

P6

P7

P8

P9

P11

IN

IN

IN

IN

IN

IN

IN

IN

IN

IN

P1

P2

P3

P4

P5

P6

P7

P8

P9

P11

1

2

3

4

5

6

7

8

9

11

IN

IN

IN

IN

IN

IN

IN

IN

IN

IN

Copy pin Sequence text
Change text value

Add and sequence
PIN_NO property
Design Architect User’s Manual, v8.6_2 6-105



Creating a Symbol Operating Procedures

n the

er

s
h
t

erty

t
bol.

he
All)
9. Change the select filter to select only pins, then select the pins. Click o
[Text] Add Property  con. In the Add Property dialog box, choose
“PIN_NO” from the scrolling list of property names. If it is not there, ent
it in theNew Property Name text entry box. Enter “1” as the property
value.

10. When you click theOK  button, you are prompted for the text location. A
you move the cursor in the edit window, an elastic string connects eac
piece of text with its pin. Move the cursor so the text for each pin is jus
above the whisker, and click the Select mouse button.

11. Press the F2 (Unselect All) function key. Select the newly created prop
text, then click on the[Text] Sequence Text icon. In the dialog box,
specify the following:

• New Prefix:    (no prefix)

• Beginning Index Number: 1

• Step By: 1

After you click theOK  button, the pins and text should look like the righ
panel in Figure6-23. That completes the pins on the left side of the sym

12. You use nearly the same steps to create the pins on the right side of t
symbol as you did for the pins on the left side. Press the F2 (Unselect 
function key. Click the on the[Draw] Add Pin  icon. Enter the following
information in the Add Pin dialog box:

• Name Height: 0.75

• Name Placement: Name with whisker

• Pintype: OUT

• Pin Placement: right side

• Pin name(s): O

Click the Select mouse button onOK .
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13. When the Add Pin prompt bar appears, place the pin to the right of pin
Move the “OUT” text to just below the pin whisker.

14. Press the F2 (Unselect All) function key. Using the F1 (Select Area An
function key, select the new pin, whisker, and property text. Copy it dire
below the original, and opposite pin 9.

15. Unselect, then add another pin opposite pin 3. This pin has a Pintype
property value of “IXO” and pin name “P”.

16. Select the pin, whisker, and property text. ChooseCopy > Multiple  from
the popup menu. Enter “5” in the Count text entry box. Press the Tab k
and click the Select mouse button below the selected pin and opposite 
The IXO and OUT pins should now appear as shown in the left panel o
Figure6-24. Press the F2 (Unselect All) function key.

Figure 6-24. IXO and OUT Pins on PLD Symbol

17. Select the Pin property text (“O” and “P”) and click the Select mouse bu
on the[Text] Sequence Text icon. When the dialog box is displayed, ent
the following information, then click on theOK  button:

• New Prefix: P

• Beginning Index Number: 19

• Step By: -1
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18. Press the F2 (Unselect All) function key. Set the select filter to select o
pins, then select the pins on the right side of the symbol.

19. Click on the[Text] Add Property  icon. In the dialog box, choose the
PIN_NO property name, and enter a dummy property value, such as “Z
(you will change it in the next step, but it should be unique). Click onOK
and place the text just above the whisker, as you did on the left side of
symbol.

20. Press the F2 (Unselect All) function key. Click on the[Text] Select By
Property icon. Specify the following information in the dialog box, then
click onOK :

• Property Name: PIN_NO

• Property Value: Z (or whatever name you gave in the previous step

• Click theText button

21. Click the Select mouse button on the[Text] Sequence Text icon. When the
dialog box is displayed, enter the following information, then click on th
OK  button:

• New Prefix: (no prefix)

• Beginning Index Number: 19

• Step By: -1
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22. Now the right side of the symbol should look like the right panel in
Figure6-24. Finish the symbol by adding a rectangle for the symbol bod
adding properties, checking, and saving. Figure6-25 shows the finished
symbol.

Figure 6-25. $MGC_PLDLIB/16hd8 Symbol

Adding and Naming a Pin Bundle

You can create a pin bundle by adding a Pin property to a symbol. The value
the Pin property must include a comma-separated list of pins or wide pins. T
pins included in a pin bundle cannot also occur on the symbol by themselves

A member of a pin bundle is defined as a pin or wide pin contained in the list
pin bundle. The members of a pin bundle must be enclosed within curly brac
for example, “U2_pins{P8,P9,P(3:0)}”.

When a pin bundle is defined on a symbol, a corresponding pin bundle is als
created on the part interface. When the symbol is instantiated, a pin bundle c
connected to either a net bundle or a bus as long as the widths are the same
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You create a pin bundle using the following steps:

1. Add a pin to a symbol.

2. Select the new pin.

3. Execute theProperties > Add popup menu item to display the Add
Property dialog box.

4. Select the “PIN” property in the list box under “Existing Property Name

5. Name the pin using bundle syntax beside “Property Value.”

6. Choose the type of visibility appropriate for your needs.

7. OK the dialog box.

You can edit a pin bundle by changing the value of the Pin property. Errors ca
by editing the syntax of a pin bundle are identified only when the symbol is
checked. For more information on creating properties, refer to “Assigning
Properties and Property Owners” in this chapter.

Pin bundles have the following characteristics:

• A pin bundle name must be unique within the scope of the symbol; tha
there cannot be two different pin bundles with the same name or both 
and a pin bundle with the same name.

• A pin can only occur once in the list of pins of a pin bundle.

• A pin cannot exist both on the symbol by itself and in a pin bundle, sinc
this would cause multiple references to the pin on the symbol.

• A pin bundle can contain other pin bundles as long as the nested bund
not also occur on the symbol by themselves.

• A pin can belong to only one pin bundle.

• Connection of the items in a pin bundle to a net bundle or bus is done 
position, not by name.
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• A pin bundle can have properties, which are propagated to the individu
pins in the pin bundle when a design is evaluated.

For more information on net bundles, refer to “Creating and Naming a Net
Bundle” in this chapter.

Bundles Connected to Ports

When you create a pin bundle on a symbol, you can connect a model of the
symbol to the pins in one of two ways:

• Create a net bundle in the model using the same name and the same
members in the Net property as those contained in the Pin property tha
designate the pin bundle.

• Create nets in the model with the same names as the members of the 
bundle.

The nets do not have to be connected to portin or portout symbols, but their n
do have to match the pins in the pin bundle.
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Checking a Symbol for Errors

Once the symbol has been drawn, pins placed, and properties added, the la
before saving and registering your symbol is to check the symbol for errors. 
symbols must pass a set of required checks before the symbol can be place
schematic sheet. The Mentor Graphics required symbol checks are set up a
invocation time and are executed, by default, with the Check command. Sym
checks descriptions are detailed in “Symbol Checks” in Appendix A.

To check the symbol, press theCheck Symbol function key. Errors and warnings
are displayed in the Check Symbol window by default for each individual
check.    Figure6-26 shows an example of a Check Symbol error log after a
successful symbol check. This error log may be diverted to a file by choosing
Check > Set Defaults pulldown menu item, and specifying a filename in the
dialog box that is displayed.

Figure 6-26. Check Symbol Log

Setting Default Symbol Checks

To setup your own default symbol checks, perform the following steps:

1. Activate the Symbol Editor window for the symbol to be checked by
placing the cursor in the window and clicking the Stroke mouse button

2. Select either theSetup > Check or theCheck > Set Defaults menu item.
The Default Symbol Check Settings dialog box appears in the active
symbol window.

Check #3 alu/alu:Symbol

Check Symbol "alu/alu"
Check Body       -------- 0 errors  0 warnings  (MGC-required)
Check Interface --------- 0 errors  0 warnings
Check Pin     ----------- 0 errors  0 warnings  (MGC-required)
Check Special   --------- 0 errors  0 warnings  (MGC-required)

"alu/alu" passed check: 0 errors 0 warnings
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3. Select the checks you wish to execute by clicking the Select mouse bu
beside the appropriate check name button. Select one of the three but
displayed for each check. The labelErrors/Warnings  means display both
error and warning messages, the labelErrors only  means display errors
only, and the labelNo check means this check is not executed.

4. After the desired checks have been selected, click the OK button.

To specify and execute a set of symbol checks, perform the following steps:

1. Activate the Symbol Editor window for the symbol to be checked by
placing the cursor in the window and clicking the Stroke mouse button

2. Choose theCheck > As Specified > Using Current Settings menu item.
The Symbol Check dialog box appears in the active symbol window. T
settings in the dialog box appear as they were last set in the current ed
session. If this is the first time the dialog box has been displayed, it wil
show the default settings.

or

Choose theCheck > As Specified > Using Default Settings menu item.
The Symbol Check dialog box appears in the active symbol window
showing the current internal default check settings.

Note

Default check settings you set in this dialog box are effective fo
this edit session only. When you exit from Design Architect, the
settings are lost. The required default checks are set at invoca
of Design Architect.
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3. Select the checks you wish to execute by clicking the Select mouse bu
beside the appropriate check name button. Select one of the three but
displayed for each check. The labelErrors/Warnings  means display both
error and warning messages, the labelErrors only  means display errors
only, and the labelNo check means this check is not executed.   If desire
the current settings can be saved as default settings by selecting the “U
Default Settings” switch.

4. Press theOK  button after selection to execute the checks.

Saving and Registering a Symbol

After the symbol is created and ready to be saved, select theFile > Save
Symbol > Default Registrationmenu item. The symbol is now saved and
marked as the default symbol for the component. A component interface is cr
and the default symbol is registered to the component interface. The compo
interface is also defined as the default component interface for the compone
The component interface name is created from the component leaf name. S
registration is discussed in detail in Chapter 2 in “Symbol Registration”.

To save the symbol and delete the registration, execute theFile > Save Symbol >
Delete Registrationmenu item. The symbol is saved, but not registered to a
component interface.

To save the symbol and change the registration, perform the following steps

1. When the symbol is ready to be saved, execute theFile > Save Symbol >
Change Registrationmenu item. The Save Symbol - Change Registrati
dialog box is displayed.

2.  To delete registration from the component interface, click the Select m
button on theDelete Registration? Yes button.

3.  To register the symbol to another component interface, click the Selec
mouse button on theChange Interface? Yes button, then enter the new
component interface name in theRegister With Interface: text entry box.
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To mark the component interface as the new default interface for the
component, click the Select mouse button on theMark This Interface As
Default? Yes button.

4. After registration changes are made, click on theOK  button.

Symbol registration is discussed in more detail in the “Symbol
Registration” section in Chapter 2.

Registering Multiple Symbols to One Component
Interface

To save and register more than one symbol to a single component interface
perform the following steps (This procedure assumes that you have already
created one symbol for the component, refer to “Saving and Registering a
Symbol” procedure in this chapter if you have not already saved one symbol 
the component.):

1. Choose the “Open Symbol” item from the palette to open the first sym

The existing symbol is displayed in a Symbol Editor window.

2. ChooseFile > Save Symbol As from the main menu bar.

The Save Symbol As dialog box appears.

3. Enter the pathname to the component that contains the first symbol in
Component Name field. For example, if the existing symbol is named
“7496” and the pathname to the component is “$CUSTOM_PARTS/74
enter “$CUSTOM_PARTS/7496”.

4. Click theOptions? YES button.

TheSymbol Name field is displayed on the dialog box.

5. Enter a new symbol name in theSymbol Name text box. For example, to
create an alternate symbol for rotated instances of a 7496 shift register
could enter “7496_rot” for the alternate symbol name.
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6. Choose the “Open Symbol” item from the palette to open your alternat
symbol.

The alternate symbol is displayed in a Symbol Editor window.

7. Make any required changes to the alternate symbol. For example, you
want to rotate the symbol body and reposition property text.

8. ChooseCheck > With Defaults from the main menu bar to check the
alternate symbol.

A report window is displayed with a summary of the check. Fix any
problems reported and repeat this step.

9. ChooseFile > Save Symbol > Default Registrationfrom the main menu
bar to register the alternate symbol with the default component interfac

CAUTION : If the symbol is not valid for the component interface (for
example, the number of pins on the symbol do not match the number o
pins in the component interface), theFile > Save Symbol >
Default Registration menu item will query you as to whether you want t
save the symbol and update the component interface. If you choose to
the symbol, any other model registered to that component interface is
invalidated.

The symbol is now saved and registered to the default component inter
The default symbol label remains on the original symbol.

10. Execute steps 1 through 10 until all alternate symbols are created and
registered to the same component interface.

11. To check that the proper symbol registration occurred, activate the Sy
Editor window for one of the new symbols and execute the Report >
Interface > This Design menu item. This displays a report about all
component interfaces for the specified component, and all models
registered with each component interface.
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Conceptual information related to the registration of multiple symbols i
discussed in more detail in the “Multiple Symbols Registered to One
Component Interface” section of Chapter 2.

Assigning Properties and Property
Owners

Assigning properties to a design is important if you intend to use the design 
other Mentor Graphics applications. Some properties are required for specifi
downstream applications, others are optional.

Setting Up Property Text Attributes

The following procedures let you set the appearance of properties on a symb
schematic sheet. Refer to “Changing Property Attributes” in this chapter for a
procedure to override selected attribute settings. For further reference, Table2-4
in Chapter 2 lists all object attributes and the associated commands and fun
used to set and change attributes.

To set up property text attributes in a Schematic Editor window, perform the
following steps:

1. Choose theSetup > Property Text menu item. This displays the Setup
Property Text dialog box.

2. Specify text font name in theSet Font text box. To make font selection
simpler, click theMenu... button to display a list of suggested fonts.

If you want to use an unregistered font, you must enter a complete
pathname to the font; the pathname must begin with a slash (/).

3. Specify text height by entering a number in theSet Height text box. The
default height is .1875 user units.

4. Specify text orientation by entering “0” or “90” in theSet Orientation text
box. These numbers represent the angle of orientation, measured in de
at which the text is placed on the sheet.
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5. Specify text transparency (on/off) by clicking the Select mouse button 
theSet Transparency buttonOn or Off .

6. Specify whether text should be visible or invisible on the schematic sh
by clicking the Select mouse button on theSet Visibility button On or Off.

7. Specify the vertical text justification by clicking the Select mouse button
theSet Vertical Justification button Top, Center, or Bottom.

8. Specify the horizontal text justification by clicking the Select mouse bu
on theSet Horizontal Justification button Left, Center, or Right.

To set up property text attributes in a Symbol Editor window, perform the
following steps:

1. Follow steps 1-8 in the previous procedure. In a Symbol Editor window
Set Property Text dialog box includes two additional attribute fields to b
specified. Attributes set with the “Setup” commands change the interna
state variable for each attribute.

2. Specify visibility (visible, hidden) by clicking the Select mouse button o
theSet Visibility Switch button Visible or Hidden. Refer to “Property
Visibility Switches” in Chapter 3for a description of how property visibilit
switches work.

3. Specify the property stability switch by clicking the Select mouse button
theSet Stability Switch button Variable, Fixed, Protected, or
Nonremovable. Refer to “Property Stability Switches” in Chapter 3 for a
description of how stability switches on properties can protect a proper
from being changed.

You can also set up property text or comment text in the Schematic Editor, a
property text or symbol body text in the Symbol Editor by clicking on the
[Text] Setup icon. The dialog box has buttons at the top for you to specify the
type of text. When you click the Property button, other items in the dialog box
the same as in the Setup Property Text dialog box for each editor.
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Adding a Single Property

To add a property name and value to a selected object in a Schematic Edito
window, perform the following steps:

1. Select object(s), for example: net, pin, and instance.   For information a
selecting and unselecting objects, refer to the “Selecting and Unselecting
Objects” section of this chapter.

2. Press the Shift-F5 (Add Property) function key, or click the Select mouse
button on the[Text] Add Property  icon. The Add Property dialog box is
displayed.

3. Select a property name from the scrolling list of properties, or type the 
property name in theProperty Name text box.

4. Type the property value in theProperty Value text box. When entering
property values in a dialog box, do not use quotes.

5. Fill in the rest of the dialog box, as appropriate. Refer to “Setting Up
Property Text Attributes” for more information about property attributes.

6. When property attributes are set, click theOK  button. The Add Property
prompt bar appears.

7. Move the cursor to the window of the selected object(s). Notice the ela
string attached to the selected object(s) and the property value text. M
the text to the desired location and click the Select mouse button. The
property value text is placed at that location.

If the property value is to remain invisible when the symbol is instantiated on
schematic sheet, the property value will have a solid DimGray rectangle as a
background. The color and background of this rectangle can be changed fro
Design Architect Session pulldown menuSetup > Hidden Symbol Property
Display...
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To add a property name and value to a selected object in a Symbol Editor win
perform the following steps:

1. Select object, for example: symbol body and pin. For information abou
selecting and unselecting objects, refer the “Selecting and Unselecting
Objects” section of this chapter.

2. Press the Shift-F5 (Add Property) function key, or click the Select mouse
button on the[Text] Add Text  icon. The Add Property dialog box is
displayed.

3. Select a property name from the scrolling list of properties, or type the 
property name in theNew Property Name text box.

4. Type the property value (no quotes) in theProperty Value text box.

5. Fill in the rest of the dialog box, as appropriate (graphics, property type
visibility switch, stability switch). For more information about symbol
property switches, refer to “Symbol Properties” in Chapter 3.

6. Press theOK  button when all desired switch settings are set. The Add
Property prompt bar appears.

7. Move the cursor to the window of the selected object(s). Notice an ela
string is attached to the selected object(s) and the property value text. M
the property value text to the location you want to place the text, and c
with the Select mouse button. The property value text is placed at that
location.

Note

When adding properties to a symbol body, select only one sym
body object. A symbol body can be constructed with a set of
symbol body graphics (arcs, rectangles, polylines and so forth)
you select more than one piece of the symbol body, the proper
will be added to each of the selected pieces. This will create an
error when you check the symbol. If an object is not selected w
the Add Property command is executed, the property will be ad
to the logical symbol.
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Adding Multiple Properties to the Same Object

To add multiple property name/value pairs with the same property attributes
selected objects in a Schematic or Symbol Editor window, perform these ste

1. Select object(s), for example: net, pin, and instance.   For information a
selecting and unselecting objects, refer to the “Selecting and Unselecting
Objects” section of this chapter.

2. Execute theProperties > Add > Add Multiple Properties menu item.
This is available from theInstance, Net, andDraw Schematic Editor
popup menus, and theAdd andSymbol Body & Pins Symbol Editor
popup menus. An Add Property dialog box is displayed.

3. Type the property name and value for each pair of properties you wish
add to the selected object(s). Notice that when you type in theProperty
Name text box, another text box is displayed, allowing you to enter as
many property name/value pairs as you wish.

4. Fill in the rest of the dialog box, if appropriate. Refer to “Setting Up
Property Text Attributes” for more information about setting up property
attributes

5. When property attributes are set, click theOK  button. The Add Property
prompt bar appears.

6. Move the cursor to the window of the selected object(s). An elastic strin
attached to the selected object(s) and the property value text. Move th
property value text to the desired location and click the Select mouse
button. The property value text is placed at that location.

7. Repeat Step 6 for each property name/value pair entered.
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Repeat Adding Properties to Changing Selection

To add a single property to a selected object(s), select another object(s), ad
single property to the newly selected object, and repeat this process as many
as required, perform the following steps:

1. Select object(s), for example: net, pin, and instance.   For information a
selecting and unselecting objects, refer to “Selecting and Unselecting
Objects” in this chapter.

2. Execute theProperties > Add > Repeat Adding Single Properties > Use
Changing Selection popup menu item. An Add Property dialog box is
displayed.

3. Select a property name from the “Existing Property Name” box, or type
property name in theProperty Name text box.

4. Type the property value in theProperty Value text box.

5. Fill in the rest of the dialog box, if appropriate. Refer to “Setting Up
Property Text Attributes” for more information about setting up property
attributes

6. When property attributes are set, click theOK  button. The Add Property
prompt bar appears.

7. Move the cursor to the window of the selected object(s). An elastic strin
attached to the selected object(s) and the property value text. Move th
property text with the cursor to the location you want to place the text, 
click the Select mouse button. The text is placed at that location.

8. After the property value text is placed, the Select Area prompt bar app
Select another object and repeat steps 3 through 7, or press theCancel
button to exit this process.
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Deleting Property Name/Value

To delete a visible property name/value pair, perform the following steps:

1. Select properties to be deleted. For information about selecting and
unselecting objects, refer to the “Selecting and Unselecting Objects”
section of this chapter.

2. Execute theDelete > Selected menu item, or click the Select mouse butto
on theDelete palette icon.

To delete hidden property name/value pairs, perform the following steps:

1. Select the objects that own the properties to be deleted.

2. Execute theDelete > Property popup menu item. The Delete Property
dialog box is displayed.

3. Type the property name to be deleted in theProperty Name text box.
Multiple property names can be entered in the dialog box.

4. Press the OK button after the property name(s) is entered.

Setting Property Owners

To define what types of objects can own a particular property on a schemati
sheet, perform the following steps:

1. Execute theSetup > Property Owner/Type > Property Owner menu
item. The Set Property Owner dialog box (Schematic Editor) is display

2. In theProperty Name text box, type the property name for which you wa
to set property ownership.

3. Press the Select mouse button on the object types that can own the pro
for example, the Instances or Nets buttons. More than one object type
be specified.

4. Press theOK  button when object type selection is complete.
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For conceptual information about property ownership, refer to “Property
Ownership” in Chapter 3 of this manual.

Deleting Property Owners

To remove certain object types from the legal owner list of a particular prope
on a schematic sheet, perform the following steps:

1. Execute theDelete > Property Owner popup menu item. The Delete
Property Owner dialog box (Schematic Editor) is displayed.

2. Type the property name whose owner list you want to modify in the
Property Name text box.

3. Press the Select mouse button on the buttons associated with the obje
types you want to remove from the owner list of the specified property
name.   More than one object type can be specified.

4. Press theOK  button when object type selection is complete.

To delete object types from the owner list of a p articular property on a symb
perform the following steps:

1. Select theDelete > Property Owner popup menu item to display the
Delete Property Owner dialog box (Symbol Editor).

2. Type the property name whose owner list you want to modify in the
Property Name text box.

3. Click the Select mouse button on the buttons for the object types you w
to remove from the owner list of the specified property. More than one
object type can be specified.

4. Press theOK  button, when object type selection is complete.

For conceptual information about property ownership, refer to “Property
Ownership” in Chapter 3 of this manual.
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Listing Property Information

To list property information for specified objects, perform the following steps

1. Select the properties, or the owners of the properties, for which you wis
extract information. Instead of selecting objects, you can enter the han
names of the objects in the dialog box that is displayed after the next s

2. Execute theReport > Object > As Specified menu item. The Report
Object dialog box (Symbol Editor) is displayed.

3. Click the Select mouse button on the buttons associated with the objec
which you want property information. More than one object can be
selected. The report generated is, by default, directed to the transcript
window, and to a file named “da_report_file” in your current directory.

If you have selected the object that owns the property, you must ask fo
report on both the object and attached properties.

4. Press theOK  button when object selection is complete.

Property attributes listed in report windows may include “-Not Visible” a
“-Hidden”. If both of these are listed, the property was hidden when add
and the property visibility has not been changed.

If “-Hidden” is listed without “-Not Visible”, the property visibility was
changed to visible on the sheet.

Changing Property Values

To change a single property text value, perform the following steps:

1. Position the cursor on the piece of text to change, and press the Shift-
(Change Text Value) function key.

2. Enter the new value in the prompt bar, then press the Return key, or c
the Select mouse button on theOK  button.
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To change the values of selected properties on a sheet or symbol, follow the
steps:

1. Select the properties to change, either by setting the select filter, or by
choosing theSelect > Area > Property or theSelect > Area > Property
menu item.

2. Choose theProperties > Change Values menu item or click the Select
mouse button on theProperty/Text > Change Value palette icon. This
displays the Change Property Value By Handle prompt bar with the cur
value, name, type, and object handle.

3. Enter the new property value in the text entry box; click theOK  button.
Another prompt bar appears for the next property to change. Repeat th
step for each selected property.

To change the value of the same property attached to several objects, perfo
following steps (this example changes the Pintype property value):

1. Click the Select mouse button on theUnselect All palette button.

2. Move the cursor close to a pin whose Pintype property you wish to cha
and press the Shift-F1 (Select Pin) function key. (Select Pin is in the
Symbol Editor; Shift-F1 is the Select Vertex function key in the Schem
Editor.) Be sure that only the pin is selected. If the line connected to the
is highlighted, unselect everything, and move the cursor slightly further
away from the pin to select it. Repeat for each pin whose Pintype prop
value you wish to change. The select count in the status line shows ho
many objects are selected.

3. Choose theProperties > Modify popup menu item. This displays the
Modify Properties dialog box.

4. Click the Select mouse button on the “PINTYPE - Multiple Occurrence
entry, then click theOK  button.
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5. Click on the Replace button to the right of the Property Value entry. En
the new Pintype property value. You can also change the property type
some attributes in this dialog box. Click theOK  button. The property
values are changed for the selected pins.

The following steps show another method of changing various pieces of
unselected text:

1. Choose theProperty/Text > Change Values popup menu item to display
the dialog box.

2. Enter a new text value for one you want to replace. When you begin
entering a value, another text entry box appears in the dialog box. Ente
new values, one per text entry box, for all the values you wish to chang

3. Click on theOK  button. The first value entered in the dialog box is
displayed in the message area. Click the Select mouse button on the t
you want replaced by the new value.

4. The old value is replaced by the new value shown in the message are
the next value is shown in the message area. Continue specifying the t
replace with the new value shown in the message area, until all specifi
values are placed.

The value_modified flag can be reset to “Not Modified” by using the pulldown
menuMiscellaneous > Mark Property Value: See “Mark Property Attributes”
in Chapter 3 for details.

Changing Property Attributes

To change property attributes for a specified property on a schematic sheet,
perform the following steps:

1. Select the property owners (nets, instances) for which you want to cha
property attribute information. Execute theProperties > Modify popup
menu item. The Modify Properties dialog box is displayed.
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2. Select the property name you want to change by clicking the Select m
button on the property name. You can select more than one property n
by holding down theCtrl key while selecting the property names.

3. Click theOK  button when the property name selection is complete. A
Modify Properties dialog box is opened for the first property name sele

4. Make the desired property attribute changes.

5. Click theOK  button when the property attribute selection is complete. T
next Modify Property dialog box is displayed for the second property th
was selected. Repeat steps 5 and 6 for each property selected.

To change property attributes for a specified property on a symbol, perform 
following steps:

1. Select the property owners for which to change property attributes. Exe
theProperties > Modify popup menu item. A dialog box appears that
includes a list of property names for the selected objects.

2. Click the Select mouse button on the property name you want to chan
You can select more than one property name by holding down theCtrl key
while selecting the property names.

3. Click theOK  button when the property name selection is complete. A
Modify Properties dialog box is opened for the property name selected

In the Symbol Editor window, the Modify Properties dialog box has two
additional property settings (stability switch and visibility switch) that ar
not available in a Schematic Editor window.

4. Make the property attribute changes.

5. Click theOK  button when the property attribute selection is complete. T
next Modify Property dialog box is displayed for the second property th
was selected. Repeat steps 5 and 6 for each property selected.
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For information about text attributes, refer to “Text Attributes” in Chapter 2 of
this manual.

The attribute_modified flag can be reset to “Not Modified” by using the pulldo
menuMiscellaneous > Mark Property Attributes:  See “Mark Property
Attributes” in Chapter 3 for details.

Changing Property Text Color

To change the color of all selected property text to White, for example, perfo
the following steps:

1. Select the property text for which you want to change the color. Execut
popup menu itemProperties > Change Attributes > Text Color:. The
Change Color dialog box is displayed as shown below:

Note

In order to change the stability switch of a Logical Symbol Bod
property, no object should be selected. Therefore, it is best to
execute an $unselect_all() function first. You then select the
property with the $select_by_property() function and specify th
property name and value. You can change the stability attribut
using the $change_property_stability_switch() function.

Change Color

OK Reset Cancel

VioletRed
Violet

Yellow
White

YellowGreen

Wheat
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2. Move the window slider button down to the bottom, click onWhite , then
click OK.

Changing the Background of Hidden Property Text

To change the background color of all hidden property text to white, for exam
perform the following steps:

1. Activate the Design Architect Session window, then execute the popup
menu item
Setup > Set > Hidden Symbol Property Display...

The Change Color dialog box is displayed as shown below:

2. Move the window slider button down to the bottom, click onWhite , then
click OK.

Note

When you change the color of a property, the annotated value 
that property text is also changed from the default color red to 
new color.

Set Hidden Symbol

OK Reset Cancel

Background Pattern

Solid

Stipple

VioletRed
Violet

Yellow
White

YellowGreen

Wheat

Background Color

Display background ?

Property Display

YesNo
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Changing Multiple Properties on the Same Object

To edit multiple property name/value pairs on a single selected object in a
Schematic or Symbol Editor window, perform these steps:

1. Select an object, for example a symbol body in the Symbol Editor wind

2. Execute the popup menuProperties > Modify Multiple...  This is available
from theInstance, Net, andDraw Schematic Editor popup menus, and th
Symbol Body & Pins Symbol Editor popup menus. The Modify Editable
Properties dialog box is displayed as shown below:

3. Enter the new value and/or attributes of the property names you wish to
or add to the selected object.

4. When the property values and attributes are set, click theOK . The Add
Property prompt bar appears if you are adding a new property.

5. If you are adding a property, move the property value text to the desire
location and click the Select mouse button. The property value text is
placed at that location.

6. Repeat Step 5 for each new property name/value pair entered.

Modify Editable Properties

Name

ADD_CONVERT

OK CancelReset

Visable

Value

BLOCK_NAME string

Visablity Type

schematic VisableMODEL string

Visable void
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Reporting on Objects
The following topics include procedures for reporting on various schematic
objects.

Reporting on Component Interfaces

To list all models, labels, and component interfaces for the component you a
currently in, perform the following steps:

1. Activate the Schematic or Symbol Editor window for the component yo
wish to report on by clicking the Stroke mouse button in that window.

2. Execute theReport > Interfaces > This Design menu item. The contents
of the report is displayed in either a popup window, a transcript window
and/or a file, as specified in the previous Setup Report command.

Figure6-27 shows an example of an interface report for a component “d
with a component interface and symbol name “latch”, a symbol pin cou
of 5, and a label of “default_sym” specifying the symbol as the default
symbol for the component.

Figure 6-27. Report Interfaces Example

Report #1 dff:Interfaces

Reporting: Interfaces

Default Interface  latch
   Pin Count 5
   Registered Models
     Type            Path
     mgc_symbol      $MGC_GENLIB/latch/latch
                     Label  [default_sym]
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To list all models, labels, and component interfaces for a selected instance o
schematic sheet, perform the following steps:

1. Select the instance for which you want component interface informatio

2. Execute theReport > Interfaces > Selected menu item. The contents of
the report is displayed in either a popup window, a transcript window,
and/or a file, as specified in the previous Setup Report command.

To list all models, labels, and component interfaces for a specified compone
and set the type of report, perform the following steps:

1. Activate a Schematic or Symbol Editor window. Execute theReport >
Interfaces > Other menu item. The Report Interfaces prompt bar appea

2. Type the component name in theComponent Name text entry box. If you
want to report on a specific component interface, enter the component
interface name in theInterface Name text entry box.

3. If you want the report to be displayed in a window, move the cursor to 
Window button and click the up arrow until the “window” text appears. 
you want the report to be displayed in a transcript, move the cursor to 
Transcript  choice stepper button until the “transcript” text appears.

4. If you want the report to be directed to a file, move the cursor to theFile
Mode button. Select one of the file mode switches. The “add” switch
specifies that the report is appended to the specified filename.

The “replace” switch specifies that the new report replaces the content
the file. The “nofile” switch specifies that no file is created. IfFile Mode is
not set to “nofile”, you can specify a new filename in theFile Name text
box.

Note

The arguments specified in the Report Interfaces prompt bar
override the arguments specified by theReport >
Set Report Defaultsmenu item, but do not replace them.
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Reporting on Schematic and Symbol Objects

To list all schematic and symbol object information for selected objects on a
symbol or schematic sheet, perform the following steps:

1. Select the objects for which you want to gather information.

2. Execute theReport > Object > Selected > All menu item. This menu item
reports information for all selected objects. The report generated is, by
default, directed to a Design Architect window; it can also be sent to a 
Refer to the “Report Object” command in theDesign Architect Reference
Manual for information reported about each object.

To list information for specified object types on a symbol or schematic sheet
perform the following steps:

1. Select the objects for which you wish to obtain information. Instead of
selecting objects, you can type the handle names of the objects in the
Report Object dialog box.

2. Execute theReport > Object > As Specified menu item. The Report
Object dialog box appears.

3. Click the Select mouse button on the buttons corresponding to the obj
for which you want information. More than one object type may be
selected. The Report generated is, by default, directed to a Design Arch
window, and to a file named “da_report_file” in your current directory.

When listing property information, if you have selected the object that
owns the property, you must ask for a report about both the object and
attached properties.
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4. Click theOK  button when object type selection is complete. Figure6-28
illustrates the type of information found on a report of a schematic she
when instance, net, pin, and property text attribute object types are
specified.

Property attributes listed in report windows may include “-Not Visible” a
“-Hidden”. If both of these are listed, the property was hidden when add
and the property visibility has not been changed.

If “-Hidden” is listed without “-Not Visible”, the property visibility was
changed to visible on the sheet.

Figure 6-28. Report Object Example

Report #2 dff

Reporting: Instance, Net, Pin, Property
           Text Attribute

Instance    Name                              Location
I$2         $MGC_GENLIB/latch/latch           (-1.00,3.50)
            flipped vertically

I$6         $MGC_GENLIB/inv/inv                (1.50,-0.25)

Net  N$3     Net Name: -----
     Vertex  Location     Attached Vertices  Vertex Pins: Name of
     V$67    (-2.75,-0.25)       V$191       P$66         OUT
     V$17    (-1.00,-0.25)       V$191       P$16         EN
     V$191   (-1.75,-0.25)       V$67
                                 V$17
                                 V$193
     V$193   (-1.75,3.50)        V$191
                                 V$43
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Reporting on Check Status

To report the status of all schematic or symbol checks, perform the following
steps:

1. Place the cursor in the Symbol or Schematic Editor window for the sym
or schematic check status you want to report on, and click with the Str
mouse button.

2. Execute theReport > Check > All menu item. This menu item reports th
status of all check categories for the schematic sheet or symbol in the a
window. The report generated is, by default, directed to a Design Arch
window, and a file named “da_report_file” in your current directory. Re
to Appendix A, “DA Design Checks,” for a description of individual checks
performed.

To report the status of specified check types on a symbol or schematic shee
perform the following steps:

1. Place the cursor in the Symbol or Schematic Editor window for the typ
check status you want to report on, and click the Stroke mouse button.

2. Execute theReport > Check > Specified menu item. A Report Object
dialog box appears.

3. Click the Select mouse button on the buttons corresponding to the che
for which you want a status report. More than one check can be select
The Report generated is, by default, directed to a Design Architect wind
and a file named “da_report_file” in your current directory.

4. Click theOK  button when check types are selected.

Reporting on All Broken Annotations

If you are viewing a design in the context of a design viewpoint and you wan
generate a complete report on all broken annotations for the whole design, yo
execute the menu itemReport > Broken Annotations.
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Editing Design Architect Models in a
Design Hierarchy

The following topics contain some of the procedures you need for schematic
having multiple sheets and/or multiple levels of hierarchy.

Creating a Functional Block

Functional blocks are helpful when creating top-down designs. A functional b
is just a symbol (usually rectangular) representing a high level of functionalit
After creating functional blocks, you can create lower-level descriptions for e
block.

To create a functional block in the Schematic Editor, perform the following st

1. Create comment graphics by clicking the Select mouse button on the
[Draw] Add Rectangle icon. Press the Select mouse button to specify o
corner of the rectangle; hold the button down as you move the cursor t
diagonally opposite corner of the rectangle, then release the mouse bu

2. Add pins by choosing the[Draw] Add Pin  icon.

3. Add properties to the comment graphics.

4. Select the comment graphics, property text, and pins.

5. Execute theEdit > Make Symbol pulldown menu item. The Make Symbo
dialog box is displayed for you to enter a component name, and, option
a symbol name and interface name. After you click theOK  button, the
newly-created symbol is checked. If it passes the required checks, the
symbol is saved and automatically registered with the default interface.
symbol is then instantiated on the sheet, replacing the comment graph
and symbol pins.Make Symbol is described in theDesign Architect
Reference Manual.
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Creating a Sheet for a Symbol

The following procedures describe two of the methods by which Design Arch
can automatically create a partial sheet for your existing symbol.

In the Schematic Editor, perform the following steps:

1. Select the symbol instance for which you want to create a sheet.

2. Choose theFile > Open Down > Choose Model pulldown menu item. This
displays the Open Down dialog box. Click on theNew Sheet button; the
dialog box now contains text entry boxes for schematic and sheet nam

3. The default names for the schematic and sheet are automatically disp
in the dialog box for you to change, if you wish. In this example, “sheet
was changed to “sheet2” because this symbol already has a sheet.

You can specify a border by clicking theSheet Border Yes button, and
clicking the stepper button until the name of the desired size is displaye
you don't remember the sizes, or you do not want a title block, click the
button. This displays the Add Sheet Border dialog box, which lists the
standard sheet sizes and lets you choose not to create a title block. Cr
a sheet border and title block for an existing sheet is described in “Adding a
Sheet Border and Title Block” in this chapter.

4. Design Architect will automatically create I/O ports from the pins on th
symbol. If you do not want this option, click the appropriateNo button.
You can specify a startup file for this sheet by clickingYes and entering the
pathname to the startup file in the text entry box that appears.

5. After you click theOK  button, Design Architect opens an editing window
on the new sheet. If you requested a sheet border and title block, the b
is drawn, and a dialog box is displayed for you to enter your title block
information. Enter the information and click theOK  button.
Design Architect User’s Manual, v8.6_26-138
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If you requested I/O ports, there will be a portin, portout, or portbi symb
instance on the sheet for each pin on the symbol. The Net property va
attached to each of these instances is the same as the Pin property va
the corresponding pin.

6. Now the sheet is ready for you to add nets and other instances.

To create a sheet for a symbol you have opened in the Symbol Editor, perfor
following steps:

1. If the symbol has not been checked, you need to check and save it be
creating a sheet for it.

2. Choose theMiscellaneous > Create Sheet pulldown menu item. This
displays the Create Sheet dialog box.

3. You can change the default schematic and sheet names, if desired. Sp
whether to replace an existing sheet of the same name, the sheet size
orientation, and whether you want a border on the sheet. If you want to
specify a sheet size other than one of the standard sizes, click the Spe
button. The dialog box expands so you can enter the width and height 
text entry boxes and click the appropriate button for units of measurem

4. When you click theOK  button, a sheet is generated with portin and porto
symbols corresponding to the pins on the symbol.
Design Architect User’s Manual, v8.6_2 6-139



Editing Design Architect Models in a Design Hierarchy Operating Procedures

form

pup

 the
 title
hen

 to

 name
ctors

re is

t2.

lick
bol.

he
Creating Additional Sheets in a Schematic

To create a second sheet on the same hierarchical level of a schematic, per
the following steps:

1. Choose one of the Open Sheet methods (palette icon, function key, po
menu item, or popup command line) from the Design Architect Session
window.

2. In the Open Sheet dialog box, enter the component name, and change
default sheet name from “sheet1” to “sheet2”. If you want a border and
block, click the options button and supply the appropriate information, t
click theOK  button on each dialog box.

3. A new sheet is displayed in a Schematic Editor window. You will need
place$MGC_GENLIB/offpage.in and$MGC_GENLIB/offpage.out
connector symbols on the sheets to establish electrical connectivity.

Using Off-Page Connectors

Off-page connectors are used to intentionally connect nets having the same
on different sheets in a schematic. Mentor Graphics supplies off-page conne
in $MGC_GENLIB. Generally,offpage.in connectors are on the left side of the
sheet, andoffpage.out connectors are placed on the right side of the sheet. The
also anoffpage.bi symbol for bidirectional nets.

Suppose you have a net named “DATA” that begins on sheet1 and extends
beyond the right side of the sheet. “DATA” continues on the left side of shee
Follow these steps to connect the nets:

1. Open sheet1. Press the Ctrl-H keys to display the symbol history list. C
the Select mouse button on “offpage.out” in the list to activate the sym

2. Click the Select mouse button in the Active Symbol window. Click on t
end point of the net named “DATA” near the right side of the sheet.

3. Check and save sheet1.
Design Architect User’s Manual, v8.6_26-140
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4. Open sheet2. Press the Ctrl-H keys to display the symbol history list. C
on “offpage.in” in the list.

5. Click the Select mouse button in the Active Symbol window. Click on t
end of “DATA” near the left side of the sheet to place the symbol instan

6. Check and save sheet2. Choose theCheck > Schematic > With Defaults
menu item. This will flag any mismatched off-page connectors and any 
having the same name, but no connectors.

Using Portin and Portout Symbols

Ports connect Net names on a sheet to Pin names on the symbol that repres
that sheet. Mentor Graphics suppliesportin, portout, andportbi components in
$MGC_GENLIB for input nets, output nets, and bidirectional nets, respectivel
To add port symbol instances to the sheet you are editing, perform the follow
steps:

1. Press the Ctrl-H keys to display the active symbol list. Click on “portin”
the list to activate the symbol.

2. Position the cursor at the beginning of an input net, and press the F5 (
Symbol) function key. Repeat for each input net. Notice that each porti
symbol instance has a Net property attached, and all have a value of N

3. Click the Select mouse button on the[Text] Name Net icon. This displays
the Select Area prompt bar. Using the mouse, enclose the Net propert
in a dynamic rectangle. The objects within the rectangle are selected, 
unselected, and the top-most, left-most Net property text is selected.

4. For each piece of selected property text, the Change Property Value pr
bar is displayed for you to enter a new value. When you press the Retu
key, or click theOK  button on the prompt bar, the selected property tex
changed to its new value. The newly changed property text is unselect
and the next piece of property text is selected.

Use the same procedure for adding portout or portbi symbol instances and
changing Net property values.
Design Architect User’s Manual, v8.6_2 6-141
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Editing the Sheet of a Symbol

After you have opened a schematic sheet, you can select an instance on the
and choose one of the models registered to the component instance to edit o

To open a model for a selected instance, perform the following steps:

1. Select the instance you want to open down into. For information about
selecting and unselecting objects, refer to “Selecting and Unselecting
Objects” in this chapter.

2. Execute theFile > Open Down > Choose Model menu item. The Open
Down dialog box appears with a list of registered models. In this case,
symbol model, schematic model, VHDL source, VHDL Entity, and a
VHDL Architecture can be chosen.

3. Click the Select mouse button on the model you wish to open, then clic
theOK  button. An editing window that matches the type of model you
selected is opened.

Creating a Symbol for a Sheet

You can generate a symbol for the sheet you are currently editing, or for ano
sheet, by performing the following steps:

1. Choose theMiscellaneous > Generate Symbol pulldown menu item.

The Generate Symbol dialog box is displayed.

2. Enter the pathname to the component that will contain the generated
symbol in theComponent Name field.

3. Enter the name of the symbol to generate in theSymbol Name field.
Design Architect User’s Manual, v8.6_26-142
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4. Choose radio buttons that effect the symbol to be created. The followin
explains your choices:

• You can choose to replace an existing symbol that has the same n

• You can choose to how the generated symbol is initially saved.

• You can choose to make the symbol the active. You must choose e
theSave Symbolor Save and Edit radio buttons underOnce
Generated... to make the new symbol active.

5. Click theSchematic button.

TheComponent Name andSchematic Name fields are displayed.

6. Enter the pathname to the component that contains the schematic in t
Component Name field.

7. Enter the name of the schematic in theSchematic Name field.

8. If desired, adjust the values in the Pin Spacing, Sort Pins, Component
Shape fields. For information on possible values for these fields, refer to
“$generate_symbol()” function description in theDesign Architect
Reference Manual.

9. Click theOK  button when you have completed your entries in the dialo
box.

The generated symbol will have whiskers from the pin to the symbol body. T
Pin property text will be placed at the end of the whisker inside the symbol b
Pin locations are determined by the port instances on the schematic sheet.

Note

The schematic generator always places user-defined ports on
input side of the symbol, unless the user adds a PINTYPE prop
to the pin and specifies the value as “OUT” or “IXO”.
Design Architect User’s Manual, v8.6_2 6-143
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Creating a Pin List

You can create a pin list for a sheet using the following procedure:

1. Choose theMiscellaneous > Create Pin Listitem from the main menu bar

The Create Pin List dialog box appears.

2. Enter the pathname to the schematic.

3. Enter the pathname to the pin list to be created.

4. If you want to replace an existing pin list file with the same name, click
Yes radio button under Replace existing pin list file?.

5. If you want to edit the pin list, click theYes radio button under

Edit pin list file? .

This opens a Notepad window on the generated pin list after you click 
OK  button.

6. If you want the pin information sorted in alphabetical order in the pin lis
file, click theYes radio button under Sort Pins?.

7. Click theOK  button when you have completed your entries in the dialo
box.

For detailed information on the constructs used in the pin list file, refer to the Pin
List File Format” appendix in theDesign Architect Reference Manual.
Design Architect User’s Manual, v8.6_26-144
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Creating a VHDL Entity for a Symbol

You can create a VHDL entity for a symbol by following these steps:

1. Open the Symbol Editor on the desired symbol.

2. Choose theMiscellaneous > Create VHDL Entity menu item.

A VHDL entity file is created in the working directory, as specified by
$MGC_WD. The entity is given the symbol name with “_entity” appended. Bo
properties, other than the Model property, are placed in an example generic
statement that is commented out. The new entity is displayed in a VHDL Edi
window for you to edit or compile.

Creating a Symbol From a VHDL Entity

A symbol may be created before or after the VHDL model. To create a VHD
model and generate a symbol for that model, perform the following steps:

1. Open the VHDL Editor by clicking the Open VHDL icon in the Session
palette, and entering the component name and the VHDL source name
the Open VHDL dialog box.

2. Write and compile your VHDL model.

3. Open the Symbol Editor using the same component name as you did 
you opened the VHDL Editor. A system-generated symbol is displayed
Symbol Editor window. The symbol is a simple block with the correct
number of pins with port names and Pintype properties assigned.

4. To verify the properties and settings, select the entire symbol and cho
theReport > Object > Selected > All pulldown menu item.

5. Close the report window. Check the symbol by choosing theCheck >
With Defaults menu item.

6. Save the symbol by choosingFile > Save Symbol > Default Registration.
Click on theYes button when asked if the interface should be updated.
Design Architect User’s Manual, v8.6_2 6-145
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Viewing Design Hierarchy

You can view the hierarchy of your design by performing the following steps

1. Choose theMGC > Design Management > Open Hierarchy Window >
Specify pulldown menu item.

The Open Hierarchy Window dialog box is displayed.

2. Enter the pathname of the component whose hierarchy you want displ
or use the navigator button to bring up the dialog navigator to find the
component.

3. Click theOK  button when you have completed the form. The hierarchy
displayed in an IDW Hierarchy window.

4. Select a component in the IDW Hierarchy window by clicking the Sele
mouse button on the component name.

5. Press the Menu mouse button in the IDW Hierarchy window to display
associated popup menu.

For more information on the IDW Hierarchy window, refer to ““my_design”
Design with COMP Property” in this manual.

Adding Comment Text and Graphics
Comment objects are used for adding non-electrical information to a design.
These objects have no electrical significance. Comment objects cannot be
instantiated.

You can add comment text and graphics directly to a sheet in the Schematic
Editor. In the Symbol Editor, you create symbol graphics and text, then conv
selected objects to comment objects.
Design Architect User’s Manual, v8.6_26-146
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Setting Comment Text and Graphic Drawing Attributes

Before you begin drawing comment objects, you can set up how text and
graphical shapes are graphically represented. For more information about
comment text and graphics attributes, refer to “Object Attributes” in Chapter 2 of
this manual.

To set up comment text and graphical drawing attributes, perform the followi
steps from the Schematic Editor:

1. Execute theSetup > Net/Comment/Page > Commentsmenu item. The
Setup Comment dialog box appears in the active Schematic Editor win

2. Click the Select mouse button on the line width you want (1 pixel, 3 pix
5 pixels, 7 pixels).

3. Click the Select mouse button on the fill type you want (Clear, Solid,
Stipple).

4. Click the Select mouse button on the text transparency you want (On, 

5. Click the Select mouse button on the text vertical justification you wan
(Top, Center, Bottom).

6. Click the Select mouse button on the text horizontal justification you w
(Left, Center, Right).

7. Click the Select mouse button on the line style you want: (Solid, Dotte
Long Dash, Short Dash, Centerline, and Phantom).

8. Enter the desired font name. The default is the “stroke” font. Fonts and
registry files are located in $MGC_HOME/registry/fonts.

9. Enter the desired text height. The default height is 0.1875 user units.

10. Enter the desired text orientation: (0 or 90 degrees). The default is 0 de
(horizontal).
Design Architect User’s Manual, v8.6_2 6-147
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11. Click theOK  button when comment attribute selection is complete.

You can also set up comment text attributes in the Schematic Editor by click
the[Text] Setup icon.

Creating Comment Objects on Schematic Sheets

You can access comment object functionality through the[Draw ] palette and the
Draw > Add  and theAdd > Draw  popup menu items. Click the Select mouse
button on theDraw palette button to display the Draw palette. The following li
describes how to create various comment objects on a schematic sheet.

• Click the Select mouse button on the[Draw] Add Polyline  icon. Click the
Select mouse button at the beginning of the line, and at each vertex. E
time you click and move the mouse, a line stretches from the vertex to
cursor. Double-click to end the line.

• Click the Select mouse button on the[Draw] Add Rectangle icon. Specify
the location of one corner of the rectangle by pressing the Select mous
button. Hold the mouse button down and move the cursor to the desire
location of the diagonally opposite corner, then release the mouse butt

• Click the Select mouse button on the[Draw] Add Circle  icon. Specify the
center of the circle by pressing the Select mouse button. Hold the mou
button down and move the cursor to define the perimeter, then release
mouse button. A ghost image of the circle moves with the cursor.

• Click the Select mouse button on the[Draw] Add Polygon icon. Click the
Select mouse button at each vertex of the polygon. Double-click at the
vertex. Design Architect automatically draws a segment between the la
and first vertices to close the figure.

• Click the Select mouse button on the[Draw] Add Arc  icon. Click at the
desired location for one end of the arc, then click at the other end of the
A ghost image moves as you move the cursor to define the arc point. W
the arc is the desired size, click the Select mouse button to place it.
Design Architect User’s Manual, v8.6_26-148
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• Choose theDraw > Add > Two Point Line popup menu item. Press the
Select mouse button at one end of the line, hold the mouse button dow
you move the cursor to the other end of the line, then release the mou
button.

• Choose theDraw > Add > Dot popup menu item. Click the Select mouse
button at the point you want the dot.

• Click the Select mouse button on the[Text] Add Comment Text icon.
Enter the comment text you want to add in the prompt bar that appears
press the return key. As you move the cursor, a ghost image of the tex
appears and moves with the cursor. Move the text to the desired locati
and click the Select mouse button.

Making a Symbol From Comment Objects

Creating a symbol from comment objects is the same as creating a functiona
block, described in the “Creating a Functional Block” section of this chapter. The
basic steps are as follows:

1. In the Schematic Editor, create a rectangle for the symbol body.

2. Add pins to the symbol body.

3. Add other property text, as needed.

4. Select the symbol body, pins, and associated text.

5. Choose theEdit > Make Symbol pulldown menu item. The symbol is
checked and, if it passes all checks, Design Architect creates a symbo
registers it (using default registration), and instantiates it in the location
the original comment objects.
Design Architect User’s Manual, v8.6_2 6-149



Adding Comment Text and Graphics Operating Procedures

, you

lt is

x
tle

ur
nt
Adding a Sheet Border and Title Block

If you did not create a sheet border and title block when you created a sheet
can perform the following steps to create the border:

1. You can choose eitherMGC STD or ANSI STD from theEdit >
Add Sheet Border pulldown menu to display a dialog box. Design
Architect supports 10 different sizes of MGC sheet borders. The defau
size D.

The sizes offered in the Add ANSI Sheet Border dialog box are:

• A Horizontal 11 x 8.5 in.

• A Vertical 8.5 x 11 in.

• B 17 x 11 in.

• C 22 x 17 in.

• D 34 x 22 in.

• E 40 x 28 in.

• F 44 x 34 in.

The Logic Symbol Pin Spacing indicator is set toHalf Size which is the
default. Notice that the Title Block indicator is set toYes. This means that a
title block will be added to the sheet border that you have specified.

2. Click theOK  button on the dialog box. The Add Sheet Border dialog bo
disappears from the screen, a border is added to the sheet, and the Ti
Block Information dialog box is displayed.

Notice that the Engineer and Drawn By entry boxes are filled in with yo
login name. The Schematic Title entry box is filled in with the compone
name, which in this example isadd_det. The Page Number entry box is
filled in with 1 because this is sheet1 of the schematic.
Design Architect User’s Manual, v8.6_26-150
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3. Enter the remaining information for your sheet, then click theOK  button.

The Title Block Information dialog box disappears from the screen and
title block is added to the sheet border.

You can also customize your own sheet borders. Refer to the
$add_sheet_border() function description and Appendix A, “Custom
Userware” in theDesign Architect Reference Manual for information about
how to customize your own sheet borders.

Converting Electrical Objects to Comments

You can select electrical objects and convert them to comment objects by clic
on the[Draw] Convert to Comment icon in the Symbol Editor, or choosing the
Edit > Convert to Comment menu item in the Schematic Editor.

Create comment objects from symbol objects by performing the following ste

1. Select the symbol graphics and text you want to convert.

2. Click the Select mouse button on the[Draw] Convert to Comment icon.

Selected symbol graphics become comment graphics; selected property tex
attached to the symbol body becomes property text attached to the graphics
symbol text and other property text become comment text, and are placed a
current locations.

Comment graphics and text cannot be instantiated and, therefore, do not ap
when an instance of the symbol is placed on a sheet.

To convert schematic objects to comments, perform the following steps:

1. Select the objects and text to convert.

2. Choose theEdit > Convert to Comment pulldown menu item.

Selected nets become lines, selected instances become graphic objects, pro
text attached to the symbol body remains property text, now attached to the
graphics, and visible property text becomes comment text.
Design Architect User’s Manual, v8.6_2 6-151
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Removing Comment Status

To remove comment status from comment objects that were created by conv
selected symbol objects, perform the following steps in the Symbol Editor:

1. Select the comment graphics and text.

2. Choose theEdit > Remove Comment Status pulldown menu item.

The objects may now be instantiated on a schematic sheet. This function do
restore electrical information that was previously on the symbol.

Viewing the Contents of a Sheet
Changing the view of a sheet is useful when large schematics are edited. It a
you to see the schematic sheet or symbol in adequate detail. You can chang
sheet view any time to see a small portion of the sheet, or zoom out to see t
entire sheet.

Viewing a Portion of the Sheet

To view a portion of the sheet, perform the following steps:

1. Press the F8 (View Area) function key or select theView > View Area
menu item. The View Area prompt bar appears on the screen, with the
location cursor on “Area”.

2. Place the cursor at one corner of the rectangular area you want to view

3. Press and hold down the Select mouse button. While the Select mous
button is depressed, move the cursor to the opposite corner of the
rectangular area. Notice that as you move the cursor, a rectangular bo
displayed. This rectangle is the boundary of the area that will be viewe

4. When the area you want to view is within the rectangle, release the Se
mouse button.
Design Architect User’s Manual, v8.6_26-152
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The area you specified is enlarged to fill the active window. View Area is als
available from the popup menu in a scroll bar, or by defining the view area w
the Context window.

Viewing the Entire Sheet

To view the entire design sheet, perform the following steps:

1. Press the Shift-F8 (View All ) function key or select theView > View All
menu item.

2. The entire design sheet is displayed in the active sheet window.

You can also view the entire sheet by double-clicking the Select mouse key i
Context window.

Other Viewing Capabilities

You can also view different aspects of the design by choosing one of the
following menu items:

• View > View Centered. This view option centers the view around the
specified location. After choosing this menu item, the View Centered
prompt bar appears in the active window with the location cursor on
“Center of View”. As you move the mouse into the active window, the
moving cursor appears. Click the Select mouse button at the desired c
of view. The view of the design is now centered around the location
specified.

Another method of centering the view is to double-click the Stroke mou
button in the edit window.

• View > View Selected. This view option centers the view around the
selected object(s).

• View > Zoom In > 2.0 | 3.0 | As Specified.This view option expands the
image size in the active window to show more detail in the window. Th
Design Architect User’s Manual, v8.6_2 6-153
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image is zoomed-in by a factor of 2.0, 3.0, or the factor you specify in a
prompt bar, with respect to the center of the image.

• View > Zoom Out > 2.0 | 3.0 | As Specified. This view option shrinks the
image size in the active window to show less detail in the window. The
image is zoomed out by a factor of 2.0, 3.0, or the factor you specify in
prompt bar, with respect to the center of the image.

Printing in Design Architect
Design Architect gives you a variety of ways to print your design. Each Desig
Architect window has specific menu items that define different printing
capabilities.

From the Design Architect Session window you can execute menu items to p

• The entire Design Architect session, including all editor windows and t
contents of the windows.

• All the schematic sheets that comprise a schematic.

• All design sheets and their back annotations, specified by the current d
viewpoint.

From a Symbol Editor window you can print the contents of the Symbol Edito
window.

From a Schematic Editor window you can print the contents of a schematic s

From the VHDL Editor window you can print a VHDL document.
Design Architect User’s Manual, v8.6_26-154
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From Design Architect Session Window

To save the entire Design Architect session in postscript format, perform the
following steps:

1. Place the cursor in the Design Architect Session window, and click the
Stroke mouse button.

2. Choose theMGC > Export Screen: menu item.

The Export Screen dialog box is displayed.

3. Enter the pathname to the output file in theOutput file path  field.

4. Click theOK  button to execute the dialog box.

5. Click the left mouse button in the session window.

For information on sending the resulting file to a printer from the shell, refer t
“From an Operating System Shell” in this chapter.

To print all sheets in a design with back annotations displayed, perform the
following steps:

1. Place the cursor in the Design Architect Session window, and click the
Stroke mouse button.

2. Execute theFile > Print > Design Sheetsmenu item.

You can change the default printer settings by executing theMGC >
Setup > Printer menu item. Refer to thePrinter Interface Reference Manual for
a description of all required and optional arguments.

Note

If a design sheet window is not open when the File >
Print > Design Sheets menu item is executed, the last design
viewpoint set for edits will identify the design sheets printed. Yo
can manually set the current design viewpoint by executing the
Setup > Set > Viewpointmenu item from the session window.
Design Architect User’s Manual, v8.6_2 6-155
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From the Symbol Editor

To print the contents of a Symbol Editor window, perform the following steps

1. Activate the edit window for the symbol you wish to print. Choose the
File > Print Symbol menu item to display the Print Object prompt bar.

2. Type the printer name in the “Printer name” text box.

3. If you want to override the default printer options, click the “Options”
button. The Print Design Object dialog box is displayed. You can spec
the printer name, the site name, the number of copies, a job configurat
file, the orientation, the priority, notification level, magnification, the sca
and the panel name (if you want to plot only a portion of the window). F
procedure describing how to create panels, refer to “Adding, Viewing, and
Deleting Panels” in this chapter.

You can change the default printer settings by specifying any or all of t
printer attributes. This overrides the default printer settings for this job
only. If you want to change the printer attributes for all subsequent prin
jobs, click theKeep options button. This changes the default settings to t
values specified in the Print Screen dialog box.

You can change the default printer settings by changing theMGC >
Setup > Printer menu item. Refer to thePrinter Interface Reference Manual for
a description of all required and optional arguments.

From the Schematic Editor

To print a schematic sheet, perform the following steps:

1. Place the cursor in the Schematic Editor window of the sheet you wish
print, and click the Stroke mouse button.

2. Execute theFile > Print Sheet menu item. The Print Object prompt bar is
displayed.

3. Type the printer name in the “Printer name” text box.
Design Architect User’s Manual, v8.6_26-156
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4. If you want to override the default printer options, click the Options butt
The Print Design Object dialog box is displayed. You can specify the
printer name, the site name, the number of copies, a job configuration 
the orientation, the priority, notification level, magnification, the scale, a
the panel name (if you want to plot only a portion of the window). For a
procedure describing how to create panels, refer to “Adding, Viewing, and
Deleting Panels” in this chapter.

You can change the default printer settings by specifying any or all of t
printer attributes. This overrides the default printer settings for this job
only. If you want to change the printer attributes for all subsequent prin
jobs, click theKeep options button. This changes the default settings to t
values specified in the Print Screen dialog box.

You can change the default printer settings by changing theMGC >
Setup > Printer menu item. Refer to thePrinter Interface Reference
Manual for a description of all required and optional arguments.

From the VHDL Editor

To print a VHDL document, perform the following steps:

1. Click the Stroke mouse button in the VHDL Editor window.

2. Execute theFile > Print > Print Document menu item. The Print
Document prompt bar is displayed.

3. Type the printer name in the “printer_name” text box.

4. Use the choice stepper button to choose whether you want to print all
VHDL text, or selected VHDL text. Press theOK  button when complete.

You can change the default printer settings by executing either theMGC >
Setup > Printer or File > Print > Setup Printer menu item. Refer to thePrinter

Note

When you send a schematic to a plotter, protected objects are
plotted in their unprotected color.
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Interface Reference Manual for a description of all required and optional
arguments.

Printing All Sheets in a Hierarchy

To print all sheets in a hierarchy, perform the following steps:

1. Choose theFile > Print All > Sheets item from the main menu bar.

The Print All Sheets dialog box appears.

2. Enter the pathname to the top-level sheet in the design in the
Component Name field.

3. If desired, restrict the sheets that are printed. The following list describ
the methods for restricting printing:

• Enter a level at which to stop printing sheets the hierarchy in the
Stop Levelfield. The default value of zero prints the entire hierarchy

• Enter a series of strings in theFilter  fields. If the reference pathname t
a sheet in the hierarchy contains one of the strings, the sheet it is n
printed.

• Choose theYes button beneathPreview. This causes a second dialog
box to appear after you execute the current dialog box. A list of all
sheets that met the criteria specified in theStop Level andFilter  fields
is displayed. You then select sheets from the list to be printed.

4. Click theOK  button to print the sheets.
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From an Operating System Shell

You can also print Design Architect graphics from an operating system shell.
following shell-level commands print a design called “my_design” on a printe
named “pr2”:

• On a Sun, Solbourne, or any other supported system which uses the B
4.3 printing environment:

$ /idea/bin/ilpr -pr pr2  -idea  -type  mgc_schematic \
  my_design/schematic

•  On an HP/Apollo workstation:

$ /idea/bin/iprf -pr pr2  -idea  -type  mgc_schematic \
 my_design/schematic

• On HP-PA, DEC, Sony, NEC, or any other supported system which us
the SysV printing environment:

$ /idea/bin/ilp -pr pr2  -idea  -type  mgc_schematic \
 my_design/schematic

Printer Configuration

You may want to adjust your printer configuration for plotting Design Archite
data. Depending upon how your network printers are set up, you may want t
a separate printer configuration file for Design Architect, so that it will not aff
printing from other applications.

Add the following lines (or modify them, if they already exist) to your printer
configuration file to adjust the page offset and the line weight for buses, bord

tray_page_offset_top      1         0.25
tray_page_offset_left     1         0.25
##                      <tag>    <weight>
line_weight               1         1
line_weight               3         7   #default=5
line_weight               5         9   #default=7
line_weight               7        11   #default=9
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Adding, Viewing, and Deleting Panels
You define panels to plot particular areas of symbol or schematic windows. T
panel area is defined by the coordinates of a rectangular region. Panels can
large or small, and they may overlap.

To create a panel in a Symbol or Schematic Editor window, perform the follow
steps:

1. Place the cursor in the Symbol or Schematic Editor window in which y
wish to create a panel, and click the Stroke mouse button.

2. Execute theView > Panel > Add Panel menu item. The Add Panel promp
bar is displayed.

3. Type the panel name in the “Panel Name” text box.

4. If you want to replace a previously defined panel with the same name 
specified, click the Select mouse button on the choice stepper button t
select the “replace” switch.

5. Click the Select mouse button on the “Panel Area” button.

6. Position the cursor at one corner of the panel. Press and hold the Sele
mouse button.

7. Move the cursor while still holding the Select mouse button. A dynamic
rectangle is created which defines an area of the sheet. Move the curs
until the rectangle is the panel size you want, then release the mouse b

Alternatively, you can define a panel name for the area currently being viewe
following these steps:

1. View the desired area, as described in “Viewing the Contents of a Sheet” in
this chapter.

2. Follow steps 2 through 4 in the previous procedure.

3. Either click theOK  button on the prompt bar, or press the Return key.
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To view and center the current panel in a Symbol or Schematic Editor windo
perform the following steps:

1. Activate the edit window of the panel you wish to view. Execute theView
> Panel > View Panel menu item. The View Panel prompt bar is display

2. Type the panel name in thePanel Name text box, then click theOK  button.

To view panel borders in a Symbol or Schematic Editor window, perform the
following steps:

1. Place the cursor in the Symbol or Schematic Editor window in which y
wish to view a panel and its border, and click the Stroke mouse button

2. Execute theView > Panel > Show Panel Border > All Panels On Sheet
menu item to view all panel borders on the sheet. Execute the View >
Panel > Show Panel Border > By Panel Name menu item to view a panel
by name.

3. Type the panel name in thePanel Name text box, then click theOK  button.

To hide panel borders, perform the following steps:

1. Execute theView > Panel > Hide Panel Border > All Panels On Sheet
menu item to view all panel borders on the sheet. Execute the View >
Panel > Hide Panel Border > By Panel Name menu item to view a panel
by name.

2. Type the panel name in thePanel Name text box, and click theOK  button.
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To delete a panel definition in a Symbol or Schematic Editor window, perform
following steps:

1. Place the cursor in the Symbol or Schematic Editor window from which
you wish to delete a panel, and click the Stroke mouse button.

2. Execute theView > Delete Panel menu item.

3. Type the panel name in thePanel Name text box, and click theOK  button.

This deletes the definition of the panel; it does not delete objects in the pane

Creating and Printing Panels in Read-
Only Mode

Design Architect allows you to open a schematic sheet in read-only mode, c
temporary panels and print those panels without changing the read-only stat
the sheet. The temporary panels are deleted when the schematic is closed, 
you specifically enter Edit Mode and check and save the sheet. The procedu
creating and printing panels in read-only mode is as follows:

1. Open a sheet in Read-Only mode.

2. Execute theView > Panel > Add Panel pulldown menu item. The Add
Panel prompt bar is displayed.

3. Type the panel name of the temporary panel in the “Panel Name” text e
box, then create the panel as described in the previous procedure.

4. View the panel border by executing the pulldown menu item:
View > Panel > Show Panel Border > All Panels On Sheet

5. Print the panel by executing the pulldown menuFile > Print Sheet:

6. Verify the printer name in the prompt bar.

7. Click theOptions... button and enter thePanel name in the dialog box text
entry area.
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8. Click OK  on both forms.

Using the Dialog Navigator
You can navigate through your directory and select Design Architect objects
the dialog navigator. The dialog navigator is invoked from dialog boxes withi
Design Architect that request object names. The requested object names ar
entered in the requesting dialog box text fields when selected.

For example, when you execute the Open Symbol command, the Open Sym
dialog box appears with a button labeledNavigator. You can type the full
component name in the “Component Name” text box, or invoke the dialog
navigator, and navigate through your directory structure until you find the cor
object. After you have found the correct object and clicked the “OK” button, t
correct object name is automatically entered in the dialog text field.

When you first invoke the dialog navigator, it lists the contents of the working
directory in alphabetic order, with an icon preceding each design object nam
You select a name in the list by clicking the Select mouse button on the item
you have set the navigation filter to exclude certain types of objects, those ob
that meet the filter requirements for exclusion are not visible when you explo
the contents of a directory.
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The buttons to the right of the list are the navigation buttons. They let you exp
and move through the directory structure. These buttons have the following
meanings:

• Explore Contents(down arrow). After you have selected an item from t
list, clicking the Select mouse button on theExplore Contents button
navigates you down one level of hierarchy, and displays the contents o
directory, if hierarchy exists.

• Explore Parent (up arrow). Clicking theExplore Parent button navigates
one level up the hierarchy to the parent directory, and displays the con
of that directory.

• Explore References(right arrow). Clicking theExplore References
button replaces the current display with the references of the selected
design object.

• Explore Back to Parent(left arrow). Clicking theExplore Back to
Parent button navigates back to the design object that holds the refere
currently displayed. That is, you return to the design object from which 
originally explored references. This button is only activated when you h
selected an object and explored its references (“@” is the right-most
character in the title bar).

• Go To (multi-directional arrows). Clicking theGo To button displays a
dialog box in which you can enter a soft or hard pathname for the file
system destination to which you want to navigate.

NT
When invoking theGo To dialog box, you can enter either a soft
path (such as “$MGC_HOME”) or a hard pathname.
When using a hard pathname, you must specify a drive letter, s
as “C” or “D”, followed by a colon “:”, and then a forward slash
“/”.
For example, the hard pathname “C:/Designs” would resolve to
the “Designs” directory on the “C” drive.
Design Architect User’s Manual, v8.6_26-164



Operating Procedures Editing in the Context of a Design Viewpoint

c
epts

ng

tton
Editing in the Context of a Design
Viewpoint

The following procedures describe specific capabilities of editing a schemati
sheet in the context of a design viewpoint. If you are unfamiliar with the conc
related to design viewpoints and editing in the context of a design, read “Editing
in the Context of a Design” in Chapter 4 before you begin.

Opening a Design Sheet

From Design Manager

To invoke the Design Manager and open a design sheet, perform the followi
steps:

1. Invoke the Design Manager by typing “dmgr” at a shell prompt.

2. The Design Manager displays a Tools window, which contains icons
representing each of the applications you can invoke, and a Navigator
window, which shows the contents of the working directory. With the
Navigator window active, use the directional arrows to navigate to the
component that contains the design viewpoint you want to open.

3. Select the viewpoint you want to open by clicking the Select mouse bu
on its icon.

4. Press the Menu mouse button to display the popup menu. Choose the
Open > Design Architect popup menu item. This opens a new shell
window for the Design Architect Session, then opens the design in the
context of the selected viewpoint.
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From Design Architect

You open a Design Sheet window on a design viewpoint so you can edit a d
within the context of the design viewpoint.You open a Design Sheet window
first setting the editing session on a design viewpoint with theSet Viewpoint
command. You can click on the SET VIEWPOINT icon, or execute the comm
from a popup or pulldown menu. A dialog box appears as shown in the follow
illustration.

You fill out the dialog box as shown above, then clickOK . To help you select the
component or viewpoint you wish to use, click theNavigator button. The dialog
navigator appears on the screen, allowing you to traverse your directory stru
to select a Design Architect component or viewpoint. Refer to the “Using the
Dialog Navigator” section of this chapter for a description of how to use the
dialog navigator.

Set Viewpoint

Component Name card_reader

OK CancelReset

Navigator...Viewpoint Name sim_vpt

Create New ViewpointExisting Viewpoint Unset Viewpoint

 Enter

Click
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After the viewpoint is set, the following dialog box appears:

From this dialog box, you can open a Design Sheet window by clickingOK , or
you can edit a source sheet within the design by clicking theSource Sheet button
and specifying the source sheet you want to edit.

Also, from the expanded Open Design Sheet dialog box, you can open the sh
Editable or Read Only, and enter a startup filename that can execute interna
state functions for setup purposes.

TheAuto Update Mode specifies whether instances should be updated when
sheet is opened, and if so, how the properties are merged. Click the stepper 
to choose between the following:

• No Auto Update: Out of date instances are not updated when the shee
opened.

Open Design Sheet

Viewpoint:    /users/train1/training/da_n/card_reader/sim_vpt

OK CancelReset

Startup File Path:

Open Top Level Sheets

HierarchicalTop Level

Open as:

Editable Read Only

Options...Sheet Name sheet1

Source Sheet
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• Auto: Instance-only and Value_Modified properties are not changed; n
properties on the current symbol are added to the instance.

• Clear: Instance-only properties are deleted; all other properties are res
the current symbol values.

You can control the visibility of existing properties by using a startup file whe
opening a sheet. Enter the file pathname in the Sheet Specific Startup Scrip
entry field in the Open Design Sheet dialog box. After the argument selection
complete, press theOK  button.

For more information about how properties are updated, refer to “Updating
Properties on an Instance of a Symbol” in Chapter 3.

Viewing Back Annotations

To view back annotations, perform the following steps:

1. With the cursor in the design sheet window, click the Stroke mouse bu

2. Type “show annotations” in the window area, or execute theSetup >
Annotations/Evaluations > Toggle Annotations. This menu item turns
the display of annotations on and off.
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Editing Back Annotations

To edit back annotations, perform the following steps:

1. Move the cursor to the design sheet window and click the Stroke mous
button. Turn on the display of back annotations.

2. Set the editing mode to Off by executing theFile > Set Edit Mode Off
menu item. If the File > Set Edit Mode Onmenu item is displayed, the
editing mode is already set to Off.

With the editing mode set to Off, only back annotation properties can b
modified or deleted. Also, when annotations are displayed, properties a
to the sheet are added to the back annotation object connected to the
viewpoint.

Viewing Evaluated Properties

To view evaluated properties on your design sheet, perform the following ste

1. With the cursor in the design sheet window, click the Stroke mouse bu

2. Type “set evaluations” in the window area. The Set Evaluations promp
is displayed. Click the up arrow until the “Mode” is set to “on”.
Alternatively, you can toggle the display of evaluations by choosing the
Setup > Annotations/Evaluations > Toggle Evaluationsmenu item.

With evaluations on, all properties are displayed evaluated.
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Merging Back Annotations

To merge back annotation to the schematic sheet, perform the following step

1. Place the cursor in design sheet window and click the Stroke mouse bu
Turn on the display of back annotations.

2. Execute theMiscellaneous > Merge Annotationsmenu item. This menu
item merges all viewable back annotation properties to the schematic s

After this menu item is executed, and if you decide to save the sheet, t
back annotation objects will no longer contain the property values whic
were successfully merged into the schematic sheet.

Locking Schematic Sheet for Edits

To lock a schematic sheet for edits, perform the following steps:

1. In the design sheet or schematic sheet window, click the Select mouse
button on the parent instance for the schematic sheet you want to lock
editing.

2. Add the property name “Source_edit_allowed” with the property value
“false” to the instance. Changing source_edit_allowed property value t
“true” unlocks the schematic sheet below the parent instance for editin
The “Adding Properties” procedures in the “Assigning Properties and
Property Owners” section of this chapter.

!
Caution

If the schematic sheet is used in more than one place in your
design, when you merge back annotations to that one sheet, a
other components that use the sheet see the changes. Since a
occurrences of the component see the changes, you should no
merge to reusable sheets.
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Opening a Non-Existent Schematic in Design Context

Design Architect has the ability to create a sheet in a new schematic inside a
existing component which is opened as a design sheet. For example, assum
you use Design Architect to open a schematic in the context of a design view
and that the schematic has an instance of a component that contains only a
symbol. If you open down on the instance, Design Architect will create a new
(blank) schematic sheet for you. You can then edit the sheet, then check and
the sheet - all without leaving the context of the design viewpoint.

Opening a Non-Existent Component in Design Context

Design Architect also has the ability to create a sheet in a new schematic ins
new component which can be opened as a design sheet. The general proce
as follows:

1. In the Design Architect session, click on the Set Viewpoint icon.

2. Enter the following in the Set Viewpoint dialog box:

a. Click on the Create New Viewpoint button

b. Enter the pathname of the non-existent component

c. Enter the name of the new design viewpoint

d. Select the Viewpoint type, then click OK.

The Create Design Sheet dialog box appears. Enter the following:

e. Verify or change the Sheet Name:

f. Verify or change the Schematic Name.

g. Optionally enter a Startup File Pathname.

h. Click OK.
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Design Architect creates all the new design objects from the ground up: the 
component, the new component interface, the new schematic, the new shee
the new design viewpoint. A new design context window is then opened on t
new (blank) schematic sheet and ready for your edits.
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Design Manager Operation Verification
The following topics list several methods for verifying the correctness of a de
object manipulation.

When referencing a design object, if you provide a relative pathname that doe
begin with the dollar sign ($) character, that relative pathname will be conver
to an absolute pathname, based on the value of the environment variable
MGC_WD. You must ensure that the value of MGC_WD is set to the correct
value for your current working directory. If is not set properly, an incorrect
pathname for the reference may be stored.

Reference Checking

Compare references before and after the Design Manager operation. The
following discussion describes the process to ensure that references have b
manipulated correctly:

1. Activate a navigator window in the Design Manager. Use the navigato
buttons to move to the directory that contains the component containe
you will manipulate through some Design Manager operation.

2. Click on the specified component container. Click theExplore Contents
(down arrow) button to display the contents of the selected container. Y
will see the model icons associated with the component, in addition to 
part icon.

3. Select all the icons at that level by depressing the Select mouse button
dragging it so all icons are within the specified selection area, then
releasing the Select mouse button.

4. ChooseReport > Show References from the pulldown menu bar. A repor
window for each selected object is displayed containing the current
references of each object.

5. Click on the schematic model icon. Click theExplore Contentsbutton to
view the sheet icons associated with the schematic.
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6. Select all the sheets. ChooseReport > Show References from the
pulldown menu bar. A report window for each selected sheet is display
containing the current references of each object.

7. When you have completed the Design Manager operation on the spec
object, check the references of the manipulated object at all levels to v
that the manipulation was successful.

This method of verification is recommended when you have a design that is
completely self-contained. If you have a design that references external obje
this method can become time-consuming. In that case, use the configuration
method, described in “Configuration Build” in this chapter.

Object Checking

To determine if any objects were mistakenly included or excluded, check for
existence or non-existence of files by performing the following steps:

1. Activate a navigator window in the Design Manager.

2. Use the navigator buttons to move to the directory that contains the
component container that you will manipulate through some Design
Manager operation.

3. Click on the specified component container.

4. Click the Explore Contentsbutton to move into the contents of the
container. You will see the model icons associated with the componen
addition to the part icon.

5. Click on the schematic model icon.

6. Click theExplore Contents button to view the sheet icons associated w
the schematic.

7. When you have completed the Design Manager operation on the spec
object, check to make sure that all the object's icons, at all levels, are
displayed in the navigator to verify that the manipulation was successf
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This method of verification is recommended when you have a relatively sma
design that is completely self-contained. If you have a design that references
external objects, this method can quickly become time-consuming. In that ca
use the configuration build method described in “Configuration Build.”

Configuration Build

For some scenarios, such as copy and move, creating a configuration from t
results and doing a build can check that all the references can be resolved. T
method of verification is recommended when you have a relatively large des
that is either self-contained and/or references external objects.

To do a configuration build, perform the following steps:

1. Activate a navigator in the Design Manager.

2.  Use the navigator buttons to move to the directory that contains the to
level design container that you manipulated through some Design Man
operation.

3. Open a configuration window by choosing theSession > Open
Configuration > New pulldown menu item.

4. Drag the design container into the configuration window.

5. ChooseConfiguration > Build  from the configuration window popup
menu. The build operation begins with the primary entry, traverses its
contents and its references, and adds secondary entries to the configu

When the build is complete, the configuration window displays the
pathnames of all primary and secondary entries, and the pathnames to
the references associated with the entries.
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Application Invocation

The simplest method of verifying that a design has been manipulated correc
to invoke the appropriate application on the manipulated design. If you have
manipulated a design that contains symbol and schematic models, invoke D
Architect on that design. If you have manipulated a design that contains des
viewpoints, invoke QuickSim II on that design. If you have manipulated a de
that contains symbol and schematic models and also contains design viewp
invoke both Design Architect and QuickSim II (or DVE) on the design.

CAUTION: The application invocation is not a bullet-proof check. A copy of t
design could contain references to the original. If the original is still available
invocation on the copy will still appear to work fine. However, when the origin
is moved/deleted, the copy will not run. A visual reference check is good
insurance.

Updating Parts on all Sheets in a Design
When you install an new parts library, you may want to update all instances 
parts on all sheets in a design. Perform the following steps to update an enti
design:

1. Choose theFile > Update All > Sheets item from the main menu bar.

The Update All Sheets dialog box appears.

2. Enter the pathname to the top-level sheet in the design in the
Component Name field.

3. Click one of theUpdate Type buttons to specify how instances should be
updated when the sheet is opened. The following list describes the upd
action for each button:

• Auto: Instance-only and Value_Modified properties are not change
new properties on the current symbol are added to the instance.

• Instance: All existing properties are unchanged; new properties on 
current symbol are added to the instance.
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• Symbol: Instance-only properties are not changed; all other propert
are reset to the current symbol values.

• Clear: Instance-only properties are deleted; all other properties are
reset to the current symbol values.

• Noupdate: Out of date instances are not updated when the sheet is
opened.

4. If desired, restrict the sheets that are updated. The following list descr
the methods for restricting the update:

• Enter a level at which to stop updating sheets the hierarchy in the
Stop Levelfield. The default value of zero updates the entire hierarc

• Enter a series of strings in theFilter  fields. If the reference pathname t
a sheet in the hierarchy contains one of the strings, the sheet it is n
updated.

• Choose theYes button beneathPreview. This causes a second dialog
box to appear after you execute the current dialog box. A list of all
sheets that met the criteria specified in theStop Level andFilter  fields
is displayed. You then select sheets from the list to be updated.

5. Click theOK  button to update the sheets.
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Appendix A
DA Design Checks

Design Architect design checks are separated into the following five major
groups:

• Schematic sheet checks, beginning on pageA-1

• Optional schematic sheet checks, beginning on pageA-8

• Symbol checks, beginning on pageA-13

• Optional schematic design (all sheets) checks, beginning on pageA-15

• Optional electrical rule violations checks, beginning on pageA-17

Each major check group, with the exception of the electrical rule violations ch
group, is broken down into smaller groups which map to individual switches u
with the Check command. Refer to “The Check Command” in Chapter 5 for
information about how to execute these specific checks.

Schematic Sheet Checks
These checks are for individual schematic sheets. The required schematic s
checks are listed below with the proper switch setting for each check catego

Required Instance Checks

The following checks are required for instances. Error messages are genera
the checks are not passed. The Check command with the “-INstance All” sw
specified executes the individual error checks listed below:
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• Does an Inst property value (instance name) have valid syntax?

• Is an Inst property value (instance name) unique within the sheet?

• Does an instance reference a version of a part which exists and is curr

• Do the instance pins match pins of a referenced symbol?

• Does a symbol model exist for the instance?

• Do instance property values have valid syntax?

• Does a Pin property value have valid pin name syntax?

The following checks generate warning messages if they are not passed:

• Can an instance name (Inst property value) be evaluated?

• Can a pin name (Pin property value) be evaluated?

• Can a property value on an instance or pin be evaluated?

Required Special Instance Checks

The following checks are required for special instances, such as ports, conne
globals, and bus rippers. Error messages are generated if these checks are 
passed. The Check command with the “-SPecial All” switch specified execut
the individual error checks listed below:

• Does a port connector (Class “P” property value) have only one pin?

• Does an off-page connector (Class “O” property value) have at least o
pin?

• Does a net connector (Class “C” property value) have at least two pins

• Does a global (Class “G” property value) have one pin?

• Does a bus ripper (Class “R” property value) have one pin with pin prop
“Bundle”?
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• Does a bus ripper (Class “R” property value) have at least two pins?

• Does a null instance (Class “N” property value) have no pins.

• Does a pin of a port connector (Class “P” property value) connect to a
named net?

• Do all nets attached to the pins of a net connector (Class “C” property
value) have the same width?

• Does a global (Class “G” property value) have a Global property value w
valid net name syntax?

• Does a bus ripper (Class “R” property value) have a Rule property atta
to an instance or an output pin?

• Does a Rule property value of a bus ripper (Class “R” property value) h
a valid subscript syntax?

• Is the output pin of a bus ripper (Class “R” property value) attached to 
named net whose width matches the width specified by the “Rule” prop
value?

• Is an input pin of a bus ripper (Class “R” property value) attached to a 

• Is a pin of an off-page connector (Class “O” property value) connected
named net?

• Does the signal name of an implicit ripper exactly match the name of a
corresponding signal in the net or net bundle?

The following checks generate warning messages if they are not passed:

• Does a net connector (Class “C” property value) connect two nets with
same name?

• Do pins of a net connector (Class “C” property value) connect to a nam
net?
Design Architect User’s Manual, v8.6_2 A-3
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• Does a Global property value (Class “G” property value) contain a
subscript?

• Can a Global property value (Class “G” property value) be evaluated?

Required Net Checks

The following checks are required for nets. Error messages are generated if
checks are not passed. The Check command with the “-NEt All” switch spec
executes the individual error checks listed below:

• Does a property value assigned to a segment of a net conflict with valu
different segments of the same net?

• Does a Net property value have valid net name syntax?

• Does a range specified in the net name (Net property value) conflict w
the range of a connected pin?

• Does a pin connected to an unnamed net have conflicting range
specifications?

• Does a property value have valid expression syntax?

• Does a single net have the same name as a bus or bundle?

The following checks generate warning messages if they are not passed:

• Can the net name (Net property value) be evaluated?

• Can the pin name (Pin property value) be evaluated?

• Can all property values be evaluated?

• Are two globals shorted together?
Design Architect User’s Manual, v8.6_2A-4
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Required Net Bundle Checks

The following checks are required for net bundles. Error messages are gener
these checks are not passed.

• Are the members of a net bundle listed in at least one occurrence of th
bundle in a schematic?

• Do all occurrences of a named net bundle in a schematic contain the s
signal names in the same order?

• Does the combined width of the nets and bus bits in a net bundle matc
width of a connecting pin bundle or wide pin?

• Does a net that is ripped by name from a net bundle actually exist in th
bundle?

• Does a net bundle name contain a parameterized expression?

• Does a net bundle have the same name as an individual net or bus?

Required Frame Checks

The following checks are required for frames. Error messages are generated
these checks are not passed. The Check command with the “-FRame All” sw
specified executes the individual error checks listed below:

• Does an instance or its pins overlap a frame border?

• Does a frame border overlap the border of another frame?

• Does a frame have a frame expression?

• Does a frame expression have valid syntax?

The following checks generate warning messages if they are not passed:

• Can the frame expression (Frexrep property value) be evaluated?
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• Does a frame contain an instance?

• Can all property values on a frame be evaluated?
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Required Symbol Pin Check

The following symbol pin check is performed on schematic sheets. Error
messages are generated if it is not passed. The Check command with the “-
PIns All” specified executes the individual error check listed below:

• Are there symbol pins left on a schematic sheet?

Required Pin Bundle Checks

The following checks are required for pin bundles. Error messages are gene
if these checks are not passed.

• Do all pins occur only once within a pin bundle?

• Is there an individual pin by itself on the symbol that is also contained 
pin bundle?

• Is a pin contained in more than one pin bundle?
Design Architect User’s Manual, v8.6_2 A-7
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Optional Schematic Sheet Checks
The optional schematic sheet checks extend beyond the required schematic
checks. They are not required by Mentor Graphics applications, but if they a
activated in the Check command and are capable of producing errors, they m
be passed like the required checks.

Property Ownership Checks

The following checks are performed on properties; error messages are gener
they are not passed. The Check command with the “-OWner All” switch spec
executes the individual error checks listed below:

• Is the Pin property attached to a pin?

• Is the Inst property attached to an instance?

• Is the Net property attached to a net?

• Is the Global property attached to an instance, not of type Class “G” or
Class “N”?

• Is the Rule property attached to an instance not of type Class “R” or C
“N”, or attached to a pin of a ripper instance?

• Is the Frexrep property attached to a frame?
Design Architect User’s Manual, v8.6_2A-8
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Init Property Checks

The following Init property checks are performed; error messages are genera
they are not passed. The Check command with the “-INItprops All” switch
specified executes the following individual error checks:

• A net has two different global components attached to it; for example, b
Vcc and Ground attached to the same net.

• A net has a forcing Init property value “xxF”, but has no global attached
it. This can result from adding a global such as Vcc to a net, then delet
the global.

• A net has an Init property value that does not match the Init property v
on the pin of the attached global instance.

This can result from adding a global Vcc to a net (causing the Init prop
on the net to have a value of 1SF), then adding a global Ground to the 
net (causing the Init property value to change to 0SF), then deleting th
Ground global. The result would be a net with Init = 0SF, but with a Glo
Vcc which specified Init = 1SF.

Parameter Analysis

The following informational check is performed on parameters, and causes a
parameter listing to be generated. The Check command with the “-PAramete
switch specified executes the individual informational check listed below:

• Identify parameters which are required to evaluate property values and
object names in the sheet.
Design Architect User’s Manual, v8.6_2 A-9
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Expression Analysis

The following informational check is performed on expressions, and causes 
expression listing to be generated. The Check command with the “-EXpressi
All” switch specified executes the individual information check listed below:

• Identify expressions in the sheet that require evaluation and the param
they require.

Instance Overlap Check

The following informational check is performed on instances, and causes an
instance listing and an error to be generated if not passed. The Check comm
with the “-OVerlap All” switch specified executes the individual informational
check listed below:

• Identify the position of two instances where the bounding box of one
instance overlaps the bounding box of the other.

• Class instances are positioned such that their bounding boxes may ov
those of other class or non-class instances. Each instance type is grou
separately within the warning message.

Not-dots Check

The following informational check is performed on not-dots, and causes a no
listing to be generated. The Check command with the “-NOtdots All” switch
specified executes the individual informational error check listed below:

• Identify all points where not-dots exist on the schematic sheet.
Design Architect User’s Manual, v8.6_2A-10
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Close Dot Check

The following informational check is performed on close dots, and causes a 
dot listing to be generated. The Check command with the “-CLosedot All” sw
specified executes the individual informational check listed below:

• Identify all points where different vertices are visually difficult to
distinguish (where the close dot symbol is displayed on the sheet).

Dangling Net and Pin Checks

The following informational checks are performed on dangling nets and pins,
cause a net and pin listing to be generated. The Check command with the “-
Dangle All” switch specified executes the individual informational checks list
below:

• Identify all dangling nets. A dangling net is a net vertex with no attache
pin, and which is not marked as a legal dangling net by the user (net w
Class “dangle” property value).

• Identify all dangling vertices.

• Identify all dangling pins. A dangling pin is a pin which is not attached t
net and has not been marked as a legal dangling pin by the user (pin w
Class “dangle” property value).

Valid dangles can be marked as such by adding a Class property with value
“dangle” to any vertex on the net or pin.
Design Architect User’s Manual, v8.6_2 A-11
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Annotations

The following informational checks are performed on back annotations when
Design Architect is invoked on a design in the context of a design viewpoint.
Check command with the “-Annotations All” switch specified executes the
individual informational checks on a sheet-by-sheet bases:

• Identify all annotations to fixed or protected properties.

• Identify all annotations that are unattached. When an unattached anno
is found, the design pathname to the object which no longer exist in th
design is reported along with a list of annotated properties on the objec

These unattached annotations can be reattached to another design ob
using the pulldown menu itemMiscellaneous >Reconnect Annotations.

Note

The annotation checks are only performed when DA is invoked
a design viewpoint. Otherwise, this option is ignored.
Design Architect User’s Manual, v8.6_2A-12
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Symbol Checks
For a symbol to pass the required checks, a set of required checks is execut
symbol bodies, special symbols, and pins. The required symbol checks mus
passed in order for the symbol to be instantiated.

Required Symbol Pin Checks

The following checks are required for symbol pins; error messages are gene
if they are not passed. The Check command with the “-SYMbolPin All” switch
specified executes the individual error checks listed below:

• Does each symbol pin have a Pin property?

• Do pin properties on a symbol have valid pin name syntax?

• Does a symbol have at least one pin (unless the symbol has a Class “N
property value)?

• Does a property value on a pin have an invalid expression syntax?

Required Symbol Body Checks

The following checks are required for symbol bodies; error messages are
generated if they are not passed. The Check command with the “-SYMbolBo
All” switch specified executes the individual error checks listed below:

• Does a symbol body have a graphical representation?

• Is the same property value assigned different values on different piece
the symbol body?

• Do property values on the symbol body have valid expression syntax?
Design Architect User’s Manual, v8.6_2 A-13
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Required Special Symbol Checks

The following special checks are required for special symbols. Error message
generated if these checks are not passed. The Check command with the “-
SYMbolSpecial All” switch specified executes the individual error checks list
below:

• Does a port connector (symbol with Class “P” property value) have onl
one pin?

• Does an off-page connector (symbol with Class “O” property value) hav
least one pin?

• Does a net connector (symbol with Class “C” property value) have at le
two pins?

• Does a global (symbol with Class “G” property value) have one and on
one pin?

• Does a bus ripper (symbol with Class “R” property value) have one pin
with Pin property value “Bundle”?

• Does a bus ripper (symbol with Class “R” property value) have at least
pins?

• Does a null instance (symbol with Class “N” property value) have no p
Design Architect User’s Manual, v8.6_2A-14
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Optional Schematic Design Checks
The optional schematic design checks extend the checking function of the
required schematic sheet checks. They are not required by Mentor Graphics
applications, but if they are activated in the Check command and are capabl
producing errors, the sheet will not be marked as having passed Check
successfully if any errors are reported. The -SCHematic switch must be selec
the optional schematic checks are to be activated.

Each optional schematic check is listed below with its proper switch setting.

Pin and Port Interface Checks

The following checks are performed on pin and port interfaces. Error messag
are generated if they are not passed. The Check command with the “-
SCHematicINTerface All” and -SCHematic switches specified executes the
individual error checks listed below:

• Does a pin on the symbol match a net on the schematic?

• Does a port on the schematic have a matching pin on the symbol?

• Does a pin on a symbol have a matching port on the schematic?

For additional information concerning interface checks, refer to “Schematic
Interface Checking” in this chapter.

Instance Check

The following check is performed on instances and causes an error message
generated if it is not passed. The Check command with the “-SCHematicInst
All” and “-SCHematic” switches specified, executes the individual error chec
listed below:

• Is the instance name (Inst property value) unique within the schematic
Design Architect User’s Manual, v8.6_2 A-15
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Special Instance Checks

The following special checks are performed on instances. Warning message
generated if they are not passed. The Check command with the “-
SCHematicSpecial All” and “-SCHematic” switches specified executes the
individual checks listed below:

• Does an on/off-page connector have a matching on/off-page connecto
the schematic?

• Are two nets with the same name on different sheets of the schematic
connected through on/off-page connectors?

Net Checks

The following checks are performed on nets; warning messages are generat
they are not passed. The Check command with the “-SCHematicNet All” and
SCHematic switches specified executes the individual checks listed below:

• Does a net and a global have the same name in a schematic?

• Are global nets shorted?
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Optional Electrical Rule Violations
Checks

The electrical rule violations checks are an optional series of schematic shee
checks which examine every electrical net in the schematic. For each net, a
warning is produced if the net is connected to more than one Source. Warnin
messages are issued if they have not passed.

Checking a Sheet for Electrical Rules Violations

The Check command with the “-busshorts” switch specified executes the che

Checking a Schematic for Electrical Rules Violations

The Check command with the “-SCHNETI.o” and “-SCHB.usshorts” switches
specified executes the individual checks.

For either a sheet or a schematic check, all PINTYPE property names and v
regardless of case, are examined. For each net, a warning is produced if the
following two conditions are meet:

• The net is connected to at least one pin with a PINTYPE property of “IN
anOutput Point, or aGlobal; and

• At lease one otherSource is attached to the net.

For this check, the followingdefinitions are made:

• Port - an instance of a symbol with a CLASS property of “P” or “E”. Po
have exactly one pin of indeterminate width. Class “P” ports are not wri
to the EDDM connectivity database as instances, while class “E” ports
written.

Note

To avoid this check, assign the net a property with the name
“MULTI_SOURCE” and any value.
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• Global - an instance of a symbol with a CLASS property of “G”.

• Input Port  - either a Port with a pin having a PINTYPE property of “OUT
or a Port with the symbol name of “portin”, regardless of case.

• Output Port  - either a Port with a pin having a PINTYPE property of “IN
or a Port with the symbol name of “portout”, regardless of case.

• Bidirectional Port  - either a Port with a pin having a PINTYPE property 
“IXO” or “IO”, or a Port with the symbol name of “portbi”, regardless of
case.

• Source - either a pin on a net with a PINTYPE property of “IXO”, “IO”, o
“OUT”, or an Input Port, Bidirectional Port, or a Global.

• Sink - either a pin on a net with a PINTYPE property of “IXO”, “IO”, or
“IN”, or an Output Port or a Bidirectional Port.

Schematic Interface Checking
As previously mentioned in “Pin and Port Interface Checks” in this chapter,
Design Architect performs an optional schematic interface check during Che
Schematic. To perform this check, you must ensure that “Schematic Interfac
checked in the Schematic Check Settings Dialog Box as shown inFigure A-1.
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Figure A-1. Schematic Check Settings Dialog Box

To select this check, following the step-by-step procedures in the “Checking a
Schematic for Errors” section of Chapter 6.

The interface check matches a schematic to its interface when there is a net
the same name as each pin on its part interface. Errors are produced for eac
interface pin that does not have a net on the schematic with a matching nam
Specifically the name of the pin, as specified by the symbol’s PIN property, i
compared, regardless of case, to the name of the net, as specified by the net
property. An error is produced if at least one net with the same name does n
exist for each pin on the part interface to which the schematic is registered.

If there is a corresponding net for each pin, then the net is checked for an att
input port, output port, or bidirectional port instance. This check will only be
performed for interface pins that meet the following three criteria:

• There is a net on the schematic with the same name as the interface p

• The net with the same name has a port instance attached to it

Default Schematic Check Settings
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Write to Transcript

No File

File Mode:No
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Errors
Only

Errors/
Warnings
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• The interface pin has a PINTYPE property with a case-insensitive valu
“IN”, “OUT”, “IO”, or “IXO”.
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Appendix B
Support Pulldown Menu

TheSupport pulldown menu is available in both Design Architect and Design
Viewpoint Editor.Figure B-1 shows theSupport pulldown menu in the enhanced
Design Architect Session Window.

Support Menu Overview
TheSupport pulldown menu allows the user direct access to Mentor Graphic
Customer Support.

Support commands that involve electronic mail transactions provide for direc
access into Mentor Graphics’ SupportNet email server. The commands invo
email includeSearch TechNotes, Open Call Log, Check Call Log Status, and
Order Patch, all of which are explained on the following pages.

Note

TheSupport pulldown menu is only available in the Session
Window of Design Architect or Design Viewpoint Editor.
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Figure B-1. Enhanced Design Architect Session Window
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Using the Support Menu
This section describes the menu items in theSupport pulldown menu. Each menu
item is listed, followed by a description.Figure B-2 shows theSupport menu.

Figure B-2. Session Support Pulldown Menu

• Troubleshooting helps you diagnose and solve problems within the
application by displaying on-line documentation based on your selectio
a problem area. TheTroubleshooting menu uses your specified on-line
viewing option (BOLD or Acrobat) to call sections of various Mentor
Graphics manuals.Figure B-3 shows theSupport >Troubleshooting menu
for Design Architect.Figure B-4 shows theSupport >Troubleshooting
menu for Design Viewpoint Editor.
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Figure B-3. Design Architect Support Submenu: Troubleshooting

Figure B-4. Design Viewpoint Editor Support Submenu:
Troubleshooting
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TheSupport >Troubleshooting pulldown menu provides the following
submenu items:

o Design Viewpoint Editor displays the message:This report has not yet
been implemented.

o Design Architect displays a text report ofDesign Architect
troubleshooting techniques and common causes of problems.

o Design Management navigates to the section in theDesign Manager
User’s Manualon troubleshooting techniques to employ when a Des
Manager problem occurs.

o Licensingnavigates to a section in theManaging Mentor Graphics
Software Manual on tools to resolve licensing problems.

o X Environment navigates to a section in theManaging Mentor
Graphics Software Manual on troubleshooting X display and X host
setup in the X Windows System.

o Printing/Plotting  navigates to a section in thePlot/Export Filter User's
and Reference Manualon troubleshooting your print environment.

o Userware navigates to the section in theAMPLE User’s Manualon
AMPLE (Advanced Multi-Purpose Language) error messages that
occur most frequently.

• Support Info displays World Wide Web (WWW) addresses for several
Mentor Graphics Internet locations (Web Pages) as well as information
quickly dialing into the Mentor Graphics Support Center. You have the
option to invoke a Web Browser on the WWW address (URL or Univer
Record Locator). You can specify any web browser, as long as it is inst
and its binary is in your UNIX search path.

When you invoke a browser, the following message appears in the
Transcript and Message windows:

//  Note: Invoking Web Browser on URL...
Design Architect User’s Manual, v8.6_2 B-5
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(from: Uims/base_toolkit/ui_session_tk 81)

On HP platforms, because you can have six different workspaces, it is
possible to have browsers invoked in a workspace other than the one 
which the current Mentor Graphics application is running. When a brow
is running in another workspace, executing a Support Info menu to invo
browser does not pop forward the browser. You must have the browse
running in your current workspace for it to pop forward automatically.

When you plan to use more than oneSupport Info menu item, leave the
Web Browser running, rather than exiting the browser. Otherwise, the
following error, which results from an overlap of browser processes
running, may appear:

A network error occurred: unable to connect to server. The server may
down or unreachable. Try connecting again later.

If the browser does not invoke at the operating system level, check for
lock links in the browser’s directory.

TheSupport Info menu provides access to SupportNet, a suite of Inter
services designed to provide fast and easy access to technical informa
for Mentor Graphics customers with current Support Agreements.
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Figure B-5. Support Submenu: Support Info

As shown inFigure B-5, theSupport >Support Info pulldown menu
provides these submenu items:

o WWW TechNote Page displays the current Internet address for the
Mentor Graphics TechNote Web Page and provides the option to
invoke a Web Browser on the displayed address. The TechNote Pa
enables you to perform interactive searches on technical notes for
Mentor Graphics applications.

o WWW AppNote Page displays the address for the Mentor Graphics
AppNotes Index Web Page and provides the option to invoke a We
Browser on the displayed address. Mentor Graphics AppNotes are
similar to White Paper documents and identify solutions to known
problems, explain processes, or define procedures necessary to
configure Mentor Graphics products. The purpose of the AppNotes
index is to help locate AppNotes information quickly and by catego
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o WWW Patch Page displays the address for the Mentor Graphics
SupportNet-Web Patch home page and provides the option to invo
Web Browser on the displayed address. This home page provides
information on release patches and downloading patches to your s

o WWW SupportBulletin Page displays the address for the Mentor
Graphics SupportBulletins Web page and provides the option to inv
a Web Browser on the displayed address. Mentor Graphics
SupportBulletins provide the latest news on current tools, answers 
frequently-asked questions, specific workarounds and user tips, an
release summary information.

Access to this page is restricted to Mentor Graphics customers with
current Support Agreement. A Password dialog box displays promp
you to supply aUser ID andPassword to access SupportBulletins. If
you do not have a valid user ID and password, you can pressCancel to
apply for a site-based SupportNet-Web account and a user-based
SupportNet-Email account.

o WWW Configurations Page displays the address for the Mentor
Graphics Qualified Configurations Web Page and provides the opti
to invoke a Web Browser on the displayed address. This web page
provides information, by platform, describing the minimum
workstation configurations and operating system levels qualified to 
Mentor Graphics software releases.

o WWW MUG Home Page displays the address for the International
Mentor Graphics User’s Group (MUG) Web Site and provides the
option to invoke a Web Browser on the displayed address. MUG
provides for the exchange of technical, administrative, and manage
information related to Mentor Graphics products between users an
between Mentor Graphics and customers.

o WWW Support Home Page displays the address for the Mentor
Graphics Customer Support Web Page and provides the option to
invoke a Web Browser on the displayed address. The Customer Su
page provides information on support information, support services
and customer connections.
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o Speed Dial Info helps you locate the correct speed dial number to u
for a particular application or topic when calling the Mentor Graphic
Support Center. Your call will then be automatically routed to the
correct Support Group for that application. If you choose not to spe
a search string or partial search string for an application/topic name
system displays all applications and topics available.

• Check Environment displays the Check Environment dialog box for
checking your current working environment to ensure that it is correctly
configured to run Mentor Graphics software. Executing the dialog box
automatically accesses a script located by default in
$MGC_HOME/install8/bin/mgc_check_env. You can optionally use the
Internet and file transfer protocol (ftp) to retrieve the latest version of th
script from the Mentor Graphics SupportNet. Refer to the pulldown me
Support > Help > On SupportNet for more information on SupportNet
and script retrieval.

• Check References displays the Check References dialog box for check
the references in your design hierarchy. You can optionally choose to c
object references outside the design data hierarchy.

• List References displays the List References dialog box for viewing all
unique references for all objects in the entire component (that is, all da
related to the design).Component Name refers to a container storing the
schematic, symbol, viewpoint, and other files which represent a design
object.

• Find Lock Files searches for files with the extensions.lck and.ed.new,
created by Mentor Graphics applications and which may have been lef
behind after a system crash or hard program crash. Executing the men
displays a report with the results of the search, along with instructions 
removing these files.

• Generate Testcase displays the Generate Testcase dialog box for creatin
testcase from a design. Mentor Graphics Support uses a testcase to
reproduce a customer-reported problem. This utility creates a tarred an
compressed file representing a fully self-contained version of the desig
You can then send the compressed file to Mentor Graphics Support us
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the pulldown menuSupport > Send Testcase to MGC. (The destination
directory is the directory to which the compressed file is written.)

The Generate Testcase utility considers all storage entities that you se
component, object, or container. This utility includes everything within 
selected directory as well as every object that is referenced by objects
that directory. For example, when you select a design directory, the uti
generates a testcase to include the entire design.

• Send Testcase to MGC displays the Send Testcase to SupportNet dialo
box for transferring a testcase or file to Mentor Graphics SupportNet. T
utility uses the Internet and file transfer protocol (ftp).

• Search TechNotes displays the Search TechNotes dialog box for using
SupportNet Email to query the Mentor Graphics TechNotes database, b
on topic, product, version, keywords, or TAN (technical application note
TechNote) ID numbers. When you do not specify a TAN ID, a summary
of TANs that meet the search criteria displays. Then, order specific TA
using the appropriate TAN IDs. You can optionally choose a summary
level to include either a short or long description for each TAN.

You must have email and be a registered SupportNet Email user to us
utility. For instructions on how to register for SupportNet and a descrip
of the syntax for each filed, refer to the pulldown menu
Support > Help > On SupportNet Email.

• Open Call Log displays the Open Call Log dialog box for creating a cal
log with Mentor Graphics Support, based on information you enter abo
your site, telephone contact, platform type, operating system, applicati
version, and a description of the reason for the call.

You must have email and be a registered SupportNet Email user to us
utility. For instructions on how to register for SupportNet and a descrip
of the syntax for each filed, refer to the pulldown menu
Support > Help > On SupportNet Email.

• Check Call Log Status displays the Check Call Log Status dialog box fo
reviewing the current status of a specified call log, based on a custome
Design Architect User’s Manual, v8.6_2B-10
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number, call summary status indicator, summary level, and approxima
start date of when the call log was initiated.

You must have email and be a registered SupportNet Email user to us
utility. For instructions on how to register for SupportNet and a descrip
of the syntax for each filed, refer to the pulldown menu
Support > Help > On SupportNet Email.

• Order Patch displays the Order Patch dialog box for electronically maili
a request to Mentor Graphics Support for a qualified patch of released
software. You can either enter a patch name, for examplep221, or the part
number for the patch. Be sure to include all required platform types, suc
HPUX, SunOS, or Solaris, for example.

You must have email and be a registered SupportNet Email user to us
utility. For instructions on how to register for SupportNet and a descrip
of the syntax for each filed, refer to the pulldown menu
Support > Help > On SupportNet Email.

Mentor Graphics ships completely qualified software updates when
software modifications are necessary. Typically, these are modification
that impact more than five percent of a product’s user base. Changes 
five measures of quality (FURPS) can cause a software update:
Functionality, Usability, Reliability, Performance, and/or Supportability.
Software updates are shipped on CD ROM to all affected customers
immediately after qualification.

• Help provides information about the queries you submit to SupportNet
SupportNet Email, and Web Browsers using the Support menu selectio
Send Testcase to MGC, Search TechNotes, Open Call Log, Check Call
Log Status, andOrder Patch. The information is displayed in a popup
window as a text file. TheSupport > Help menu is shown in Figure 2-130
Design Architect User’s Manual, v8.6_2 B-11
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.

Figure B-6. Support Submenu: Help

As shown inFigure B-6, theSupport >Help pulldown menu provides these
submenu items:

o On SupportNet displays the How to FTP SupportNet popup window
This window displays a text file that includes these topics:

• Mentor Graphics SupportNet,

• Directories on the SupportNet,

• How to Connect to SupportNet Manually,

• and FTP Connection File.

Support Info

Check Environment...

Check References...

List References...

Troubleshooting

Find Lock Files...

Generate Testcase...

Send Testcase to MGC...

Search TechNotes...

Help

Open Call Log...

Check Call Log Status...

Order Patch

On SupportNet Email

On Web Browsers

On SupportNet

Help
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o On SupportNet Email displays the SupportNet Email Instructions
popup window. This window displays a text file that includes these
topics:

• Introduction,

• To Query the Technical Application Notes database...,

• To Submit a Call Log into the North America or Europe Call
Tracking System,

• To Check the Status of Call Logs and Defect Reports..., and

• Mentor Graphics SupportNet-Email.

o On Web Browsers displays the Help on Web Browsers popup
window.
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INDEX
$MGC_HOME,2-20
$MGC_WD,2-20
.ed.new extension,B-9
.lck extension,B-9

A
Active symbol history list

loading,6-47
viewing,6-47

Adding properties in Design Context,4-16
Addresses for SupportNet Web sites,B-5
Annotations

reconnecting,4-31
reporting on broken,6-136
setting the color,6-8

Applying Edits,4-30
AppNotes,B-7
Architecture body,2-92
Attributes,2-50

change,2-51
commands and functions,2-53
internal state variables,2-51
line, 2-50
setup,2-51
summary,2-52
text,2-51

Auto Sequence Text,6-75
Auto_ripper_mode,6-43
Automatic Placement

Net Name,6-43

B
Back annotation

changing the color,3-9, 6-8
definition of,1-8
editing,6-169
expressions in,4-28
merging,4-19, 6-170
reporting on broken,6-136

setting visibility for new,4-15
viewing,4-17, 4-20, 6-168

Bits
extracting from bus,2-43

Built-in primitives,2-61
Bundle Repeating Syntax,2-32
Bus ripper,2-43
Buses,2-27

indicating width,2-30, 3-8
multi-dimentional,2-28
naming examples,2-34
stepping syntax,2-31

C
Call logs,B-10
Check Call Log Status dialog box,B-10
Check Call Log Status menu,B-10
Check command,5-3

setting up,5-5
user-defined error checks,5-5

Check Environment dialog box,B-9
Check Environment menu,B-9
Check References dialog box,B-9
Check References menu,B-9
Checks

annotations,A-12
close dot,A-11
dangling net and pin,A-11
expression analysis,A-10
instance,A-15
instance overlap,A-10
net,A-16
notdots,A-10
optional electrical rule violations checks,

A-17
parameter analysis,A-9
pin and port interface,A-15
required frame,A-5
required instance,A-1
required net,A-4, A-5, A-7
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Index
required property ownership,A-8
required special instance,A-2
required special symbol,A-14
required symbol body,A-13
required symbol pin,A-7, A-13
special instance,A-16

Class property,2-43, 3-28
Closeness Criteria

for Make Polygon,6-12
Color

changing for properties,6-129
setting for design objects,6-6
setting the annotation color,6-8
setting the color configuration,6-6
setting the selection color,6-8

Comment objects,2-25, 2-46, 2-58
add to schematic,2-58
adding,6-146
attributes,6-147
commands,2-47
convert objects to comments,2-48, 2-65
convert to comments symbol graphics,2-65
sheet border,6-150
title block,6-150
types,2-46
uses,2-48

Compiled pin name,2-64
Compiling VHDL,2-70
Component

change references,2-103
copy,2-99
definition of,2-83
delete,2-103
design manager,2-83
move,2-99
rename,2-100

Component interface
body property set,2-85
definition of,2-84
instance definition,2-95

model table,2-85
pin list, 2-85
registration of models,2-87
registration, multiple models,2-93
registration, multiple symbols,6-115
reporting,6-132

Component Interface Browser,2-86
Component library,1-6

choosing from,6-43
default,6-48
dialog navigator,6-44
interface default,6-50

Component models
behavioral language models,1-7
gen_lib primitives,1-7
hardware models,1-8
quickpart schematics,1-7
quickpart tables,1-7
sheet-based models,1-7
VHDL models,1-8

Copy
alter basepoint during,6-26
design object,2-99
inter-window,2-81
multiple,2-80
objects,6-26
objects between windows,6-29
repeat,6-26
to a line,6-27
to an array,6-28
to array,2-80

Copy objects,2-80
Create a symbol pin list,6-144
Creating VHDL Entity for a symbol,6-145
Customer Support Web Page,B-8

D
DA Startup Files,2-19
Dangling net,3-29
Default library,6-48
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Delete,6-33
Delete objects,2-80
Deleting a component,2-103
Design

hierarchy,2-62
Design Architect Environment,2-1
Design Architect menu bar,2-2
Design Architect palette menu,2-2
Design Architect Session popup menu,2-2
Design Architect Session window,2-1
Design checking,A-1

close dot checks,A-11
dangling net and pin checks,A-11
expression analysis checks,A-10
frame checks,A-5
init property checks,A-9
instance checks,A-1, A-15
instance overlap checks,A-10
net checks,A-4, A-5, A-7, A-16
not-dot checks,A-10
parameter analysis checks,A-9
pin and port interface checks,A-15
property ownership checks,A-8
required special symbol checks,A-13
required symbol body checks,A-13
required symbol pin checks,A-13
special instance checks,A-2, A-15
symbol pin checks,A-7

Design Context
add properties,4-16
locking sheet for edits,6-170
merge back annotations,4-19
open design sheet,6-165
opening a non-existant component,6-171
opening a non-existant schematic,6-171
traverse the design hierarchy,4-18
view properties,4-17

Design Management
change component references,2-103
configuration build,6-175

configuration object,2-98
copy design object,2-99
delete design object,2-103
move design object,2-99
object checking,6-174
reference checking,6-173
release a design,2-104
rename design object,2-100
verification,6-176
versions,2-106
viewing hierarchy,6-146

Design Management submenu,B-5
Design Manager,6-2

invocation from,6-2
Design Navigation,2-107

closing a multiple sheet schematic,2-109
left arrow button,2-107
multiple page icon button,2-107, 2-108
navigating multi-sheet schematics,2-108
right arrow button,2-107

Design Sheet window,2-7, 6-166
Setting the Viewpoint,6-9

Design Viewpoints
applying edits,4-30
conceptual explanation,4-1
evaluating properties,4-25
how they are created,4-13
iconic view,4-10
multiple views of a source design,4-3

Design-wide net,2-39
Design-wide net naming rules,2-39
Dialog boxes

Check Call Log Status,B-10
Check Environment,B-9
Check References,B-9
Generate Testcase,B-9
List References,B-9
Open Call Log,B-10
Search TechNotes,B-10
Send Testcase to SupportNet,B-10
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Index
Dialog navigator,6-44
Dynamic Cursor

setting the shape,6-10

E
Edit symbol in-place,2-68
Electrical connectivity,2-25
Electrical objects represented on a schematic,

2-26
Electrical rule violation checks,A-17
Electrical rule violations checks

schematic,A-17
sheet,A-17

Elements of VHDL,2-70
Email to SupportNet,B-3, B-10, B-11
Entity description,2-92
Environment Variables

DES_ARCH_HIDE_BA_ONLY_PROPS,
4-16

HOME, 2-20, 4-16
MGC_GENLIB,2-41
MGC_HOME,2-20
MGC_LSLIB, 1-6
MGC_WD,2-20, 6-4

Error checking
Check command,5-3
Check command switches,5-4
close dot checks,A-11
dangling net and pin checks,A-11
evaluated,5-7
expression analysis checks,A-10
frame checks,A-5
init property checks,A-9
instance checks,A-1, A-15
instance overlap checks,A-10
net checks,A-4, A-5, A-7, A-16
not-dot checks,A-10
overview,5-1
parameter analysis checks,A-9
pin and port interface checks,A-15

property ownership checks,A-8
reports,6-136
required special symbol checks,A-13
required symbol body checks,A-13
required symbol pin checks,A-13
schematic,6-57
schematic checks,6-57
sheet checks,6-57
special instance checks,A-2, A-15
symbol,6-112
symbol pin checks,A-7

error checking
schematic error checking,A-18

Expressions,3-20
Expressions in back annotation objects,4-28
External Port,2-42

F
Find Lock Files menu,B-9
Flip objects,2-80, 6-35
Frames,2-40, 6-86, 6-89

setting parameters,6-90
Frexp property,3-32

CASE value,3-32
FOR value,3-33
IF value,3-35
OTHERWISE value,3-33

Functional blocks,6-137
Functional models,2-87

examples of,1-6

G
Generate

symbol from pin list,2-67
symbol from schematic,2-66

Generate Testcase dialog box,B-9
Generate Testcase menu,B-9
Global property,3-30
Global signals,2-29
Globals,2-45
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Graphic commands,2-47

H
Handles,2-49
Help

on Support menus,B-11
quick,6-5
reference,6-5

Hidden Symbol Property Text,6-11

I
IDW Component Window,2-86
Inst property,3-30

character restrictions,3-8
Instance,2-24, 2-41

instance evaluation,2-95
instantiation,2-41
placing,6-43
repeating,2-40, 6-87
replace,6-51
resizing,2-101, 6-31
special,2-41

Instance evaluation,2-95
Instantiation,2-41
Integrated command set,2-15
Inter-window copy and move,2-81
Invocation

from Design Manager,6-2
from operating shell,6-4

J
Joining sliced objects,6-101

L
Library

setting default,6-48
Library palette,6-43
Licensing submenu,B-5
List References dialog box,B-9
List References menu,B-9

Listing check status,5-7
Logical symbol,2-24

M
Make symbol on schematic sheet,2-69
Manipulate graphical objects

copy,2-80
copy to an array,6-28
copy to line,6-27
delete,2-80
flip, 2-80
move,2-80
pivot, 2-80
rotate,2-80
select,6-13
the "match" command,6-15

Manipulating Graphical Objects
hot keys for move and copy,6-23

Manipulating graphical objects
basepoint change during copy,6-26
basepoint change during move,6-24

Mentor Graphics User’s Group,B-8
Menus

Design Management,2-97
Help,6-5
Library, 6-44
palette popup,6-51
Session,2-2
Window,6-4

Merging annotations,4-19
Model registration,2-82
Models

definition of,2-87
functional,2-87
registration and labeling,2-87

Move
basepoint change during,6-24
cycle origin through pins during,6-44
design object,2-99
flip during,6-44
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n

inter-window,2-81
objects,6-24
objects between windows,6-25
repeat,6-25
rotate during,6-44

Move objects,2-80
MUG, B-8
Multi-Dimentional Buses,2-28
Multiple window object selection,2-79
Multiple window viewing and editing,2-19

N
Naming Nets

Automatic Placement,6-43
Net,2-24, 2-27

dangling,2-57, 3-29, 6-57
Net and bus naming examples,2-34
Net connector,2-41
Net naming syntax,2-29
Net property,3-30

character restrictions,3-8
Net router,2-57
Net vertices

connecting,6-54
disconnecting,6-54

netcon,2-41
Nets

attributes,6-42
auto_ripper_mode,6-43
auto_route_mode,6-54
connecting,6-54
disconnecting,6-54
global signals,2-29
modifying names,6-55
moving net names,6-56
naming,6-54
routing,6-54
terminating dangling net,6-56
valid dangles,6-57

Null instance,2-46

O
Object attributes,2-50
Object handles,2-49
Object selection,2-71
Off-page connector,2-42, 6-140
Online help,6-5
Open Call Log dialog box,B-10
Open Call Log menu,B-10
Opening a Non-Existant Component in Desig

Context,6-171
Opening a Non-Existant Schematic in Design

Context,6-171
Opening multiple sheets,6-38
Optional schematic sheet checks,A-8
Order Patch menu,B-11

P
Palettes

Library, 6-44
popup menu,6-51
Session,2-2

Parameter
definition of,3-18
setting,6-90

Part
definition of,2-84
elements of component,2-84

Patches,B-8
Pin,2-27

grid, 6-93
spacing,6-93

Pin list,6-144
Pin naming syntax,2-29
Pin property,3-30

character restrictions,3-8
Pivot objects,2-80, 6-34
Polygons

making from polylines,6-101
Port,2-43
Primary design unit,2-92
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Printing
All sheets with back annotations,6-155
bitmap format,6-155
configuration,6-159
from operating system shell,6-159
From Schematic Editor window,6-156
From Session window,6-155
From Symbol Editor window,6-156
From VHDL Editor window,6-157
Schematic sheet,6-156
Schematics with protected objects,6-157
VHDL documents,6-157

Printing/Plotting submenu,B-5
Properties

adding multiple,6-121, 6-131
adding single,6-119
AMPLE, 3-20
attribute_modified,3-14
auto_update_mode,6-51
automatic update,3-16
changing attributes,6-127
changing hidden symbol property text,

6-11, 6-130
changing the color,6-129
changing values,6-125
character restrictions,3-8
class,2-29, 2-57
dangling nets,6-57
deleting,6-123
deleting owners,6-124
evaluating,4-25
global,2-29
in context of a design,4-15
introduction,3-1
listing information,6-125
logical symbol,3-11
mark property attributes,3-15
mark property value,3-15
merge options,3-16
name,2-24

name restrictions,3-7
names versus values,3-5
net,6-54
parameters,3-18
propagation,3-28
repeat adding,6-122
set owner,2-57
setting attributes,6-117
setting owners,6-123
stability switches,3-12
symbol,3-9
types,3-6
update switches,3-16
updating,3-14, 6-50
value,2-24
value restrictions,3-7
value_modified,3-14
viewing evaluated,6-169
visibility switches,3-13

Properties variable resolution
examples,3-23
facts,3-22

Property
attributes,6-117

Property annotation
definition of,1-8

Q
Quick help,6-5

R
Reconnecting Annotations,4-31
Redo,2-82
Reference help,6-5
Registration

multiple models,2-93
schematic,2-90
symbol,2-88
VHDL, 2-92

Reopen selection,2-75
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ts,
Repeating instances,2-40, 6-87
Repeating Syntax

bundle,2-32
Replacing properties,6-50
Reporting on broken annotations,6-136
Reporting on check status,6-136
Reporting on objects,6-134
Reselection,2-75
Resizing Instances,2-101, 6-31
Ripper

auto_ripper_mode,6-43
Ripping

bits from bus,2-43
bits from two-dimensional bus,2-43

Rotate objects,2-80, 6-34
Rule property,3-30

S
Schematic

adding comment objects,6-146
auto_ripper_mode,6-43
auto_update_mode,6-39
check,2-59
convert comment objects to symbol,6-149
creating a bus,6-64
creating a sheet for a symbol,6-138
creating a symbol for,6-142
creating additional sheets,6-140
creating CASE frames,6-90
creating FOR frames,6-86
creating IF frames,6-89
default check settings,6-59, 6-61
grid snap,6-40
grid spacing,6-40
net attributes,6-42
open down,6-142
opening a sheet,6-37
opening a sheet, options,6-39
pin spacing,6-40
placing symbol,6-43

register,2-59
registering,6-63
reporting on objects,6-134
saving,6-63
setting edit environment,6-39
sheet border,6-150
sheet checks,A-1
title block,6-150
unctional blocks,6-137

schematic
error checking,6-60

Schematic capture
definition of,1-3

Schematic Editor window,1-3, 2-3
Schematic registration,2-90
Schematic window pulldown menu bar,2-4
Search TechNotes dialog box,B-10
Search TechNotes menu,B-10
Secondary design unit,2-92
Selection

closed selection set,2-73
general,2-72
individual,2-78
multiple window,2-79
name display of selected instances and ne

6-22
out-of-view selected objects,6-21
reopen,2-75
reselection,2-75
selection color,6-8
selection filters,2-77
selection set,2-73
specific,2-72
text,2-78

Selection filters,2-77
setting,6-21

Send Testcase to MGC menu,B-10
Send Testcase to SupportNet dialog box,B-10
Sequence Text,6-75
Session window pulldown menu bar,2-2
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Setting interface default,6-50
sheet

error checking,6-58
Sheets

opening multiple,6-38
SLD properties

Class,3-28
Frexp,3-32
Global,3-30
Inst,3-30
Net,3-30
Pin,3-30
Rule,3-30

Slicing graphic objects,6-100
Special instances,2-41

bus ripper,6-68
net connector,6-81
using off-page connectors,6-140
using port symbols,6-141

Speed Dial Info submenu,B-9
Startup files,2-19
Stepping

bus naming syntax,2-31
Support Info menu,B-5
Support menu

Check Call Log Status,B-10
Check Environment,B-9
Check References,B-9
Design Management,B-5
Find Lock Files,B-9
Generate Testcase,B-9
Help,B-11
Licensing,B-5
List References,B-9
Open Call Log,B-10
Order Patch,B-11
Printing/Plotting,B-5
Search TechNotes,B-10
Send Testcase to MGC,B-10
Speed Dial Info,B-9

Support Info,B-5
Troubleshooting,B-3
Userware,B-5
WWW AppNote Page,B-7
WWW Configurations Page,B-8
WWW MUG Home Page,B-8
WWW Patch Page,B-8
WWW Support Home Page,B-8
WWW SupportBulletin Page,B-8
WWWTechNote Page,B-7
X Environment,B-5

SupportBulletins,B-8
Symbol

activating from Symbol Editor,6-48
add pins,6-101
adding multiple pins,6-102
adding single pin,6-102
bus ripper,6-70
check,2-65, 6-112
consecutive pins,6-104
convert comment objects to symbol,6-149
create from schematic,6-138
creating from VHDL,6-145
creating VHDL Entity for a symbol,6-145
default check settings,6-112
draw symbol body,6-94
edit in-place,2-68
edit sheet of,6-142
generate from pin list,2-67
generate from schematic,2-66
joining sliced parts,6-101
opening,6-92
pin, 2-60
pin names,6-101
pin spacing,6-93
placing,6-43
register,2-66
registering,6-114
registering multiple symbols,6-115
reporting on objects,6-134
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saving,6-114
setting edit environment,6-93
slicing,6-100
symbol body attributes,6-93

Symbol Editor window,1-4, 2-5
Symbol graphics,2-47
Symbol pins,2-69
Symbol properties

logical symbol,3-9
stability switches,3-12
update switches,3-16
visibility switches,3-13

Symbol registration,2-88, 6-115
Symbol window pulldown menu bar,2-5

T
TANs, B-10
TechNotes,B-7
Testcases

generate,B-9
send,B-10

Text
auto sequence,6-75

Text attributes,2-51
Troubleshooting menu,B-3

U
Undo,2-82
Unselection,2-79

multiple objects,6-19
single object,6-19

Updating properties,6-50
attribute_modified,3-14
auto option,3-16
auto_update_mode,3-16, 6-51
automatic,3-16
clear option,3-16
default,3-16
during open sheet,3-16
examples,3-17

instance of symbol,3-14
instance option,3-16
mark property value,3-15
merge options,3-16
symbol option,3-16
value_modified,3-14

User-defined error checks,5-5
Userware submenu,B-5

V
Valid dangling nets,6-57
Value_Modified flag,3-14
Versions,2-106
VHDL Editor
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